Learning Material
for
DOEACC ITES BPO (Customer Care) Training Program

Developed by :
DOEACC Society Guwahati / Tezpur Centre

Guwahati Address :
Near LGBI Airport, Borjhar, Guwahati-781015
Ph : + 91 361-2843247/2843269 (O)
Fax : + 91-361-2843270
E-mail : guwahati@doeaccassam.ac.in

Tezpur Address :
2nd Floor, ICCW Building
Near Civil Hospital, Tezpur-784001, Assam India
Phone : +91-3712-230310, Fax : +91-3712-252671
E-mail : tezpur@doeccassam.ac.in
PREFACE

The DOEACC ITES BPO (Customer Care) course has been designed and executed under the aegis of DOEACC Society Tezpur/Guwahati Centre (a unit of DOEACC Society, under the Ministry of Communications & Information Technology, Govt. of India) in preparing people for the ITES BPO (Customer Care sector). The training program was sponsored by way of fee subsidy for training from 2003 to 2008 by Ministry of DONER, where in 2120 number of candidates have been trained in seven locations viz. Guwahati, Tezpur, Jorhat, Shillong, Gangtok and Agartala and a total of 931 candidates have been placed in various call centers and other BPO industries as on April 2008 as per records. Moreover the DOEACC centres at Imphal, Aizwal and Kohima also trained nearly a 1000 trainees under this program. From 2008 the Dept. of Information Technology, Govt. of India has also sponsored this program by way of fee subsidy for training 4800 women trainees in sixteen locations in the North Eastern region viz Guwahati, Tezpur, Jorhat, Nagaon, Sibsagarh, North Lakhimpur, Mangaldai, Silchar, Bongaigaon, Shillong, Gangtok, Imphal, Aizwal, Kohima and Agartala. This program has started w.e.f. 2008 and is to be completed by April 2011(3 years). This training program is also conducted without sponsorship at DOEACC Society, Kolkata, Jammu & Kashmir and Gorakhpur.

Experts from the ITES BPO industry, eminent academicians were involved in the process of developing the syllabus for the training program. The course has been developed in three modules that include Soft Skills (Communications, Call handling skills, Domain knowledge skills, Corporate culture, CRM Concepts and Behavioral skills), English Skills (Communication in English, Vocabulary, pronunciation, listening and speaking skills, Business English etc.) and Basic Computing Skills.

This book contains study material on Soft skills comprising of eight topics, English language of seven topics and Basic Computing skills of eight topics. All the outlined points in each of the topics have been elaborately dealt with ample illustrations and instructions. Each of the topics is accompanied by a list of practical assignments and tutorials. The tutorials and practical assignments have been designed in such a way that the students get a chance to check their progress.

The experts and academicians who faced the challenging task in developing these course materials under the guidance of Shri. K. Baruah, Director, DOEACC Society, Guwahati/ Tezpur are Prof. Tabu Taid (Resource Person) and Ms. Reshma Shah (Consultant). The supporting team comprised of Mr.Sazzad Zahir (ITES Coordinator), Ms. Rimi Phukan (ITES Faculty), Mrs. Jaya Devi (ITES Faculty) and Ms. Khamseng Baruah (ITES Faculty) who deserves appreciation for their efforts in preparation and compilation of this course materials.

DOEACC Society  Guwahati / Tezpur Centre
## Contents

<table>
<thead>
<tr>
<th>Chapter No</th>
<th>Title</th>
<th>Page No</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SOFT SKILLS</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UNIT 1</td>
<td>COMMUNICATION SKILLS</td>
<td>1</td>
</tr>
<tr>
<td>UNIT 2</td>
<td>CALL HANDLING SKILLS</td>
<td>27</td>
</tr>
<tr>
<td>UNIT 3</td>
<td>CORPORATE CULTURE</td>
<td>42</td>
</tr>
<tr>
<td>UNIT 4</td>
<td>CRM -THE MANAGEMENT MODEL</td>
<td>69</td>
</tr>
<tr>
<td>UNIT 5</td>
<td>ACHIEVING EXCELLENT CUSTOMER SERVICE THROUGH CRM</td>
<td>79</td>
</tr>
<tr>
<td>UNIT 6</td>
<td>SELLING SKILLS</td>
<td>92</td>
</tr>
<tr>
<td>UNIT 7</td>
<td>TIME MANAGEMENT</td>
<td>92</td>
</tr>
<tr>
<td>UNIT 8</td>
<td>STRESS MANAGEMENT</td>
<td>107</td>
</tr>
<tr>
<td><strong>ENGLISH SKILLS</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UNIT 1</td>
<td>HOW TO LEARN ENGLISH</td>
<td>151</td>
</tr>
<tr>
<td>UNIT 2</td>
<td>LISTENING</td>
<td>160</td>
</tr>
<tr>
<td>UNIT 3</td>
<td>PRONUNCIATION</td>
<td>169</td>
</tr>
<tr>
<td>UNIT 4</td>
<td>VOCABULARY</td>
<td>183</td>
</tr>
<tr>
<td>UNIT 5</td>
<td>SPEAKING</td>
<td>199</td>
</tr>
<tr>
<td>UNIT 6</td>
<td>BUSINESS ENGLISH</td>
<td>206</td>
</tr>
<tr>
<td>UNIT 7</td>
<td>NON-VERBAL COMMUNICATION</td>
<td>215</td>
</tr>
<tr>
<td><strong>I.T. SKILLS</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UNIT 1</td>
<td>INTRODUCTION TO ITES/ CALL CENTRE</td>
<td>227</td>
</tr>
<tr>
<td>UNIT 2</td>
<td>INTRODUCTION TO COMPUTER FUNDAMENTALS</td>
<td>237</td>
</tr>
<tr>
<td>UNIT 3</td>
<td>INTRODUCTION TO INTERNET</td>
<td>275</td>
</tr>
<tr>
<td>UNIT 4</td>
<td>OFFICE AUTOMATION TOOLS : MS OFFICE</td>
<td></td>
</tr>
<tr>
<td>4 (A)</td>
<td>MICROSOFT EXCEL</td>
<td>291</td>
</tr>
<tr>
<td>4 (B)</td>
<td>MICROSOFT POWER POINT</td>
<td>325</td>
</tr>
<tr>
<td>4 (C)</td>
<td>MICROSOFT WORD</td>
<td>339</td>
</tr>
</tbody>
</table>

DOEACC Society Guwahati / Tezpur Centre
Learning Material for ITES

SOFT SKILLS
1.0 OBJECTIVES

The objective of this topic is to introduce the concept of communication skills. It discusses the main components of the communication process. After going through this unit you should be able to:

- Understand the process of communication;
- Identify different styles of communication and use them in appropriate situations;
- Develop your presentation skills and listening skills;
- Improve your communication skills when you communicate with your peers, colleagues, customers and social circle.

1.1 INTRODUCTION

Effective communication is the key to the success of any interaction, both in the informal or personal context as well as the formal or professional context. On the professional front, an organisation depends on a well-defined communication system to get its work done and to communicate with its customers.
In order to make communication an effective management tool we must understand the essential elements of communication and how it creates an impact on inter personal relationships and productivity in any workplace.

As professionals we are required to handle different situations where different styles and means of communication need to be used. You may be called in to discuss a problem or asked to prepare a presentation to a group of business leaders. How you articulate and put your point across during a group discussion will be significantly different from how you make a presentation. A presentation requires a different skill set to be successful. Similarly, when working with team members you will need to have a mindset and manner of communication that will bring out the best in the team. Since the communication requirements are determined by the different roles that you play, you must be able to adapt your style of communication as the situation demands. In this unit, we will deal with the process of formal communication as a tool for enhancing individual growth and success and an instrument of organizational success.

1.2 COMMUNICATION SKILLS

1.2.1 Definition and Meaning

When we speak of communication, we normally think about the day-to-day talks and discussions we all indulge in. But that is not precisely communication. Although communication seems to be simple, it is not so. It is not just about blabbering or talking nonsensically. Communication can be defined as a process of translating any complex thought process into simple and meaningful utterances through an appropriate channel. Therefore, communication is a two-way interaction where both the parties cooperate and coordinate with each other in striking a meaningful conversation. Communication can take place both at the individual and organizational levels. When two or more people communicate face-to-face or via the telephone or by means of any other technology (such as internet chat tools), it is a comparatively simple process. However, when a group of individuals interact with one another or with an organization, the communication process becomes much more complex and requires certain skills to generate it smoothly.

For any kind of organizational growth, effective communication skills are a must because an open and healthy communicative ambience always provides ideal conditions for generating constructive feedback. Feedback always determines the efficacy of any communication process and ensures its successful completion.

The word “communication” has been derived from the Latin word “communis”, meaning common. A person with whom we wish to share an idea will understand what we speak and write only when we communicate it in a way that will be understood by the other person. An idea in itself cannot be understood, unless it is made relevant by our ability to express it clearly in a concrete manner. And this is not always easy to do. It has to be coded either in words or symbols and signs.
Communication can be effective or ineffective depending upon the performance of the parties participating in the process of transaction of views or ideas. Therefore, it is essential to consider the factors that contribute positively towards effective communication and those that act as barriers.

In order to succeed in our efforts to communicate our thoughts effectively to the receiver of the information we deliver, simply expressing our ideas through words is not enough. It is “how we communicate” that is more important than “what we communicate” because it is crucial for the success of our communication. Research has shown that more than half of what is conveyed between people in face to face discussions is communicated ‘non – verbally’. If we want our messages to be understood and accepted, we do need to take into account the non-verbal cues that accompany the way we speak. So it is not just “what we say” that defines the communication process, it is “what is understood from it” that is more crucial to effective communication. As Peter Ustinov says, “Communication is the art of simply being understood”. To put it simply, communication is the expression of an idea, which may be verbal, non-verbal or vocal, that is perceived, heard or read by another person.

Some other definitions of communication that have been widely used are given below:

- A transactional process that involves an exchange of ideas, information, feelings, attitudes or beliefs and impressions.
- A cultural interaction with people in groups for conversing and sharing ideas in social gatherings and not talking shop.
- A disseminating process that involves passing on information to the masses through media.
- An interaction process with the corporate.
- A transformational process that motivates and fosters growth and mutual understanding.
- A dynamic process that challenges “what you say” and “how you say”.

Therefore, it is all the more essential to understand how the communication process works and how to improve one’s communication skills.

Activity 1

As individuals, we have all faced situations when we had difficulty explaining a point and were consequently frustrated in our efforts; or were extremely happy with the outcome of an interaction. Can you recollect any such instance in your personal life? If you were in a frustrating situation where what you said was not being understood correctly (at a wedding party, family get-togethers, group discussion etc.), what factors do you think contributed to it? Again, if you were in a situation where what you said was being clearly understood, what factors do you think contributed to it? Do you think the factors that you mention can be addressed or improved?
Activity 2

Research shows that more than 70% of a trainee’s total working time is spent on communication. See the list below and check the time that you spend on different tasks during a typical day.

<table>
<thead>
<tr>
<th>Task</th>
<th>Easy</th>
<th>Difficult</th>
<th>More difficult</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demonstrating/ explaining</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Giving presentations (oral/ written)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interacting with colleagues/peers to solicit help/advice/information</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interacting with strangers/friends via telephone, face-to-face, online chats</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Participating in meetings/ group discussions/seminars/workshops</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reading and responding to business emails/letters/memos</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Report writing / documentation</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Can you identify the main tasks where you spend the most time? How crucial are they to your role as a learner? Do you think that you have the required communication skills to handle such tasks efficiently? Please assess yourself by ticking in the correct box according to your personal aptitude on the basis of the parameters given above- Easy, Difficult, More difficult.

* List of tasks adapted from Krishna Mohan and Meera Banerji (2006)

1.2.2 The process of communication: the intent and the content

Communication is a dyadic and cyclic process. Dyadic means that it is an interaction between two persons (or two entities) and cyclic means that the process is not one-way: a message originates and is transmitted via a common medium and code, and it is processed at the receiver’s end, after which there is a to-and-fro transmission of messages from each end to confirm the understanding or react to the message. This to-and-fro transmission of messages continues till there is mutual agreement on the message and the process is then formally brought to a close.
In order to start the communication process ideas need to be conceived in the mind. These ideas, when processed consciously, flow out in the form of spoken or written words. The concrete ideas attain meaning as they are transmitted through a series of commonly understood codes (language or other signs). When the message reaches the receiver, he processes the message consciously in his mind to unravel the underlying meaning of the message. Once the meaning is deciphered the receiver acts upon the message in a desired manner by leaving enough room for feedback. The reciprocation or feedback given by the receiver to the sender of the message is important for the fulfillment of the communication process. Thus the cycle of communication is accomplished. During dyadic communication (face-to-face or telephonic interaction) all this takes place instantaneously, so there is a great risk of miscommunication as there is not enough time to process or understand the deeper meaning of what is being said.

In a nutshell, the communication process comprises the following elements:

- The sender
- The sender has an idea
- The sender encodes the idea into a message
- The message travels through a channel
- The barriers in the path of transmission process
- The receiver gets the message
- The receiver decodes the message
- The receiver provides the message
- The frame of communication between the sender and the receiver

The interlinking of these elements of communication completes the cycle of communication process as shown below:

**FRAME OF REFERENCE**

```
SOURCE  SENDER  MESSAGE  RECEIVER  RESULT

CHANNEL  CHANNEL

SENT  RECEIVED

NOISE

FEED BACK
```

Diagram 1.2: Components of communication
Unit 1-COMMUNICATION SKILLS

One factor that determines the quality of communication is the relationship between the intent and the content of the message. The correlation between thoughts and the way of expressing them is the relationship between the intent and the content of a message. The closer the content (for example, language used) is to the intent (idea/meaning intended), the greater the chance that it will be understood clearly. There are however, many instances when the use of inappropriate words or language or wrong terminology creates barriers to the communication process as it takes the receiver longer to understand. It is essential, therefore, to be conscious of how best to communicate a thought in a particular language.

Another factor is the attitude of the person who is communicating. It is said that a positive person is likely to have good communication abilities, as his thoughts will be coloured by hopefulness and optimism. His ideas will be more concrete, his outlook and attitude more positive and his values stronger than a person whose pessimistic bent of mind cannot hold the thread of communication for a long time showing a lack of effectiveness.

However, given the nature of communication, which is highly intricate and interactive, it is not always easy to have a control over our mind. A tacit relationship between our thought-process (intent) and its varied form of expressions through words (content) is illustrated in the concepts discussed below.

The Top Performers Leadership Centre based in Singapore had developed an interesting concept of ISEP (Inner side of Effective People). This concept focuses highly on the effectiveness of communication process through exercises and self-realization games. This concept has brought home the fact that there is a very deep connection between our patterns of thoughts and patterns of communication. Further research led to the concept of ISEC (Inner Side of Effective Communicators).

The representation below shows that effective communication lies at the base of all relationship building processes.

<table>
<thead>
<tr>
<th>Inner side of effective people (ISEP)</th>
<th>Inner side of effective communicators (ISEC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effective communication is at the base of all relationship building</td>
<td></td>
</tr>
<tr>
<td><strong>To be a learner</strong></td>
<td><strong>To take responsibility</strong></td>
</tr>
<tr>
<td>- Unlearning</td>
<td>- Be committed</td>
</tr>
<tr>
<td>- Learning</td>
<td></td>
</tr>
<tr>
<td>- Re-Learning</td>
<td></td>
</tr>
<tr>
<td><strong>Consideration</strong></td>
<td><strong>Conciseness</strong></td>
</tr>
<tr>
<td>- Your attitude</td>
<td>- Avoid all discriminatory thoughts and words</td>
</tr>
<tr>
<td><strong>Compleness</strong></td>
<td></td>
</tr>
<tr>
<td>- Need for adaptation</td>
<td></td>
</tr>
</tbody>
</table>

To have total involvement

Unlearning Learning Re-Learning
Be open
- Avoid Focusing on unimportant details
- Listening with an open mind

To have a purpose Clarity
- Achieve a new level of attention by disciplining oneself to reserve one's opinions, evaluations and judgments

Concreteness
- Abstract Language

Correctness
- Avoiding all ambiguity
- Being Ethical

The concept of ISEP and ISEC emphasizes that communication is not only about learning functional skills in isolation but also knowing the 'why' and 'how' of communication.

1.3 STYLES OF COMMUNICATION

Communication styles can be classified into the following types:

(1) Aggressive

(2) Passive

(3) Assertive

In **Aggressive** style of communication, one always stands up for one's rights. Sometimes doing so may result in the violation of the other's rights.

Such communicators give the impression of being superior in attitude, domineering and self-important. They think their feelings are more important than that of the other person. They ignore or dismiss the needs, wants and opinions, feelings or beliefs of others and express their own in an inappropriate way. They may have a loud voice and articulate mostly in the second person. Their non-verbal cues are narrow eyes, clenched fists, pointing fingers, rigid posture and hard stares. These types of communicators often face disrespect from others. They are the worst victims of low-self esteem. As a consequence, they easily incur other people's wrath and in the worst case people avoid them out of fear. They give an impression that they have something to contribute and others have little or nothing to contribute. The aim of aggressive behaviour is to win at any cost.

The **Passive** style of communication allows the communicator to put others' rights before his and thus reduce his own self-worth.
Passive communicators always consider themselves to be inferior to others. They negate their personal feelings, rendering themselves unimportant. They fail to express their needs, wants, feelings, opinions and beliefs and express them in an apologetic and self-effecting manner. They have an overly soft voice with an apologetic demeanour. They create a negative impression on others by their non-verbal signals. They shy away from maintaining eye contact with people. Their downcast eyes, stooping posture and excessive nodding of the heads may indicate lack of drive and motivation. They suffer from poor self-esteem and are heavily dependent on others for support and recognition. They are easily victimized and exploited at the same time, as other people tend to disrespect them. The aim of passive behaviour is to avoid conflict and to please others.

The **Assertive** style of communication teaches one to stand up for one’s rights while having respect for others’ rights.

Those communicating in assertive style give equal importance to both others’ as well as to their own rights. They deal with people on equal terms. They exude confidence in whatever they do and always own up responsibility for their actions. Assertive communicators stand firmly on their foot and don’t buckle under pressure. Talking straight on the face, looking directly, always at ease with oneself and others, relaxed and smooth body movements are some of the strong characteristics of any assertive communicator. Assertive communicators always buzz with life and activity wherever they go. These people are positive with a high self-esteem. As they give respect to all they also get it back in abundance. The aim of assertive behaviour is to satisfy the needs and wants of any two parties in a given situation.

Amongst these three distinctive styles of communication, the Assertive style of communication is the one to strive for. Depending on your personal circumstances, you can make use of the other two styles as well. In a situation, where being passiveness may drive home an important point or may resolve an issue it is better to act passive. Likewise, aggressiveness also helps sometimes in turning a situation in your favour, especially when you know you are not getting anywhere in that situation.

**Activity 3:**

Mr. Roy is a sincere and hardworking person who does his job quietly and does not like to argue much. He prefers to write notes and send written messages instead of face-to-face interaction. He is being given the responsibility of leading a team to handle a prestigious project. But before that he has to get the project approved by the board of directors. Can you suggest what style of communication he should use to make it a success? Discuss with your instructor.
Check your progress 1

Note: 1) Use the space below for answers

2) Compare your answers with those given at the end of this unit

1) Which style of communication do the following portray?

a) “That is all right. I will continue once you have finished!”

b) “Wait! Let me finish first!”

d) “I appreciate your opinion, but may I finish first, as I am running a little late?”

a) ........................................

b) ........................................

c) ........................................

1.4 COMMUNICATION NETWORKS IN AN ORGANISATION

There are regular patterns of communication in an organisation. They are referred to as communication networks. These networks can be formal or informal. The formal network functions as a chain of command. It enables the organisation to disseminate information throughout the organisation and also gather information in the form of formal reports, letters, memos, announcements. In a healthy organisation where there is exchange of ideas, information mainly flows in three directions: downward, upward and horizontal.

**Downward communication** occurs when decision makers such as top executives and directors or CEOs pass down information related to organizational goals, mission, plans, or expectations from employees or make any formal announcement. To avoid distortion of such communication it is essential for managers to use effective communication techniques (simple and appropriate language, clear instructions, brief points, no roundabout language) that remove ambiguities and misunderstandings.

**Upward communication** occurs when subordinates initiate discussions (seeking solutions, resolving problems, raising an important issue, making the superiors aware of certain problems and issues) with their superiors regarding their responsibilities. Face-to-face talk, emails, messages, memos and reports, and phone calls are used as channels for such communication. However, because of the hierarchical nature of the organisation there may be a perceptual difference regarding certain issues and a manager may not see eye-to-eye all the time with subordinates. As organisations recognize the potential and
importance of information that comes from people on the floor, they encourage upward communication in the form of feedback or review meetings and have an ‘open door’ policy.

**Horizontal communication** occurs when employees working at the same level or peer group exchange information. This works best within a congenial working environment when there can be free flow of ideas, best practices are shared and colleagues are supportive of each other. An organisation can benefit from such lateral communication when the people involved in them use it for productive purposes to exchange views, get feedback, ask for help or share knowledge. However, professional rivalry, ego problems or inability to use such channels appropriately may act as barriers to such communication.

### 1.5 ACTIVE LISTENING

Expressing our wants, beliefs, needs and feelings is only half the part of the entire communication process needed for our interpersonal effectiveness. The other half is listening and understanding mainly what is communicated.

“We were given two ears but only one mouth, because listening is twice as hard as talking.”

The process of listening is intricate and entails more than simply straining the ears to hear the sound along with the words accompanying the sound coming from a speaker. This implies that listening is hearing and at the same time understanding quite clearly what one has heard. When someone listens, he or she does it with the heart and the mind, not just with the ears. Let us now discuss the basic difference between hearing and listening in order to get a clear picture of how active listening functions as a formidable tool of communication in increasing effectiveness.

**Hearing and Listening**

Hearing is a natural and unconscious function of the ears. It is a simple, mechanical process that enables us to hear all the sounds around us.

**Listening is a conscious effort on the part of the listener. One has to pay attention to every detail to listen.**

When a listener activates his mind to listen, three basic modes of listening begin to work.

According to clinical psychologist, Dr. Larry Alan Nadig, **Combative or Competitive listening** happens when we are more interested to promote our own point of view then understanding what the other person is saying. In this process of listening, we listen to the other person solely with the aim of finding faults so that in turn we can attack the speaker with those weak points we have collected. As we pretend
to listen, we also wait impatiently for an opening, or to prepare our plan for upsetting the speaker by formulating a rebuttal and emerge a victor. Here, the motive of the listener is very obviously to compete or to combat.

In **Attentive or Passive listening**, we are genuinely interested in the other person’s point of view. We listen attentively but passively to what the other person says. We show our full understanding of the content or the message we have listened to, but we are quite passive in verifying our knowledge of understanding.

**Reflective or Active listening** is the most single and useful listening skill. In active listening we are also genuinely interested in understanding what the other person is thinking, feeling, wanting or what the message means, and we are active in confirming our understanding before we respond with our own new message. We restate or paraphrase our understanding of their message and reflect it back to the sender for verification. This verification or feedback process is what distinguishes active listening and makes it effective.

In Active Listening, our mind is focussed on all the sounds as well as the meaning attached to them. We not only hear the words with rapt attention but also concentrate on the feelings and emotions associated with those words. On listening actively we can ferret out the underlying intention or meaning of any message we receive from a speaker. Therefore, listening is akin to reading between the lines for a deeper meaning.

There is a real distinction between merely **hearing the words** and really **listening for the message**. When we listen effectively we understand what the person is thinking and/or feeling from the other person’s own perspective. It is as if we were standing in the other person’s shoes, seeing through his/her eyes and listening through the person’s ears. Our own viewpoint may be different and we may not necessarily agree with the person, but as we listen, we understand from the other’s perspective. To listen effectively, we must be actively involved in the communication process, and not just listen passively.

We all act and respond on the basis of our understanding, and too often there is a misunderstanding that neither of us is aware of. With active listening, if a misunderstanding has occurred, it will be known immediately, and the communication can be clarified before any further misunderstanding occurs.

In order to listen actively, you must –

- Concentrate
- Open your mind
- Pay attention to details
- Relate to the content or the ideas
- Focus on the hidden meaning
Unit 1-COMMUNICATION SKILLS

- Establish a relationship with the speaker for better understanding of the meaning of the message.
- Try to think about what the speaker is saying from his/her point of view.
- Not interrupt or finish sentences for the speaker. Be patient and let them finish.
- Focus on what is being said and not on what you are going to say in response.

Listening Tips

- Usually it is important to understand the message and verbalize the content using your own words. Simply parroting and reproducing the message word-by-word shows lack of proper understanding on the part of the listener.
- Depending on the purpose of interaction, and understanding what is relevant, you could reflect back the other person’s:
  1. Account of the facts.
  2. Thoughts and beliefs.
  3. Feelings and emotions.
  4. Wants, needs or motivation.
  5. Hopes and expectations.
- Do not respond to just the meaning or the content of the message; look for the intent beyond the message. Try to look for the feeling associated with the meaning. The dictionary meaning or the surface code is not the message.
- Inhibit your impulse to answer questions immediately. The code may be in the form of questions. Sometimes people ask questions when they want to express themselves and may not be open to hearing an answer.
- If you are confused and know you do not understand, either tell the person you don’t understand and ask him/her to say it another way, or use your best guess. If you are incorrect, the person will realize it and will likely attempt to correct your misunderstanding. Try repeating key words and try and match the language of the speaker.
- Use eye contact and listening body language. Avoid looking at your watch or at other people or activities around the room. Face and lean toward the speaker and nod your head, as it is appropriate. Be careful about crossing your arms and appearing closed or critical.
- Be empathic and nonjudgmental. You can be accepting and respectful of the person and their feelings and beliefs without invalidating or giving up your own position, or without agreeing with the accuracy and validity of their view.
1.6 GOOD COMMUNICATION SKILLS FOR A MANAGER

Working with others is an integral part of being a manager. It becomes crucial to employ effective communication to perform well as managers because the manager’s job is to ensure that work gets done. This can be ensured only if the channels of communication are open and the manager employs the right style and technique to get the best out of the team. Effective communication requires us to have clarity of thought and to be able to communicate that thought in unambiguous terms. At the same time it also involves actively listening by empathising with the interlocutor and making a sincere effort to understand what is being said. Empathy includes “the quality or process of entering fully, through imagination, into another’s feelings or motives.” In the fullest sense, empathy implies putting yourself into the other person’s shoes or even getting into his or her skin so that you really understand and feel his pain, fear, or, more positively, his joys. The opposite of empathy would be (in communication terms) invalidation: when someone presents an idea or feeling and it is rejected or contradicted. Feelings of anxiety, sorrow, fear or the like will occur and it could be very painful for the person.

Here is a list of good communication skills you should cultivate:

- Acknowledge others communicating with you verbally and non-verbally.
- Rephrase thoughts: It is often good to rephrase and repeat what is being said to you, back to those who are speaking. This insures that you understood what they said and more importantly, what they meant.
- Give examples: Using examples or personal experiences is a helpful way to communicate your ideas.
- Use good diction: Speaking clearly and distinctly is extremely important. People may miss your point if you are hard to understand.
- Maintain a positive attitude: You can communicate with a positive attitude whenever you speak. People will be more interested in what you say if you are using a positive sentence structure too.
- Establish (in clear terms) some unwritten rules regarding team dynamics and roles so that everyone knows what is expected of them. This helps to remove ambiguities and misunderstandings about who is supposed to do what, report to whom or hand over their completed work to whom.
- Listen actively: Listening is the key in developing any type of relationship.
- Interpret: Read between the lines of what is being said. Some people have a hard time expressing themselves. You can help them by trying to interpret what they mean.
- Share: Sharing your ideas is a personal effort to relate to others.
Unit 1 - COMMUNICATION SKILLS

- Build trust: You need to build a bond of trust between you and the others in the conversation. Make them feel more at ease and they will be more likely to exchange ideas.

- Make a connection: True communication requires a connection between the parties to a conversation. Try to build a connection. Find a common ground or common interest to open the way to a good conversation.

Activity 4

Your instructor will read out a newspaper article and ask you questions based on it. You may take down notes. Try and make this a daily activity in class and also take turns while reading. Try and bring life to the article by intonation. This will help you to enhance both your hearing and speaking skills.

1.7 HOW TO COMMUNICATE IN DIFFERENT SITUATIONS

As a professional, the demands on your time and job are many. You may be prepared for some of the demands and you may be given short notice for other requirements such as conducting a seminar, speaking at meeting, making a presentation or engaging in a group discussion or interview. All such situations require you to communicate your thoughts or opinion or idea to you. Here is a list of guidelines for how to communicate in such situations.

**Face-to-face**: Be simple and direct in your responses. Match your non verbal cues with what you are saying. Use hand gestures or other body language to give a positive impression about your intent. Even if you disagree about something, say so in clear terms but use appropriate language without getting too personal. Stay focussed on the topic, not on the person.

**Public Speaking**: Prepare, if you have the time, with good research and mentally organise your thoughts in a structured and cohesive manner. Articulate clearly as you will be speaking to an audience when people may have difficulty understanding your accent. Use audio-visual aids to support what you want to say. Make eye contact with different members of the audience but do not stay focussed on one person for too long or it will make them uncomfortable. Avoid long winded sentences. If reading out from a prepared speech, practice to get the right pause and modulate your voice accordingly. Underline the key points and emphasise them when you read them out. You must being a certain amount of passion into your speech or you will lose the attention of the audience. While taking questions, keep your responses brief and to the point. Do not show impatience even if the audience asks simple questions to issues that you may have discussed in your speech. Treat the audience with respect.

**Group Discussion**: In a group discussion, a small group of people interact face-to-face to exchange
information or attempt to find a solution to a problem. No one is assigned the role of a leader but as the discussion proceeds one person may emerge as the leader. For a group discussion to be an effective exercise it must have people with diversity of opinion, knowledge and skill, but with a shared, common agenda. To participate in a group discussion you must be sensitive to the group dynamics. Each participant must get a fair chance to speak and articulate their thoughts and opinions. Because of the semi-formal nature of such discussions, such discussions enable people to clearly articulate and express their opinions. If you have to intervene, do so without annoying the speaker. You may make notes but remain attentive to what is being said. Your body language should show interest and openness to discussing things. A defensive posture will create a negative impression and may not take the discussion further.

**Interview**: An interview is usually associated with a job interview where one representing an organisation assesses the other person (the applicant). Some interview situations may have one interviewee and more than one interviewer. Interviews are useful to elicit information that is not otherwise available in written records. Depending on the nature of the interview and the role you are playing (the one who is questioning or responding), you will encounter direct questions, open-ended questions, closed questions or loaded questions. Sometimes interviews are used as research techniques to collect data or gather customer feedback. When you use the interview method to gather data from the respondent or customer, you should keep a few things in mind. Never take on a superior attitude. Frame questions that elicit the required information. To make it easier for the respondent you may give choices to the respondent. In some cases when the respondent is not familiar with the terms being used or unable to understand the question, rephrase it, and repeat the question if required. During any interview do not enter into an argument or lengthy discussion. Avoid questions that may embarrass the respondent.

**Meetings**: Whether you are chairing a meeting or participating in it, follow certain protocol to ensure that the meeting achieves its objective. First you must clearly understand the objective of the meeting. If chairing, it is your responsibility to ensure that the objective is clearly articulated. Use simple language (The purpose of this meeting is to…, We have called this meeting to…). Explain why the participants are present and their role in the meeting. You will also have to act as a moderator and ensure that everyone gets a fair chance to speak. Know when to cut a discussion short or avoid heated arguments. As a participant, you must use active listening skills and demonstrate your interest in the topic with appropriate body language. Raise your hand or use appropriate gestures when you want to speak. Do not get too personal. Stick to the topic of discussion. Volunteer information, even if you think it is insignificant. Sometimes that may be of value to the group. If you are chairing the meeting, always remember to close the meeting with an appropriate summary and action points so that there is clarity about who does what and by what time. Thank everyone for attending.

### 1.8 HOW TO MAKE A PRESENTATION

Presentation is the process of presenting the content of a topic to an audience. It is the ability to speak effectively on a particular subject within a given time slot to create an impact on the listeners. Presentations
take place all the time in organizations. Generally, presenters take ample time to prepare a presentation. Yet, there are times when a presenter has to make a presentation on the spot. A presentation may or may not be supported by visual aids depending on the nature of presentation. People give presentations in all kinds of ways and situations and for all sorts of reasons. The audience might be just one person, a group of hundreds or anything in between.

For making a presentation successful, gathering a lot of information is not enough to ensure its success. It requires lot of behind the scenes preparation and good deal of concentration and hard work while actually giving the talk. In order to make a good presentation one has to start with three P’s-Preparations, Planning and Practice.

The act of giving a presentation is a skill that calls for clarity of thought, concept, logic and expression. A presentation that lacks clarity becomes a dull and boring lecture without serving any purpose. Clarity depends on these three factors:

- Appropriateness
- Relevance
- Confidence

Appropriateness suggests that the presenter must be familiar with the audience he is going to interact with while giving the presentation. It is important to know the type and the profile of the audience before getting started. The speaker has to show a genuine enthusiasm for the subject, understanding clearly its inherent thought process as well as its concepts. Accordingly, a thorough preparation of the subject is the right way to get started for a presentation. In the preparation process itself, the presenter should be ready to invest a considerable amount of energy to shape up the presentation with immense clarity of thought and concept.

While working on the Relevance of a presentation, a number of details need to be included. The relevance determines the importance of the subject matter, the depth of treatment of the topic within a limited framework and the usefulness of the content to the audience. While concentrating on the planning of the topic, a logical progression has to be made from one sub topic to another sub topic. This will keep the speaker focussed on what he has to speak at the time of actual presentation without losing track of his points. While preparing the topic, the speaker should also prepare some footnotes and references for effective handling of questions that would come from the audience. Relevance of the topic boosts up the clarity of logic and also helps you to decide what to throw out or retain when writing the presentation.

For a presentation to be really good, the speaker should present the topic with full Confidence. After adequate preparation and planning, the most important thing to do is to practice the presentation. As the saying goes, *practice makes one perfect*. In giving a presentation it is practice that makes the
presentation sound and perfect. Proper practice is nothing but rehearsing the sequence of the presentation, thereby making the speaker confident. The “clarity of expression” or “how the presentation is given” depends upon the confidence level of the speaker. The speaker’s body language, manner and tone, use of voice, his ability to build rapport with the audience, his capacity to manage properly the audio-visual aids and at the same time his ability to give satisfactory answers to the audience’s questions, reveal his clarity of expression.

How effective the presentation is depends to a large extent on the following factors:

- The presenter’s subject knowledge
- Logical thinking (the ability to organise information as pieces of content that can be presented according to a sequence or structure)
- Exposure and experience of public speaking (confidence)
- Ability to handle questions and answer them satisfactorily
- Ability to build a rapport with the audience
- Ability to clearly articulate a thought or give an opinion without being judgmental

1.8.1 Clarity and Oral Presentation

Oral presentation is an effective communication between two or more persons. The competencies of the presenter that will be tested are verbal and non-verbal communication skills, knowledge of making power point slides, ability to deal with inter-personal skills while handling questions and objections on differences of opinions and finally a word of thanks on a courteous note. Presentation demands multiple communication skills. Remember the adage small things make perfection, but perfection is not a small thing! Simple power point slides accompanied by excellent oral delivery make a presentation perfect.

But sometimes, oral presentation would also mean a face-to-face talk across the table. In this case, the topic of reference is explained without the use of any computer–based tool. In this kind of presentation, fluency and smartness are not the only factors. Presentation is about combining matter with manner. When you know the matter, words come to you naturally. To put across a point to your listeners you need a dash of sincerity and a seriousness of purpose. You can make your talk enjoyable once you talk with conviction and confidence. You can tweak the interest of your listeners by involving them.

Speaking to a small or large groups demand that you

a) handle your listeners well
b) know your subject well
c) sharpen your skills of speaking
1.8.2 Written Presentation

In a written presentation the factors of layout, content, language and style are of great concern. Here, we will discuss mainly about the documenting part of a presentation. Before preparing the slides, it is advisable for the beginners to write down the entire manuscript of the presentation. The following tips will help you to document your presentation:

**Putting it all together**: Clarify the topic; make sure that you know exactly what you will be speaking about. Make a well chalked out outline of the topic, mentioning the Heading, sub headings and other points to be included.

**Identify the theme**: Once the theme is identified you can easily weave your content around this theme. The theme must connect all the pieces of the content.

**Choose your words well**: The words must accurately express your thoughts. Avoid the use of difficult words, irrelevant phrase or jargons.

**Emphasize the important points**: The presentation must incorporate all the key concepts. Therefore, the slides should cover all the important points and not the bulky explanations, which is the responsibility of the presenter to convey to the audience.

**Edit Ruthlessly**: Time bound presentation needs conciseness and precision of expression. Superfluous words, phrases, sentences, paragraphs must be removed.

1.8.3 Steps for making a presentation:

Here are the steps you should follow when preparing for a presentation:

1. Analyse the audience (gather information regarding their demographic profile, level of knowledge, their needs, and attitudes)

2. Analyse the environment where you will make the presentation (if possible, find out about the location, the size of the room and whether you will get facilities such as a projector or computer for your audio-visual aids)

3. State the purpose of the presentation (Why the need for the presentation, what is the topic of discussion, is any action (approval, funding, opinion, agreement, learning) being sought from the audience?)

4. Brainstorm the main ideas (let the ideas flow as they come, then think of how to elaborate to illustrate them)
5. Making the presentation: Make the sub points for each of the main ideas (examples, illustrations, key points for each main idea)

6. Making the presentation: Develop the introduction and conclusion (The introduction should state the purpose of the presentation and give a preview of what you will present while the conclusion should summarise the key take-away points)

7. Making the presentation: Develop slides of other visual aides (Snapshots, demonstrations, film clips, animations, pictures, graphics of bar charts and other diagrams should be prepared as per requirement).

8. Edit the presentation

9. Make speaker notes and handouts if required

10. Rehearse, rehearse, and rehearse.

How do I make a presentation interesting?

In any presentation, the introduction must have a tremendous impact to grasp the attention of the audience. There are many ways to do this. You can begin with an anecdote that demonstrates or highlights what you will present. You may also use quotations or statistics to highlight the significance of your topic. You may even use humour by starting with a joke, provided, of course, it is relevant and within appropriate and acceptable social norms. Many presenters play by the ear, so that they know when to modify what they say as they can ‘feel’ how the audience is reacting. If you are inexperienced, you should stick to the conventional path and start with a formal introduction. As you gain in experience, you can get more creative. Many good presenters start with something that is attention grabbing and yet relevant to the topic. They may use the picture of a contemporary work of art, a photograph from a magazine or newspaper, a film clip or even an interactive game to let the audience ‘warm up’ to the topic. But remember, simplicity is the key to success. Keep your presentation simple and it is sure to impress the audience. Simple, of course, does not mean boring. Pepper your speech with the right pauses, the right questions and the right examples and you will have a presentation that will stay in your audience’s mind.

1.8.4 Body Language:

The effective delivery of a presentation is done not simply through words but also through the appropriate use of body language. It is very crucial to make a positive impact on the audience while giving a presentation. A presentation is all about verbal abilities, a visual and vocal impact. The following tips will help you to enhance your body language in a presentation.

- Stand straight, hold your head high and keep your shoulders straight and not drooping.
- A very normal standing posture will exude an aura of confidence about you, which is very necessary to keep your audience’s attention glued to you.
Unit 1-COMMUNICATION SKILLS

- While giving the presentation, your tone of voice should be well–controlled, the pitch should be neither very high nor very low; the pacing between the key words should be about 3 seconds for the audience to grasp your talk. A slower and lower tone indicates confidence and expertise, which can only be attained with a lot of practice.

- Maintain eye contact with the audience but don’t stare hard at them to the point of making them feel uncomfortable.

- Make use of the moving space that you get but that doesn’t mean you will frequently show your back to the audience.

- Use hand gestures to emphasise your main points and integrate it with an open body language.

Some common errors that should be avoided:

- Don’t put your face down.
- Avoid all awkward gestures (crossed arms, tilted body, eyes down and no smile).
- Avoid fidgeting.
- Stiff body (Give your body a bit of movement to add a little variety to your speech so that the audience feels like participating.)
- Talking too fast or too loud.
- Bad voice.

Activity 5

Imagine that you are a travel agent and you need to deliver a presentation on a trip to London to a group of people of a mixed age group. Collect information on interesting places and make sure you make a list of places that would appeal to different age groups and cultures. Your presentation should not exceed ten minutes. Ask your colleagues or instructor to evaluate your performance.

Activity 6

You may have given presentations during an internal evaluation (face-face, to a group) or during a seminar in the class. Rate your presentation skills on a scale of 1 to 5 with respect to the parameters given below.

1: inadequate; 2: satisfactory; 3: good; 4: very good; 5: exceptional
Subject knowledge

Logical thinking (the ability to organise information as pieces of content that can be presented according to a sequence or structure)

Exposure and experience of public speaking

Ability to handle questions and answer them satisfactorily

Ability to build a rapport with the audience

Ability to clearly articulate a thought or give an opinion without being judgmental

Ability to modulate voice and rate of speech according to the situation

Check Your Progress 2:
1. Use the space given below to write your answer.
2. Check your answer with the model answer given at the end of this unit

Give the correct sequence of the tasks you should do to prepare an effective presentation:

<table>
<thead>
<tr>
<th>Task</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Develop the introduction and conclusion</td>
<td>1</td>
</tr>
<tr>
<td>Make the sub points for each of the main ideas</td>
<td>2</td>
</tr>
<tr>
<td>State the purpose of the presentation</td>
<td>3</td>
</tr>
<tr>
<td>Analyse the environment</td>
<td>4</td>
</tr>
<tr>
<td>Brainstorm the main ideas</td>
<td>5</td>
</tr>
<tr>
<td>Develop slides of other visual aides</td>
<td>6</td>
</tr>
<tr>
<td>Make speaker notes and handouts</td>
<td>7</td>
</tr>
<tr>
<td>Edit the presentation</td>
<td>8</td>
</tr>
<tr>
<td>Rehearse, rehearse, and rehearse.</td>
<td>9</td>
</tr>
<tr>
<td>Analyse the audience</td>
<td>10</td>
</tr>
</tbody>
</table>

1. .................................................................
2. .................................................................
3. .................................................................
4. .................................................................
5. .................................................................
6. .................................................................
7. .................................................................
8. .................................................................
9. .................................................................
10. .................................................................
1.9 USING COMMUNICATION IN BUILDING BETTER TEAMS

The focus of this unit is how we can use communication as an effective management model to increase productivity. The Johari Window is a communication model that can be used to improve understanding between individuals within a team or in a group setting. Based on disclosure, self-disclosure and feedback, the Johari Window can also be used to improve a group’s relationship with other groups.

Developed by Joseph Luft and Harry Ingham (the word “Johari” comes from Joseph Luft and Harry Ingham), there are two key ideas behind the tool:

- That individuals can build trust between themselves by disclosing information about themselves; and
- That they can learn about themselves and come to terms with personal issues with the help of feedback from others.

**Explaining the Johari Window:**

The Johari Window model consists of a foursquare grid (think of taking a piece of paper and dividing it into four parts by drawing one line down the middle of the paper from top to bottom, and another line through the middle of the paper from side-to-side). This is shown in the diagram given here:

![Diagram 1.1: The Johari Window](image)
Using the Johari model, each person is represented by his or her own four-quadrant, or four-pane, window. Each of these contains and represents personal information - feelings, motivation - about the person, and shows whether the information is known or not known by themselves or other people.

The four quadrants are:

**Quadrant 1:** Open Area: What is known by the person about him/herself and is also known by others.

**Quadrant 2:** Blind Area, or "Blind Spot": What is unknown by the person about him/herself but which others know. This can be simple information, or can involve deep issues (for example, feelings of inadequacy, incompetence, unworthiness, rejection), which are difficult for individuals to face directly, and yet can be perceived by others.

**Quadrant 3:** Hidden or Avoided Area: What the person knows about him/herself that others do not.

**Quadrant 4:** Unknown Area

The process of enlarging the open quadrant vertically is called self-disclosure, a give and take process between the person and the people he/she interacts with.

As information is shared, the boundary with the hidden quadrant moves downwards. And as other people reciprocate, trust tends to build between them.

**Tip 1**
Don’t be rash in your self-disclosure. Disclosing harmless items builds trust. However, disclosing information, which could damage people’s respect for you, can put you in a position of weakness.

**Using the tool:**
The process of enlarging the open quadrant horizontally is one of feedback. Here the individual learns things about him- or her-self that others can see, but he or she cannot.

**Tip 2**
Be careful in the way you give feedback. Some people have a very open and accepting approach to feedback. Others don’t. You can cause incredible offence if you offer personal feedback to someone who’s not used to it. Be sensitive, and start gradually.

If anyone is interested in learning more about this individual, they reciprocate by disclosing information in their hidden quadrant.
For example, the first participant may disclose that he/she is a runner. The other participant may respond by adding that he/she works out regularly at the local gym, and may then disclose that the gym has recently added an indoor jogging track for winter runners.

As your levels of confidence and self-esteem rises, it is easier to invite others to comment on your blind spots.

**The Johari Window in a Team Context:**

Keep in mind that established team members would have larger open areas than new team members because they have known each other for a longer period of time. New team members start with smaller open areas because little knowledge about the new team member has yet been shared. The size of the Open Area can be expanded horizontally into the blind space, by seeking and actively listening to feedback from other group members.

Group members should strive to assist a team member in expanding their Open Area by offering constructive feedback. The size of the Open Area can also be expanded vertically downwards into the hidden or avoided space by the sender’s disclosure of information, feelings, etc about himself/herself to the group and group members.

Group members can also help a person expand their Open Area into the hidden area by asking the sender about himself/herself. Managers and team leaders play a key role here, facilitating feedback and disclosure among group members, and by providing constructive feedback to individuals about their own blind areas.

**Key Points:**

In most cases, the aim in groups should be to develop the Open Area for every person.

Working in this area with others usually allows for enhanced individual and team effectiveness and productivity. The Open Area is the ‘space’ where good communications and cooperation occur, free from confusion, conflict and misunderstanding.

Self-disclosure is the process by which people expand the Open Area vertically. Feedback is the process by which people expand this area horizontally.

By encouraging healthy self-disclosure and sensitive feedback, you can build a stronger and more effective team.
1.10 SUMMARY OF THE TOPIC

In this unit, we have discussed the importance of communication skills, which is crucial for the growth of any individual as well as an organization. The term communication is defined and its meaning is explained. You have also learnt the communication process and the intermediate connection it establishes between the sender and the receiver of a message or an idea. The intent and content of communication is the inherent correlation between the matter and manner of articulating a thought process.

Three styles of communication, i.e. aggressive, passive and assertive are discussed elaborately. Here, you have learnt why assertive style of communication is recommended as the best style of communication. It is the most popular style of communication because an assertive communicator gives equal importance to other’s rights along with his own rights.

Further, we have also discussed about the virtues of active listening. A clear distinction is made between listening and hearing in this unit. You have learnt how active listening helps in understanding the dynamics of communication skills and makes you a better communicator.

There is also a vivid description of presentation skills in this unit that separately deals with the concept of clarity, oral and written form of presentations and impact of non-verbal communication or body language in presentation skills. Clearly, an effective presentation is the one in which the presenter demonstrates excellent visual and verbal skills. He must be able to create an impact in front of his audience by perfectly combining matter with manner. His delivery is reflected both in his oratory and written skills. His clarity of concept, thought and expression gives an extra edge to his presentation skills.

We have also discussed how a suitable model of communication can be used to improve communication between members of a team and bring out the best in them. If you are aware of your style of communication and that of others, you will be able to employ the model effectively to improve communication and team performance.

1.11 FURTHER READING


1.12 MODEL ANSWERS TO CHECK YOUR PROGRESS

Check your progress 1

a) passive form of communication
b) aggressive form of communication
c) assertive form of communication

Check your progress 2

1. Analyse the audience
2. Analyse the environment where you will make the presentation
3. State the purpose of the presentation
4. Brainstorm the main ideas
5. Make the sub points for each of the main ideas
6. Develop the introduction and conclusion
7. Develop slides of other visual aides
8. Edit the presentation
9. Make speaker notes and handouts if required
10. Rehearse, rehearse, and rehearse

***
Structure

2.0 Objectives
2.1 Introduction
2.2 Call Handling Skills
   2.2.1 Telephone etiquette
   2.2.2 Confidence over phone
2.3 Understanding the EPABX system
2.4 Customer Service via the telephone
   2.4.1 Handling a customer who calls for help or support
   2.4.2 Some words to use and avoid
   2.4.3 How to say 'No'
2.5 Summary of the topic
2.6 Further Reading
2.7 Exercise to check your progress: Model Answers

2.0 OBJECTIVES

The main objectives of this unit are to:

- familiarize you with call handling skills
- educate you about telephone etiquette
- introduce the EPABX system and describe how to handle inbound and outbound calls with the help of this system
- facilitate you with some effective tips on customer service and techniques
- help you to develop a customer eccentric approach while handling business calls

2.1 INTRODUCTION

Conversation is the most common form of communication involving two participants. It links people together, be it in social or professional life. Conversation may be defined as oral and usually informal or friendly exchange of views, ideas. In a conversation the participant has to play the role of a speaker or listener interchangeably. One form of dyadic conversation is interaction between two persons on the telephone. In this form of communication the fear of facing or seeing the other person is not there since
there is no display of body language or maintenance of eye contact. It is one of the fastest, easiest and most economical means of communication.

With the proliferation of telephones and mobile phone services, many business transactions (such as product enquiries, sales enquiries, follow up calls, complaints, feedback, product and technical support, organizing official meetings, client interactions) take place via the telephone. Many organizations recognized the need to define call handling procedures to ensure that they fulfill customer expectations and create a favourable impression for the organisation. Call handling procedures are designed to maintain a defined standard and quality of interaction during telephonic conversations. Different industries (such as IT, ITES, Banking and Hospitality) have different requirements for customer-employee interactions that take place via the telephone. However, there are some standard procedures that any person should follow to be able to communicate effectively.

In this unit, we shall discuss at length about the skills one needs to apply while talking over phone.

After going through this unit you will be able to

- Handle professional calls in a professional manner.
- Follow telephone etiquette.
- Be confident about taking and making telephone calls.
- Understand the EPABX system.
- Develop customer service and selling skills that you will require for transactions that take place over the phone.

2.2 CALL HANDLING SKILLS

Activity 1 : Are you interested in the way you sound? Try this voice inflection exercise by speaking into a tape recorder. Read the following sentence in your normal voice :

- "Would you mind holding for a moment?"
- Now restate the same sentence with surprise in your voice.
- Try it again, but this time, make it a casual statement
- Next, make it sound like a secret
- Finally, turn it into a question

If done properly, as your inflection changes, the sentence will convey a completely different meaning to the listener.
Handling the Telephone

The features of the telephone are designed to enable us to handle calls smoothly. To understand the capabilities of your telephone better it is necessary for you to know its features. You need to practice the call handling techniques thoroughly, until they become automatic for you.

Activity 2
Ask a colleague who is familiar with the features of the telephone to demonstrate the main features to you. You need not know how to use all the features. Focus on becoming familiar with the ones that are most used (or you may be required to use frequently in your current role), such as putting a call on hold, redial, transferring a call, handling two calls simultaneously, leaving voice messages on the answering machine, and accessing your voice messages.

It may take you more than two or three attempts to be able to handle each feature smoothly. Before trying them with your customers, practice with a colleague.

2.2.1 Telephone Etiquette

Telephone etiquette is a set of polite manners we observe while conversing with a person on the phone. Proper phone etiquette is important for personal or professional calls. Being polite on the telephone is just as important as when speaking with someone in person. You might be surprised at how good you feel about yourself if you use proper telephone etiquette and the positive responses received while talking on the phone.

Here are a few guidelines that may help:

- When taking a call (for yourself or for someone else), ask the name of the person you are speaking to, without sounding impolite.
- Smile! It makes your voice brighter and more pleasant.
- Speak naturally - When you sound rehearsed, you come across as insincere and robotic.
- Use simple, uncomplicated language.
- Never make an anonymous call. Always identify yourself first before you continue further.
- When making a call, always know and state the purpose of your communication.
- Listen actively - your time on the phone is limited. Make notes if necessary.
- Learn to listen to others without interrupting them.
Avoid "dead air". Keep speaking to the customer. If you have nothing to say, put the customer on hold or simply keep telling him what you may be doing on your system or the steps you are taking. (This is applicable for call centre executives who handle incoming and outgoing calls.)

When you put the customer on hold, always specify the time you will need. If it takes longer, come back on line and tell the customer that it will take longer and put him on hold again or offer to call him back.

Be as helpful as possible.

Always return calls (within 24 hours) and ask for an appropriate time to call in case you need to call back the person.

When taking a phone call that is not meant for you, always be polite and guide the caller to the right channel if you can.

No matter how busy you are, answer the call courteously.

Offer information, which may help the customer to trace the person, or department that he/she wants. This not only reduces repeat contact but also gives a good impression of the organization you handle or work for.

When you are giving out information that is lengthy or important ask the caller if he or she has a pen and paper ready so that the information can be written down.

Make use of words such as 'thank you' and 'please'. For example, if you are asking a person for his driving license number and he asks you to wait while he fetches it, thank him.

While transferring a call, make sure that you introduce the caller to the person you are transferring the call to and vice-versa. This can be done either by conferencing the call or putting either party on hold.

Wrong Numbers -
- If you have interrupted someone's day, it is your mistake. Apologise before disconnecting.

Speaker phone etiquette -
- Always ask for permission of the other person before putting him on the speaker phone, and be sure to identify the other people present in the room.

Answering Machine-
Always anticipate that you may have to leave a message. Prepare what you want to say. Do not ramble on.

- It is important to include: Your name, telephone number and company.
- Spell an unusual name and repeat your name and number at the end of the message.
Specify the purpose of the call rather than saying, "Please give me a call". That way, they will know the urgency.

Let them know the best time to return your call.

Repeat numbers slowly.

Sign off positively.

Don't ignore the machine due to personal 'hate factors'.

**Voice Mail Etiquette**

- Keep your outgoing message current.
- If you are going to be out of the office, your message should say so. It should include:
  
  (i) When you will not be available.
  (ii) Date and Time when you will be back.
  (iii) Whom to contact in your absence.

**Office Phone Etiquette**

- Don't hover outside a co-worker's office or cubicle waiting for him or her to finish a phone call. Leave and try again later.
- Don't eavesdrop on co-workers' phone conversations.

### 2.2.2 Confidence over phone

Many people have inhibitions and are nervous when handling phone calls. This may happen because of lack of practice, fear of technology (in this case, the telephone), fear (or being in awe) of the person at the other end or lack of basic communication skills such as fluency in the language in which the conversation is taking place. Each of the problems listed above can be solved if they are addressed systematically.

Some people can handle telephone calls more confidently than others. This confidence comes from knowing what to say, how to say it and when. 'What' is the subject matter or topic of discussion. You may fumble if you are unsure of how to respond to a query. You should always do your homework before you speak on the phone. If you are not sure, be honest and say you will check and inform the person later (if that is acceptable).

'How' is the way you speak. Depending on the situation, you may be courteous, firm, casual, polite or even brief and curt in your response. The tone of your voice also communicates how you view the
Unit 2 CALL HANDLING SKILLS

conversation. If you are talking to a customer, it is advisable to use a courteous tone, no matter what the
provocation is. Using the right words is crucial to get the conversation going, avoid ambiguity and
miscommunication.
‘When’ is the time when you say something. Do not interrupt when the other person is speaking. Give
out information as the situation demands. Your responsibility is to get an intelligent conversation going,
so listen before you speak.
No one gets it right the first time. You have to know how to get the right tone when you speak on the
phone. Keep practicing till you know that you sound confident.

A well-modulated voice always energizes a phone conversation. The voice you project is determined by
the following factors, which can be controlled.

- **Energy**: The energy in your voice reflects your attitude and enthusiasm.
- **Rate of Speech**: A normal rate is 125 words per minute. Speaking faster may create
problems. Speak in a relaxed mood without stressing yourself.
- **Pitch**: You should avoid a monotonous voice. Cultivate variation in tone and inflection
while speaking.
- **Put a smile into your voice**: A smile adds a zing of friendliness to your voice while answering
a call.
- **Soft skills**: A combination of excellent communication skills with a positive attitude is the
right way to exude confidence over phone. You should avoid jargons and complex sentences
that might confuse the other person or create a negative impression.
- **Familiarity**: You should demonstrate a keen sense of familiarity with the communication
process by handling the phone conversation effectively. Even if you are not aware of some
facts and figures, do not let embarrassment mar your conversation. If you fumble while talking,
it will reveal how low in confidence you are.
- **Rapport building**: Try and build a rapport with the person you are speaking to. This helps
you to gain the confidence of the other party and also lets him of her know that you can
understand their point of view which in turn would help you to make your conversation
useful and overcome the disadvantages of not being there physically.

2.3 UNDERSTANDING THE EPABX SYTEM:

The Electronic Private Automatic Branch Exchange (EPABX) has made day-to-day working in office
much simpler, especially in the area of communication. It can be defined as a switching system that
makes available both external and internal switching functions of an organization. By using an EPABX
System both the external and internal needs of an organization are fully served.
Some features of EPABX are listed below:

- True Caller ID
- Auto Call Transfer
- Auto Redial
- Door Phone/Lock Connectivity
- Paging Port
- Computer Port
- Printer Port
- Pop Up Screen software

With the advent of powerful microprocessors and advancement in the field of computers, EPABX gadgets are becoming very beneficial for effective coordination and communication between various professionals and organizations.

Call / Telephone Handling

Only recently, for many enterprises, an EPABX system was just a voice switch and nothing else. There has been a fundamental change in the way an enterprise views an EPABX today. EPABX today is in many ways a strategic tool for any business. Many enterprises rely on it for adding competitive advantages to their business. In fact, the name EPABX too has become somewhat inappropriate. After all, apart from voice, it also facilitates data and video communication. In other words, it has assumed the role of a facilitator in making convergence possible in enterprises. However, the world has not found a better and more appropriate term for the box that resides at the reception of most enterprises.

Before the advent of automatic exchanges, it was impossible to make any call without the assistance of an operator. Callers rang up an operator at a switching office who then literally connected their wire to the proper circuit in order to complete the call. With the development of computerized telephone dialing systems, many tasks have become automated. The calling party can place many telephone calls simultaneously. As phone systems became more sophisticated, direct intervention by the telephone operator was reduced.

As customer services (help desk, product set up support, technical support, feedback, enquiry), increased, organisations needed an efficient automated system to handle hundreds of calls coming in daily. Operators were also needed by companies to answer incoming calls and connect them to the correct extension. This function is still needed but computerized answering systems (“if you are calling about … please press 1”) have reduced the workload of operators and in small companies the operator usually has other functions such as greeting visitors. Today, anybody who handles an EPABX system is also called a Switchboard Operator.
Many ITES companies use automated call handling systems that enable them to handle hundreds of calls in a day. The computerized system can dial many numbers at the same time, route calls to different executives depending on the traffic and maintain records of each transaction. These systems have enabled the IT industry to provide a higher level of service than was possible till a few years ago.

**2.4 CUSTOMER SERVICE VIA THE TELEPHONE:**

When we think about customer service, we generally visualize a group of individuals working in a company or organization responsible for providing customer satisfaction. However, customer service is not the sum total of everything a company does for its customers. In some companies the customer service department is only a small portion of the over all service responsibility. Everyone from the CEO to its lower level executives provides customer service and contributes to an organization's reputation for customer service and courtesy. Every service industry in India today is a major source of revenue and income. The ITES/BPO sector is a constant revenue-generating source by being excellent service and solution providers to the customers. Some of the major quality customer service providers are:

- The sales group
- The customer service group
- Technical support
- Service technicians
- Telephone receptionists
- Managers and supervisors
- Lobby attendants
- Accounting

Although one or two groups stand out, almost everyone who is a part of these groups are responsible for satisfying the customers.

Diagram 2.1: Diagram of a quality conscious company
From the diagram, you can see that the customer is at the top of the pyramid. This implies that the customer is the most important entity for a company. Therefore, those who are the points of contacts with a customer (sales and service departments) are the crucial entities. They support the customer by providing services. For a service provider who handles customers via the telephone, it is important to keep this pyramid in mind as it shows not only the importance of the customer but also the important role played by the entities that interact with the customer.

2.4.1 Handling a customer who calls for help or support

This section deals with how to handle calls to a help desk or support team. A well-developed call cycle can help you get to the bottom of a caller’s problem. You can create a call cycle by splitting the basic phases of a help desk call into simple, recognizable sections. Once you’ve mastered this technique, you can handle a call uniformly and effectively, which will help not only the caller but your colleagues as well. Some points discussed here mention a call tracking system. Do not be concerned if your organisation does not have such an advanced system. The objective is to keep records of the calls being made, whether in a system or in your notebook.

**Listen: And take control of the call**

Take control of the call by immediately asking for the caller’s contact and problem information. However, make sure that you have given ample time to the caller to state his reason for calling and that you have acknowledged his issue. While the caller describes the problem, you can open the call log and enter this information. This simply means that you are making a note of what the caller is saying so that you do not need to ask him things that he has stated already and it also helps you to zero down on the issue and go about solving it promptly. When taking a call, be sure to "log in" the problem, that is, enter the details into your help desk’s call tracking system while you are actually talking to the caller. You can 'log in' or write down the details in your notebook if you do not have access to a system. Logging in reduces the chance for incorrect data entry and allows you to close the call more quickly.

You might find it hard to listen if the caller is not communicating well, whether due to frustration, nerves, or anxiety. If this is the case, you can steer the conversation in the right direction by asking closed questions (ones that can only be answered with a yes or a no). If the caller is faint and you cannot hear him, let him know politely that you are not able to hear him. Also remember that you might have taken a hundred calls during the course of the day, but for the person calling you, it maybe the first call of the day he is making.
Unit 2 CALL HANDLING SKILLS

**Acknowledge the problem**

Let the caller know you understand his or her predicament. Recap the caller's problem. This allows the caller to clarify any details you might have missed the first time around. Another trick you can use is to summarize the problem but repeat a detail so that the caller has the opportunity to correct the information. This technique allows the call handler to check that communication is working in both directions. You can acknowledge in three ways:

- **By showing empathy**: For example, "I can certainly understand how you feel. I would feel the same way if I were in your place".
- **By agreement**: For example, "Yes, the services were not available last night".
- **By reporting others’ view**: For example, "Yes, a lot of people have been telling us that they like the service.

**Provide the solution**

Make sure the caller understands what he or she needs to know. Be sure to make the solution easy to understand (e.g., don’t overwhelm a caller with an overly technical explanation) and make sure the caller understands what you just said. Outline why the problem occurred and give concise details of the fix. If alternative solutions to the problem exist, ask additional questions to see whether these probable solutions might work better for the caller. Do not use jargons. It may be normal and comprehensible for you, but to a person outside your line of work it would become very confusing.

**Recap the call: Make sure the caller understands and feels comfortable with the resolution**

Recap your conversation and invite the caller to ask additional questions. Close the call with an agreed course of action. Make sure the caller knows to call again if he or she needs further assistance but always try to leave things on an upbeat note. Finally, thank the person for calling and end the call. Do not hang up too abruptly, however. Let the caller hang up first.

**Check your facts: Make life easier for your colleagues**

Double-check your call log and make sure that your comments are concise and accurate. Your co-workers may need to revisit the problem later, and they will need to know exactly what transpired because you may not be there to answer any questions.

If you have logged the call, you can probably close the problem log at the same time the call ends. That way, you’ll be ready to take the next call as soon as it comes.
Activity 3:
Work in pairs. Take turns enacting the following roles:
(a) a customer service representative taking telephone calls for a business.
(b) the customer who calls in with an issue.
Write the dialogue that may take place between the customer and the service representative for each of the following situations. Here are some ideas you can use:
1. A customer has lost his insurance papers for the policy that covered his shop.
2. A customer has misplaced her ATM card.
3. Over-billing for a credit card.
4. A healthcare policy has expired and the customer wants to renew it.
5. A customer wants to follow up on a home loan application.
6. The computerized system does not recognize a customer's ATM card.
7. A customer wants to renew a healthcare policy that has expired.

2.4.2 Some words to use and avoid

Always be Courteous. Use 'Please' and 'Thank You' as often as required. Be positive in your attitude and reflect that in your speech. You communicate your attitude, confidence and competence over the phone. The words and phrases you use shape other people's image of you. They can affect other people's decisions about whether they are going to cooperate with you or not.

Words and Vocabulary to Use

<table>
<thead>
<tr>
<th>Yes</th>
<th>Of course</th>
<th>You are right</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thank you</td>
<td>Certainly</td>
<td>I can do that</td>
</tr>
<tr>
<td>It would be great if you can</td>
<td>I made a mistake</td>
<td>I understand</td>
</tr>
<tr>
<td>I will</td>
<td>That is great</td>
<td>Definitely</td>
</tr>
<tr>
<td>My pleasure</td>
<td>You are welcome</td>
<td>I will make sure</td>
</tr>
<tr>
<td>I am going to</td>
<td>I will follow this through</td>
<td>Thank you for your time</td>
</tr>
</tbody>
</table>
Words and Vocabulary to Avoid

<table>
<thead>
<tr>
<th>Ok</th>
<th>Yes</th>
<th>Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>All I can do is</td>
<td>I can only do</td>
<td>We do not do that</td>
</tr>
<tr>
<td>Bear with me</td>
<td>It should</td>
<td>Obviously</td>
</tr>
<tr>
<td>I am afraid</td>
<td>Unfortunately</td>
<td>I'm sorry but</td>
</tr>
<tr>
<td>It is company policy</td>
<td>You have to</td>
<td>I need (want) to</td>
</tr>
<tr>
<td>What is your problem</td>
<td>I can not / You can not</td>
<td>Maybe</td>
</tr>
</tbody>
</table>

Vocabulary to Demonstrate Awareness

I appreciate …
I understand …
What I will do for you is…
"Why don't you let me worry about that for you?"

When you show that you understand a customer's problem, he not only appreciates it but also puts his trust on you and on the company you are working for. When you are on the phone it is your way of addressing the customer and the positive insight you give him that helps you to walk the extra mile in converting opportunities into business.

2.4.3 How to say 'No'

One of the most difficult and avoidable responses is 'No'. However, certain situations demand that you say 'No' to a customer. Ask for clarification or more information before you say 'No'. You should lay emphasis on what can be done always. You should always be ready with alternative solutions. Kindly apologize when you cannot offer an instant solution or if the solution you give somehow fails to rectify the problem the customer faces. Don't apologize profusely. Slow down, speak steadily and with warmth and empathize with the caller.

Check your progress 1:

Take these negative phrases and turn them into positive phrases

a) I will try and get that done by the end of the day.
b) Can you hold a minute?
c) Well, they have been sent out…
d) I can only apologize

a) ........................................
b) ........................................
c) ........................................
d) ........................................

Activity 4

Work in pairs. One is a customer and the other is a sales executive/service provider. You can switch roles. Choose one of the situations given below. Write down the dialogue for the situation. You can check with your instructor for appropriateness of language. Then speak the dialogues. Check with your instructor if there are alternative words to the key ones you are using. (For example, look for alternatives for "The balance payment is due from you...") When you speak, ask your customer to rate you on a scale of 1 to 3 (3 being the highest) with respect to (a) rate of speech, (b) clarity of pronunciation, (c) politeness, (b) problem solving.

1. Make a call to sell an insurance product.
2. Follow up on payment due from a customer.
3. Customer calls up to report that his credit card is missing.
4. Make a call seeking more information from a customer who has applied for a personal loan.

2.5 SUMMARY OF THE TOPIC

In this unit we have discussed why it is essential to develop excellent call handling skills to attain a high level of customer satisfaction, get new customers and increase the customer base. We have seen how the right attitude can reflect the right tone and create a positive impression in the customer’s mind. Here is a brief summary of the main points.

- Call handling skills are essential to communicate effectively with customers and overcome the disadvantages of not being there physically.
Though different industries have different industry-specific requirements, there are some standard call handling procedures that are designed to maintain a defined standard and quality of interaction during telephonic conversations.

The customer is the most important person for a company. When a customer makes a call or receives a call, he/she should be treated as the most important person.

It is essential to practice telephone etiquette when making a call or taking a call.

One has to practice to get the right tone and the right words to sound confident over the phone.

There are ways to say 'No' to a customer. If you can handle how to say 'No' without being rude or creating a negative impression, the customer will appreciate it.

2.6 FURTHER READING


2.7 EXERCISE TO CHECK YOUR PROGRESS: Model Answers

2.6 Check your progress 1: Model Answers
a) I will make sure that it is done by the end of the day
b) May I put you on hold for a minute?
c) They have been sent out but I will check and see the status again
d) I am sorry for the inconvenience caused but what we can do at the moment is..

2.7 Check your progress 2: Model Questions

Tick the boxes below to show in which situation you would use a phone

1) To talk about a sensitive situation to a colleague
2) To confirm a hotel booking next month
3) To confirm someone's availability for a meeting
4) To clarify about some information
5) To tell someone that you have finished the job they are waiting for
6) To confirm some fairly complex information involving accounts

Check your progress 2: Model Answers

1. You would **not use the telephone** in this situation. It would be important for you to do everything you could to put the message across in the right way, using expressions, gestures, body language etc. and to be sensitive to the response from the other person.

2. Speed is not necessary here so **a letter or fax** would probably be better. You will also have a record of your communication.

3. You need up to date information to co-ordinate with other people, so **a telephone call** is by far the best method.

4. Using the telephone, you can ask follow up questions and ask the person to explain in more detail. It would be very time-consuming to do this in writing.

5. The person needs the information quickly so the phone is the best method.

6. This needs to be put in writing to reduce the chances of mistakes and misunderstandings.

***
Unit 3 CORPORATE CULTURE

Structure

3.0 Objectives
3.1 Introduction
3.2 Corporate Culture
  3.2.1 Definition and Meaning
  3.2.2 Professionalism at the workplace
  3.2.3 Youthfulness and its role in professional growth
  3.2.4 Dynamism and its contribution towards success
  3.2.5 The concept of being Goal-Oriented
  3.2.6 How to be a team player
3.3 How to be an effective leader
  3.3.1 The role of Emotional Intelligence
  3.3.2 Managing your state of mind
  3.3.3 Being proactive
  3.3.4 Emphatic Listening
  3.3.5 Developing a WIN-WIN attitude
  3.3.6 Using the right style- Situational leadership
  3.3.7 Adaptability to change
3.4 The Importance of Employees in an Organisation
  3.4.1 The importance of employee evaluation
  3.4.2 How to prepare an evaluation
  3.4.3 How to motivate employees
  3.4.4 Physical health and leisure time
3.5 Summary of the topic
3.6 Further Reading
3.7 Exercises to check your progress
3.8 Model Answers
3.0 OBJECTIVES

This Unit discusses the concept of Corporate Culture that is followed in an organization. After studying this unit you should be able to:

- Understand how an organization creates and follows a set of values and principles as part of the organizational culture;
- Appreciate the role that values such as professionalism, youthfulness and dynamism play in contributing towards professional and organizational success;
- Understand how a goal is set up and work towards its fulfillment;
- Identify and develop skills that make one an effective leader;
- Identify the factors that make an employee the most valuable asset;
- Understand how processes like evaluation, motivation and training of the employee contribute towards professional and organizational growth;
- Understand what aspects of an organization help to encourage employee loyalty;
- Create interesting assignments and opportunities for the employee and provide facilities for health care and leisure time.

3.1 INTRODUCTION

The term "Corporate Culture" means the attitudes, experiences, beliefs and values of an organization. It defines the standard norms of behaviour for any person representing that organization. Therefore it is also known as organizational culture. Corporate culture differs from organization to organization. Every organization has its own set of behaviour, expertise, skills and knowledge to follow. Accordingly, every organization defines its own culture on the basis of the rules and policies it lays down for itself. Organizational culture or corporate culture affects every single employee working for a particular work set up in different ways.

The management of an organization often determines the corporate culture for its employees. Whether or not this culture is acceptable, the management imposes it on the entire work force and makes each one of the employees answerable even for the minor infringements of this culture. They may wish to impose corporate values and standards of behaviour that specifically reflect the objectives of the organization. In addition, work-groups within the organization have their own behavioural patterns, which, to an extent, affect the whole system. Members of an organization react in a common way to a given situation when the values of the organization are strongly instilled in them. This is how an organization fosters a strong corporate culture.
3.2 CORPORATE CULTURE

Many articles and books have been written in recent years about culture in organizations, usually referred to as "Corporate Culture." The dictionary defines culture as "the act of developing intellectual and moral faculties, especially through education." But this definition used in the context of an organization describes Corporate Culture as: "the moral, social, and behavioral norms of an organization based on the beliefs, attitudes, and priorities of its members".

Every organization has its own unique culture or value set. The process of creating culture in an organization is not defined. The culture of the organization is typically created based on the values advocated by the top management or the founders of an organization.

The importance of corporate culture is growing as the result of several recent developments. Companies try to inculcate a sense of ownership in the employees so that they become more accountable and responsible and act and think like owners. In exchange for more flexible work schedules, employees are expected to be always accessible to the call of the company duties. With the disappearance of more close-knit social groups (e.g. neighborhoods, etc.), companies are taking up the role of a community and are meeting the requirements of the employees. At the same time companies encourage teamwork and the formation of teams.

Therefore, organizational leaders should not ignore corporate culture. It should be highlighted as the organization's mission, vision, and goal statements, and emphasized in company sponsored training and communication for the employees.

3.2.1 Definition and Meaning

Culture refers to an organization's values, beliefs, and behaviours. In general, it is concerned with beliefs and values on the basis of which people react to situations, individually and in groups. Cultural statements become operational when executives articulate and publish the values of their firm, which provide patterns for how employees should behave. Firms with strong cultures achieve higher results because employees remain focused on what to do, and how to do it.

Corporate culture describes and governs the ways a company's owners and employees think, feel and act. A business owner's culture may be based on his personal beliefs declared as a statement in the mission and vision of his organization. It could consist of a corporate symbol, or a logo that represents the company to others in the market. Whatever form it takes, corporate culture plays a big role in determining how well a business performs.

A symbol, ritual or tool is usually used to communicate the values and practices that the members
or the employees want for their company. A cultural tool might be a new corporate logo or a punch line symbolizing the company's personality. Many big organizations have induction sessions where they tell the new employees how they are expected to conduct themselves professionally while interacting with colleagues, customers and service providers. Where physical logos or taglines are not available, innovative companies can use other methods to disseminate information about its corporate culture. An employee, who has managed to bring accolades for his company, can make his approach a part of his company's culture. For example, an admired former employee can be turned into a symbol by giving an award named after that individual, complete with a ceremony.

Some definitions based on the study of some researchers on corporate culture are given below:

- "A blend of the values, beliefs, taboos, symbols, rituals and myths all companies develop over time."

- It has been defined as "the specific collection of values and norms that are shared by people and groups in an organization and that control the way they interact with each other and with stakeholders outside the organization. Organizational values are beliefs and ideas about what kinds of goals members of an organization should pursue and ideas about the appropriate kinds or standards of behavior organizational members should use to achieve these goals. From organizational values develop organizational norms, guidelines or expectations that prescribe appropriate kinds of behavior by employees in particular situations and control the behavior of organizational members towards one another." (Hill & Jones, 2001)

- Gabrielle O'Donovan-author, management consultant and university lecturer in his book, The Corporate Culture Handbook, defines "culture as an organic group phenomenon, whereby tradition passes on acquired learning to success generations while innovation builds capacity to evolve with the environment. The interplay between these complementary forces manifests in the shared beliefs and assumptions of the workforce. It is visible in shared attitudes, behaviours and artefacts, and determines the quality of (business) outcomes and results." (O'Donovan, 2006)

- Stephen McGuire defined and validated a model of organizational culture that predicts revenue from new sources, "An Entrepreneurial Organizational Culture (EOC) is a system of shared values, beliefs and norms of members of an organization, including valuing creativity and tolerance of creative people, believing that innovating and seizing market opportunities are appropriate behaviors to deal with problems of survival and prosperity, environmental uncertainty, and competitors' threats, and expecting organizational members to behave accordingly."
Activity 1.

Make a list of 5 values that you think you share with your family members with respect to culture, moral values, bonding, punctuality and sense of responsibility etc. Ask two of your class-mates to do the same. Compare notes.

Strategies for Building a Growth Culture:

- Emphasize the future, not the past.
- Emphasize the possibility, not the constraints.
- Reach customers outside through the employees inside.
- Encourage risk taking and discourage political protecting.
- Reward collective, not individual successes, but maintain clear individual accountabilities and keep heroes visible.
- Look for alternatives before seeking closure.

Recent research has led to the creation of some models that attempt to study and classify cultural diversity. One model, the Hofstede Cultural Orientation Model, as reported in the Spring 1995 issue of the ACA Journal, classifies cultures based on five continuums. They are:

1. Individual vs. Collective Orientation
   The level at which behavior is appropriately regulated.

2. Power-Distance Orientation
   The extent to which less powerful parties accept the existing distribution of power and the degree to which adherence to formal channels is maintained.

3. Uncertainty-Avoidance Orientation
   The degree to which employees are threatened by ambiguity and the relative importance given to employees sticking to rules and long-term employment ensure steady progression through well-defined career ladders.

4. Dominant-Values Orientation
   The nature of the dominant values - e.g., assertiveness, monetary focus, well-defined gender roles, formal structure vs. concern for others, focus on quality of relationships and job satisfaction, and flexibility.

5. Short-Term vs. Long-Term Orientation
   The time frame used: short-term orientation involving frequent rapid gains through revenue generation schemes vs. long-term involving the preservation of status-based relationships, prevention of thrift and gratifying the employers.
There is some debate over whether companies should design their personnel policies and reward systems around cultural values. Many companies prefer not to follow a value-based reward system for fear of creating rigid stereotypes whose culture does not allow them to handle changes efficiently.

Instead of forming hard bound rules or norms, many companies retain the flexibility to be able to "reengineer" themselves, which involves an attempt to change their culture, usually to a team orientation as reported in the ACA News (September 1995) journal. The study indicates that the following are necessary for a company to change to a "team culture:"

- Common and consistent goals
- Organizational commitment
- Role clarity among team members
- Team leadership
- Mutual accountability with the team
- Complementary knowledge and skills
- Reinforcement of required behavioral competencies
- Power (real and perceived)
- Shared rewards
- Encourage debate before consensus

### 3.2.2 Professionalism at the workplace

Today, the term 'professionalism' is mostly associated with people who work in any public sector or privately owned organization. Professionalism is typically regarded as an approach or a way of undertaking a task and getting it done. It is seen as an attitude displayed by the work force of an organization in organizing and completing a ritual task. The persons who are carrying out professionalism are called professionals.

Among the meanings of the word 'professional' in the dictionary, there are two, which are connected with the way we work. One meaning is 'something that is related to a job or profession'. The other meaning is 'well trained, or a person who is good at one's work'. To be a professional, therefore, implies that a person is good in his job and can be depended upon. Clearly, it is easy to be a professional in the first sense. If we can do something the way we have wanted to do it always, we assume ourselves to be professionals. The second implication, however, is more difficult. It is easy to do a job, but to do it well putting our heart into it is not very easy. Most of us are contented in 'just doing', or finishing the task at hand without worrying about the quality of the output. Sometimes such an attitude may arise from our perspective that nobody is going to appreciate us or recognize our individual efforts.
Whether we behave professionally or not does not always affect the big projects or important assignments. Professionalism, or the lack of it, is reflected in even the minutest of tasks or semi-formal interactions that take place daily. If you are typing a letter and make a mistake, the professional in you will always do another draft and check it before sending it out. A professional executive in a hotel will always make an effort to be charming and make you comfortable if you are a new guest. If your organization is professional in its administration and management, any suggestion or complaint that you may voice will be professionally handled with appropriate steps taken to address it.

Contrary to popular perception, professionalism is not always a virtue of only private companies. Hard-working and sincere executives in the public sector or in the government sector continuously take up initiatives that reflect truly professional behaviour.

It is important, therefore, to understand what 'professionalism' implies. Is it an attitude, a set of values, or a moral code of conduct? Attitude, a code of conduct, and a set of values does define professionalism to a certain extent. But it is more than that. Professionalism is the interplay of accountability and moral responsibility with a code of ethics involved in managing and fulfilling a goal.

**Attributes of a professional**

Our technical qualifications and experience give us the expertise or knowledge that is required to carry out an assignment. Planning and management give us tools through which we can carry it out successfully. In order to become professional at the workplace, it is important to understand and internalize the values and set of norms that is the framework within which we work.

The practices discussed below are essential to being professional. They help us to organize our priorities, take the right decisions, minimize risks and communicate effectively so that we can do our job well.

**Planning**: When done well, good planning is like getting half the job done. It helps to identify priorities, manage time and money effectively, employ the best-suited resources, and finish a project on schedule. Whether it is an operation performed by a surgeon or a project executed by an engineer, professional behaviour demands a certain amount of planning, so that risks are minimized and the desired goal is achieved without any hiccups. One of the keys to good planning is to break up a big task into manageable small tasks.

**Decision-making**: For any project or venture to be successful, the right decision has to be taken at the right time. To reach the right decision one has to know or gather the relevant facts. The way we make our decisions shows how professional we are. Critical issues need decision-making at the critical time before they impact a project negatively. For instance, if a project is delayed because of lack of proper tools, it
becomes critical to take the decision to acquire the required tools before the project gets delayed for too long. Similarly, it is important to know when a person is not suitable for a particular assignment and decide to make changes accordingly, either by giving the person support or changing the assignment. Wrong decisions may be based on misinterpretation of a situation or lack of knowledge of the facts. Such decisions may cause loss both in terms of time and money, the two most precious resources. At the organizational level, companies that misinterpret market trends or diversify without taking into account the ground realities may have to change plans midway, with immense financial losses.

Communication: How we communicate also shows how professional we are. Objective, unambiguous and precise communication not only helps in saving time but also makes our performance more effective. Do we take care to explain something to our customers, subordinates or superiors? Within an organization, the nature of communication from the top management contributes significantly to the morale of the organization. How a team leader talks and communicates with the team is directly responsible for the team's performance. A salesman who makes an effort to remove doubts, answer queries and demonstrate a point to a concerned customer is more likely to close a sales deal successfully than one who simply does his job in a non-committal and automatic manner.

**Doing our job:** Our attitude gets reflected in the job that we do and its output. The output could be an email that we send to a customer, a project report that we make for circulation or a presentation that we have to make before a board of directors. As professionals we should check whether it has any mistakes, oversights or errors. Expecting someone else to spot our mistakes, or worse, not being aware of them in the first place, is not a sign of a thorough professional. It is crucial to have an eye for detail and be meticulous in whatever job we undertake to do.

**Professionalism is an attitude towards our work rather than anything else and it has** to be acquired over a period of time. Any action that reflects professional behaviour gains respect from customers, colleagues and peer groups.

**Activity 2:**
This quiz is developed by Steve Gregg, a retired human resources director. Find out how professional you are by answering these questions.

1. Do you truly have all the skills required to be successful at your job?
2. Do you communicate well with others?
3. Do your managers see you in the right light?
4. What is your integrity level?
5. Do you practice the golden rule? "A true professional treats others with respect, and expects the same from them."
6. Do you live up to your commitments?
Now, match your own answers with the answers given below to see if you are a true professional.

1. If not, are you in the process of learning them. A key trait among professionals is knowing what to do and when to do it. Just as important, they know what not to do. Avoiding incorrect or inappropriate actions is crucial to your success.

2. This means more than just conveying your own thoughts and ideas. It means being able to listen thoughtfully and respecting the thoughts and ideas of other people.

3. This is tough for anyone. But you need to look at yourself through your boss’ eyes. Does your boss approve of your attire, the hours you keep, the way you conduct yourself in general? Does your boss seem comfortable coming to you with special projects or to discuss problems or ideas? If not, you may need to make some changes. "If you think your manager has a problem with your level of professionalism," says Gregg, "by all means, talk it out. Ask for advice. Let your boss knows you want to improve, and ask for mentoring if you think it’s needed."

4. The workplace can be cut throat, if you are seen as conniving or a cheater. Your image will suffer in that case. And never, ever tell a lie, especially to the boss.

5. "A true professional treats others with respect, and expects the same from them." This does not mean that you have to let people step on you, but it does mean showing concern for their feelings, respecting their opinions, and being honest with them. If you think someone else is mistreating you, deal with it and tell them you will not tolerate disrespect.

6. In any job, you agree to do certain tasks. Some tasks you must do routinely, without being asked, and there may be others that the management may ask you to take on. A real test of your professionalism comes in your ability to meet all these commitments while upholding the standards of quality and timeliness set by your employer. But it does not mean breaking your neck in the process. Managers value workers who know when to ask for help, or who can admit when they are overloaded. If asking for help means that the work will get done, and that your commitments are being met, then that is a good thing. Good managers understand that the load has to be shared sometimes, and respect employees who are smart enough to ask for help.

3.2.3 Youthfulness and its role in professional growth

Youth is a state of mind. It is not about growing old by years but it is to stay young in spirit and mind. This process of keeping the spirit agile and active is very crucial for achieving success in any professional endeavour undertaken by an individual. A drooping spirit in someone is synonymous with poor performance that results in personal failures. Youthfulness is also suggestive of perennial synergy of bright ideas with ageless enthusiasm. A youthful person is always full of life no matter how old he is. His
eagerness to learn new things, keeps him young and preoccupied. He doesn't have to prove himself to be extraordinary or different from others but he has a knack for doing things differently, which distinguishes him from the rest.

In the workplace, a youthful and spirited employee often gives the impression of someone who relentlessly pursues his goal with an indomitable courage that becomes a norm for success for others to follow. These people are always admired and looked upon as role models in the professional arena. To some extent, they assume the role of a hero or a pivot based on their personal credentials and professional achievements.

Youthfulness, seen from the above standpoint has a greater significance in a professional context. Being youthful is basically about the psychological adaptability of someone in a work environment in spite of the factors of age taking a toll on his psyche. Thus, if you can practice positive thinking, self-motivation and work with an active mind you can take on any responsibility, learn new skills to adapt to new requirements, be open to new ideas and become successful in any assignment. It makes you invaluable for any organisation.

3.2.4 Dynamism and its contribution towards success

Dynamism is a driving force of life. The essence of dynamism is communication, connection and personal sovereignty. It teaches us how to handle a situation in life and manage a case efficiently without creating any disharmony in our existing world.

Dynamism gives us the power to understand "who we are" and once this understanding is completed we gain a new perspective on our capabilities and strengths and attain a sense of wholeness and harmony. Dynamism is the energy, vigour and willingness to go ahead in life. Dynamic employees are a powerhouse of energy and are considered to be valuable assets of any organization. The presence of a dynamic individual is an inspirational factor for other employees in a workplace. A dynamic professional inspires his team and colleagues by being positive and enthusiastic in any situation. It takes a dynamic leader to get the best out of any team. By being dynamic you can release the dormant energy you have within you. A dynamic individual is a kind of a cheerleader who leads as well as paves the way for others to become winners and not losers in life.

3.2.5 The concept of being goal-oriented

Psychologists say that to be rational, human behaviour must be goal-oriented. At the individual level, it may sound simple. But when an individual is part of an organisation, the problem becomes complex. Humans have more than one goal. So a person’s goals need to be prioritised. When an organization employs an individual, it is expected that the individual contributes towards fulfilment of the organization's goals.
Sometimes it is difficult for the individual to identify with the goals of the organization if they are not clearly articulated or easily understood. Being professional implies that you must understand 'why' you are doing something. Problems arise when you are unaware of the 'why' or you have an incomplete or wrong understanding of it.

To achieve a goal, concrete planning is done according to individual aptitudes and feasibility of the goal. As soon as the groundwork is over, the organization motivates its employees or the members of the team to demonstrate action for the fulfilment of the target or the goal. In case of an organizational goal, achievement of the goal depends upon the level of dedication contributed by each employee. A personal commitment shown towards one’s goal is a key to a goal-oriented behaviour displayed by each member of the team. An indoctrination of the values, beliefs and culture of an organization by all the team members of an organization for achieving a common goal will enhance goal-oriented behaviour.

3.2.6 How to be a Team player

- **Teamwork** is the concept of people collaborating to achieve a common goal. Large ambitious projects usually require that people work together, so teamwork has become an important concept in organizations. Effective teams are an intermediary goal towards getting good, sustainable results. Industry has seen increasing efforts through training and cross-training to help people to work together more effectively and to accomplish shared goals, whether the colleagues are present or absent.

- **Team player.** The team player is the one who is most aware of the others in the team, their needs and their concerns. They are sensitive and supportive of other people’s efforts, and try to promote harmony and reduce conflict. Team workers are particularly important when the team is experiencing a stressful or difficult period.

A survey revealed that Americans think that 'being a team player' was the most important factor in getting ahead in the workplace. People who behave outside of such implicit and default norms may be perceived not to be team players. Implicit and default norms often include unwritten, unspoken cultural norms. It is the difference between individuation (that is, maintaining a sense of self and identity in an organization) and losing the self in the organization.

**Skills needed to become a team player:**

Besides any required technical proficiency, a wide variety of social skills are desirable to be team player. Here is a list of some attributes:
Listening- it is important to listen to other people's ideas. When people are allowed to freely express their ideas, these initial ideas will produce other ideas.

Questioning - it is important to ask questions, interact, and discuss the objectives of the team.

Persuading- individuals are encouraged to exchange, defend, and then to ultimately rethink their ideas.

Respecting-it is important to treat others with respect and to support their ideas.

Helping- it is crucial to help one's coworkers, which is the general theme of teamwork.

Sharing- it is important to share with the team to create an environment of teamwork.

Participating- all members of the team are encouraged to participate in the team. Team work is the key to win in a game.

3.3 HOW TO BE AN EFFECTIVE LEADER

Leadership, a critical management skill, is the ability to motivate a group of people toward a common goal. The old-fashioned view of leadership is that leaders are marked out for leadership from early on in their lives, and that if you are not a born leader, there is little that you can do to become one. The modern view on leadership is that through patience, persistence and hard work, you can be a truly effective leader, just as long as you make the effort that is needed.

Every leader or person who wants to become a leader should remember that it is important to know one's strengths and weaknesses before leading others. This implies that one should be able to control one’s emotions and feelings and react appropriately in any situation- no matter what the provocation or motivation. We cannot expect our team to behave responsibly if we are not punctual and we do not follow office procedures and processes. It is also important to give the team a sense of ownership in the process as well as the final product so that the end product is the result of a collaborative effort instead of a job assignment. Having a sense of ownership lays the responsibility of getting things done and problem solving at the hands of the team. Similarly, to be an effective leader, build an atmosphere of trust so that the work environment is congenial and there is no unnecessary politics within the team. Foster an atmosphere of collaboration instead of competition. Another sign of a good leader is to help others build capacity. This means that we empower the team members to develop their skills and abilities to such an extent that they become capable of handling greater responsibilities. A team leader helps the team to grow with him. It is also essential to know what kind of team is best suited for your project. Current trends show that the more inclusive the team, the greater the number of talents and viewpoints will be on hand to tackle problems. It is advantageous to a team leader to include people who
represent a diversity of attitudes, values, and ways of thinking. This strengthens the team as everyone has something to contribute.

### 3.3.1 The role of Emotional Intelligence

Success and power increases as one makes new conquests in the corporate and competitive world. Ultimately there may come a time when successful executives identify more with their job title or positions at work and cannot relate to colleagues as fellow workers and human beings. The emotional connect is lost. This may hamper the way they 'perceive' their responsibilities as a leader.

Although you may be meeting in small groups or making one-on-one contact with people in your company, you still may not reach people because you haven't connected with them on a personal, emotional level.

Author Daniel Goleman, best known for his two best-selling books on the topic of emotional intelligence, says that emotion, more than intellect, drives our thinking, decision-making and interaction with others. Recent findings also show that the brain's limbic system, which governs feelings and impulses, is stronger and more stubborn than the neocortex, which controls logic.

On the professional front, we have to engage in decision-making and interaction on a daily basis. Therefore it is essential that we understand how our emotions work so that our decision-making and thinking can give us productive results.

By communicating emotionally, you can make your leadership more memorable and develop long-term bonds of trust with your colleagues. The real ideas will flow when your team can relate to you as an individual with emotions, hopes, aspirations and expectations.

Emotional Intelligence is an important leadership skill. Every leader has to have a certain level of understanding to co-ordinate work and make his team members efficient. It involves understanding how the human mind works and can be mastered only with experience. If you are emotionally intelligent, you know how to relate to people and understand what will motivate them. As a team leader, part of your job is to know what motivates your team members. For some it may be money, while for others it may be the challenge of a new assignment. Unless you build an emotional rapport with the person you will not know what makes them tick. This is where Emotional Intelligence can help.

Emotional Intelligence is a combination of Intrapersonal and Interpersonal Intelligence. Intrapersonal Intelligence is the inner intelligence we use to know, understand and motivate ourselves. Interpersonal Intelligence is the outer intelligence we use to read, sense, understand and manage our relationship with others.
The FIVE STEPS to Emotional Intelligence:

**Self Awareness**
Who am I? What are my strengths and weaknesses? What are my "buttons" (what triggers my emotions)?

**Emotion Management/Self Regulation**
What do I feel? Why am I feeling it? What is an appropriate reaction?

**Self-Motivation**
What do I do to make myself achieve goals?

**Emotional Coaching/Social Skill**
How do I create rapport? How can I be friendly and purposeful?

**How can we raise our Emotional Intelligence**

- The first step is to identify your own emotions.
- Take responsibility for them (this is much harder).
- Learn what compassion and empathy are (this is much easier if you have taken the first two steps; impossible if you have not)
- Read books on emotions (consult the mind body and soul section of any book shop)

3.3.2 Managing your state of mind for effective leadership

It is vital that you have high self esteem and that you are in a good state of mind to be successful in leading other people.

State of mind can be defined as your mood or the way in which you are thinking at a particular time. Managing your state is important to consider, especially when you are dealing with situations where you are likely to come across potentially negative incidents.

If your self-esteem is low then you will encounter difficulties in:

- Hearing and using feedback
- Handling difficult situations
- Presenting a professional and confident impact

People in a sustained low state of mind often demonstrate poor body posture (bent necks and backs) shallow breathing, ....... As if they are literally 'carrying the world on their shoulders'

People maintaining, in general, a positive state tend to display good posture, full breathing, good energy, etc. They do sometimes give the semblance of "walking on air."
3.3.3 Being proactive

The term proactivity is a common term in management literature. It is more than merely taking initiative. It means that as human beings, we are responsible for our own lives. Our behaviour is a function of our decisions, not our conditions. We have the initiative and the responsibility to make things better.

Look at the word responsibility—"response-ability"—the ability to choose your response. Highly proactive people recognize that responsibility. They do not blame circumstances, conditions or conditioning for their behaviour. Their behaviour is a product of their own conscious choice, based on values, rather than a product of their conditions, based on their feeling. Proactive people do not blame circumstances for inefficiency. They are value driven and if their value is to produce good quality work, they do so, regardless of the circumstances surrounding them.

You can be proactive as an individual. If you have been given an assignment but you do not have the required technical staff or tools to implement it, you will not let that come in the way of your willingness and ability to complete the assignment on time. If required you will request or actively seek help from the relevant sources in order to create the right conditions for you to be able to complete your assignment. Many people cite unfavourable circumstances as the reason for not doing their work as expected. People who are proactive in their approach are sought after as go-getters and trouble-shooters and gain the trust of the organisation.

You can also be proactive as a leader. If you are setting up a new team and have assigned responsibilities to each member. If you are aware that one of the members may not have the required skill set or level of expertise, you would proactively go up and ask if they needed any support; you may even ask an experienced colleague to 'help out' the person whenever required. You will not let the circumstance of having a less skilled or inexperienced team member come in the way of successfully implementing a project. A proactive team leader instills confidence in the team and inspires the team to actively remove obstacles that threaten the progress of the project. Such leaders usually get the prestigious and critical projects as organisations prefer handing such responsibilities to people who do not wait for things to happen; they make them happen.

3.3.4 Empathetic Listening

One of the key skills that a leader should have is the ability to 'listen' to his team. "Seek First to Understand than to be Understood". We typically seek first to be understood. Most people listen, not to understand but with an intent to reply. Sometimes we get so carried away with what we have to say that we forget to consider what might be going on inside the mind of another human being. By empathetic listening we are not referring to active listening or reflective listening as discussed in the unit "Communication Skills". Empathetic listening means listening to understand and not
mimicking what the other person says. Once you relate to what the person is saying and "put yourself in his shoes", you will understand him emotionally and intellectually. This makes your job as a leader all the more simple. Not only do you know the person better by viewing the world through his eyes, but you also know how to motivate him and in turn he will look up to you as a caring and a compassionate person, for whom he would like to work. When you listen with empathy to another person, you give that person psychological air. After this vital need is met, you can focus on influencing or problem solving.

3.3.5 Developing a WIN-WIN attitude

Win-Win is a frame of mind and heart that constantly seeks mutual benefit in all human interactions. Win-Win means that agreements of solutions are equally beneficial. It makes the atmosphere co-operative and not competitive. It is based on the paradigm that there is plenty for everyone and one person's success is not achieved at the cost or exclusion of the success of others. The diagram below demonstrates the WIN-WIN attitude.

| LOSE-WIN" | WIN-WIN |
| "Go ahead, have it your way" | "What will work for both of us?" |
| LOSE-LOSE | WIN-LOSE |
| "If you talk to me like that, I will not help you!" | "I get my way; You do not get yours" |

Diagram 1.1

3.3.6 Using the right style - Situational Leadership

Leaders have different personalities that determine how they 'run' or manage a project and the team. Some lead by example, with a hands-on approach; others delegate and review performances on a daily basis; still others follow a 'democratic' style by giving scope for the team to air their grievances and providing support wherever required; some are more 'authoritative' in their approach. There is no one "right" way to lead or manage all types of situations. To choose the most effective approach for you, you must consider:

- The skill levels and experience of your team
- The work involved (routine or new and creative)
The organizational environment (stable or radically changing, conservative or adventurous)

Your own preferred or natural style.

A good leader will switch instinctively between styles according to the people and work they are dealing with. This is often referred to as "situational leadership".

3.3.7 Adaptability to change

In today's global economy where market conditions change even before they are stabilized, change is inevitable. In fact, change is inevitable in every aspect of life. On the professional front a person may encounter changes at many levels. Organisations may change missions, the demands of your work changes, opportunities change. There may be a merger leading to loss of jobs or having to report to a new boss. Changes are also made to a person's roles and responsibilities in keeping with the organisation goals and market requirements. Change may be gradual or drastic. It may be for the better or worse. A change may result in hardship or misfortune. In order to stay ahead you need to be able to build skills in resiliency by broadening perspectives and gaining new competencies so that you can absorb any organisational, personal and career changes instead of being consumed by them. A professional leader will always be able to handle changes in circumstances and situations without buckling under pressure. This ability is called resilience. It enables a person to recover quickly from hardship, change or misfortune. People who are resilient are flexible in their attitude, have an open mind to learn new things, and are always optimistic. This attitude helps managers deal with the pressures and uncertainties of being in charge in organisations today. It is a key element to success in professional advancement. Developing resiliency requires that you pay attention to the complexities of your experiences, listen to your emotions, and be willing to learn from disappointment as well as success.

Activity 3

Imagine that you are travelling in a vehicle with six of your colleagues on the way to a wedding ceremony at a resort. You started from home at 7:30 a.m. Along the highway you take a dirt road to avoid traffic. At 9:15 a.m. you end up with a flat tyre. You realize that you do not have a spare tyre and the nearest town is 15 kms away and the main road is 10 kms away. The wedding ceremony is supposed to take place at 10:30 a.m. Suddenly you hear a call for help and when you turn around to look, you see that a young boy has fallen into the river. You hear another cry for help from the other direction and when you approach the scene you see a man lying by a bicycle in a pool of blood. He tells you that he had overheard a gang of criminals planning to loot a film crew that was shooting nearby and was shot by them. Also by sheer misfortune you and your friends have forgotten to carry your mobile phones. How would you handle this situation?
Activity 4: Here is a list of some leaders who have made a mark in their respective fields. What qualities or attributes do they have that make them effective and successful as leaders? Compare notes with your colleagues.

Ratan Tata
Rahul Dravid
Kiran Bedi
A.P. J Abdul Kalam
Kapil Dev
Kiran Majumdar Shaw

3.4 The Importance of Employees in an Organisation

People are the most valuable asset of any organisation, be it in the form of its manpower resource or employees. An organisation has a tremendous potential for growth on the basis of this resource. Employees are not directly owned by an organization but they indirectly make the organisation indebted to them as they are the harbinger of growth and prosperity of the organisation. We know that employees are important to the effort and results of the organization. It seems obvious that employees who are truly professional in their work are more productive, loyal and generally supportive of the organization and hence they are "a real asset".

The other physical assets that are employed in an enterprise to create products or services are depreciating assets. As soon as a new piece of equipment is installed, the process of depreciation begins. Regular and preventative maintenance will extend the life of the equipment but it will inevitably decline in value and performance.

Employees, on the other hand, are the only physical assets that are appreciated in value. As the employees learn more and more about the business and about their own role, their performance will increase over time. In the knowledge based economy, they also become storehouses of knowledge, expertise and experience. A company turns to senior (not necessarily in age), experienced employees to mentor newcomers and become role models. This enables the newcomers to imbibe the company's work ethics and culture from them.

Investing in employees promotes the idea that the employees are valued, and valued employees tend to be more engaged in their work and supportive of the company.
3.4.1 The importance of employee evaluation

The employee performance appraisal enables the employers to identify, evaluate and develop an individual's performance. It is a tool to encourage strong performers to maintain their high level of performance and to motivate poor performers to do better. Other important benefits of a formal appraisal process are:

- **validation** of hiring practices - are the right people in the right positions?
- provision of an objective measuring tool on which compensation decisions, and promotions can be based
- **identification of training needs** - individually, departmentally and organizationally
- **identification of employees** who have the potential for advancement or who might be better suited in other areas of the organization.

Well conducted evaluation processes help to determine if the performance standards accurately reflect the skills, behaviours and goals that the organization values.

3.4.2 Employee evaluation and its role in performance

Periodical and regular review of employee performance provides a good incentive for employees to perform efficiently. Performance evaluation not only provides a tool for the organization to identify gaps and strong points in the person, but also forms the basis of monetary compensation offered to the employee.

Whether the actual evaluation tool is numerically based, a narrative overview or a combination of both, the performance appraisal tool needs to be user friendly for the manager, and easily understood by the employee.

The evaluation should be a comprehensive and a detailed account of the employee's performance. It should be specific with concrete examples whenever possible. Details of how the employee met, surpassed or fell short of the previously established performance standards and goals help give the true picture.

The performance appraisal tool needs to be updated on a periodic basis to remain relevant to the employees and business objectives.

3.4.3 How to motivate employees

The job of a manager is to get things done through employees. To do this the manager should motivate his employees. But it is easier said than done. In spite of enormous research done on the subject of
motivation it is not clearly understood and more often poorly practiced. To understand motivation, a
deep understanding of human nature is a must. Human nature can be very complex. An employee can
be properly motivated when his nature is well understood. Understanding and appreciating an employee
is a prerequisite for motivating his leadership skills and honing his management abilities.

There are eight strategies to motivate people.

1. Positive reinforcement / High expectations
2. Effective discipline and punishment
3. Treating people fairly
4. Satisfying employees' needs
5. Setting up work related goals
6. Restructuring jobs
7. Rewards based on job performance

These are the basic strategies used in any work place as motivating factors but depending on what the
needs of the organization are, these factors may be applied in different ways. It could be a choice of
health plans, five-day workweeks, medical and life insurance, a flexible vacation policy, and a competitive
salary. Human Resource professionals all over the world are well aware that their toughest job is not
recruiting the right employees, but retaining them. Many companies view the availability of such perks
as a necessary tool for helping people achieve a balance between their work and personal lives, resulting
in employees who are productive, motivated and committed. Interesting assignments, promotions and
opportunities for future promotions can go a long way towards pleasing employees. The same incentive
might not motivate every employee. Some might want money while others prefer sponsored vacations
or other beneficial services.

"The way people treat each other in companies and other organizations is affected by the common
vision shared by employees," says Peter Senge, author of The Fifth Discipline" One of the deepest
desires underlying shared vision is the desire to be connected to a larger purpose and one another."

A company can also motivate and increase loyalty through clear and frequent communication. When an
organization lets employees know what is happening, employees feel more included and trusted. Loyalty
to a company's mission does not come easily. It is built gradually with time.

3.4.4 Physical health and leisure time

More and more organisations are recognizing the benefits of good physical and mental wellbeing of
their employees. Healthy and happy employees give good results for a company. The approach today
is that the organisation should also do its bit to facilitate the employees in maintaining a healthy lifestyle. Though it is not declared as part of a formal vision statement it is becoming part of company's 'culture' to encourage its employees to take time off when required and maintain a healthy and active lifestyle.

Active Living is an approach to life that values and includes physical activity in everyday living. You can find ways to be active at your work place and active living is not the same as an exercise program. Active living means making physical activity part of every day life whether you are taking the stairs instead of the elevator, walking to the other building at your facility, or swimming laps in the pool. Physical activity should be a mixture of endurance, flexibility and strength activities. This mixture helps to strengthen the heart and lungs, keep joints flexible and mobile, and maintain strong bones. This goal can be achieved throughout the day by sparing only 10 minutes of your life everyday. Many times people feel they don't have time to 'add' activity into their day. The workplace can help. A workplace can encourage employees to take on various activities at all levels regardless of age and ability. Most people just need help to get started. "Balance" needs to come from the individual wanting to start or continue with an activity program, and having encouragement from the workplace in order to meet these objectives. Whether you work in a small or large company, there are many areas and strategies that can increase participation in fitness and active living programs.

Some strategies are:

- Develop a physical fitness policy for the workplace.
- Ask staff what types of programs they are interested in.
- Have flexible working hours. Allowing people to arrive at work a little later, or leave a little earlier can help them add activity to their day.
- Job sharing, telecommuting, and on-site day care will also provide some flexibility to schedules.
- Allow individuals to take an extra half hour twice a week at lunch to walk, swim, attend fitness class, etc.
- Encourage people to walk to a co-worker’s office or workstation rather then using the telephone or e-mail.
- Map a 10 minutes walking route inside or outside your workplace. Encourage staff to take a mid-morning or afternoon "active" break.
- Start each workday or shift with a pre-shift stretch program.
- Offer on-site fitness facilities, or negotiate discounts to various health clubs in the area.
- Offer a wide range of company programs, whether it is a walk / bike group or an organized exercise activity (can be just 10 minutes long).
- Provide resources and education - newsletters, bulletins, community guides, health fairs, guest speakers, etc.
- Help staff to find a support group or a buddy to encourage each other.
How can a physical activity program help your workplace?

Simply speaking, a workplace that supports physical activity enhances the quality of life for employees, both inside and outside of the workplace. When employees are encouraged to be active, there can be benefits for both the employee and the company, such as:

- gains in productivity.
- decreases in absenteeism and turnover.
- more positive and happier employees and workplace culture.
- lower medical costs and fewer injuries.
- enhanced corporate image.
- reduction in stress and increase in relaxation.
- improved employee health / wellness.

It is important for organizations to analyze the cost of running a physical activity program in the short term, but also to see how it will benefit the organization in the long run.

**Activity 5**

Do you think it is important to balance work and leisure? What would be your strategy to strike a balance between work and leisure? Make a table where you can enlist your tasks at hand along with the recreational activities you would like to indulge in according to the priority you set for each activity, whether work related or recreational.

### 3.5 SUMMARY OF THE TOPIC

In this unit, we have discussed about the definition and meaning of corporate culture. Corporate culture is also known as organizational culture because of the common values, beliefs and goals shared by both the employees and the management.

Thereafter, the concept of professionalism is introduced so that you can inculcate the virtues of professionalism and learn to become a true professional. A professional knows how to think, act and behave in a work place and achieve goals.

We have also studied how youthfulness and dynamism as attributes of professionalism are appreciated and valued and incorporated into corporate culture. A youthful and dynamic employee is looked upon as a role-model in any work place as they inspire others to work hard and achieve goals.

The concept of being goal-oriented is discussed in this unit to emancipate goal oriented behaviour of the employees. It is a professional strategy to ensure success in a business venture or project undertaken by organizations.
The importance of being a team player and developing leadership skills is also discussed in this unit to highlight its role in the personal development of any professional.

We have also discussed how we can develop certain skills to become an effective leader. To be a good leader you must not only lead by example and build trust in the team, but also use your emotional intelligence to relate to the people who make up the team. It is also crucial to be adaptable to change and recover from any misfortune or hardship and turn it to your advantage.

We have learned why employee is considered as the most valuable asset of a company in the. Employees are precious resource of an organization whose valuable contribution towards the growth of the organization turns them into assets. While the other equipments of a company have a depreciating value, there is always a satisfactory increase in the value of the men power employed in the company. This is because of the continuous inputs and the efficient and competent manpower a company provides.

The employee evaluation and motivation is an integral part of human resource development programme of an organization. Evaluation is a necessary to enhance the performance level of the employees. The employees can rectify their shortcomings on the basis of the feedback they receive once their performance appraisal is done. Employee motivation acts as a stimulus to initiate further productivity and turnover for the organization.

We have studied about employee loyalty, which suggests that in a work environment factors of loyalty promotes and guarantees professional advancement to the company. We have also seen how interesting assignments and opportunities offered to the employees can stabilize their mind and make them more loyal to the company. Their efforts should be duly recognized and compensation should be given in the form of perks, incentives and salary hikes. Other allowances like paid holidays and travel allowances will further tie them to the company.

The last section deals with the issue of physical health and utilizing one's leisure time fruitfully in a company. As the saying goes, "All play and no work makes Jack a dull boy", so in every work place there should be provision for the employees to pay attention to their physical health by facilitating them with recreational activities. This will help them to take interest in their work and increase the good-will of the employees for their company.

3.6 FURTHER READING

Alan Kantrow, 1998 "The Constraints of Corporate Tradition: Doing the Correct Thing, Not Just What the Past Dictates", Publication- HarperCollins (paper);
Wayne Dyer, 2001, "You'll See It When You Believe It!" Publication-Quill;
Activity: 1

This important learning might be your first priority when you are employed. Try to become familiar with this checklist before you start a new job, as it will help guide your questions during your orientation, and throughout the training process. If you don't have a formal training program, use part of the time with this exercise to get familiar with these issues. Your success will depend on it!

Three key learning questions will be:

1. What are employees expected to do to fulfill the company's mission, values, goals and objectives?
2. How do you want things to work for you in a company?
3. What are your expectations?

Be prepared to be patient and tenacious to get this questions answered!

The following checklist will give you some guidance on what questions to ask and what information to look for:

1. Quality performance for evaluation purposes is determined by:
   - workmanship
   - the amount of work accomplished in a set period of time
   - attention to detail
   - accuracy
   - customer satisfaction
   - sales volume
   - number of items produced
   - number of people served
   - quotas met
   - outcomes
   - other:

2. The department manager expects employees to demonstrate:
   - quality performance
   - quality workmanship
   - good organization
   - honesty and integrity
   - efficient use of time
   - cooperation
   - collaboration as a good team player
   - respect for others and individual differences
   - promptness
   - good customer service
Unit 3 CORPORATE CULTURE

___ professional appearance and presentation
___ adherence to policies and practices
___ dedication
___ a willingness to make personal sacrifices for the good of the company
___ other: ________________________________________________

3. The department management's decision-making style is
___ a. democratic - management seeks and considers input from employees regarding all decisions made.
___ b. occasionally democratic - management seeks and considers input from employees regarding some decisions made.
___ c. autocratic - management makes decisions on their own with little or no input from employees.

4. The management's style and mode of operation tends to be:
A. ___ management-oriented ___ employee-oriented ___ both
B. ___ supportive ___ fairly supportive ___ non-supportive
C. ___ formal ___ semi-formal ___ semi-casual ___ casual
D. ___ reserved ___ somewhat reserved ___ friendly-open
E. ___ directive ___ somewhat directive ___ consensus-oriented
F. ___ restrictive ___ somewhat restrictive ___ non-restrictive
G. ___ controlling ___ fairly controlling ___ non-controlling
H. ___ supervision level: ___ high ___ moderate ___ low

5. The management strives to create a work environment that is:
___ professional in appearance and operation
___ efficient and well-organized
___ relaxed and casual
___ welcoming to clients or customers
___ fast-moving (employees are expected to work in fast frenzy)
___ productive (employees are expected to look busy at all times)
___ other: ______________________________________________

6. The management's interaction with employees could be described as:
___ impersonal - management strictly talks business and displays little or no interest in employees' personal lives; employees are discouraged from bringing anything personal to work.
___ semi-personal - management visits but guards and limits the amount of personal information shared with employees; management takes a limited interest in employees' personal lives.
___ personal - management visits and shares personal information with employees; management takes an interest in employees' personal lives.

7. The amount of contact the management desires to have with employees is:
___ frequent
___ occasional ___ minimal ___ only when problems arise
8. The management prefers interacting with employees:
   ___ only during certain times of the day
   ___ only during certain times of the week
   ___ only at meetings
   ___ only at specified scheduled times
   ___ only at times when it's convenient for the manager
   ___ only when there is a problem or crisis
   ___ whenever an employee has a question or concern
   ___ other: __________________________________________________

9. Regarding general matters and questions, the management prefers employees communicate with them by:
   ___ meeting in-person
   ___ e-mail
   ___ memo
   ___ phone
   ___ other: _______________________________

10. The management prefers employees meet with them by:
    ___ walk-in (any time)
    ___ walk-in (only at specified times)
    ___ appointment
    ___ scheduled meeting times (arranged on a daily or weekly basis)
    ___ other: _______________________________

Now, use the space below to prepare your answers. You can rate each other on the basis of your answers. Find out for yourself, if you have got the three important questions that was asked at the beginning of this activity answered on the basis of your individual answers you have got from this check list.

Check your progress 1

1) When you meet a colleague or a boss should you greet them courteously in the office?
2) How do you introduce yourself to someone you meet for the first time in your workplace?
3) Does shaking hands too much and smiling continuously at your customer reflect your organization's culture?
4) Should you maintain punctuality always by arriving at your workplace in time?
5) Is taking leave frequently and often being absent imply that you are a dynamic worker?
6) Should an employee cooperate and coordinate well with your team members while doing any team-work?
Unit 3 CORPORATE CULTURE

7) Should you receive others' ideas well in a work place?
8) Do you think wearing fashionable clothes to the office makes one look a professional?
9) Does taking part in the office gossips and complaining about your co-workers to your boss makes you a loyal employee?
10) Is addressing your boss as "dear sir" or "hello Mr. Dutta" appropriate while writing an e-mail to him?

1) ………………………………………………………………………………………
2) ………………………………………………………………………………………
3) ………………………………………………………………………………………
4) ………………………………………………………………………………………
5) ………………………………………………………………………………………
6) ………………………………………………………………………………………
7) ………………………………………………………………………………………
8) ………………………………………………………………………………………
9) ………………………………………………………………………………………
10) ………………………………………………………………………………………

3.8 MODEL ANSWERS

1) Greeting is a presentation of a strong corporate culture. It reveals the value system followed by an organization.
2) The introduction should be formal and precise with a warm handshake and a friendly greeting.
3) No, this kind of behaviour does not reflect an organization's culture. It is an uncouth way of showing off culture traits.
4) Punctuality should be maintained at all cost in an organization. One should reach office in time and should leave its premises only when it is time.
5) Taking leave frequently by employees and tendency of absenteeism are symbols of slow progress for any organization. In no way, these things are a part of dynamism.
6) Yes, cooperation and coordination are integral elements of teamwork. They are also a necessary part of corporate culture.
7) It is necessary to be open to new ideas and display interpersonal skills to be a team member in an organization.
8) In an office environment one should dress according to the organization's culture. Dress represents the corporate culture a professional follows. Decency and neatness are desired to look professional and smart, whether wearing a formal or non-formal outfit.
9) Loyalty is not about gossiping or giving complains about someone. It is a virtue of being honest and sincere to one's work and the work place.
10) Whenever you write an e-mail to your boss, please address him as 'Dear Sir' and not 'Hello Mr. Dutta.' Official communications should be formal, be it an e-mail or a handwritten letter.

***

DOEACC Society Guwahati / Tezpur Centre
4.0 OBJECTIVES

The main objective of this unit is to give you an overview of the concept of CRM. In this unit you will know how the concept is related to all aspects of the customer-employee interaction and how it determines the success of a business. After studying this unit you will be able to:

- Understand the concept of CRM as a Management Model;
- Identify the key factors that determine the relationship of the customer with an organization;
- Differentiate between CRM as a technology-based tool and CRM as implemented in the day-to-day functions of an organisation; and
- Become aware of the causes of the failure of CRM.

4.1 INTRODUCTION

The success of a business depends not only how its operations are managed but also on how it manages its relationship with its customers. In a market-driven business environment it is essential to have a solid customer base and ensure that the customers grow with the business. Customer relationships are not as simple as it was earlier. At one time it may have been possible for a banker or retailer to know a customer in person and keep track of his or her requirements. Today, depending on the products or services being offered, it is possible that the same customer may have different relationships with the different parts of an organisation. A customer may have a retail account with one part, an investment portfolio with another, a mortgage with a third part and insurance with yet another. It has become increasingly difficult to maintain a thorough knowledge of customer details in the given
circumstances. Therefore, the need to develop a Customer Relationship Management Model has gained priority in the business circuits for managing the customers and their needs well.

Customer Relationship Management (CRM) is a term that defines a company's comprehensive effort to attract and retain customers through an integration of information, people, policies, processes, and systems strategies. It requires a cross-functional process since no single business unit can execute CRM on its own. It is a top-down driven process.

CRM is applicable in every domain of business and has been adopted as the new mantra for ensuring success in businesses. Though it sounds like management jargon, CRM is essentially the scientifically devised application of the old business adage - 'know thy customer!'

CRM is mostly associated with Business to Consumer (B2C) situations but it is an equally effective strategy in Business to Business (B2B) situations. To put it simply, the main idea is to integrate customer information such as profile, buying preferences and buying trends and study such data to be able to anticipate future needs and be prepared. It does not matter where the data comes from as long as it is authentic. Small companies may get the data directly from retail outlets or dealers, while big companies may implement online CRM to capture such data from online bookings and purchases. A company that uses such data to anticipate customer requirements is practicing CRM. An example would be a company that uses the data from its online order receipts to understand customer buying trends and anticipate future requests.

The concept of CRM stems from the belief that customers put a high premium on the notion of value. This notion of value extends beyond financial considerations, such as price or discount or freebies offered with a package. The customer perceives value to be derived from the entire experience with the product and/or service. A pleasant and satisfactory experience with the product and/or service will create the perception of value in the mind of the customer. This notion must be understood well by organisations and individuals to be able to grow the customer base and retain customers. At the core of the CRM is a customer-oriented perspective.

4.2 CRM - THE MANAGEMENT MODEL

When used as a management model, CRM is a tool for systematically acquiring new customers, retaining current customers and gaining profits. It uses scientific tools to record information regarding the nature and quality of customer interaction with different departments of an organisation. This information is a mine of data that provides valuable inputs regarding customer insight. This helps to devise business strategies aimed at increasing the customer base and growing in the market. Many organisations recognize that for CRM to be a successful tool, the people who manage customers at any level should be trained to use it efficiently. Every year, in an effort to stay ahead of the competition, companies allocate funds for training of staff in the use of new systems so that customers can get a higher level of service and remain satisfied with the company.
CRM seeks to re-create the position to know a customer and understand what makes them tick. It uses the recent developments in software that allow mapping of complex transactions and relationships to give a holistic picture of a customer and, in theory, gives the client the same level of service through a range of possible channels.

Diagram 4.1: The CRM concept (PHS Associates Ltd)

In a sense it focuses on **customer share** rather than market share, using the Pareto rule that 20% of your customers will deliver 80% of the value, and is about understanding just who that 20% is. This is crucial for any organisation. It does not prevent increases in market share but helps an organisation in focussing on the value it gets from any customer base. This then allows a customer service provider to focus on the value generating proportion and maximise his share of profit. Given the valuable input, a company can strategise and allocate resources to provide products and services that the customer's demand.

The longer a customer is with you the better the profitability. CRM therefore is about managing your customer base to ensure that they stay with you and therefore yield a better profit. It is also about getting rid of those customers that take up a disproportionate amount of time for the profit that they yield.

### 4.2.1 Introduction and Overview of the Model

**CRM** will succeed if the way in which customers are perceived and managed is changed throughout the whole organisation.

It must improve both the customers' and the service providers' life. How can you help them to improve their day? What do they get out of it that helps them to improve their business? How can you help them where it matters the most: in running their business efficiently or managing their customer's needs or solving a crucial problem for them. The continuous overlapping between a company's needs and the customers' needs and in turn, the needs of their customers being looked into by the services the company offers, bring success to the company in managing the customers. CRM also includes the
storing of customer information in a database (or data warehouse) and using the information to improve the customer's "experience".

The CRM programme is usually interpreted as a subject based on technology. However it is about bringing about a change in the way customers are managed, and enhanced IT enables that change to take place by providing the right information.

Some key points:

- Be clear as to your objectives in making use of this concept - understand why you are doing this - who it will affect and the benefits that will accrue. Wherever possible the benefits should be quantified and documented.
- Focus on the customer and the market not the technological system - the system is merely an enabler and should only be considered after the strategic and business planning has been carried out.
- It must be business-lead not IT-driven - business must take ownership and lead the project to make sure that it does what is required rather than buying a state-of-the-art programme that misses the target.
- Plan for the changes to behaviour and provide training for staff. Change management begins right at the beginning of such a programme and involves planning and thinking through the implications, involving the users in the planning and ensuring that the people side is not overlooked in any implementation.
- Introduce a new culture and change incentives in order to motivate staff to adopt it. Incentives work best when they are linked to performance. An employee will be quick to adopt to a new system if it is linked positively to the remuneration system. Sometimes changes are introduced without thinking about the behaviours that exist within the organisation or are driven to occur due to the remuneration system.
- Do not underestimate the amount of work involved. A proper programme must be set up with the right levels of resource, budget and sponsorship.

### 4.2.2 The Management Model

CRM is a simple management tool. This concept is further developed into a model that encompasses the issues of customer acquisition, customer retention and customer extention, and three contextual factors - marketing orientation, value creation and innovative IT.

The **CRM model** has four major components:

- **The universe of customers** (current, suspects and prospects) - those customers with whom you deal and those with whom you would like to deal as you believe that they could also contribute to your profit. It is also about understanding the key levers that encourage them to choose a company over others and identifying the key drivers of customer behaviour. Many organizations make the mistake of
misinterpreting inertia for customer loyalty. As soon as competitors find the right levers and offer a better value proposition, this inertia disappears and customers change loyalties. This is when the customer base is threatened.

The number and frequency of interfaces that a customer has - with which channels does the customer come into contact with on a regular basis, those that are accessed infrequently and those that are not used at all. It also implies recording the nature of business carried out through these interfaces and the quality of such transactions.

The internal information feeds - what data are you capturing about your customer - what are you doing with it and how are you using it to increase your share of the customer's wallet.

The external information feeds - what is going on in the market place - what are your competitors doing, is regulation changing what you do, what are the press and other media saying. This helps you to formulate responses to other initiatives to counter possible customer issues.

Each component provides key inputs to the CRM.

Diagram 4.2: The major components of CRM (PHS Associates Ltd)

The model above depicts the major ingredients that CRM requires. As it clearly shows the model deals primarily with maintaining and strengthening the current customer base. It uses data about prospects and suspects or potential customers to devise strategies on how to get more customers. It observes and records interaction via the interfaces that each customer goes through and collects and stores the information necessary to enable the right level of service and tailored products to be offered. It enables an organisation to customise its products and services to suit the customers' needs and tracks customer preferences regarding usage, pricing, type of product, feedback and suggestions. This data, if collected and organised in a systematic manner, reveals an insight into the mind of the customer and gives an organisation an edge over its competitors.
Interface analysis

Interface analysis, however, is not just about the channels that customers use, (or that are made available to them) it is also about understanding the types of interface that staff may have. The diagram explores these types of interactions and categorises them into four:

Diagram 4.3: The employee customer interactions (source: PHS Associates Ltd)

**Inter-facers:** They have frequent or extensive periods of contact with customers and are heavily involved in delivery of services, e.g. banking relationship managers, payments clerks or cashiers.

**Inter-jacents:** Staff such as receptionists or telephone operators who have constant involvement but little delivery. They are often the first point of contact.

**Inter-fusers:** Often involved in development of services but they have little involvement in delivery. Some examples of inter-fusers are strategic managers, marketing, research etc. An organisation must enable them to develop customer awareness by giving them the opportunity to understand customer interactions.

**Inter-players:** Support staff, who have little contact with customers and have only indirect involvement in service delivery.

Measures need to be developed taking into account each type of role to ensure their activities add value and they are motivated and rewarded accordingly. The CRM model takes information from both internal and external feeds in order to build up that picture of customers that relationship managers require. Also after each customer interaction information is fed back into the model and synthesised and then analysed to allow the same excellent levels of service to be maintained by the next inter-facer.

**Activity 1:**

Have you thought of how your colleagues in another department handle a customer and his/her requirements? Think of the role they play in the customer-employee relationship. Are they involved in support functions or in delivery of a product or service? Use the model for employee-customer...
interactions given above to identify the inter-facers, inter-jacents, inter-fusers and inter-players from the different departments in your organisation. You can add to the list given below:

Administration
Finance
Technical
Support
HR
Sales
Front Desk

4.3 REASONS FOR FAILURE OF CRM

Many CRM initiatives, however, fail to deliver the expected benefits. This is largely due to the following reasons:

- It is often misinterpreted and treated as an IT initiative - i.e. the Information Technology department has driven the programme. Sometimes the technical system is seen as the key to success and therefore the programme is handed over to the IT department without sufficient input from the business thereafter. Thinking that 'pure software' is the solution; architecture and integration are forgotten.

- Wrong or inappropriate system was chosen because of lack of information or confusion regarding the purpose of the system. Sometimes an easier option is chosen due to lack of understanding of the system requirements or business goals that the system has to achieve.

- The business support was lacking - i.e. poor buy-in from the business was obtained or no buy-in from the business was sought. This resulted in little ownership within the business and therefore failed implementation or poor usage.

- The planning had insufficient detail or depth - Introducing CRM into an organisation is a major initiative and if it is not planned adequately then it will fail. In most cases, the scale and nature of the operational change (as opposed to the systems change) was underestimated. It is easy to install a system. It is much harder to change people's work practices.

- It was poorly implemented - which usually means that the training of staff was inadequate and neither were the right changes put in place to introduce a new culture.

- The Executive had little customer / CRM understanding or involvement. Too often it was seen as a tactical issue and therefore insufficient senior sponsorship is sought.

- Poor quality of customer data and information. CRM being primarily about information, it is vital that this aspect is considered before the initiative commences.
Typically, organizations have approached the idea as something for the IT department to buy and expect the CRM to have a beneficial effect. Only when they are presented with a system that does not do what they want or expect, they will start to understand the implications. There is little doubt that the concept of CRM is a vital element in success, but to ensure that it succeeds it must be a business-lead endeavour, not IT-driven and must permeate the strategic and marketing thinking of an organisation.

**Key steps for success:**

- Follow a plan that clearly relates the CRM to strategy and the marketing functional plan;
- buy-in is essential;
- it needs to be business lead;
- complete business planning before systems are considered;
- input is required from business, IT and customers; and
- you must ensure that the programme is managed properly (see diagram).

Diagram 4.4: A proper CRM programme (source: PHS Associates Ltd)

Before starting a CRM initiative it must be clear what the benefits will be, how they will be realised and what the implications are for an organisation. If this is not the case CRM will end up merely as another revenue earning venture with absolutely poor returns. (The PHS Management and Training, PHS Associates Ltd.)

### 4.4 SUMMARY OF THE TOPIC

This unit introduces the concept of CRM as an important management tool. This concept is designed to formulate business policy, which is used as an effective management strategy by many companies in
managing relationship with their customers. CRM is the building and maintenance of long-term customer relationships. The relationship delivers value to customers, and profits to companies. This relationship is supported (but not driven) by IT. The business strategy is based upon the recruitment, retention and extension of products, services, solutions or experiences to customers. This is the core of CRM.

CRM entails all aspects of interaction a company has with its customer, whether it is sales or service related. Computerization has changed the way companies are approaching their CRM strategies because it has also changed consumers' buying behaviour. A model on Customer Relationship Management is helpful to develop an insight into the more intricate facets of customer and company interactions. It shows how a company interacts, values and sustains its existing customers and retains the new.

4.5 FURTHER READING


4.6 EXERCISE TO CHECK YOUR PROGRESS

Activity 2
Make a database of three sets of customers on the basis of your above study, highlighting the needs of each groups, i.e. current, suspects and prospects. Use the CRM Model to analyse their needs and applicability of their needs to target the success of a company.

Your answers should comprise:

a) who the current customers are
b) who the suspect customers are
c) who the prospective customers are
d) their specific needs
e) the strategy to fulfill their needs
f) analyze if the goal targeted is achieved

Activity 3

Now you know that customer retention policy is a customer-focussed sales effort every company undertakes to earn maximum revenue. The CRM model as a strategy adds more quality to this policy of customer retention and validation and creates value for your customers. To achieve high rate of customer retention you must be able to answer three primary questions regarding your organisation:
How does your company give "value" to the customers' requirements?
Does your organisation's structure enhance customer value?
Are your customer processes unique in creating customer value?

To have a good grasp on how to create value for your customers, read the answers given below:

The Answers to Activity 3

To answer the first question, the management you work for needs to have a clear understanding of its customer portfolio and in particular a clear view of the value generated for its customers. In a customer management system, two sets of customer portfolios are recorded. One portfolio includes the Healthy Customers and the other portfolio constitutes the Unhealthy Customers. The health of your customers is determined by two conditions: customers' perception of what value the company offers and the direct relation customers have with the company. The customers' perception can be assessed in different ways by making surveys via questionnaires or focus group interviews on factors like trust, satisfaction, relationship commitment, quality and service performance. The value for customers' relation with the company can be created successfully by implementing the tenets of CRM. This ensures that every customer should get back a unique value for his long term attachment with a brand.

The answer to this question reflects the organisation's way of handling its customers. Every organisation follow certain norms or policies to execute customer service. It also depends upon how the supporting staff of a company offers and execute highly dedicated service to its customers. The slightest slack on their part in delivering service may cause to lose the valuable customers. An integrated system of processes, people, policies and system strategies should be in place for CRM to be effective and to ensure successful delivery of value to the customer.

To answer the third question, let us define what customer processes are. These are "moments of great satisfaction" or "unique experiences" shared by both the customer and the company. These unique processes are subjected to emotional assessment that keeps on adding to the customer's delight as time passes by through experience. These processes in turn generate a value in the customer's mind. These "moments of satisfaction" starts from the time a customer is about to associate himself with your company. All the good things he hears about the company gives him a wonderful feeling of satisfaction directly or indirectly and he choses to be your customer right away. In order for a company's processes to be unique, the customer must perceive that at each point of interaction, he is satisfied with the value that he gets. To take an example, from an initial sales call to taking an order to the final bill, and then after sales services, the customer encounters different moments of satisfaction or truth. The way a customer is taken through each step is the result of well-defined systems and processes that should already be in place. In the customer's mind, this experience should be unique. This is what differentiates one company from another.
Structure
5.0 Objectives
5.1 Introduction
5.2 CRM Concept - Customer and Centre of Activity
5.2.1 Definition and Meaning of a Customer
5.2.2 Developing a customer-oriented perspective
5.2.3 Self Assessment
5.2.4 Viewing Customer needs
5.2.5 Commitment to Customers
5.3 Summary of the topic
5.4 Further Reading
5.5 Exercise to check your progress
5.6 Model Answers

5.0 OBJECTIVES

This topic will cover the following areas for discussion:

- Define the meaning and role of customer as a part of CRM concept.
- Study the meaning of Centre of Activity as a customer-centric approach.
- Understand the need of self-assessment.
- Speculate on customer needs.
- Highlight the preconditions for fulfilling commitment to customers.

5.1 INTRODUCTION

In the previous unit, we have discussed the concept of CRM and how it is applicable as a management tool to devise business strategies. The customer is at the centre of the CRM concept. In this unit, we will look at the framework within which we can provide quality customer service. CRM is operated through software available in the market but it can be made functional only through a market driven strategy. The success of CRM therefore does not depend on an advanced technological system. Technology is, at best, an enabler. What really determines the success is how we apply the principles of a customer-centric approach to improve the customer’s ‘experience’.
Activity 1:

Think of the various things that you buy regularly: household goods, groceries, fuel for the vehicle, stationery. Do you buy them from a neighbourhood store or a large departmental store? Think of the reasons why you choose that store/service provider/vendor. Then rate it on a scale of 0 (does not meet expectation), 1 (meets expectation sometimes), 2 (meets expectation all the time), 3 (exceeds expectation). Give your rate for the following:
1. First impression
2. Cordiality of the staff
3. Helpfulness
4. Ability to meet your requirements
5. Range of products/services offered
6. Innovativeness
7. Willingness and ability to solve your problem
What will motivate you to switch to another store/service provider/vendor?

5.2 CRM CONCEPT - CUSTOMER AND CENTRE OF ACTIVITY

CRM may be an IT-enabled service provided to the customers but traditional CRM does not use software or any technical gadgets. It is based on the foundations of inter-personal skills, i.e., soft skills to relate to the customers. Unlike eCRM, which is highly technical in nature and stores, retrieves and provides customer data instantly, the traditional CRM enables the customer service executive to service his customer by keeping in mind the urgent needs and demands of the customer. He has to personally oversee the fulfillment of commitments given to the customer without relying solely on technically aided processes. Thus a customer becomes the Centre of Activity in Customer Relationship Management and Customer Service becomes a major activity in satisfying the customer’s expectations of getting world-class service. The primary focus of a company today is to recruit and retain customers. The managers of a company work hard to keep the customers satisfied so that they do not lose the customers on any grounds.

Product quality is essential for garnering customers, but it is service quality that is key to customer retention and growth. Customer Service is far more important than you realize.

Customers are “five times more likely to switch vendors because of perceived service problems than for
price concerns or product quality issues”, according to a study conducted by the Forum Corporation. In a US News and World Report, the reasons for losing customers were recorded as follows:

1% Die
3% Move away
5% Form other friendships
9% For competitive reasons
14% Dissatisfaction with products or Services
68% Indifference shown to the customer by some employee of the supplier.

Market pressure is driving companies to search for better service practices to obtain an advantage over competitors. Many companies adopt and enforce strict quality and service standards to ensure that customer service does not suffer and that customers are retained. Retaining customers gives an advantage to any business. The Humble Global Service Survey found in their survey that service is a major source of differentiation in business and they believe that service is the new competitive edge.

5.2.1 Definition and meaning of a customer

The Oxford Dictionary defines a customer as “a person who buys especially regularly from one seller; an account holder in a bank, person with whom one is concerned.”

A customer is considered as omnipotent and omnipresent as God, as important and powerful as a King, and as demanding as a Boss. A customer is the boss because you can lose your job when he is unhappy with you or your work. One sure way to lose your job is to displease your customer. We are not doing the Customer a favour by serving him. He has given us an opportunity to provide a service by choosing us over others. At the same time, in a market-driven and competitive environment, the customer has no compulsion to stay with a single company. His loyalty with a company lasts only as long as he remains satisfied with the service. The Customer is innovative, fussy, choosy, ambitious, proud, sophisticated and global in outlook and he will always go for the better option available. A company that understands consumer behaviour and reaction scores over others who do not. We can please customers the most by treating them as individuals who are important to us. So, if you do not serve your customer he will find someone else to serve him.

If, at all, a slip occurs, it is a smart move to acknowledge it rather than denying it. Customers tend to be more forgiving to organizations that acknowledge and apologize for their mistakes rather than denying them. Taking responsibility for mistakes and correcting them is considered an important aspect of good customer service.

5.2.2 Developing a customer-oriented perspective

Customers gain an eminent position in the service platform of an organization and assume a central role in the service system implemented by the organization. This allows the company to confer on the customer
a position as a centre of the organization’s activities. A suitable approach is the best way to prove the importance of the concept of Customer as Center of Activity.

There are several Customer retaining marketing strategies. Among them, there are two strategies that keeps the companies in direct touch with the customers to create a customer base in the market.

**Customer experience management (CEM)** describes the processes and methods used to design and manage a customer’s entire experience with a product or a company. It involves using a survey of consumer behaviour. The purpose of a customer survey is to collect focussed opinions from consumers of a product or service. They are seen as a powerful tool because they allow the makers of the product or service to ask direct questions to the customers. Companies can then ‘manage’ the experience of the customer by filling in the perceived and actual gaps. It is important for the customer to ‘perceive’ that the company is making a sincere effort. This ‘perception’ is actualised in the real experience that the customer has when interacting with the customer.

**A service system** is a configuration of technology and organizational networks designed to deliver services that satisfy the needs, wants, or aspirations of customers. Marketing, operations, and global environment considerations have significant implications for the design of a service system. There are three criteria used to classify service systems. They are customer contact, capital intensity, and level of customer involvement. In this sense, service systems are a type of complex system that is partially designed and partially evolving. Service systems are designed to deliver services, but they often consume services as well.

Total quality management (TQM) is an approach improving the performance of an organisation on a systematic and continuous basis. This is achieved by involving all employees of the organization in satisfying the requirements of every customer, whoever he may be (external or internal). The principles of TQM like meeting the customer’s needs, exact assessment, continuous improvement, teamwork, and enthusiasm of the leaders are typical for any service.

**Total** - everyone in the organization is involved in creating and maintaining the quality of the services and products offered.

**Quality** - it recognizes that the customer perception of quality is crucial and there is individual and collective action to meet the customer’s needs.

Management – it lays emphasis on managing the system by continuously improving it in order to achieve the best results. This may involve seeking customer feedback, scheduling periodical upgrades of tools, adopting more efficient systems for smoother workflow and delivery and retraining staff to achieve the best results.

*TQM is a management philosophy embracing all activities through which the needs of the*
customer and the community, and the objectives of the organization, are satisfied in the most efficient and cost-effective way by maximizing the potential of all employees in a continuing drive for improvement (Metreveli, 1998).

To accentuate the purpose of making customer a center of activity it is important that we attend to customer demands, right now. Quality Management makes provisions for the service executive to keep track of customer’s needs on a day-to-day basis. It gives personal service and efficient back room preparation, manages minute transactions and it provides value and maintains a distinction, thereby enhancing the customer’s experience as a whole. To achieve all of this dynamically, a quality management professional needs data and mechanisms to provide it. He needs a minimum of four channels of information. One, to keep him in touch with the customer’s changing requirements; the other to monitor his output against those requirements; third, to give him feedback on his performance in matching the first two; and a fourth to keep highlighting his customer’s needs and help him stay a step ahead of the others.

5.2.3 Self-Assessment

Today every organization has to look within for a quick evaluation of its performance and the service it renders to the customers. This evaluation or assessment is done with an aim to identify the areas in which an organization is lagging behind and accordingly generate means to overcome the shortcomings. This is a remedial measure to improve performance of an organization in terms of providing excellent service to the customers.

Every customer service executive who interacts with the customers on a personal level is an individual representative of the organization. These executives need to perform in such a way that customer expectation is exceeded by the service provided. Therefore, many organizations conduct a performance review of their services wherein they do a self-assessment of their customer policies and management processes.

Assessment for Excellence is a review of an organization’s management processes and performance that is used as a model of Business Excellence.

It enables an organization to clearly:

- Assess the performance of its leadership and management systems.
- Build those results into strategic planning processes.
- Benchmark where the organization stands in terms of the marketplace and competitors.
- Drive and focus business improvement to achieve measurable results.

Assessment for Excellence is suitable for any organization that is serious about evaluating the perfor-
formance of its management and leadership systems. It is an option that facilitates a systematic and structured approach to assess and improve the performance of an organization’s leadership and management systems. They help to assess how effectively an organization:

- Uses knowledge and information at all levels of decision making
- Aligns its people and strategic objectives
- Accurately analyses customer needs and markets, and integrates the results into activities
- Deploys effective internal and external processes to supply quality products and services, as well as value creation processes to improve those products and services
- Demonstrates its performance to date, and envisages future success

In many organizations, a self-assessment review is done weekly by issuing Customer Feedback Forms to the customers, in which customers are required to give individual scores to a company’s rating system on the basis of the service performance of the company. This system of taking feedback from the customers throws a light to the organizational loopholes which otherwise remain unattended. Depending on the rating system a company frames for its growth and success, it can prioritize its focus on different areas that needs improvement. The service system is restructured taking into account these key development areas of its management system. Thus, the importance of self-assessment reviews is paramount for the success and life of any organization.

5.2.4 Viewing customer needs

In order to view what customers’ need, we have to understand that customers are not just demographical figures on a sales chart but are real life individuals with distinct needs, instincts, lifestyles and problems. Just because they buy a company’s products or services they are not called customers. They are individuals who come to a company to address a need: solve a problem or make their life more comfortable. They depend on the company to fulfill that requirement for them. Without understanding their needs, we cannot motivate them. To give them complete satisfaction, we have to deliver quality service.

What do customers need?

To understand the needs of customers, the gaps that occur between the customer wants and their fulfillment needs to be looked into. Often the management tends to overlook this gap formed. Using research, Chris Daffy (1999) cites five common “perception gaps”:

1) The gap between what you think the customers want and what they actually want.
2) The gap between what you think the customer has bought and what they perceive they have received.
3) The gap between the service quality you believe is being provided and what the customer perceives as being provided.
4) The gap between the customer’s expectation of service quality and the service quality you actually deliver.
5) The gap between the marketing promises and your actual delivery.

As per the reports of a new Economist Intelligence Unit survey commissioned by UK Trade & Investment, on a study done for 298 customer care executives worldwide, a majority admit that they understand customers and employees better at home than in foreign markets. However the report also reveals that the biggest consideration in giving more independence to overseas operations is the quality of the local management.

Current studies attribute a higher degree of emotionality to the levels of dissatisfaction faced by the customers as opposed to the satisfaction felt by the customers in the past. For example, customers who have experienced service failures feel annoyed or victimized. Although victimization is felt at a deeper emotional level than frustration, both can result in outrage. By focussing on more intense customer emotions, such as outrage and delight, the companies pay more attention to the dynamics of customer emotions and their effect on customer behaviour and loyalty.

The base for identifying the needs of customers should be on human needs rather than conventional ideas that focus on a customer’s expectations from a company. Business that sustains customer delight and outrage originate from three basic human needs. They are security, justice, and self-esteem. Enacting a situation that has irritated a customer in the past as a source of outrage is inadequate to gauge his true feelings. The emphasis should be on encouraging the customers to express themselves freely by creating a forum for addressing their grievances directly.

Recent emphasis on relationship marketing that is, attracting, developing, and retaining customers is an invaluable exercise because building relationships requires a company to view customers as people first and consumers second. Service is an exchange of relationship in which customers swap their money and loyalty for a deep-rooted contract with service firms to have their psychological needs gratified. Strategies can help companies gratify and, in some cases, delight customers, while avoiding the perception that they do not respect customer needs.

Companies must manage how they show concern for customer needs in all actions, including the activities of the back office (e.g., billing, shipping), and not just for front-office personnel who directly contact the customer.

Customer satisfaction can be measured by the following equation:

Perceived Performance is equivalent to Expectation.
When

Perceived performance = Expectation
   \textit{Customer is just satisfied}

Perceived performance < Expectation
   \textit{Customer is dissatisfied}

Perceived performance > Expectation
   \textit{Customer is highly satisfied or Delighted}

To attain 110\% of customer satisfaction some corrective steps taken by an organization can fulfill or gratify the need to delight customers. They are:

- Observe
- Understand
- Plan
- Implement
- Feedback
- Evaluate
- Take Remedial measures

Some of these customer service tips go a long way in understanding the customers. Having properly streamlined systems ensure that we do the job right the first time around. So, never under-promise and over-deliver to a customer. Always say 'yes' but do not follow up the "yes" with a "but". While we measure customer satisfaction with the best practices, at the same time we should learn to show respect to our customers. When we continuously improve on our services we can easily create ‘moments of truth’ for our customers.

The “\textit{Moments of Truth}” is an advertising jargon coined by the President of SAS [Scandinavian] airlines about two decades ago. The airline was on the verge of closing down when he took over. He stressed that there are many moments in the interaction of the customer with the airline staff, where the customer made an impression about SAS. These moments would be either ‘bright’ or ‘dull.’ For example, if the boarding pass is given after an avoidable delay, it is a dull moment of truth. If the ground staff person goes out of his way to help a passenger load his bags on the trolley, it is a bright moment. SAS estimated that there would be around 50000 moments of truth in a journey for a single passenger. How bright the SAS staff makes these moments for the customers will directly affect the satisfaction of the customers. Similarly, this concept can be used in other areas of marketing services that directly deal with customers. These “moments of truth” can become magical moments if they can perfectly satisfy the customers by creating a positive impression in their minds about the company, the product and its services.
5.2.5 Commitment to customers

It is often easy to promise a thing or two to a customer and let it slip off our minds when the time comes to fulfill it. Commitments to customers are not always easy to keep, but they must remain at the top of the priority list for any business to thrive. To build stronger, long-lasting relationships with customers, promises made to them must be kept. It can range from returning a phone call to living the mission and vision statements of a company. The way companies treat employees and associates determine how they treat customers. In order to make this functional as primary objective, organizations need to establish the philosophy that states that the customer is a king and people are your greatest asset. Commitment should be woven into the very fabric of the organization. To fulfill commitment towards the customers, customer service should create a value-oriented environment than just paying lip service to the old adage, ‘the customer is always right.’ The seriously customer-centric organizations incorporate a set of beliefs and principles that are articulated from the top to bottom levels in any organization. These principles are understood and practiced by everyone in the organization and are easily recognised by anyone who comes in contact with the organization. These values lay the foundation stone for a company to do business on the right ground. They shape up the company’s image and determine how it is perceived by customers, competitors and also the company’s own people. The five guidelines mentioned below can help communicate to the employees of an organization’s what commitment to the customer means.

1) Operating plans to provide a basis for how the organization does business.
2) Meetings, whether annual, quarterly or monthly, that regularly helps to carry and reinforce the message throughout the ranks of the organisation.
3) Company publications, bulletin boards, and other written forms of communication from management that reflect the operating philosophy and cite examples of real-life situations.
4) Actions of managers throughout the organization are the most effective method of conveying the message of commitment to the customer. Management demonstrates example on a day-to-day basis.
5) Performance plans that are written for each employee so that they know how this philosophy relates to their area of responsibility. The ‘customer connection’ should be explicitly spelled out in every job description.

Organizations that are driven by customers’ interest train their employees to work for the welfare of customers. Any mistake committed while dealing with customers is immediately replaced by apologetic gestures like sending a note of apology to the customer or delivering a surprise gift at his doorstep as a token of good faith and friendship he has with the company. One of the most critical jobs is setting priorities and completing tasks so the organization knows what is required. This means having a clear set of goals, objectives and measurements to keep one committed to one’s goal.
Many people set objectives, but few sit down and actually go about achieving them. The manager’s role is more than just to say, ‘I’m here to monitor everything.’ He or she needs to say, ‘I’m here to help. Let us try to understand the problem.’ The managers should check if they are contributing to the task they are entrusted with. The goals of the business that have not been achieved can be transformed into specific tasks for each individual to perform. The trouble begins when we emphasise on a wide range of things, and nobody knows how many hours need to be spent on writing a proposal, or calling on prospect customer, or servicing existing customers. It is the allocation of time and resources for everything we do that counts. Success comes from self-discipline and organising one’s task according to the organization’s requirements.

Also, an organization must constantly listen to its customers to ensure that their needs are being met. It can keep in touch with customers through surveys, focus groups or industrial councils. Employees should also be surveyed for their views on the company and its products or services. They must also be given the opportunity to make suggestions for improved customer relations. These findings should then be measured against company objectives. Necessary adjustments should be made and the results should be conveyed to employees.

Feedback systems must be placed throughout the service period of a company. These systems, whether used as consumer satisfaction indexes or simply as customer surveys, helps the company to focus on overall quality of products and services at its highest level. An organization must continually check in with customers to ask, ‘How are we doing?’ Every function within the organization exists to satisfy the customer, and this begins with employee responsibility. What encourages an employee’s commitment to customers is more to do with the recognition from management. It is important to give public recognition to people for doing the right job. A simple exclamation that says, “Well done” or “Keep it up” goes a long way in motivating the employees to discharge their duties in the best way possible.

If we want to maintain old customers and create new ones, then our organization must strive to provide the best service, not just within the industry but also outside it. The secret to providing good customer service lies in doing the little things well, the first time and all the time, which fulfills every commitment made to the customer.

To recap the following are essential to achieve excellent customer service:

- **Develop and encourage a customer-oriented perspective.** As some business experts say, you must be able to ‘jump the counter’ to get the customer’s view of what the world looks like. This enables you to prioritise their needs and plan your business activities accordingly.

- **Ensure reliability** of your service at all times. Breakdown in reliability may turn away many customers.

- **Assure quality**, all the time in whatever you offer. Do not compromise, even if it is a minute task.
of returning a phone call or acknowledging receipt of payment for a bill.

- **Demonstrate empathy with your customers** so that they perceive that you are listening to them, especially when something goes wrong and they take the trouble to complain. A customer who has complained and received special attention as a result is more likely to remain loyal than a customer who is always satisfied.

- **Recover fast from service mishaps.** If a mistake has occurred, acknowledge it, no matter how minor or grave. Then rectify it at the earliest possible opportunity. This ensures that your customer perceives that you recognize that they are important to you and that you will make that special effort to address their needs.

- **Strive to go beyond the expected service levels.** Every customer has a minimum service level expectation beyond which they will not tolerate any shortcomings. For example, it is acceptable to wait for 15 to 20 minutes to be seated in a busy restaurant but if the waiting period extends beyond that, then the restaurant is at risk of losing new customers. Similarly, it may be acceptable to give 24 hours for a courier service to deliver to international cities, but any time exceeding 24 hours may cause the business to lose existing customers. If you can strive not only to meet the expectation, but also surprise them by exceeding it, then the customers will stay with you.

- **Strive for a high degree of responsiveness.** If your customers know that they can depend on you for meeting their requirements, trouble-shooting, anticipating needs and responding to their complaints and suggestions, they are more likely to stay with you.

- **Re-organise and retrain to suit the customer.** Traditional organizational structures drive how the sales person or front office handles customer relationship without being sensitive to the crucial role played by them in creating value for the customer. It is usually the people who are in direct contact with the customers who are the keepers of the ‘moments of satisfaction’ or ‘moments of truth’, not the management. They should be empowered to do their job well.

### 5.3 SUMMARY OF THE TOPIC

In this unit, the role of the customer is defined as an integral part of customer relationship management. The omnipotent status given to a customer is justified by advocating proper reasons. The focus here lies on establishing customers as centre of activity in a business domain. Because of the attention and care the customers receive, the entire activity of customer service revolves around gratifying the customers.

The other sections deal thoroughly with the aspects of CRM that can be applied in every sphere of customer service. In keeping with the trends of market, management processes of organizations conduct self-assessment tests to scrutinize the quality of their services they provide to the customers. Also,
a need to understand the customer is stressed upon as a prerequisite for keeping customer commitment.

5.4 FURTHER READING


5.5 EXERCISE TO CHECK YOUR PROGRESS

Check your progress 1

Note: 1) Use the space below for answers
2) Compare your answers with those given at the end of this unit

1) Why is a customer called a “king”?
2) Is customer a centre of activity in a company? If so, why?
3) How do we view or understand a customer’s need?
4) Why is it important to keep our commitment to customers?

1) ………………………………………………………………………
2) ………………………………………………………………………
3) ………………………………………………………………………
4) ………………………………………………………………………

5.6 MODEL ANSWERS

1) The customer is called a ‘king’ for his omnipotent as well as omnipresent status in a business environment. He can fire his service providers at the slightest inconvenience he faces. In this way his allegiance keeps on shifting incurring heavy losses on the company. Therefore, a customer should be treated like a king.

2) Yes, customer is a centre of activity in a company. In customer relationship management, the customer is always the centre of customer services. Customer service is a major activity in an organizational set-up. This entire activity caters to a customer’s need of earning satisfaction from the services provided by the company he is associated with as a buyer.
3) We view or take up measures to understand a customer’s need because a customer is more than just a buyer. He is an individual first, and then a buyer. His needs arise from his individual wants. It is important to know him first as a human being, his psychological make, his instincts and his tastes in order to understand his consumer behaviour. We can satisfy a customer only when we understand a customer’s need.

4) It is important to keep our commitments to the customers in order to retain the existing customers and add new ones for the company’s growth. Customers are greatest asset of a company, so we should keep our commitments to the customers.

**Activity 2**

Imagine that you were to open a salon for men. Design a project by getting into groups of two and emphasizing what you would do to make it different from other salons. You should have at least 10 points each on how you would make it different for your customers and employees. Make the presentation in front of the class and discuss your plans. Your classmates can make suggestions for the betterment of your plan and also ask you questions on the aspects of your plan.

**Activity 3**

You buy household goods from one neighbourhood departmental store. Think about everything you like in the store and what makes you go there again and again. Narrate to the class your positive service experiences as a regular customer of that particular departmental store.

***
6.0 Objectives

After going through this unit you will be able to:

- Understand the dynamics of selling skills in the context of learning marketing policies of organizations through the study of the psychology and principles of selling.
- Learn how to make an appointment with your customers and develop the habit of creating positive first impressions to build trust and rapport with your customers.
- Appreciate the virtue of active listening for understanding your customers better.
- Gain a perspective on how to understand features of a product and turn these features into benefits to sell a product in the market.
- Analyze consumer behaviour and use this knowledge to identify buying signals.
- Learn to understand and handle objections, which a sales personnel or executive tends to come across while dealing with the customers in a sales process.
- Understand and apply the techniques of successfully closing a sale.
6.1 INTRODUCTION

Selling is a commercial activity associated with any business venture that constitutes an integral part of the marketing policy of an organization. Selling is an act of persuading the customers to purchase the goods and services of a company. Selling, therefore, includes contacting potential customers, presenting and demonstrating products, taking orders, delivery of goods and the collection of payment.

6.2 SELLING SKILLS

Selling skills is a soft skill that teaches a sales person how to master the art of selling a product in the market successfully. These skills are essential to build a rapport with the customer and to fulfill the organisation's aim of retaining the customer. A customer will always return to or ask for a sales person with whom he has had a positive experience. To perform well as a sales person, you will have to use the skills of persuasion, but this has to be supported with the right technical knowledge and people skills so that customers make the purchasing decision in your favour. Many sales efforts fail simply because instead of applying soft skills, many sales personnel adopt scientific methodologies in manipulating the buyers to become customers of their respective organizations. When customers see through such manipulation, they form a negative impression of the person and the organisation and are most likely to go to their competitor hoping for a better experience. It is very hard to measure the points scored by different sales person to prove oneself better than everyone else in selling a product. A good salesman usually asks open questions, analyses, understand the customer's need, present the benefits, and clinches the business.

6.2.1 The Psychology and Principles of Selling

Selling is often defined as, "a professional, interactive process directed toward demonstrating to all your buyers how your product or service serves their self interest, and will enhance their lives."

Psychology of selling is basically the "frame of mind" in which a sales person conducts a sales exercise. Understanding the "psychology of selling" is important for sales people at all levels of customer dealing. A proper training on the psychological aspects of sales process enables a sales person to study the potential customers through their non-verbal signals. Once a sales person knows how to handle his customers according to their psychological make up, he can quickly connect with his customers and influence them without losing his integrity. In mastering the techniques of selling skills, many training experts recommend the sales personnel to inculcate the principles of Rapport Building from Neuro Linguistic Programming (NLP) into their behaviour to increase effectiveness.
Rapport building is the ability to create a common bond of understanding with the listener or customer. Rapport building is done in three ways: matching the behaviour of the other person; mirroring the non-verbal gestures of the other person; and pacing, that is the manner in which you match and mirror. Rapport building is a gradual process that takes about 5-10 minutes to set in after the first hello. In a sales situation, the need is to establish a rapport immediately without making it seem like you are mimicking the customer. Many sales people first ask the necessary questions to find out what the customer needs, and then express their empathy and understanding of the customer's need or problem by using appropriate linguistic and non-verbal cues. They then proceed to show how their product can address that need (make life easier, suitable for the family, price within range, value for money) and why it is the best choice for the customer.

The Principles of selling incorporates within its purview the process of communicating with people at different levels with ease and clarity. Different customers react differently to different situations and this is determined by their personal circumstances, awareness, knowledge and personality. Active and dynamic sales personnel can motivate and influence their customers anywhere, if they can figure out the customer's buying strategy and the values that they hold dear. Smart sales persons can attach the values of their customers with the solution they offer.

The most effective way to remedy a customer problem is to apply the knowledge of people skills in lending a voice for the problem the customer faces. A sales person has to act like a mouthpiece for the customers' doubts and queries as every customer believes his doubts to be important and expects them to be taken care of. A sales person should always demonstrate a friendly disposition to avail of potential business opportunities. A hassle free sale involves the person's capacity to handle objections raised by buyers effectively by addressing the questions and doubts in a satisfactory manner. The main objective is to win the trust of the customer. Ultimately, a sale is about influencing the decision of a buyer in making a right choice of a product. Once a customer makes his choice of a product and announces his decision, then it is the sales person's turn to ask for the sale.

### 6.2.2 Making an Appointment

A sales person opens up or initiates a sales deal by taking an appointment with his customer. An appointment is a request for an approval to meet the customer in person on a suggested date and time. Making an appointment is an art and an integral part of the communication of an organization. While conversing over the phone to make an appointment, a sales person should effectively convey his message to the customer in order to get his approval for the meeting. Half-hearted conversations or improper use of words or vocabulary would disrupt the process. A busy customer may not wish to be disturbed with a sales call. Moreover, if the customer is unhappy with the sales caller, he is likely to decline the proposal of a face-to-face meeting with the sales man, irrespective of his persistent persuasion and coherent conversation.
The process of calling up a customer over phone for appointment is adopted both in Teleprospecting and Teleselling to promote a product or services. In teleprospecting, where the stake is usually higher than teleselling, unlike asking for the customer’s money (gradually), his time is (immediately) asked for. This calls for efficiency and people friendly behaviour to conduct oneself as a telemarker and at the same time a patient and warm countenance to deal with such sensitive customers. In many companies, sales personnel are allowed to hire the services of telecallers to make appointments with customers. These people are trained to be efficient in soft skills before engaging them in the business of calling people. To make an appointment, we should:

- Initiate a phone conversation with a friendly greeting. The greeting should be immediately followed by an inquiry about the customer’s general well being.
- In the same friendly tone and with a well-modulated voice ask the customer if it is convenient for him to talk with you at that moment.
- If the customer shows disapproval of the conversation, do not pester him with more questions. Thank him for sparing his valuable time and let him know that you will call him again at his convenience.
- Set the mood for another conversation, by winding up the present conversation on a positive note.
- Even if the customer is rude or unwilling to talk, do not loose your cool.
- Use easy and simple language.
- Maintain a diary to log in your calls for making appointments. Next, time when the customer agrees to listen to you, you should show your understanding towards your customers' needs by listening actively to whatever they say.
- When the customer agrees to a meeting, register all the details of the meeting like place, time and date of meeting, purpose of the meeting etc in your diary. Whenever an appointment is made that pertains to a particular sale, then, consider that sale call as open for a deal.
- Once the appointment is made express your gratitude to the customer by reassuring him the best of your services.

6.2.3 How to create positive first impressions

In today’s world, creating positive first impressions is crucial for success in all forms of business endeavour. Three main factors contribute to the creation of positive first impressions. They are:

- Appearance
- Behaviour
- Communication
Impressions are based upon instinct and emotion, not on rational thought or in-depth investigation. They are the product of the associations we make between outward characteristics and the inner qualities we believe they reflect. We all harbour assumptions regarding almost every human trait imaginable: tall or short, heavy or thin, articulate or not, clean or dirty, well mannered or rude, organized or disorganized. Whether we like it or not, a person who examines us outwardly may prefer one trait to the other, whereas, someone else may go for another trait altogether.

Positive first impressions are lasting impressions, for a couple of reasons. Our life experience has taught us that the first impressions we form about others create an unforgettable impact on the mind. When these impressions are recollected time and again, we try to judge a person according to the positive or negative effects they cast in our minds. The more the impression is positive, the longer the impact will be on our minds.

Sales people employ a technique called "mirroring" discussed above. They know that when they reveal their posture, gestures, speaking style and way of dressing to a customer and open communication in a confident manner, he begins to see these sales people as people who understands him and who have the same values as him. Trust is quickly built and the deal is sealed. Thinking beyond daily objectives and being prepared to encounter all types of people are the traits of a successful sales person. "Mirroring" is a typical example of ‘seeing is believing’ in the act of creating positive first impressions.

Activity 1

When a door-to-door salesman comes to your house to sell books/cosmetics/household items/cleaning items, what happens during the interaction? Discuss in the class taking two situations:

1. Where he was able to sell.
2. Where he was not able to sell.

Discuss the reasons for his success or failure.

6.2.4 Building trust and rapport with your customers

Building rapport with customers is important while making a sale. It really does not matter how knowledgeable we are about the product or how skilled we might be at selling, unless we earn our prospects’ confidence. Customers want to do business with people who they can relate to and who they feel understand their needs. Obviously, the efforts put in to build up trust and rapport escalates the direct relationship you establish with your customers in exchange for the price of your products. There are five steps to guide you in building trust and rapport with your customers.

1) Be mindful of your body language gestures and remember to keep them positive! Unfold your
arms, uncross your legs, show your palms and remember to smile. Develop awareness and sensitivity to your prospect's body language. An effective listener notices all aspects of communication and is aware of voice tone, facial expression, repetitive movements, and muscle tension. Watch for inconsistencies between your prospect's spoken word and their nonverbal communication. Rely on the nonverbal as a much more accurate indicator of intent. By understanding your prospect's body language you will minimize perceived sales pressure and know when it is appropriate to close the sale.

2) **Create harmony!** "Matching and Mirroring" your prospect's body language and gestures will psychologically cause them to identify with you. The power behind this principle is firmly grounded in the precept that people trust people whom they believe are similar to them. Matching and mirroring is an unconscious mimicry by which one person tells another that he is in agreement with their ideas and attitudes. Likewise, studies have shown that when people disagree they subconsciously mismatch their body language gestures. You want to be careful not to be too obvious when you are consciously matching someone because it will be perceived as manipulative if you do not do it naturally. An effective way to begin matching is to subtly nod your head in agreement when your prospect nods their head.

3) **Remember to make eye contact and listen with genuine interest.** You are certain to create an unfavorable impression if you give your prospect the idea that you are not fully present in the conversation. Unfortunately, we are often busy game-planning our response instead of truly listening to what is being said. You should occasionally repeat verbatim what your prospect says, especially their key words or phrases. Restating in your own words serves to clarify communication, but you deepen rapport when you use their words.

4) **Ask open-ended, clarifying questions** like who, where, what, when and how. Open-ended questions will require your prospect to give in-depth responses. Become an active listener. While it is important to educate your prospect about your product or service, as a general rule you should listen more than you talk. Keep your attention focused on your prospect and avoid the temptation to interrupt and dominate the conversation. The quickest way to destroy trust and rapport is to interrupt another person while they are speaking. If you do interrupt, minimize the damage by apologizing and ask them to please continue.

5) **Dress and act professionally.** While it may seem unfair, we are judged on our appearance. Research indicates that people form a lasting impression of us within the first five minutes. Take care to dress appropriately for the occasion.

**Source: Power HomeBiz.com**

### 6.2.5 Listening Skills

With practice and conscious resolve, a salesperson can acquire the mental agility to become a better listener by mastering these six "mental listening exercises":

---

DOEACC Society Guwahati / Tezpur Centre
UNIT 6: SELLING SKILLS

1) Learn to "listen ahead":

"Listening ahead", means trying to anticipate where a discussion is leading to, during the dialogue, or determining the conclusion in advance of our required response. It allows us to relax and improve information absorption.

2) Learn to periodically validate communicated information:

By mentally striving to validate the accuracy and completeness of information points made by the prospect, especially during pauses in the dialogue, (which can be achieved with note taking), we can allow ourselves to absorb more information easily, especially information forthcoming in the continued dialogue.

3) Utilize "Active Listening" techniques:

By periodically, mentally summarizing the major points communicated by the prospect and voicing and reaffirming our interpretation of the points made back to the prospect we add a tremendous amount of clarity to the information exchanged.

4) Strive to understand:

By working consciously to understand what the prospect is saying along with the natural tendency of judging - approving or disapproving what is said will allow us to absorb what is actually said more than any other listening development technique.

5) Use your eyes to "get the rest of the story":

By listening with your eyes, paying attention to the prospect's body language, their nonverbal facial and body movements or hand gestures we can see what the whole body is trying to tell you, not just the mouth!

6) Maintain a mental repertoire of common responses:

By mentally developing and rehearsing how we are going to strategically respond to common sales prospect objections, for example, in advance of a sales call, allows us to listen more effectively. A comprehensive mental inventory of common responses also gives us more confidence in any selling situation.

Today's successful salesperson is ultimately an effective problem solver. Whether it is an existing or potential customer, the most successful sales people continuously strive to hone their listening skills to
accurately define their customer’s business intentions. If properly trained, and with constant practice, a salesperson quickly realizes that how they talk or present their product or service is relatively unimportant when compared to how and what they listen to, when guided by well honed listening skills. Applying the selling skills developed from these listening exercises can give extraordinary power, not only to the spoken word, but the words listened to, and may provide the only margin of victory in any given sales situation.

Source: business-buyer-directory.com

6.3 UNDERSTANDING FEATURES AND SELLING BENEFITS

A feature in a product is all about what it looks like, what it is made of (size, colour, horsepower, functionality, design, fabric content, etc). Features are basically straightforward facts, which the sales people present to their customers.

The benefits are what the feature can do for the customers, eventually and finally as an element of surprise. While Product Features are usually easy to detect and describe, Product Benefits can be trickier because they are often intangible. The most compelling Product Benefits are those that provide emotional or financial rewards. People are more interested in benefits.

It is not the brighter smile that the toothpaste offers but what the smile might bring you. (A good-looking mate, a better job, etc.) Emotional rewards run the gamut of human emotions but basically allow the buyer to feel better in some way.

Products that deliver financial rewards allow the buyer to:

- Save money (a discount, a long-distance phone plan)
- Make money (computer software for managing a home-based business)
- Gain convenience and time (microwave meals).

Be aware that nearly all sales people slip back into quoting Features and miss out the Benefits. Translating Features into Benefits is one of the most important skills for a sales person to master.

Some transitional phrases are given here that connects features with benefits:

- Because ..
- This lets you …
- That means …
- What this gives you …

In order to turn Features into Benefits, an example is given under for our understanding:
This paint is non-drip (Feature) which means that you will not mess up the floor while painting (Benefit).

Questioning is a powerful technique that lets customers know that we are concerned. If we do all the talking, chances are that we will loose the customer's attention. With a smart question, we can find out what concerns the customer and what would ease his concern. Questions help to find out what a customer wants so that we can match the product to their specific needs and wants and satisfy their desires.

**Activity 2**
Prepare a sales presentation for a toothbrush. Present it in front of the class. The class may ask you questions and you have to convince the class to buy the product.

Use the following techniques:

**Step One**
Use open-ended questions to establish a full picture of customers' real needs, wants and desires.

**Step Two**
Use close-ended questions to clarify the specific points. Relationship Building Questions

*The most important relationship-building questions you can ask are:*

How do you feel about this?
What do you think about this?
What is most important to you when buying a Product or Service like this?
What has been your past experience with a product or service like this?

*These are essentially open-ended questions!*

Determining the Specifics or Situations that would require "close-ended" questions to finally close a sale procedure

*These questions will help you to zero in on a “Sale”:*

Can you spare a few minutes of your precious time?
Do you use this type of product or service?
What is your usual budget in this area?
Would you like to go for it?
When can I get back to you?

*These are closed ended questions*

Using Emotions

Motion (doing something) happens only when emotion is involved (towards pleasure, away from pain).

Use questions that take people to points of emotion. Create emotion for people.

Emotion Arousing Questions:

- What are you looking forward to the most?
- What is your favourite memory of staying at …?  
- How do you feel about going back to …? 
- What excites you about visiting that part of the world?

### 6.4 IDENTIFYING BUYING SIGNALS

One sure way of identifying buying signals is to do proper prospecting in a business. **Prospecting means, finding potential customers and matching the profiles of the customers with the product.** It involves generating, qualifying and categorizing **leads**.

After prospecting has been done, one has to generate Leads to sell the Product or Services. Leads are those prospects that have shown some kind of interest in the product or service. To be a prospect a lead should have:

- Money
- Authority to make decisions
- The need to buy

There are mainly three types of Leads:

1) **Hot leads**
2) **Warm leads**
3) **Cold leads**

**Hot Leads**—are those prospects that have a reasonably high probability of buying a particular product or service.

**Warm Leads**—are those prospects that have a medium to high probability of buying.
Cold Leads—are those prospects that have shown a lukewarm or little interest in the product or service. But a cold lead should not be ignored, because he/she might change his/her mind about the product in future.

To identify buying signals one has to identify the leads who become the ultimate buyers of a product. For measuring the accuracy of time in the closing of a sale, a sales person should look for buying signals as in:

- How much is it?
- How soon can I get it?
- Sounds good!
- What is the next step?
- What is the catch?

Recognise buying signals, or many potential sales opportunities and customers will slip away from you.

6.5 UNDERSTANDING AND HANDLING OBJECTIONS WITH EASE

Objection is "a reason which a prospective Customer gives for not buying a product or service." It is basically a mismatch of Customer's needs and the product or service offered. It is an obstacle, which needs to be overcome. Objections can be either voiced or unvoiced. Objections are usually raised in the forms of skepticism, misunderstanding and stalling.

Skepticism is promising too much and failing to gain a rapport with the sales person. It is also not answering fully the questions being asked. The stances maintained by the customers become defensive.

Misunderstanding takes place when the customer's needs are inadequately defined and addressed. If the salesperson fails to translate the features into benefits for the customer, there will be misunderstanding regarding the suitability of the product for the customer.

Stalling is an unclear communication that takes place between a customer and the salesman. The customer shows reluctance in buying the product and does not hesitate to compare the salability of the product with its offered price.

In the above-mentioned circumstances, it is imperative to anticipate objections and prepare ourselves mentally to handle these objections with ease. To do so, we have to

Pre-empt the possible objections, come up with possible answers, put the objections and their answers in a "FAQ" file and try to make our presentation almost " Objection Proof."

To deal with Objections efficiently, we must expect them, welcome them, agree with them, give com-
plete answers and remember to highlight benefits to our customers. If we simply cannot sell a product to a potential Customer, we should give up! Some people, no matter how good the product is, simply will not want to buy them. To understand and handle objectives with ease we must:

- Maintain a positive attitude and be enthusiastic.
- Not take objections as a personal affront.
- Listen actively to the unvoiced objections.
- Be prepared to prove our position with testimonials, references and documentation.
- Not degrade our Competitors.
- Not say anything negative about our Company.
- Not say anything negative about your product or service.
- Tell our Customer that he is wrong but politely.
- Not argue with our Customers.
- Not lie to our Customers.
- Not be too defensive.
- Not letting an objection goes unanswered.
- Not pass the buck on to our colleagues if we can handle it on our own.
- Not say anything negative about our colleagues.

Objections are questions that we must answer before the sale can be closed. Arguing, showing hostility, discourtesy or intimidation of prospects do not work. Every time an objection is successfully answered, the prospect's interest increases.

6.6 CLOSING THE SALE

The close is the process of helping people make a decision that will benefit them. The sales man helps them make that decision by asking them to buy. To attain this objective a question or action is designed to elicit a buying decision. We can make people buy things they do not need, but we cannot make people buy things they do not want. Asking questions is the only way to close a sale. We can evaluate our closing skills by asking ourselves these questions:

- Have I summarized the Benefits and customized them?
- Have I got my Prospect to agree that my product/service meets his/her needs?

Perspectives on Closing:

Closing should be natural and easy; it should be planned like the rest of the process. Closing is integrated throughout the presentation. It is not a separate event, each point of agreement is a minor Close, and it is the start of an ongoing Relationship with your Customer.
For Closing a Sale, the most important points are:

- Timing of the Close
- Closing techniques

Rules for Closing a Sale:

- Always look for Opportunities to Close.
- Remember, you need to ask Customers to buy more than once because of their fear of making a decision.
- The more Closes you know, the better you are prepared to face that moment of truth at the end of your Presentation.
- Instead of locking yourself into two or three closes, give yourself more options - more chances to make a Sale.
- The moment a Customer gets sold on a particular Benefit, try to close the Sale.
- If one Close does not work, try another.
- Remember ABC's of Closing - "Always be Closing"

Making a purchase is an emotional investment as much as it is a financial one. Potential Customers want to deal with someone they trust, someone who cares about them. So, the best Salespeople are not salespeople alone. They are involved and caring advisors. The Closing Curve explains the statistics of sale that can be conducted.

- 10% will never buy
- 10% will be easy
- 80% can be closed

6.7 SUMMARY OF THE TOPIC

In this unit we have highlighted selling skills as an important soft skill to be acquired by an individual to excel in the business process of an enterprise.

We have learnt the importance of understanding the psychology and behavioural traits of people to present an effective sales proposal. We learnt that we can make people buy something they may not need, but we cannot make them buy something they do not want.

We also learnt the importance of making an appointment and laid down various guidelines to be followed when making an appointment. Then we talked about making a positive first impression and how it goes about determining, how customers would perceive our products depending on how we present ourselves. We also talked about a few guidelines to be followed when approaching a customer for the first time.
We also discussed the importance of active listening while making a sales presentation and the importance of building rapport with customers. We learnt that it is important to listen patiently and respond positively to people before finally closing a sale, because it not only helps us to close the deal, but it also helps us do it easily. We learnt that ‘mirroring’ a customer's concerns, goes a long way in understanding as to how we should approach the person for a sale, as it makes him rely on us builds a connection between us and our customers. We also learnt to 'listen ahead' or to anticipate what is going to be said and to be well prepared with our response while acknowledging the customers views at the same time.

We also discussed how identifying the benefits of a product help us to make our sales presentation better by reaching out to the customer's emotions and making the products we try to more appealing to them. We learnt what leads are and how they are classified and also how we can identify buying signals by citing appropriate examples. We discussed how we could handle objections that we face while selling products smoothly and master the art of sales, by avoiding conflict. The unit talked about how and when conflicting situations arise. Lastly, we discussed the importance of closing a sale properly and how to do it by ascertaining the correct moment for closing a sale.

6.8 FURTHER READING

Tom Hopkins, 2003 "How to Master the Art of Selling".

David People, "Selling to the Top - Executive Selling Skills".


6.9 EXERCISE TO CHECK YOUR PROGRESS

**Activity 3**

The following has been designed for you to understand different questioning techniques and when they can be used. Make a list of at least two sales situations where you could use each of them.

**Open**: Where, when, who, how, why, which. Discuss why and how to phrase it as sometimes it can be seen as aggressive. Open questions are good for establishing needs and steering the conversation by allowing you to follow up on information the customer has given you. E.g. "When did you say, you informed us?"

**Closed Questions: (the ones we most use)**: These can ONLY be answered with a YES or a NO - Do, is, Can, Are, etc. These are particularly useful when confirming facts and drawing the conversation to a close.
**Leading Questions**: are used to "lead" the customer to agreement - particularly useful when you want to close a call and get agreements on next steps. Start with "Would you agree ……?" Do you agree….? So if I did …… would you be happy with that?

**Alternative Questions**: by offering a choice you are helping the customer make the decision and therefore feel more in control of the solution - both options are acceptable for you. We use this all the time in social situations. E.g. "Which would you prefer - to wash or dry?" "Do you want to got to a restaurant or eat in tonight?"

**TED Questions**: Really open up the conversation for the customer to elaborate but you could loose control quickly. They are particularly good after the introduction if you are not clear about what is going on. Tell me, Explain to me, Describe….E.g. "Explain to me what happened when you tried to use the microwave."

**Statement Question Technique**: This has been designed to help you take control of conversations. It involves making a statement in response to a customer's question and then following it up quickly with a question of your own. The technique means that we will be "driving" the conversation by controlling the dialogue.

****
UNIT 7: TIME MANAGEMENT

Structure

7.0 Objectives
7.1 Introduction
7.2 Time management
7.3 Identifying Time stealers
  7.3.1 Interruptions-telephone
  7.3.2 Interruptions-personal visitors and meetings
  7.3.3 Tasks you should have delegated
  7.3.4 Procrastination and Indecision
  7.3.5 Acting with incomplete information
  7.3.6 Dealing with team members
  7.3.7 Crisis management (Fire Fighting)
  7.3.8 Unclear communication
  7.3.9 Inadequate technical knowledge
  7.3.10 Unclear objectives and principles
  7.3.11 Lack of planning
  7.3.12 Stress and Fatigue
  7.3.13 Inability to say "No"
  7.3.14 Desk Management and Personal disorganisation
7.4 Management of Priorities
7.5 Increasing work effectiveness and productivity
7.6 Scheduling and Planning
7.7 Managing a balanced lifestyle
7.8 Feeling more in control of daily activities
7.9 Reducing stress with effective planning
7.10 Summary of the Topic
7.11 Further Reading
7.12 Exercise to check your progress
UNIT 7: TIME MANAGEMENT

7.0 OBJECTIVES

After going through this unit you will be able to:

- Understand the basic components of time management, and how these components influence an individual's psychological and emotional development.
- Identify time stealers which act as interruptions in the time management strategy.
- Study the activities relative to time management which, when done perfectly can minimize the wastage of time. This study will facilitate the learning of a proper plan that everyone needs to follow to avoid inconvenience while managing one's time in a work place.
- Learn management of priorities for increasing your work effectiveness and productivity.
- Understand how to manage a more balanced lifestyle and feel more in control of the daily activities.
- Eliminate stress, which results from lack of effective planning.

7.1 INTRODUCTION

Everyone gets 24 hours in a day, and 168 hours in a week. How we use or misuse this time depends on our ability to appreciate the value of time and manage our priorities well.

Time management is an effective tool that helps us not only to set long-term goals in life but also successfully sees us through them. Time management is the development of processes and tools that increase a business' time-efficiency. It teaches a number of techniques that aim to increase the effectiveness of a person in getting the things done that need to be done. It is the key to success in everything that we do. Time management is actually more about managing ourselves or how we make use of the time that is available to us. Hence time management is mostly about self-management.

7.2 TIME MANAGEMENT

Time Management is mainly defined as, "the ability to manage and control time. The use of planners, calendars, and the like are effective tools in managing time. Implementing a routine is a method of scheduling actions which enforce a regiment to fit with a person's flow of work and production activities".

A concrete personal goal setting system is the key to effective time management and life planning. When we set personal goals wisely, we get a heightened sense of achievement that sustains motivation, and ultimately keeps stress away. Going by the old adage, Time is money time must be explicitly managed. Just like money, we must manage our lives effectively, keeping our mission in mind and understand what is important as well as urgent. Thus, we can maintain a balance between what we do
each day and our ability to produce positive result in the future. Being successful does not make us manage our time well. Managing our time well makes us successful. Bad time management is equivalent to stress that can lead to a situation called “time famine” in your life. Therefore, managing time well becomes an important parameter to fulfill the dreams of our lives.

If you were to break up your day into daily activities from the time you wake up till the time you go to sleep, you will find that there are some regular tasks that you do daily, and some on an occasional basis. Ideally your tasks should be done within the allotted or estimated time, but you end up taking more time, either because you underestimated the time required to do the task or took up too many tasks without realizing your limitations or got your priorities wrong. Consequently, you end up drawing on your time bank of ‘leisure time’ or ‘family time’ to adjust your work schedule and meet work deadlines. As a result you are continuously stressed out. This slows you down and leads to burn out easily.

Activity 1

How does a homemaker manage the different tasks at home? Discuss and analyze what kind of planning and time-management is required to keep a home running smoothly.

7.3 IDENTIFYING TIME STEALERS

The first step is to detect what makes us waste our time. Surprisingly, most of us do not have an accurate picture of how we spend our time. We may think that we know how long we spend on each task, but these impressions may be inaccurate when we discover the actual time we spent on each task.

It is useful to carry out an objective review of how we currently spend our time by keeping a detail of what we do, when and for how long. This is an effective way to identify stealers, which present themselves to us in the form of various interruptions hampering our management of time.

7.3.1 Interruptions-telephone

We are faced with numerous interruptions throughout the working day. It is important to be able to understand precisely what an interruption represents as a demand on our time and learn to deal with interruptions in a clear and polite manner.

Interruptions during the working day not only take up our time, they also have a secondary impact in costing us valuable moments as we get back into what we were doing before the interruption. Interruptions need to be managed to reduce our exposure to interruptions. This will definitely result in an increase in our overall efficiency.
UNIT 7: TIME MANAGEMENT

Various strategies can help reduce the time lost to interruptions. We should always be aware of the type of interruption, who or what caused it and how much time it took up. Once we have a clear idea of what causes the interruptions we can begin to develop tactics to control them.

If the telephone is a major source of interruptions then try using your voicemail to screen calls or ask your associates or colleagues to handle queries when you are busy, on the understanding that you will reciprocate. This could also be used to inform callers of the time of your availability, enabling you to protect yourself from distractions at times you set aside for concentrated work. Whenever you plan a regime to get a difficult and time-consuming work done, aim to be generous with your time in a realistic manner, or you may end up succumbing to the wasted time caused by interruption from telephone calls. If the length of the calls is a problem you should try setting a limit to the amount of time you are prepared to spend on any phone call. Start by saying something like "Sorry, but I have only got five minutes . . ."

Here are some tips to save you from telephone interruptions while you are in the midst of an important and urgent task:

- Keep calls short; stand during call.
- Start by announcing goals for the call.
- Do not put your feet up.
- Have something in view that you are waiting to get to next.
- When done, get off with something like this, "I have someone waiting..."
- If necessary, hang up while you are talking, saying you have a visitor.
- Group outgoing calls: just before lunch & at the end of the day.

You must reduce frequency and length of interruptions. If you allot 6-9 minutes for each call it can give you a 4-5 minute recovery of time. Five interruptions at a stretch can hinder an hour's work. You should keep monitoring how well you have been able to manage your call interruptions.

7.3.2 Interruptions-personal visitors and meetings

People who are very sociable may distract others with inappropriate socializing. This can be disruptive and is complicated by the fact that sociable people tend to take criticism personally.

If you are interrupted at your workspace then using body language can make it clear that you expect the interruption to be as brief as possible. For example, by turning your head but not your whole body towards a visitor, your arm and shoulder will form a natural barrier, which will discourage a lengthy conversation. If you continue to hold your pen and occasionally glance at your watch, then this will have the same effect. You could also avoid asking unexpected visitors to sit down; get on your feet and remain standing until they have gone. Give an indication of how long you expect a meeting to last and
make it clear that you must get on with other tasks at this time. It is therefore necessary to prepare an agenda. While a meeting is on, an executive should allot not more than 40% of average time to it, which, amounts to maximum of 1 hour. No calls or visitors should be entertained during the meeting.

There are some other specific tactics that should help you to focus more effectively on concentrated periods of work:

**Closed Door**

Apart from those times when you want to encourage others to step into your office, try keeping your door closed. It will not stop anybody who has an important request but it will reduce the number of non-important or purely social interruptions.

**Signs**

Get three signs made, the first saying ‘Available’ the second ‘Busy’ and the third ‘Please Do Not Disturb’.

**Making Visits**

If you have colleagues who tend to be very talkative, then arrange to visit their workspace, rather than have them coming to you. This makes it much easier for you to end the meeting without facing the difficult task of getting them to leave.

**Schedule Meetings**

If talkative colleagues are coming to you for a meeting, schedule this ahead of another commitment or a fixed break, so that there is a compelling reason for getting on with the business at hand.

**Polite Terminators**

Add some polite winding up statements to your repertoire. Try to include references to work and time constraints. For example saying, "Sorry George, I have got to crack on, as this report has to be finished by lunch-time" is much better than saying "I have got work to do".

**Coming Out**

Let your colleagues know that you are trying to manage your time more effectively, and inform them of some of your chosen tactics. This will not stop all interruptions, but at least they are likely to understand why you are less responsive to them.

Whatever approach you adopt to dealing with interruptions, it is important to be consistent. If you frequently change your response to interruptions it will give others the impression that you can be persuaded to change your mind and this will undermine your attempts to gain control of your time.
7.3.3 Tasks you should have delegated

Delegation can help to create the time needed for vital managerial functions. Many managers find themselves getting bogged down in routine operational tasks, which leave them no time for the vital managerial functions like long term planning and business development. The essential time management technique of delegation involves giving someone else the responsibility to perform a task that is actually part of your own job. Delegation is not as straightforward as it might appear. It always carries with it an element of risk, since you are assigning to someone else work for which you retain the ultimate responsibility.

One of the most important reasons for delegation is that it develops the skills of the people who work for us. People in your team will become more involved in helping to achieve the organization's objectives and goals.

It is widely observed that managers who delegate successfully usually experience lower absenteeism and staff turnover. Delegation is not dumping of responsibilities. There is nothing called being independent in one's style of functioning. Every activity is in a state of inter-dependency. We can accomplish a lot more with help. Delegation requires responsibility to make yourself accountable for your actions.

To reduce the risk a manager should select the tasks to be delegated carefully and select the right people to do them. You should be very careful when delegating tasks or with the tasks which have been delegated to you. The person delegating the task has already reduced their direct control and may be very reluctant to reduce it further. In delegating, tasks that should be considered, first include-routine tasks where progress is measurable, tasks that can be planned clearly well in advance and tasks that one of your team members has expressed a genuine interest in taking on.

- Do not delegate only unpleasant tasks. In order to bring out the best in your subordinates you should offer them a mix of tasks.
- Conversely, do not keep all the unpleasant tasks for yourself. It is important not to hold back all the jobs that you personally dislike, considering it unfair to give these to others. Make sure that you set aside sufficient time to actually specify delegated tasks and go through them with the relevant members of staff.
- Ensure that tasks are not delegated at the last minute, each member of staff have their own responsibilities into which they must find the time for the delegated work. Work delegated at the last minute might not be done properly.
- Once you have identified someone that you think the task could be delegated to, you should establish whether or not their present workload would allow them to take it on. If so, you will need to specify the delegated task and agree the level of support that will be required.
There are two common reasons why people reject responsibility for a task they have been delegated. Firstly, they may feel that they have been given a task that should not be their responsibility. Secondly, they may believe that their manager is interfering in the details of the task, and not allowing them to use their initiative. Managers need to overcome both of these obstacles, by shelling out the benefit of doing the task and leaving for the team member enough room to take initiative regarding how the task is to be done.

### 7.3.4 Procrastination and Indecision

Most of the time certain reasons cause time to run out of our hands without getting our important tasks accomplished. This happens because we put off our important tasks for some other time without even thinking about the consequence of its delay. This tendency to put off tasks is called "procrastination". If you often see yourself in such low productivity situations, then there is a big chance that your life got under control of the procrastination habit and those situations are only the most explicit symptoms. What makes a big difference for your success is your ability to recognize procrastination reasons and expressions in their different forms, and to promptly take them under control, before this bad habit steals your opportunities, damages your career and pride, or destroys your relationships. The causes of procrastination are the greatest time stealers, doing an irreparable damage to our productive selves. An overview of these causes will help you to identify the time stealers.

#### Causes of procrastination

Procrastination can be caused by the following conditions:

- Waiting for the right mood
- Waiting for the right time

Having a look at the way you organize your work you may notice other reasons for procrastination like:

- Lack of clear goals.
- Underestimating the difficulty of the tasks.
- Underestimating the time required to complete the tasks.
- Unclear standards for the task outcomes.
- Feeling as if the tasks are imposed on you from outside.
- Tasks may be too ambiguous.
- Underdeveloped decision-making skills.
- Fear of failure or fear of success.
- Perfectionism.
Decision-making is an important aspect of time management. For example, when classifying activities on the basis of their importance or urgency, you will need to be decisive and not indecisive over each and every activity. If you want to improve on your ability to make decisions, you will need to identify the types of job you put off and the reasons and excuses you give yourself. Many people admit to putting off jobs because they find the job daunting or unpleasant and they hope that the job will somehow go away or they just do not know where to start. They may justify this procrastination by finding routine tasks to do instead. Alternatively, they may wait until the pressure is really on before starting to take appropriate action. Deadlines are really important, so we must set deadlines, and work smartly to meet it to save the last minute inconveniences.

7.3.5 Acting with incomplete information

The flow of work is disrupted when we act with incomplete information. Your ‘inflow’ represents the various ways in which people can communicate new information or requests to you. Typical inputs of information are email, phone calls, meetings, faxes, regular mail, and drop-in visitors.

Generally, information is derived from communications you receive through each of these inputs. They contain new work, but they can just as easily contain passive information (announcements, discussions) or be completely irrelevant (junk mail). The most effective way to handle these different communications depends on their content. Some need to be handled right away, others should be postponed or delegated, and yet others may be filed away, and the rest should be trashed.

Often, people at work do not have complete information for action because hundreds of e-mails piles up in their inbox, urgent notes accumulate all over their computer screens and a big pile of paper is stacked by the side of their desks! In the given circumstance, they use memory to keep track of it all. Consequently, it becomes hard for them to remember what they need to work on next, let alone figure out the best way to use time. The main reason for inadequate flow of information is the lack of a systematic way of handling, capturing, and processing the different inputs and projects. As long as we keep a track of the significant details using our memory, we will still feel the nagging inadequacy of not getting the full details of a particular task. We will most likely forget something important and find it difficult to plan our next step. Using a time management system can help us remember the low-level details of work when we actually need them.

7.3.6 Dealing with team members

Many managers have found ways to improve their own time management skills and have refined their working habits so they function more effectively. They have sharpened their skills, techniques and disciplines solely to focus on what counts most. They have learned to cope with interruptions, changing conditions, and the demands placed on them by others. But even more important, some of these managers
have shared the techniques with others, particularly the people reporting to them. Guiding actively the members of our team, in group meetings and one-on-one counseling sessions produces mutual understanding of the best methods for effective time use and will lead to improved productivity, minimal frustration, and increased job satisfaction for all. It can become possible by implementing three measures:

- First is a realization that some actions may not be productive.
- Then an inventory of time wasting habits to be done away completely and ways to overcome them is identified.
- Finally, these new time-effective behaviors are to be shared with the entire organization.

Making each person aware of his or her own time use and providing the skills and techniques for effective time management can help resolve complicated time related issues. Another way to deal with team members is to bring about uniformity in their way of sharing time management techniques with each other. The effort must be taken within the entire organization and among groups of people from all levels of management to work together on time problems. Identifying objectives, priorities, and the best means to reach them often brings wonderful results, and the differences in perceptions must be recognized, faced, and resolved. Mutual exploration of time-wasting activities, their impact on others, and agreement on their reduction keeps a team together and on time.

7.3.7 Crisis management (Fire Fighting)

Management by crisis is a phrase used to describe the common problem of allowing unexpected events, interruptions, problems, or emergencies to dictate your priorities and actions.

Effective crisis management is an important best practice. It is an essential skill of effective time managers because unexpected things do happen. Sometimes we do need to react quickly to a crisis and contain it before it does more damage. The problem comes when crisis management becomes the routine rather than the exception. If we spend more time putting out fires than working, we are managing by crisis.

When crisis management becomes the routine, it can easily lead to what Stephen Covey refers to as "Urgency Addiction." People that are addicted to urgency enjoy putting out fires. They like stepping in and solving problems, and their bosses often reward them for doing so. They have no incentive to avoid or prevent the fires because they get a payoff every time they put one out.

To eliminate the worst practice of management by crisis, we need to take two important steps.

Firstly, we must distinguish between a real crisis, which is something important that requires immediate attention, and other lesser problems, events or interruptions that do not qualify as a true crisis.
UNIT 7: TIME MANAGEMENT

The Second key step is to realize that when crisis management becomes a routine rather than an exception, it is usually pointing to a more fundamental problem that needs to be solved. There is an old Chinese proverb that says: "The superior doctor prevents sickness. The mediocre doctor attends to impending sickness. The inferior doctor treats sickness." We must not just treat the symptoms of the latest crisis, but cure the underlying disease and prevent it from recurring.

7.3.8 Unclear communication

You often fail to do what you want to do for one single reason and that is when your objectives are not clearly defined. Your long term goals should impact on your daily activities and be included on your "to do" list. **Without a clear-cut goal or objectives, people tend to just drift personally and professionally.** It is generally hard to believe that there are managers who neglect this participatory approach and they tend to be their own worst enemies. They make the incorrect assumption that their time-effective work habits will be clear to all and over time will be adopted by the supervisors reporting to them, the group as a whole, and other people and groups in the organization. But the reality is that such an occurrence is not automatic. Further, these managers' behavior may be misconstrued and may be seen as curt or abrasive. The resultant resentment may adversely affect work routine and productivity.

It is often difficult for a manager to recognize the impact that his or her actions have on others. Managers usually function with positive and constructive intent. But methodology of communicating the intent may not be appropriate, if one or the other is inappropriate, a manager's actions can be perceived as a real obstacle to achievement. Where the manager functions in a counterproductive manner with subordinate management, the subordinate managers not may be diverted from what is important may also misdirect their own subordinates.

7.3.9 Inadequate technical knowledge

Most of the tasks we perform today are supported by technology. We are aided by cutting-edge technology in getting prompt results of our work. It is difficult for a professional to manage his time effectively if he does not know how to operate the technical gadgets he uses to get his work done faster and better. Inadequate technical knowledge may lead him to waste his valuable time in relearning all the essential techniques necessary for the smooth functioning of his work. Inadequate technical knowledge therefore mars effectiveness of a person as well as his efficiency.

7.3.10 Unclear objectives and principles

Objectives and principles should be clear, as these identify exactly what needs to be done and in what time frame. Principles are the guidelines we follow to achieve our target. These guidelines help to set a clear achievement target, which can be measured and assessed. Our objectives should focus on what
it is we actually plan to do and should not leave any room for vague abstractions. The definition of clear objectives is a key time management skill. We should always assess the effectiveness of our planning by reviewing the results achieved against the desired objectives.

7.3.11 Lack of planning

An essential time management skill is the ability to recognize the need to plan periods of time when we can concentrate on the main demands of our job. People frequently refer to the sheer volume of interruptions that they suffer when trying to justify their lack of achievement. With an interruption occurring, on average, every 7 minutes, managers have to do their work between distractions. Whilst each interruption may not seem to take up much time, they can typically account for 25% of a working day and make it very difficult to address tasks that require concentrated effort.

The effect of allowing interruptions to continually distract you is likely to undermine your efforts to plan your working day. One solution is to batch up the interruptions that you cannot avoid and to set aside time slots during your working day when you can break off and address them. For example, you could set aside 20 minutes before lunch and half an hour before the end of each working day to address all the interruptions that have occurred in each half of the day.

7.3.12 Stress and Fatigue

A particularly unpleasant source of stress comes from what is called "Hurry Sickness". Here you can get into a vicious circle of stress, which causes you to hurry jobs and do them badly. This under-performance causes feelings of frustration and failure, which causes more stress, which causes more hurry and less success, and so on. Stress-creating behaviour can compound this, as can an inability to relax at home or on holiday. If you do not manage long-term stress effectively, it can lead to long-term fatigue, failure and one of the forms of physical or mental ill health.

We can eliminate this sort of overload by effective use of time management, particularly by learning how to prioritise effectively. We can neutralise the associated stress by effective use of stress management techniques.

7.3.13 Inability to say "No"

Saying 'yes' to requests for your time is not always a bad practice. In fact, the better you are at managing your time and your projects, the more likely it is that you will be chosen to handle important tasks that need to be completed quickly with quality and care.

Taking on and completing important projects can be very rewarding and can lead to promotions and bonuses. The problem occurs when you say 'yes' to almost any request no matter what it is, who is
asking, or how much work you already have on your plate.

Always saying 'yes' is a major source of overload and stress, and it can lead you away from your priorities into less important tasks. If you want to avoid the work and stress associated with attempting too much, you need to decide carefully whether to accept new tasks or not.

The most common reasons for saying "yes" are a desire to please, fear of rejection, and guilt. You may be saying "yes" because of a payoff you are receiving or because of not wanting to confront the one who makes the request.

Mahatma Gandhi once said, "A 'No' uttered from deepest conviction is better and greater than a 'Yes' merely uttered to please, or what is worse, to avoid trouble."

### 7.3.14 Desk Management and personal disorganisation

For managing a task well and completing it on schedule, it is important that we clear our desk everyday before we start work. When too many junk documents keep piling up on our desks along with the important ones, we tend to develop a condition known as "desk stress". A desk should be clutter free and spacious enough to give you a stress free feel. A tidy desk is not the sign of someone with nothing to do, nor is a messy desk the mark of a busy manager.

A tidy desk is different for everyone. Some people need a clean desktop, with such basic tools as pens, stapler and tape dispenser out of sight in a drawer. Others are comfortable with tidy piles of paper and knickknacks.

**Activity 2:**

Use the space below to write your answer. Arrange the list of time stealers in the order of frequency of occurrence (very high to low) in your typical day.

1. Acting with incomplete information
2. Crisis management (Fire Fighting)
3. Desk Management and Personal disorganisation
4. Inability to say "No"
5. Inadequate technical knowledge
6. Interruptions-personal visitors
7. Interruptions-telephone
8. Lack of planning
9. Procrastination and indecision
10. Stress and Fatigue
11. Unclear communication
12. Unclear objectives and principles
13. Personal commitments

7.4 MANAGEMENT OF PRIORITIES

Management of priorities is the essential skill you need when you want to make the very best use of your own efforts and those of your team. It is particularly important when time is limited and demands are seemingly unlimited. It helps you to allocate your time where it is most-needed, freeing you and your team from less important tasks that can be attended to later.

With careful management of prioritized tasks you can bring order to chaos, massively reduce stress, and move towards a successful conclusion. Without it, you will flounder around, failing to rise up to the existing demands. You can prioritize your tasks based on the time constraints, or on the potential profitability or benefit of the task you are facing, or on the pressure you are under to complete a job.

- Prioritization based on project value or profitability is probably the most commonly used and rational basis for prioritization. Whether this is based on a subjective guess at value or a sophisticated financial evaluation. It often gives the most efficient results.

- Time constraints are important where other people are depending on you to complete a task, and particularly where the task is crucial for the completion of an important project. Here, a small amount of your own effort can go a very long way. And it is normally impossible for a person to resist his or her boss's pressure to complete a task, when that pressure is reasonable and legitimate.
Activity 3:

How equipped are you to prioritise your tasks? Can you decide or does someone else decide for you what your priorities are? Think of the current tasks that you do as part of your responsibility. During a typical errand day, how many of them are urgent/ can wait; planned/ unplanned; or routine activities/ fire fighting?

7.5 INCREASING WORK EFFECTIVENESS AND PRODUCTIVITY

The idea that work effectiveness is related to organizational productivity is based on years of research and practice. Work effectiveness comes from organizing people to work systematically for achieving a goal. When building a successful career or a business of our own, our time is perhaps our most valuable asset. We can apply these three practical ideas to increase our effectiveness without working any harder than you do now to increase your productivity:

Keep a detailed Time Log:

The first step to better managing your time is to find out how you are currently spending your time. Keeping a time log is a very effective way to do this, and after trying it for just one day, you will immediately gain tremendous insight into where your time is actually going. The very act of measuring is often enough to raise your unconscious habits into your consciousness, where you then have a chance to scrutinize and change them.

Cut back on total hours to force an increase in efficiency:

If you have ever tried to discipline yourself to do something you were not really motivated to do, you are most likely to fail. If your time log shows your efficiency ratio to be on the low side, try severely limiting your total amount of working time for a day, and see what happens. Once your brain realizes that working time is scarce, you suddenly become a lot more efficient because you have to. When you have tight time constraints, you will usually find a way to get your work done. But when you have all the time in the world, it’s too easy to be inefficient.

Gradually increase total working hours while maintaining peak efficiency:

Time logging is the intelligent choice to ensure optimal productivity without increasing your hours. Time logging needs to be done only periodically. When you feel your productivity is lower than you would like
it to be, raise your awareness via time logging, measure your efficiency ratio, and then optimize your efficiency to boost your productivity back up where it belongs. Time logging is a high leverage activity that takes very little time and effort to implement, but the long-term payoff is tremendous.

**7.6 SCHEDULING AND PLANNING:**

It is important to know how to schedule and plan. Plans can be long term and short term. Long term plans are related to the long-term goals of your organisation and your long-term career plans. Short-term plans have more to do with what you will be doing in the next one or two months and in the next week. Once you have clear long-term goals, you can break them down into short-term goals and the tasks that you need to do consequently attain priority as required.

It is impossible to plan down to a minute, so schedule work in blocks of time. Try to schedule similar tasks together. Schedule important tasks for peak times (you should know at what time of the day you are most alert). Be smart when making appointments. Make sure you know how much time the meeting will take, how long it will take to get there and any unforeseen activities you might have to take up. For any task, do not underestimate or overestimate the time it will take. This ability comes from experience, but you can also ask your colleagues for advice. Tackle important work, not the urgent and always try to resist unscheduled activities.

A daily planner helps in managing your time well as you can consult it any time and schedule your day accordingly. When you make a daily planner always start with the pre-scheduled activities. Then add the regular/scheduled activities or practices. Remember to keep about 10 minutes before (starting your computer, settling down) and 10 minutes at the end of the day (wrapping up). Always keep time in your daily plan for breaks (lunch, 5 minute coffee break). That way you do not over commit or take up more than you can handle. At the same time expect diversions and change. Sticking to a rigid plan will make it difficult for you to work in collaboration with your colleagues. Sometimes circumstances beyond your control (a colleague calls in sick, a customer wants your immediate attention, technical breakdowns, unexpected events in the family, project requirements change) may require you to adjust your schedule accordingly. Retain the flexibility to handle such exigencies smoothly but ensure your office knows about the change in plan.

Always monitor your daily routine. Review daily time spent on each activity and try to analyse the share of productive time, supportive time and unproductive time. Ideally you should spend at least 60% on productive activities, 30% on supportive activities and 10% on unproductive activities.

A rescheduled time-planner can make an extremely hectic life more flexible and easy. All you need to do is manage your personal time by a systematic and organized approach to life. Simply maintaining a personal logbook alone will not come to your rescue in managing your life and your time. As it is said,
"Old habits die hard", you have to gradually wean away your old time-consuming habits and slowly adapt yourself to new effective time saving methods. The best way to cope with these changing situations in your life is to discipline yourself for a more positive outcome.

7.7 MANAGING A BALANCED LIFESTYLE

When life is busy, or all our energy is focused on a special project, it is easy to find ourselves "off balance", and find that we are not paying enough attention to other important areas of our life. While we need to have the drive and focus to get things done, taking this too far can lead to frustration and intense stress.

Here we can take the illustrations from Wheel of Life or Life Wheel to help ourselves. Commonly used by professionals, it helps you to consider each area of your life in turn and assess what is off balance. So that it helps you to identify the areas that need more attention.

Figure 1 below shows an example of wheel of life with "dimensions" below. (We will explain how to choose the right areas of life or dimensions for you.)

The Wheel of Life is powerful because it gives you a vivid visual representation of the way your life is currently, compared with the way you would ideally like it to be. It is called the "Wheel of Life" because each area of your life is mapped on a circle, like the spoke of a wheel.

The incredibly powerful way of balancing your life is to move on with ease. Unnecessary worries that you carry within and the desperation to get everything done the way you plan can demoralize you to the point of depression. Working in a relaxed mood can increase your adaptability with life situations. Take
UNIT 7: TIME MANAGEMENT

a realistic view of your past failures and never lower your self-esteem or dampen your spirit because of them. Instead, connect with the people outside your personal territory to relate with the big, wide world. You are definitely in it for wonderful opportunities and unexpected surprises. Letting go off your worries, troubles and misfortunes can restore the balance of your life.

Source: Mind Tools.

7.8 FEELING MORE IN CONTROL OF DAILY ACTIVITIES

It is essentially stress and boredom that deprive us from exerting a control or choice over our daily lives. We see that daily lives are structured by the dominant culture and the high standards society lays down for each one of us to follow as a benchmark for success. The relationship between stress and free time activities is clearly determined by the feeling of having too many things to do and not enough time to do them all. Such a situation clearly reduces opportunities for leisure.

The feeling of being "rushed" or "busy" may be due to high time demands on a day to day basis, or it may be due to a response to high, but intermittent and occasional time demands, or it may be associated with a lack of control over the daily activities of life. Given that, time stress and work stress seem to be increasing in adult society. Stress-related diseases are also on the increase. For professionals, time stress may be due to demands associated with projects and other time bound activities, as well as with the demands of paid work and expectations from peer groups and senior bosses about making contributions to the organisation's productivity.

To bring about a feeling of control over the daily activities of life, participation in recreational and homebased activities will give a positive feeling of well being and healthy. These constant demands of time on a professional's life should be managed and balanced properly to bring about a control over their daily lives and the activities they do.

7.9 REDUCING STRESS WITH EFFECTIVE PLANNING

We have all felt stressed out at one time or another. Stress has been implicated as a possible cause of numerous conditions, including work overload, disease, eating problems, sleep disturbances, and emotional trauma etc. Apart from these, another critical situation of life leads to stress, i.e. lack of effective planning. Learning to reduce your stress levels can help you live happier, healthier, and maybe even longer. Some useful tips to reduce stress are given below:

Be realistic

Do not take on everything and learn to say no. Set realistic goals for yourself. If you feel overwhelmed,
try eliminating an activity which is not absolutely necessary. Ask yourself, "What really needs to be done? Is the deadline realistic?" No one is perfect, so do not expect perfection from yourself or others. And ask for help if you need it.

Meditate

It only takes about 10-20 minutes to meditate but the benefits are immense. These few moments of quiet reflection may bring relief from stress as well as increase your tolerance to it. And it is simple to do. You can sit quietly, listen to peaceful music, relax, and try and think of pleasant things or think of nothing.

Visualize

Take a moment to picture how you can manage a stressful situation more calmly and successfully. This can work with just about anything, whether it is an important presentation at work or moving to a new place or taking an exam. A visual rehearsal can boost self-confidence and help you have a more positive attitude toward a difficult task.

Take one thing at a time

When you start to feel overwhelmed, try taking one task at a time. Make a list of things you need to do. Put the most urgent task at the top. Once you have accomplished it, cross it off and move on to the next one. The positive feeling of crossing things off can help in keeping you motivated.

Exercise

Regular exercise is a great way to reduce stress, and it benefits the body as well as the mind. Just 20-30 minutes of physical activity a day can do the trick.

Get involved in hobbies

Take a break from the stressors of life and do something you really enjoy. Try gardening, painting, or reading. Set aside time to pursue these activities.

Practice a healthful lifestyle

Eating healthfully will make a difference. Avoiding things like smoking, drinking alcohol, and caffeine. Make sure you get adequate rest and exercise, and that you balance work and play.

Share your feelings

Talking about things can help you feel better. A conversation with someone can help you relax. And
listening to someone else can take the focus off yourself, something we all need to do every now and then. Stay in touch with your family and friends and try not to cope alone.

**Give in occasionally**

You do not always have to be right. Be flexible. Be willing to compromise. If you do, others may meet you halfway. If you know you are right, stand your ground. But be calm and rational. And listen and make allowances for other peoples' opinions.

**Go easy with criticism**

When you expect too much from yourself or others, you may end up feeling frustrated, let down, and disappointed. Remember that each person is unique and everyone, including you, has shortcomings. But each person also has many beautiful qualities to share with the world.

### 7.10 SUMMARY OF THE TOPIC

This unit explores the implications of managing time in professional as well as personal fronts. The time stealers, which often show up in the form of interruptions are identified and discussed at length. Necessary tips and techniques are suggested during the course of discussion to manage your time effectively.

In the management of priorities, the issue of priority is based upon time constraints we face while managing an important task. We have learned from this topic that without managing our priorities we are sure to falter in shouldering our responsibilities and likely to fail in reaching our goals.

Time management trains us in another important area of life, i.e. increasing our work effectiveness and productivity. When our effectiveness increases we can contribute immense productivity. A single contributor in turn can add to the collective productivity of an organization and can be counted as a successful individual in the society.

A balance in life is attained when we can do successfully whatever we want to do.

An important facet of time management is experiencing a feeling of control over daily activities of life. There cannot be any scope for relaxation in the midst of stress that springs from the pressure to handle daily a time bound schedule. Therefore, it is necessary to manage stress to have a control over daily activities of life.

The last section advocates some important tips to reduce stress that results from a lack of effective planning in life.
UNIT 7: TIME MANAGEMENT

7.11 FURTHER READING


7.12 EXERCISE TO CHECK YOUR PROGRESS

Activity 4 Make a list of 10 things that you could do to manage your time better at work. Your answer could range from anything like getting up earlier than usual or sharing your work with your peers, without hampering their productivity. At the end of it, get into groups of ten and discuss the pros and cons of each activity and lay down a common resolution before the class. Also come up with at least five unexpected situations that may arise and how you would go about handling them without compromising your work. You can cite examples from your daily life, and explain to the class what your 'time-stealers' are and how you are going to deal with them in future, taking into account, what you have learned.
UNIT 8: STRESS MANAGEMENT

Structure
8.0 Objectives
8.1 Introduction
8.2 Stress Management
  8.2.1 What is pressure and what is stress
  8.2.2 The three stages of burnout
  8.2.3 Recognizing your own stressors
  8.2.4 Personality types and reactions to stress
  8.2.5 How your beliefs and perceptions cause stress
8.3 Managing Yourself
  8.3.1 Does your job cause stress?
  8.3.2 Five ways to battle job stress
  8.3.3 Developing a strategy for stress management
  8.3.4 Self-management
  8.3.5 Managing Change
  8.3.6 Relaxation techniques
  8.3.7 Assertiveness skills
8.4 Planning your next steps
8.5 Summary of the topic
8.6 Further Reading
8.7 Exercise to check your progress

8.0 OBJECTIVES

Among the behavioral problems people face in at work, stress related problems are severe and requires immediate attention. In this unit, the basic problems of stress will be discussed, keeping in mind the regular demands of a professional life. After going through this unit, you will be able to:

- Know the causes of stress and learn how to tackle these causes to prevent stress related disorders
- Develop a strategy that will not only manage stress but also make you aware of the techniques that can curb stress
UNIT 8: STRESS MANAGEMENT

- Bring a positive change in yourself following the tips of self-management, relaxation techniques and assertiveness skills
- Plan your next steps as a gateway to a better life.

8.1 INTRODUCTION

Stress is the biggest single problem of the 21st century. This is one major reason why so many people get sick or die prematurely, not being able to handle the demands of modern life. Every health problem, from headaches to heart attack, from psychosomatic disorders to stroke can be linked to this great malady. There is no defined age at which one is at risk of suffering from stress. Anyone can be stressed at any time if they are not adequately equipped to balance work and home. Many psychologists say that in our frenzy to get into the rat race of becoming successful men and women we often neglect the vital issues of health and we become prone to stress. So, if we cannot get a grip on stress we will have to pay the price physically, mentally and spiritually. At the same time, studies show that even if one has a very demanding job, stress can be avoided. Psychologists and doctors point out that having unrealistic expectations of oneself and striving to live up to that expectation leads to the constant feeling of stress and causes health problems.

Stress is dangerous because many treat the symptoms of stress (headaches or insomnia) without realizing what triggers it. Poor health results in missing important deadlines and assignments and this has a negative impact on their professional growth. When peace of mind and productivity suffers their professional and personal life gets affected. This makes them worry more and become tenser as they constantly feel the pressure of having to live up to what the organisation and their family expect of them. To add to this they have their own expectations to fulfill. Consequently when they feel better they slip into the old stressful routine and the ailments reappear. Medication helps, but only temporarily and their health and mental well-being deteriorate. The vicious cycle continues. If we learn to manage our expectations, both what we expect from ourselves and what others expect of us, we will be able to lead a stress-free life.

8.2 STRESS MANAGEMENT

Stress management is a holistic approach that integrates body, mind and spirit using techniques and strategies. This unit includes many techniques to combat and reverse stress. This will be your first step to take on the issue of stress head on and apply the techniques you learn in your day-to-day life. Before learning how to manage stress, it is important for you to know what stress is and what causes stress.

Many researchers have been conducting experiments on stress and stress-related factors.
Many of their findings are acceptable while others are debatable. This topic will address the important issues related to stress and also will help us to understand the basic principles of stress as ascertained by current psychological research.

We start by defining stress and then we look at the underlying mechanism that causes it. Next, we look at the nature of stress and consider the relationships between stress and health, and between stress and work performance. We see how stress can have very negative effects on short and long-term health, performance and career success, as well as on our personal happiness. This emphasizes the importance of good stress management. Finally, we look at the three types of approach to managing stress:

- action oriented (reducing stress by taking action).
- perception oriented (dealing with attitudes and emotional responses to stress).
- survival oriented (living and coping with stresses that cannot be otherwise resolved).

The concepts introduced here will help you to manage stress constructively.

**Activity 1**

Have you ever been in a stressful situation? Please recall a stressful situation when you have an argument with a family member/ friend. What according to you caused the stress? Was it avoidable? What happens to you when you are in stress?

(a) Do you lose sleep ?
(b) Do you become quiet/ raised your voice ?
(c) Do you lose your appetite ?
(d) Do your limbs shake or face becomes red ?

**8.2.1 What is pressure and what is stress**

Pressures of life originate from the demands of everyday life. The pressures of career and all the activities of daily life generally demand a great deal of energy and focus on your part to deport you to higher level of consciousness. You feel torn between your duty in the world and the yearning of your heart, a yearning so important and deep that life seems entirely empty and worthless without that fulfillment. Further, you assume at times you are not progressing. Based on your limited judgment, not knowing much about the situation at all, you can somehow assume you are qualified to gauge your experience as being successful or unsuccessful. Not yet being very subtle or very aware, you usually make false assumptions and fall prey to the pressures of life.
Not only do the regular pressures of life seem agonizing at times but also there are so many unforeseen variables. For example, you strive to lead a balanced, goal-centered life but suddenly something goes wrong and you have to work harder to compensate your loss. Constant problems can be antagonizing unless you understand your perspective from the viewpoint that life's problems and challenges need to be handled in a creative and forthright manner.

We can define stress as a normal physiological response of the body to situations or stimulus, which are perceived as 'dangerous' to the body. When it occurs frequently it affects health, both physical and mental. One major problem of defining stress is, it has so many things included in it that it often becomes hard to evolve a single definition for stress. In finding a suitable definition for stress different perspectives and circumstances are taken into account. It is a family of related experience of events and circumstances. Different people therefore, identify with different definitions.

Hans Selye, one of the founding fathers of Stress Research, says that to a linguist or a lawyer words have very precise and fixed meanings. But to others, belonging to other fields, ideas and definitions are continually evolving due to research and knowledge expansion.

Selye's view in 1956 was that "stress is not necessarily something bad - it all depends on how you take it. The stress of exhilarating, creative successful work is beneficial, while that of failure, humiliation or infection is detrimental." Selye believed that the biochemical effects of stress would be experienced irrespective of whether the situation was positive or negative.

Since then, ideas have moved on. In particular, the harmful biochemical and long-term effects of stress have rarely been observed in positive situations. So the question of how we can define stress in the given circumstances arises. A common consensus on the definition is, "Stress is a condition or feeling experienced when a person perceives that demands exceed the personal and social resources the individual is able to mobilize." (Researcher, Richard S Lazarus)

8.2.2 The three stages of burnout

Burnout is not something that happens overnight. It is a gradual process of affecting your physical health by developing undetected symptoms and signs of stress. Burnout is a constant feeling of cynicism, pessimism and hopelessness. Many people grow self-doubts in the face of these debilitating tendencies. They feel they no longer can contribute to their work, which results in low productivity, lesser mobilization of their energy and a dwindling commitment to work. Research shows that there are three stages of burnout that completely demoralizes a person and makes him susceptible to failures. The three stages defined here are based on the book Get a Grip! Overcoming Stress and Thriving in the Workplace by BobLosyk.
Stage one: Turned on

This stage occurs when a person takes up a new job, a new position, or become involved in a new project. The person in his new role displays a high level of enthusiasm, abundant energy and a deep involvement. He tends to get carried away in his endeavour thinking the job is "be all, end all" of his life. Some people may cope well with these changes by handling well the demands and pressures the job brings with it. But one who cannot adapt well with these changes becomes prone to stress and exhibits fatigue syndrome as he starts burning up too much energy in his process of adaptation.

Stage two: Turned off

In this stage the burn up that began in stage one slowly sneaks on the person's life without his awareness. He often overlooks this condition, as it does not show immediately any obvious signs of his deterioration. He gradually discovers his job to be not what he expected it to be, breeding disillusionment in his mind. His earlier enthusiasm is replaced by chronic fatigue now. He starts to withdraw from others and avoids work. He begins to doubt his own ability of getting the job done. Sadness, cynicism and confusion overwhelm him.

Stage three: Wiped out

This is a stage of rude awakening, which leads him to think that he is in deep trouble. The fatigue turns into exhaustion, sadness and confusion into depression. He faces problems in eating and sleeping. Negative thinking further lowers his resistance to illness and makes him prone to illnesses. Emotionally and physically he feels worn out, loses his focus and interest in the job. Physical symptoms start appearing at this stage exposing him to blood pressure and heart problems.

People feel burnout when they do not enjoy the advantages of a job in a workplace. Too much work pressure and strained relations with one’s colleagues and bosses aggravate burnout problems. The type of organization and position plus salary and benefits all play a major role in cutting down the factors of stress in an organization. Therefore, emotional and physical well being of a person is necessary to prevent burnout problems in work place. Last but not the least, every individual must try to relieve stress, recharge one’s body, mind and spirit everyday to cope with pressure and stress.

8.2.3 Recognizing your own stressors

While a certain level of stress is necessary to avoid boredom, high levels of stress over a sustained period can damage your health. The sections below show common symptoms of stress, and the negative effects that excessive stress can cause. While the symptoms in isolation may or may not show stress,
where several occur it is likely that stress is having an effect. Note that as the stress you are under increases, your ability to recognise it will often decrease.

The symptoms are organised into the following sections:

- Short term physical symptoms
- Short term performance effects
- Long term physical symptoms
- Internal symptoms
- Behavioral symptoms

**Short Term Physical Symptoms**

The following mainly occur as your body adapts to perceived physical threat, and are caused by release of adrenaline. Although you may perceive these as unpleasant and negative, they are signs that prepare your body for the explosive action that assists survival or high performance:

- Faster heart beat
- Increased sweating
- Cool skin
- Cold hands and feet
- Feelings of nausea, or 'Butterflies in stomach'
- Rapid Breathing
- Tense Muscles
- Dry Mouth
- A desire to urinate
- Diarrhoea

These are the symptoms of survival stress.

**Short Term Performance Effects:**

- While adrenaline helps you survive in a 'fight-or-flight' situation, it does have negative effects in situations where this is not the case.
- It interferes with clear judgement and makes it difficult to take the time to make good decisions.
- It can seriously reduce your enjoyment of work.
- Where you need good physical skills it gets in the way of fine motor control.
• It causes difficult situations to be seen as a threat, not a challenge.
• It damages the positive frame of mind you need for high quality work by:
  1. promoting negative thinking,
  2. damaging self-confidence,
  3. narrowing attention,
  4. disrupting focus and concentration and
  5. making it difficult to cope with distractions
  6. consuming mental energy by distraction, anxiety, frustration and temper.

**Long Term Physical Symptoms:**

These occur where your body has been exposed to adrenaline over a long period. One of the ways adrenaline prepares you for action is by diverting resources to the muscles from the areas of the body, which carry out body maintenance. This means that if you are exposed to adrenaline for a sustained period, then your health may start to deteriorate. This may show up in the following ways:

- change in appetite
- frequent colds
- asthma
- back pain
- digestive problems
- headaches
- skin eruptions
- aches and pains
- feelings of intense and long-term tiredness

**Internal Symptoms of Long Term Stress:**

When you are under stress or have been tired for a long period of time you may find that you are not able to think clearly and rationally about problems. This can lead to the following internal emotional 'upsets':

- Worry or anxiety.
- Confusion and an inability to concentrate or make decisions
- Feeling ill.
  Feeling out of control or overwhelmed by events
- Mood changes
- Depression
UNIT 8: STRESS MANAGEMENT

- Frustration
- Hostility
- Helplessness
- Impatience and irritability
- Restlessness
- Being more lethargic
- Difficulty sleeping
- Drinking more alcohol and smoking more
- Changing eating habits
- Relying more on medication

Behavioural Symptoms of Long Term Stress:

When you or other people are under pressure, this can show as:

- Talking too fast or too loud
- Yawning
- Fiddling and twitching, nail biting, grinding teeth, drumming fingers, pacing, etc.
- Being irritable
- Defensiveness
- Being critical
- Aggression
- Irrationality
- Overreaction and reacting emotionally
- Reduced personal effectiveness
- Being unreasonably negative
- Making less realistic judgements
- Being unable to concentrate and having difficulty making decisions
- Being more forgetful
- Making more mistakes
- Being more accident prone
- Changing work habits
- Increased absenteeism
- Neglect of personal appearance

These symptoms of stress should not be taken in isolation as there could be other factors causing them. However if you find yourself exhibiting or recognising a number of them, then it would be worth investigating stress management techniques.
Stress is linked to the six leading causes of death: heart disease, cancer, lung ailments, accidents, cirrhosis of the liver, and suicide.

### 8.2.4 Personality types and reactions to stress

Scientists have identified a series of different factors that can influence an individual's vulnerability to stress. While age and sex can seemingly make you vulnerable to stress, the major deciding factor is your personality type. Psychologists have learnt that people respond to stressful situations in different ways. Everyone has different stress 'thresholds'. Someone with a low stress threshold can become highly stressed by simple events, such as being late for a meeting or forgetting their keys. But it would take something much more threatening, like failing an exam or moving house, to initiate the stress response in a person with a high stress threshold.

Psychologists talk about two personality types when it comes to stress.

**Type A and B.**

People with Type-A personalities are more likely to rush, be competitive and be perfectionists. They often attempt to do two or more things at once and feel guilty when they take time out to relax or do nothing, even if it is just for a couple of hours.

Type-B personalities, on the other hand, are people who can be described as 'laid back'. They are easy going, able to work at a reasonable pace and can 'relax without guilt'. Not surprisingly, Type A people are much more prone to stress than Type B people. Any event that disrupts their normal routine or gets in the way of their plans can upset a Type A person, while a Type B person is much more able to take the world in their stride. They tend to be more adaptive in their thinking and are better at putting things in perspective, thinking through how they are going to deal with a situation rather than just stressing over it as a Type A person would.

### 8.2.5 How your beliefs and perceptions cause stress

Anxiety and fears may result from how we perceive and react to situations. Our adherence to faulty beliefs and perceptions cause us to react severely to different life situations. We may or may not take kindly to bad situations we face in life. The faulty perceptions occur when our unrealistic expectations, subdued fears, or wishes change our way of seeing other people and ourselves. We have a definite "set notion" of viewing an event, which causes us to see the situation in a certain way--we give it our own
slant. For example, a person who wants to please others so much will not see the other person’s
disinterest in him. A person with a pessimistic outlook will consider every event to be the beginning of a
catastrophe. Many of these faulty perceptions, called "maladaptive schemas" by Young (1989), arise
from emotions or needs and obviously cause stress.

Every irrational idea, stems from beliefs like things must go the way I want them to, and if they do not, I
have a right to get terribly upset. This demand for love, success, self-importance is certainly going to
produce stress, especially when the demands are not met. These demands surely arise from a long
history and a complex variety of emotions, thoughts, needs, fears, and hopes. These cognitive-emotional
demands that life unfold differently produce, in turn, many new and disturbing emotions. After perception,
we appraise the situation and decide how well we can handle it.

A situation that is identified as a stressor, such as having to give a speech, is perceived and responded to
very differently by different people. A person would want to get out of doing it, being unable to think of
anything worthwhile to say, and be certain that she would mess up and say stupid things. Another person
with no more speaking experience might be thrilled, be eager to begin gathering material, be sure he has
important things to say, and fantasize doing well (in spite of some anxiety). The event has very different
meaning to these two people. Their expectations of themselves and others are entirely different.

Life is 10% what you make of it and 90% how you take it.

8.3 MANAGING YOURSELF

You should learn to recognize when you have outrun your abilities. You can fall back on the
leadership qualities that you have learned previously to take yourself to the next level in managing
yourself and others. If you open yourself to being transformed you can effectively listen to
others thereby, letting go old notions of leadership. When you cultivate a sense of self-awareness
you can understand what works for you better in a hardcore professional world. The easiest
way to manage yourself is to be flexible enough to adapt with changes, people’s mindset and
stress factors.

8.3.1 Does your job cause stress

Here is a set of questions that may help to find out if you are under stress. Answer them honestly.

1. Do you wake up tired first thing in the morning?
2. Have you lost the feelings of satisfaction, accomplishment and enjoyment that always
   inspired you to live your life to the fullest?
3. Are you more irritable and impatient than usual? Do you often feel like you are not yourself?

4. Do your well-wishers and friends frequently ask you, "Are you all right?" or inquire whether something is wrong?

5. Does taking a vacation give you a temporary sense of relief, but as soon as you return back to your daily life you feel tired and have no energy or enthusiasm for work?

6. Do you take longer lunches and breaks than you used to? Is it hard to make yourself go back to work once you are on lunch, or a break?

7. Does life seem like "all work and no play"?

8. Do you often feel overwhelmed and too tired to do your work?

9. Do you look for excuses to stop what you are doing (procrastinate), and do you welcome interruptions?

10. Do you spend time doing non-work activities so you do not have to face your work?

11. When you are doing your work, is it accompanied by a feeling of inescapable fatigue?

12. Do you daydream about "running away" and quitting your responsibilities towards life?

- If you answered "yes" to three or more of the questions, you should consider taking action to reduce your stress at work.
- Four to seven "yes" answers means your attitude at work is suffering and serious burnout is on the horizon, so you should take action now.
- Eight or more "yes" answers means you are experiencing acute burnout and should seek help immediately.

8.3.2 Five ways to battle job stress:

1. **Prevention is the key:** Tend to your spirit, stay physically fit, have a life outside of work, get plenty of rest and avoid alcohol and drugs. If you are in good health, work will not overwhelm your life. Exercise helps ease tension and keeps the body and mind happier.

2. **Meditate, pray,** practice yoga or relax daily: Starts your day by meditating to get connected with "the Divine." The important thing is to feed your spirit frequently. Research has shown that meditation leads to a more productive day. Make it a priority, and you will begin to feel more balanced.
UNIT 8: STRESS MANAGEMENT

3. Prioritize: There are more demands on our time than ever now, with lots to accomplish. To avoid getting overwhelmed, prioritize your workload at the beginning of the day, then reassess later if necessary. By creating priorities, you can better judge, for example, whether you should be replying to a friend’s e-mail or not while you are working to meet a deadline? (The answer is no.)

4. Breathe: It is really important to just pause, take a breath and think about your breath. Then pray or meditate.

5. Consider the root of the problem: If you have tried everything and you are still feeling anxiety over work, maybe your job really is the problem. Using your support network of family and friends to help develop an action plan, you can succeed in your efforts. You might also consider contacting a therapist if the problem persists.

8.3.3 Developing a strategy for stress management

Have you ever-experienced stress from obsessive or unwanted thoughts? Did you say to yourself, "Today I am not going to think about....?" What is the first thing you thought about? Was it that obsessive" or "unwanted" thought? These negative, stressful thoughts can be stopped by a technique called thought-stopping.

First, picture a scene that brings up wonderful, comfortable feelings, and that makes you feel good about yourself. Imagine the scene in terms of what it looks like, sounds like, smells like, and feels like. For example: You are on a beach. You see the sand and the water; you hear the waves beating against the shore. You smell the salt water and feel invigorated, yet calm. The scene you imagine does not have to be a true experience. The important point is that whatever you picture makes you feel good. Every time one of these unwanted thoughts occur, yell "Stop!" in your mind or out loud. Yelling, "Stop" immediately breaks the thought cycle. Then substitute your positive scene, replacing the negative thought that makes you feel badly about yourself with a positive thought that makes you feel good. The scene will leave your mind but the good feelings will remain.

After a few days the negative thoughts will be less frequent and you will be able to control them. It gets easier every time you do it. It is important to use this technique each time the unwanted thought appears. You can do thought stopping when you feel bad about yourself, guilty about something, when you are obsessed about the future or the past, or when you just want to get rid of a thought that is taking up your emotional energy. If you combine this technique with a conscious breathing relaxation exercise, it will help you sleep at night. You will feel better and experience less stress. There will be more time for you to enjoy your life and be productive in the ways you want to be.
8.3.4 Self-management

Here is a checklist on self-management for you to follow as guidelines. Self-management is a pertinent tool for a better life. Abiding by these rules of self-management, you can manage your life the way you want it.

**Specify a clear-cut goal you want to accomplish.** And be very specific. Like 'I will write for four hours a day, or 'run three miles'.

**Specify when you will do it.** Like everyday, Monday through Friday, or every morning, seven days a week, or at 10:00 am on Thursday.

**Record your hit rate.** Make a record of your successes and your failures, like a graph of the numbers of hours per day or a note on your calendar of the number of miles run each day.

**Make a public commitment.** Tell someone what your goals and your deadline are and ask them to check on you to see if you got it done. This is a subtle way of arranging for a little mild social reward or punishment, approval or disapproval, depending on whether you get the job done.

**Add an explicit penalty for failure, if you need to.** Tell your monitor that you will pay them a quarter or a dollar or take them out to lunch for each of your failures. But keep the penalty small, almost at a joke level, otherwise everyone will start getting uptight, and you are liable to give the wrong impression.

**Think small.** Do not try to make up for your past sins in a single day. If you have got a hundred letters to write, do not try to do them all right away. A postcard a day may be infinitely better than doing now. Going for too much too soon is why many people fail at self-management. That's a big one so watch out for it.

**Specify the amount of product you are going to produce.** Simply specifying the amount of time you are going to log in does not do the trick; in other words, specify the amount of work you are going to do.

**Get a timer that beeps every five minutes and chart whether you are on task, if you find yourself drifting off too much.** This is especially good when you might have trouble measuring the amount of the product.

**Arrange for regular contact with your monitor, daily or weekly as needed.** This is another one of those week points in the system. It helps to put your self-management project on the agenda with someone you meet with regularly and formally, a superior, a peer, or a sub-ordinate.
UNIT 8: STRESS MANAGEMENT

Arrange for your friend to monitor your graphing as well as your goal attainment. It is important to keep a good record of your performance so you are motivated not to mess up that pretty record, but you might also need to contract your charting, or that charting may fall out.

"Put Satan behind you." Get rid of distractions. Try to do your work when and where no one can bother you. Watch out for the phone. We might even blow a whole morning sorting through our junk mail and new magazines. Get as many tempting distractions out of your work environment as possible. Put an axe on the TV set.

Recycle. Your self-management project may not work the first time you try it. It might even fall apart from time to time. So be prepared with some scotch tape and bubble gum to put it back together again. Remember, you do not demean yourself by using these explicit self-management techniques. Use them and you will be in the company of some of the world's most productive people.

Source: Richard W. Malott (Learning Skills Programme)

8.3.5 Managing Change

Change is an effective guide to a better life and greater career opportunities. It is the only constant variable that brings variety and spice to a person's life. There can be no upgradation in a goal seeker's life if he does not allow change to intervene in his life. You can manage change only when you welcome change. There are eight tips for you to cope with change beautifully:

Increase urgency - inspire people to move, make objectives real and relevant.

Build the guiding team - get the right people in place with the right emotional commitment, and the right mix of skills and levels.

Get the vision right - get the team to establish a simple vision and strategy, focus on emotional and creative aspects necessary to drive service and efficiency.

Communicate for buy-in - Involve as many people as possible, communicate the essentials, simply, and to appeal and respond to people's needs. De-clutter communications - make technology work for you rather than against.

Empower action - Remove obstacles, enable constructive feedback and lots of support from leaders - reward and recognise progress and achievements.

Create short-term wins - Set aims that are easy to achieve - in bite-size chunks. Manage numbers of initiatives. Finish current stages before starting new ones.
UNIT 8: STRESS MANAGEMENT

Don't let up - Foster and encourage determination and persistence - ongoing change - encourage ongoing progress reporting - highlight achieved and future milestones.

Make change stick - Reinforce the value of successful change via recruitment, promotion, new change leaders. Weave change into culture.

8.3.6 Relaxation techniques

Any type of stress triggers physiological responses. Your adrenaline output increases, your heart pumps faster, and your breathing rate goes up. These bodily responses are positive if you channel them over a short period of time, but if there is no release, however small, then stress becomes a negative force. The strain of negative stress manifests symptoms like chronic fatigue, headaches, a change in eating habits, inability to concentrate, general irritability, as well as other physical problems.

A certain amount of stress, however, is beneficial. So, to purge your body from the evil effects of stress, these relaxation techniques will help you best in soothing and revitalizing your spirit, body and mind.

For quick relaxation from stress you can refer to the following techniques:

- Loosen your clothing and get comfortable.
- Tighten the muscles in your toes. Hold for a count of 10. Relax and enjoy the sensation of release from tension.
- Flex the muscles in your feet. Hold for a count of 10. Relax.
- Move slowly up through your body- legs, abdomen, back, neck, face- contracting and relaxing muscles as you go.
- Breathe deeply and slowly.
- For long-term relaxation, get in a comfortable position.
- Minimally tighten your right fist so that you feel only the smallest amount of tension. Hold for sometime. Be sure you continue to breathe... Now let go and relax...
- Observe the difference in feelings between the right and left arm and fist. Now minimally tighten your left fist. Hold for sometime. Let go and relax. Let the relaxation spread through the arms and the rest of the body.
- Now tighten ever so slightly the following parts of your body. (Each time tighten only to the point at which you can observe tension. Where you can observe tension, where you become conscious of or can "feel" the tension. Hold the tensions at that level, and be sure you tighten only the intended muscle while the rest of the body stays quiet and relaxed. Be sure you continue to breathe. Each time you let go, let those parts relax further and further.)
Here are some more guidelines for assertive delivery:

- Acknowledge and be honest about your own feelings to yourself.
- Adopt new positive inner dialogue for situations where you need to be more assertive.
- Be clear, specific and direct in what you say.
- If necessary, keep repeating your message if you encounter objections.
- If necessary ask for clarification if you are uncertain about something.
- If necessary, acknowledge diversion tactics, then again repeat your message.
- Adopt appropriate body language to back up your assertion.
- Keep calm and stick to the point.
- Always respect the rights of the other person.

8.4 PLANNING YOUR NEXT STEPS

We try to plan our lives as well as our business. So, in planning up your next steps the focus will be to create a life plan and then use it up for your maximum benefit. These are some of the elements of your life plan:

Your Current Status:

Think carefully and honestly about where you are now in your life. Consider work, recreation, relationships, finances and anything else that is important to you. Then, jot down some simple, succinct bullet points in each of these categories:

- Realities of your life, including responsibilities, funds available to start a business, expenses.
- Things that make you happy.
- Things that make you unhappy.

Your Ideal Life:

This is a snapshot of your "ideal" life, in a very brief, bulleted list. Remember, the sky’s the limit, so do not be afraid of being bold or maybe even a little grandiose. Factor in things like family, time hobby, charity work, and early retirement - anything that gets you really excited.
UNIT 8: STRESS MANAGEMENT

Your Likes: What you love to do most

Think about the types of things that you love to do, whether at work, at home, or at your work place. List these things out briefly. And do not worry if some themes are starting to repeat in each section. It just means you have some really focused ideas about what you want in life!

Your Skills & Capabilities: What You Do Well

List the abilities, experience and strengths you can build on to attain that ideal life. Bear in mind that your skills need not be strictly from your professional life - list skills developed in your personal life as well. It may be a combination of skills that leads you to what is best suited to fit your needs.

Your Track Record: What You Have Experience Doing

List those accomplishments in your professional and personal life of which you are most proud. Pay particular attention to successes you have had that would be helpful in starting a business and managing it successfully.

Some of the most successful and happy people we know are self-made professionals who created a name for themselves in perfect synchronicity with what they want out of life. If you do what you love, you will work harder, better and more happily.

8.5 SUMMARY OF THE TOPIC

This unit introduces the management of stress to you. Stress is defined as a psychological and physiological reaction to external stimulus. It affects everyone like a plague. Therefore, it becomes relevant for you to know the causes of stress and its prevention.

This unit advocates the strategy of "managing yourself" as an important tool for creating a stress free and happy life. This strategy includes the techniques of self-management, managing change and relaxation techniques to combat and contain the ill effects of stress. Here, assertiveness skills provide the necessary boost for successfully planning the essential next steps of life.

The section of this unit explains to you the important elements of a life plan which will help to proceed to the next important phase of your life i.e. establishing yourself as a career person.

8.6 FURTHER READING

Bob Losky, "Get a Grip: Overcoming Stress and Thriving in the Workplace.", Publication-Wiley India Pvt. Ltd., New Delhi.
8.7 EXERCISE TO CHECK YOUR PROGRESS

The 90/10 Principle

Take a look at the following. It will help you to reduce unnecessary stress in your life. This will change your life or at least the way you react to situations. What is this principle? 10% of life is made up of what happens to you. 90% of life is decided by how you react. What does this mean? We really have no control over 10% of what happens to us. We cannot stop the car from breaking down. The plane will be arriving late, which throws our whole schedule off. A driver may cut us off in traffic. We have no control over this 10%. The other 90% is different. You determine the other 90%. How? ………. By your reaction. You cannot control a red light but you can control your reaction. Don't let people fool you; You can control how you react. Let us use an example and see how this works……. You are eating breakfast with your family. Your sister knocks over a cup of coffee onto your dress. You have no control over what just happened. What happens next will be determined by how you react. You curse. You harshly scold your sister for knocking the cup over. She breaks down in tears. After scolding her, you turn to your mother and tell her to keep an eye over your sister's conduct. A short verbal battle follows. You storm upstairs and change your shirt. Back downstairs, you find your sister has been too busy crying and at the same time she struggles to finish breakfast and get ready for school. She misses the bus. Your mother tells you to drop your sister at school while on your way to college. You must leave immediately for your college. So, you hire an auto rickshaw to drop your sister at school. Because you are late, you ask the auto driver to speed up so that you reach your destination on time. After a 15-minute delay you arrive at your sister's school. Your sister runs into the building without saying goodbye. After arriving at college 20 minutes late, you find you forgot your assignment, which you have to submit in the class. Your day has started terribly. As it continues, it seems to get worse and worse. You look forward to coming home. When you arrive home, you find a small wedge in your relationship with your sister and mother. Why? …. Because of how you reacted in the morning.

Why did you have a bad day?
A) Did the coffee cause it?
B) Did your sister cause it?
C) Did your mother cause it?
D) Did you cause it? The answer is "D".

You had no control over what happened with the coffee. How you reacted in those 5 seconds is what caused you ending up having a bad day.
Here is what could have and should have happened.

Coffee splashes over you. Your sister is about to cry. You gently say, "I'm okay dear, you just need to be more careful next time". Grabbing a towel you rush upstairs. After grabbing a new shirt and your college bag, you come back down in time to look through the window and see your sister getting on the bus. She turns and waves. You arrive 5 minutes early and cheerfully greet your friends in class. Your teacher comments on how good a day you are having.

Notice the difference?

Two different scenarios.

Both started in the same way but ended differently. Why? Because of how you REACTED. You really did not have any control over 10% of what happened. The other 90% was determined by your reaction.

Here are some ways to apply the 90/10 principle. If someone says something negative about you, don't be a sponge. Let the attack roll off like water on glass.

You don't have to let the negative comment affect you!

React properly and it will not ruin your day. A wrong reaction could result in losing a friend, being fired, getting stressed out and a whole lot of other miserable things. How do you react if someone cuts you off in traffic? Do you lose your temper? Pound on the steering wheel? (A friend of mine had the steering wheel fall off) Do you curse? Does your blood pressure skyrocket? Do you try and bump them? WHO CARES if you arrive ten seconds later at work? Why let the cars ruin your drive? Remember the 90/10 principle, and do not worry about it. You are told you lost your job. Why lose sleep and get irritated? It will work out. Use your worrying energy and time into finding another job.

Source: Orkut.com

Activity 1

Answer the following questions. Be honest. Read your answers out and let the class decide if the answers you provide are going to cause stress or help you avoid it. Remember that there are no wrong or right answers here. The idea is to promote a better understanding of your "stressors" and how different situations may aggravate them and how you can use what you have learned so far to combat them.

1) You are in at a restaurant and order a plate of "Chicken chowmein", but you are served "Chicken fried rice", you:
   a) Accept it with comment because you are running out of time and need to get back to work.
UNIT 8: STRESS MANAGEMENT

b) Angrily refuse the "Chicken Fried Rice" and insist on complaining to the manager for poor service.

c) Call the waiter and indicate you ordered something else.

d) Storm out of the restaurant.

2) You are at the bank trying to deposit your salary check amongst all the madness and suddenly a frail lady steps ahead of you in line and claims that she is in a hurry, you:

a) Let her stay ahead of you as she is already ahead of you and it would be rude to speak out.

b) Pull her out of line in a loud and angry manner and make her go back.

c) Calmly indicate that you are in a hurry to and you have queued then point out where it begins.

d) Storm out of the queue.

3) After walking out of a store you realize that you have been short changed Rs.5 you:

a) Let go since you have already moved out and have no proof.

b) Go to the manger and argue that the assistant cheated you.

c) Return to the clerk and indicate that he has made an error.

d) Resolve never to come back to the store.

4) You are in a group discussion at work, which includes your boss and a colleague asks you a question about your work but you don't know the answer:

a) Give your colleague a false, but plausible answer so your boss will think you are on top of things.

b) Do not answer but attack your colleague by asking a question you know he/she cannot answer.

c) Indicate to your colleague you are unsure just now, but offer to give him/ her the information later.

d) Fume internally with a "how dare he / ask that question".

5) You are in the middle of watching your favourite television programme and your mother asks you to run an errand for her, you:

a) do the errand as quickly as possible and get back
b) Say, "No way I am missing this programmer!"

c) Ask if it can wait till the programme is over.

d) Slam the door on her face/walk out of the room thinking your evening has been ruined.

6) A friend drops in and stays too long and you start getting late for work
a) Let him stay because you do not want to upset him!

b) Tell the person to stop bothering you and ask him to disappear!

c) Explain you need to go to work and request him/her to drop in some other time.

d) Sit with him (hating every minute) and answer his questions in a clipped tone.
Learning Material for ITES

ENGLISH SKILLS
1.0 OBJECTIVES
This unit discusses the need to learn English by trying to communicate in English and not necessarily by learning about the structures of English or drilling them. You will realize the need to learn English by trying to acquire it naturally. In addition to this, you will know the approach to be followed to use English for various communicative purposes. After having studied this unit you should be able to:

- think in English instead of thinking in your mother tongue, and thereby improve your level of proficiency in the language;
- use English to communicate for your day-to-day needs;
- acquire communicative competence to perform different functions such as giving an opinion, agreeing or disagreeing on a topic, making a request or asking for something;
- learn how to rectify your errors that arise due to Mother Tongue Interference.

1.1 INTRODUCTION
English is being used almost everywhere: media, offices, educational institutions, and in business establishments. It has become essential to have an acceptable level of proficiency in the language in
order to be at par with the rest of the world. The primary objective of every learner of English is to know enough English for whatever purpose they have in learning English. Every learner may have a different purpose: to get a job, to be able to speak effectively in social and public gatherings, to build interpersonal relations, to be able to interact with friends and different persons or to be able to read English novels and books. These are only a few instances of why you learn a language. It has become very important to learn English to fulfill your day-to-day needs. How can you use English effectively? Should you rely on the knowledge of your mother tongue to learn English? How can you synchronize your thought process to think as well as speak in English? Should you learn the sentence structures of English without developing the ability to apply the rules in practical communication? These are some of the issues we will discuss in this unit. We will explore the approach that we should follow to use English for practical purposes in a natural way.

### 1.2 COMMUNICATING IN ENGLISH

#### 1.2.1 Meaning

Language is the means through which we communicate our thoughts, emotions and feelings to another person. When you learn a new language, your prime objective is to be able to communicate the same to another person. To be able to do this, you will need to learn the structure and grammar, and with it, the nuances of how to say what and to whom. A word or sentence may not be appropriate in a particular context or situation but may be perfect in another situation. For example, it may sound awkward or too formal if you say “I am deeply indebted to you for your help” to a close friend when a simple “thanks” will be much more effective. It may fit in perfectly in a formal office situation. Similarly, there is a difference in the way you write a letter or email to your friend and to your teacher. You should be able to use the language in any context to perform different functions such as expressing gratitude, regret, joy, despair; giving an opinion, agreeing or disagreeing; requesting. This is not possible by simply mastering the rules of grammar though its knowledge is a necessity. **Knowing the rules of grammar may help you to write correct sentences but may not help you to communicate effectively. To communicate in English is to use it in every context and situation effectively, both in the spoken and written form.**

When we speak of communicating in English, it means communicating through spoken or **written** words. It does not mean speaking only. A learner of English should aspire to be able to use it for different purposes and get the desired result. You should know what to say, when to say and how to say something.

#### 1.2.2 Concept of Functions

As mentioned earlier knowing English involves not only producing language correctly, but using language for particular purposes: for example being able to express your thoughts and feelings, give advice in English, make predictions, describe people, make a request, agree or disagree with someone or give
instructions. These are called functions. Functions are the same for all languages. So you need not learn the functions; function will be created automatically by the situation in which you have to use language. But you should know how to use English to perform those functions. If you learn the structures of grammar for no obvious reason and do not try to find out when and where to use it you may not become competent to express yourself in English. For instance, you are practicing a series of exercises on going to but do not know exactly how to use it according to the need of the situation. But if you try to talk about your intentions and plans (another function) you are likely to use the structure correctly and know its use.

### 1.2.3 Some functions with examples

1. **Total Agreement**
   - A: The director’s speech was very interesting.
   - B: Yes, it was great.

   - A: This dress looks good on her.
   - B: Yes, it does.

2. **Partial or qualified agreement**
   - A: There is a need to look at the issue of child labour more seriously.
   - B: Certainly it’s true, but we need the support of every section of the society.

   - A: People have become too busy to take time off for leisure.
   - B: Yes, but the demands on them have also increased.

3. **Tactful disagreement.**
   - A: This is a very well-written book.
   - B: Yes, it is well written but I found some parts of it quite boring.

   - A: She was right in refusing to sign the agreement.
   - B: Yes, but it will create more problems for her.

4. **Polite Request**
   - Could you open the door, please?

   - May I borrow your pen for a while?

   - Can I have a chocolate now? Please

5. **Permission**
   - You may leave after an hour.

   - You may use that computer till lunch time.
6. Asking for information
Can you tell me where I will find good storybooks for children?

Whom should I ask for the hotel

7. Avoiding giving an opinion
A: I think it is a tremendously well-written book. What do you think?
B: It’s difficult to say.

A: She should have married that rich businessman. What do you think?
B: Maybe the match was not meant to be.

Activity 1

Have you ever been to a bank? Think of a situation where you need to talk to a banker regarding an issue (opening an account, depositing money). Write down the conversation (a few lines) between you and the banker in the space provided below.

Activity 2

Try to recollect some functions you might have performed in the day. List them in the space provided below.

Write down the sentences that you used to perform the functions you have listed in English.

Check Your Progress 1

Look at the two columns below. Column A consists of the sentences and B consists of the functions they express. Match them.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>He’s tall, fair and has got curly hair.</td>
<td>Expressing regret</td>
</tr>
<tr>
<td>I’m going to study medicine.</td>
<td>Giving permission</td>
</tr>
<tr>
<td>I wish I were a bit more careful.</td>
<td>Describing</td>
</tr>
<tr>
<td>Could you open the door, please?</td>
<td>Expressing intention</td>
</tr>
<tr>
<td>You can leave early today.</td>
<td>Making a request</td>
</tr>
</tbody>
</table>

1.3 THINKING IN ENGLISH

Since language is not an abstract entity that is used for producing correct sentences, it is not possible for us to learn by heart all the structures of English and use them. We should be able to produce sentences for unpredictable circumstances.
Activity 3
Recollect a conversation you had today. The conversation you had may have been in your mother tongue. Write down the conversation (a part of it) in English. Try not to translate the sentences directly into English. Instead try to convey the idea (yours and the other speaker’s) in English.

1.3.1 Meaning

Even before you start to utter a word to speak, your thinking process has already formed the sentence in your mind. This means that your mind has already made a mental image or linguistic text of the order of the words, the grammar and the vocabulary you need to express that thought. This happens so intuitively that you are hardly aware of it, especially when you are communicating in your mother tongue. Do you ever consciously pause and think about the next word or sentence when you are having a conversation in your mother tongue? The answer is you do not, simply because the process of forming and arranging the words is so intuitive to you that they seem to come out without any effort. You may not make any grammatical errors while speaking in your mother tongue, irrespective of whether you are using it in a formal or informal situation or to perform any function. Why? This is because it has become a habit for you to think in that language.

Now, when you are in a situation where you have to use English to communicate, you should be able to do so without any awkward pauses, grammatical or syntactical errors or ambiguity. The thought process that creates the text in your mind to speak or write in English should be as natural and habitual for you as it is in your mother tongue. Think about it. It is not as simple as switching by translating from one language to another. This switch should take place in your mind, before you form the sentence that you are about to speak or write.

In the beginning you may find yourself translating from your mother tongue to English as you speak. But that is not thinking in English.

1.3.2 The Best Way to Do It

The best way to learn how to think in English is to practice it until it becomes a habit. Your thought process should find its expression in English itself without the help of the mother tongue. This is not achieved simply by learning to make sentences according to the rules of English grammar. You will have to be able to use the rules naturally in any situation.

It means you should try to learn the language by actually using the language. Knowledge of grammar is definitely important. But knowing grammar does not guarantee your competence in English or any
language. Your goal should be to use English effectively and appropriately. You should be able to perform a function in any situation you may not have encountered before. If you think in your mother tongue, translate it and then speak, your speech will not have the natural flow. There is a good chance that your mother tongue will influence the way you use grammar and how you pronounce. Thus the best way is to listen to, read and speak the language you are learning (in your case English) as much as possible and try to communicate in that language, rather than by consciously learning grammar. You should synchronize your thought process in such a way that you think as well as speak in English in order to communicate for different purposes of your daily life. Initially it may be a process of trial and error for you. You may not be accurate every time, but gradually you will acquire the required competence.

**Activity 4**
To make thinking in English a habit you will have to practice it every day. Think of an object, say, a book or pen or box. Try not to think of it in your mother tongue. Try and think of the English word for it. Keep thinking of it only in English. If you do this everyday you will realize that you can think of it almost naturally in English instead of in your mother tongue.

**Activity 5**
Write a daily diary in English. Remember where you went, with whom you interacted, what you did and when. Make a note of the minutest details. Go through the diary each day and frame sentences in English in your mind about the events, people noted in the diary. Discuss with your instructor, as if you were telling him/her about your day.

### 1.3.3 First Language (Mother-Tongue) Interference

Mother-tongue interference is the negative transfer of the structure of one's mother tongue to a new language that a person is learning. When you are learning a new language you already have the knowledge of your mother tongue. You may transfer this knowledge into the language you are learning. This transfer may have positive effects if the structure of your mother tongue and the new language is the same. But it may influence negatively if the structures of the two languages are different. This interference is known as mother-tongue interference. For example, in most Indian languages the word order (order in which words occur in sentences) is subject-object-verb (SVO) “Maine (I- Subject) aam (object) khaayaa (verb)”. However, in English it is subject-verb-object (SOV) as in, “I (subject) ate (verb) a mango (object)”. 

Mother-tongue interference can take place, while speaking or writing, vocabulary, at the level of grammar and pronunciation. To overcome these interferences at the level of pronunciation you will have to listen to good Spoken English, learn pronunciation from a teacher who speaks good English and learn from materials specially designed for the purpose of teaching pronunciation to learners. To overcome the interference of your mother tongue at the written level, you should read good English novels, short
stories and contemporary drama, newspapers, journals, magazines, etc. In addition to this, you should keep remedying yourself by consulting good dictionaries with emphasis on usage. You may also go through materials dealing with common errors.

**Check your Progress 2**

Correct the following sentences:
1. Couple of days was not long enough to see all the sights.
2. Could you do a favour to me?
3. Cleopatra as well as her retinue of slaves are sailing down the Nile.
4. I’ll be surprised unless prices go up next year.
5. He used to study History for three years.
6. What is the time on your watch?
7. Could you pass me onto the dealer? (speaking on the phone)

**Check Your Progress 3**

Look at these short conversations and explain which remarks are inappropriate to the situation, according to you. Decide what should have been actually said.

1. Assistant: Can I help you?
   Customer: No.

2. You: Hi there, how is it going?
   Teacher: I am fine. How are you doing?

3. Waiter: Will you place the order now?
   Customer: No. Come after sometime.

4. Friend: Would you like a cup of tea?
   You: Yes. That’s so nice of you.

5. Boss: I will have to say that you did a very good job. Well done!
   New employee: Thanks.

**1.4 LET US SUM UP**

We learn a language to use it as a means of communication, to express our thoughts and feelings. We can use our mother tongue so fluently and naturally because we pick it up from birth. So our thought process
is also tuned to think in our mother tongue. When we learn a new language, say, English, we not only have to learn how to speak and write in English, but also how to think in English. In fact, learning to think in English is the first step before we speak or write.

The communicative functions that we perform, such as expressing interest, regret, joy, intention or agreeing or disagreeing or thanking someone are the same in all languages. Languages differ in the way we express those functions. If we are able to think in the target language (English), then it will be easier to express any function in that language. Learning the grammatical structures is not enough to speak or write proficiently.

Practice thinking in English till it becomes a habit for you.

Word for word translation into English will often lead to mother tongue interference in writing. Try to convey the idea in English. Only then will you be able to communicate with minimal errors in any situation you are in. Thinking in English will lead to improvement in the four basic language skills: Listening, Speaking, Reading and Writing along with grammar, vocabulary building and pronunciation practice.

1.5 FURTHER READING


1.6 CHECK YOUR PROGRESS: MODEL ANSWERS

Check your Progress 1

He’s tall, fair and has got curly hair.  Describing
I’m going to study medicine.  Expressing intention
I wish I were a bit more careful.  Expressing regret
Could you open the door, please?  Making a request
You can leave early today.  Giving permission

Check Your Progress 2

1. Couple of days was not enough to see all the sights.
2. Could you do me a favour?
3. Cleopatra as well as her retinue of slaves is sailing down the Nile.
4. I will be surprised if prices go up next year.
5. He studied History for three years.
6. What is the time by your watch?
7. Could you transfer my call to your dealer?

Check Your Progress 3

1. Assistant: Can I help you, Sir?
   Customer: That’s all right. Thank you.
2. You: Good morning teacher. How are you?
   Teacher: I am fine. How are you doing?
3. Waiter: Are you ready to order, Sir?
   Customer: Not now. Could you come after sometime?
4. Friend: Would you like a cup of coffee?
   You: Sure. Thanks.
5. Boss: I will have to say that you did a very good job. Well done!
   New employee: Thank you.
UNIT 2 LISTENING

2.0 OBJECTIVES

This unit discusses the role listening plays in learning English. Developing this skill can help you in developing your communication skills in general. After reading this unit you should be able to:

- understand what is the role of listening when learning a new language;
- understand the relationship between listening and speaking a new language;
- differentiate focused listening from casual listening;
- identify the listening difficulties;
- practice focused listening; and
- increase your listening efficiency.

2.1 INTRODUCTION

In order to gain proficiency in a new language, we must be able to read, write and speak the language well. When we learn a new language, we may tend to focus more on knowing how to learn the alphabets, the grammar and vocabulary of the language. These are taught as part of a formal learning session. However, this alone does not always guarantee that we will be able to pick up the nuances of the new
language. Sometimes we may fail to understand what the speaker is saying even if he or she is speaking at a normal speed. Sometimes we may get confused when a speaker uses similar sounding words or phrases, such as stationary and stationery, I scream and ice-cream, reign and rain, or break and brake. At other times, differences in pronunciation of words and our inability to make out the word being spoken may create misunderstanding or confusion in our minds. One reason why this happens is related to how we listen when others speak. In this unit we will discuss the role that listening plays when learning a new language. We will also discuss the barriers to effective listening and provide you some ways to develop your listening skill.

2.2 LISTENING

Activity 1

Watch the English news at 9 on TV. When you go to the class the next day, give the gist of a news item to the teacher.

2.2.1 Meaning and Definition

We need to develop four basic language skills in order to become proficient in a language. The four skills are: listening, speaking, reading and writing. Listening is the first skill we will have to develop to communicate (speak or write) effectively. Listening is often confused with hearing. It is more than hearing words. “Listening is an active process by which students receive, construct meaning from, and respond to spoken and or nonverbal messages”, Emmert, 1994. In very simple terms it means hearing something and being able to understand or comprehend what is heard. But it involves far more abilities than just hearing something. It involves: recognizing the words, phrases, clauses, meaning (i.e. all the elements of a connected speech), identifying different sounds, being able to segment the sounds into words, being able to get the gist without trying to understand each and every word and sentence and finally being able to keep track of what the speaker is saying even if it is a long conversation. It is an active process rather than a passive one.

As an active process, listening plays a significant role in developing a person’s interpersonal skills. In this case listening essentially involves listening to the speaker with concentration to establish interpersonal relations with the speaker for various purposes like striking a business deal, building a rapport with the speaker or to show empathy to the speaker that is, trying to see the problem the way the speaker sees it. This form of listening comes at a later stage when your primary motive is not necessarily developing your speaking skill. In this unit, we will limit our discussion on listening to the first case where listening as a language skill is as important as speaking, reading or writing.
2.2.2 Importance of Listening When Learning English

There must be equal participation by the speaker and the listener in a conversation. But if you fail to understand what is said it is almost impossible to take the conversation forward. In that case it will not be possible for you to communicate effectively in the situation, for instance, when replying to a question.

... act of listening requires not just hearing but thinking, as well as a good deal of interest and information which both speaker and listener must have in common. Speaking and listening entail ... three components: the speaker, the listener, and the meaning to be shared; speaker, listener, and meaning form a unique triangle. (King, 1984, p. 177)

The ability to understand spoken English at a normal speed is a prerequisite to knowing how to speak English and also to perform some functions like listening to the radio, understanding foreign visitors, studying. You learn by hearing. Thus listening and speaking are closely connected. You need to listen to English spoken at a normal speed with native like pronunciation (native speakers of English) in order to train your ears on listening. A trained ear can pick up grammatical rules, structures, good pronunciation and a vast vocabulary of a new language by listening attentively. It is often seen that people who have plenty of exposure to English (if it is used in schools, for official purposes or in the media) learn it faster than people who do not hear English around them.

Discuss with your teacher:

1. Do you have trouble in understanding the actual sounds of English, for example, whether it is ‘think’ or ‘sink’ when the former is spoken with a native like pronunciation?
2. Do you need to hear things more than once in order to understand it properly?
3. Do you expect the speaker to speak slowly since it is difficult to understand natural, native sounding speech or even English spoken with a Standard Indian accent (refer 3.2) say, while listening to the news on radio?
4. Do you often fail to distinguish between important and unimportant information and as a result fail to understand the gist?
5. Can you guess, predict or interpret the meaning from the context?

Check Your Progress 1

1. What is the basic difference between listening and hearing?
2. When you say you are a proficient listener of English, what does it mean?
3. In what way is listening related to speaking?
Activity 2
You can listen to the news on BBC radio and note down what the news was about.

2.3 TYPES OF LISTENING

Activity 3
Ask your English language teacher to give you instructions on doing something (for example, how to build an aquarium, how to write a report or visit a new place). After the speaker has finished try and repeat what you heard. Check with your teacher whether you have got the main points.

2.3.1 Casual Listening

You are practicing casual listening when you listen without any particular purpose in mind and often without much concentration. In this case you do not listen very closely and may not remember what you heard. Examples of this kind of listening are: listening to music while doing something, chatting with a friend. You listen casually when you are listening to something just to pass the time. You may also become a casual listener when the subject discussed does not interest you.

2.3.2 Focussed Listening

You may listen to something for a particular purpose. The purpose may be: to find out information we need to know, to remember instructions, to evaluate or judge the message, to respond appropriately (for example, to clarify, sympathize, encourage, or paraphrase). In these situations we need to listen more closely. This is called focused listening.

In focussed listening you may not listen to everything you hear with equal concentration- you may listen for the most important points or for particular information. Usually in this kind of listening you know the purpose- why are you listening- beforehand and so it becomes easier for you to listen. For a learner of English, focussed listening plays an important role in understanding and picking up diction, tone and intonation while speaking.

Activity 4
Repeat activity 3. But this time try to focus on the way the language is being spoken. Are all the words spoken with equal emphasis? Are important words spoken with emphasis to make a point? Can you understand each word clearly or does the speaker have to repeat or rephrase to clarify a point? Do you speak in the same manner? Also focus on the main points of the conversation. Was it easy or difficult to understand and remember them? You may find that you may remember the main points easily as you were focussed on the crucial facts instead of everything.
2.3.3 Active Listening

This is a way of listening to the speaker with empathy. You try to understand what the speaker is saying by trying to see things from the speaker’s point of view. **You are an active listener if you listen to the speaker without drawing conclusions or forming an opinion about the speaker or the topic even before the speaker completes it.** This helps you in building a rapport with the speaker. If you listen with an open mind, you can receive new ideas. There might be differences of opinion but you should listen for a critical understanding of the matter.

**Active listening has many benefits.** It forces you to listen attentively. It helps you build good relations, as people like to open up to someone who listens with empathy.

**Check Your Progress 2**

1. What is the difference between casual listening and focused listening?
2. How will focused listening help the learner of English?

2.4 BARRIERS TO EFFECTIVE LISTENING

How often have your mind wandered when someone was telling you something? This usually happens when the topic matter does not interest you. Sometimes the conversation may be too long and tedious. Sometimes the topic matter may be interesting but the speaker is unable to grab your attention, or you may be unable to comprehend because of lack of knowledge of the topic or the vocabulary or language of the speaker.

There must be motivation and interest in a conversation to be able to listen effectively. However, even if there is motivation and interest, there might be some barriers that affect our ability to listen well. Here we will discuss the difficulties you face in listening.

**Linguistic/Semantic Barriers**

This is one of the most common barriers to listening. Learners of a language normally face this kind of barrier.

(a) **Unfamiliar vocabulary:** Words used by the speaker are not familiar to you. The speaker may use difficult words and jargons. As a result you cannot comprehend what the speaker says.

(b) **Elements of connected speech:** The speaker is too fast. There are very few pauses and the
rhythm that are not familiar to you. You fail to recognize familiar words because of contractions, reductions, linking. For example, the speaker says, “I scream” and you hear “ice-cream”.

(c) **Unable to predict, guess, and interpret meaning from the context:** A person who pays attention to sound structure would recognize that a rapidly spoken “Idrankitfirst” could mean either “I drank it first” or “I’d rank it first.” You should be able to recognize whether it is “I drank it first” or “I’d rank it first” from the context. Sometimes the speaker implies something but does not overtly express it. “That would be all, thank you” is a polite and indirect way of telling someone you do not need their services anymore instead of the more direct “You may leave now”. You guess the meaning from the context though the speaker does not overtly express what he or she wants.

(d) **Get words but lose ideas:** You lose track if you concentrate on each and every word the speaker says, especially if you need to do it for a long period. As a result you may understand the meaning of almost all the words but do not get the gist. You do not distinguish the important information from the unimportant.

**Socio-cultural Barriers**

(a) **Different cultural background:** The speaker’s accent and pronunciation of words are not familiar to you because of difference in cultures between you and the speaker.

(b) **Unfamiliar subject:** The subject may not be familiar to you because you are not familiar with a particular culture or unaware of the lifestyle of a particular society.

**Psychological barriers**

(a) **Forming opinions and drawing conclusions before listening:** It is not a bad idea to know the purpose of your listening. But you may form opinions about the speaker even before he or she speaks. You may make assumptions about the subject to be spoken about and draw conclusions even before the speaker speaks. This may block your mind and as a result you will not be able to listen.

(b) **Not interested in the topic:** You may not listen if you do not have any interest in the speaker’s topic.

(c) **Inability to pay attention:** Day dreaming and a wandering mind may prevent you from listening.

(d) **Prejudice:** You may refuse to listen to something, which goes against your ideas and beliefs. You hear only what you want to hear.

**Physical Barriers**

(a) **Noisy surroundings:** The environment may be too noisy, which may affect listening.

(b) **Physical distance:** You may be too far away from the speaker or too close to the speaker to be able to hear clearly.
Check Your Progress 3

Identify what kind of barrier it is when:

(a) you are unable to listen to the speaker because the speaker is standing too far away from you.
(b) you are unable to listen because the speaker is using difficult words and complex sentences.
(c) you are unable to listen because you do not agree with what the speaker is saying.
(d) you are unable to listen because the speaker is from the U.S. of A and speaks in American accent.
(e) you are unable to listen because you are tired and bored.

2.5 HOW TO INCREASE LISTENING EFFICIENCY

You probably spend more time using your listening skills than any other kind of skill. Like other skills, listening too needs practice for you to become proficient in it. As we have already discussed the barriers to effective listening your next step should be to practice the ways to increase your efficiency in listening. Here are some tips:

1. Listen to spoken English that is clear in diction. Try to recognize elements of natural, connected speech. Try to segment the sounds into words.
2. Listen for main ideas rather than trying to understand each and every individual word. You may get worried if you do not understand even a single word and as a result lose track.
3. Make use of the context to guess, predict and interpret meaning.
4. Figure out the purpose of your listening. Then you will be able to distinguish the important information from the unimportant.
5. Make sure your mind is focused. You may let your mind wander if you think you know what the person is going to say next, but you might be wrong! If you feel your mind is wandering, change the position of your body and try to concentrate on the speaker’s words.
6. A final skill is to train your mind to concentrate on what the speaker is saying. You cannot ‘hear’ the speaker’s point of view or process information when you argue mentally or come to a conclusion before he or she has completed. An open mind is a mind that is receiving and listening to information.

Activity 5

Watch an English film. Listen to the speakers carefully. Can you understand all the words correctly? Or are you finding it difficult to understand because of the speaker’s accent? Are you finding it difficult to understand the words, as the way he or she is pronouncing the English sounds is different from the way you pronounce them? Take note of the diction and style in which the sentences are spoken.
Activity 6

Watch an English film (a good Oscar winning film). Listen to the dialogues carefully. Can you guess the attitude and the personality of the speaker from his dialogues and the way he or she utters them? Tell your teacher about a particular character in the film- about his or her attitude, personality, or any other implications- as obvious from the dialogues you heard.

2.6 LET US SUM UP

Listening is one of the basic language skills. Developing this skill is as important as developing the other three skills, namely, speaking, reading and writing.

Listening is more than simply hearing what is being said. It is an active process where the listener receives information and processes it to create meaning.

You must be able to listen to spoken English in a focussed manner to be able to speak it proficiently.

Listening has been classified into three types: casual, focussed and active. It is our state of mind and our requirement that determines whether we are listening casually, in a focussed manner or actively. Casual listening, as the name suggests, is casual in its approach and appropriate for informal situations. Focussed listening has a purpose and therefore the listener listens with the intent of gathering the information required to fulfill that purpose. Those who learn English as a second language benefit from focussed listening (if the speaker is proficient in English) as it helps to concentrate on the way English is spoken and pick up the right nuances of pronunciation. Active listening involves listening with empathy and an open mind to be able to clearly understand the speaker. By being an active listener you can develop a good rapport with the speaker and improve inter-personal skills.

- You need to have the right motivation and interest (for example: answering questions during a job interview; requesting for information at a counter; seeking information about a product or service; learning a new language, asking for directions, demonstrating a product to a potential customer) to listen well without letting your mind wander.
- You should be conscious of the barriers to effective listening and try to overcome them whenever possible.

2.7 FURTHER READING


2.8 CHECK YOUR PROGRESS: MODEL ANSWERS

Check Your Progress 1

1. Listening is more than hearing. It involves hearing something, processing it and understanding it. It is an active process unlike hearing, which is passive.

2. A proficient listener of English is the one who can recognize the words, phrases, clauses, meaning (i.e. all the elements of a connected speech), identify different sounds, is able to segment the sounds into words, is able to get the gist without trying to understand each and every word and sentence and finally can keep track of what the speaker is saying even if it is a long conversation.

3. The two language skills, listening and speaking are interrelated in the sense in order to develop speaking skill proficiency in listening is necessary. One learns a language that he or she keeps listening to. Good listening practice will help in developing speaking skill.

Check Your Progress 2

1. Casual Listening is when you listen with no particular purpose in mind and often without much concentration

2. Focussed listening enables the learner to listen for a particular purpose. When one knows why he or she is listening, it is easier to differentiate the important information from the unimportant. A learner of English will therefore be able to pick up the nuances of pronunciation when he or she practices focused listening

Check Your Progress 3

1) Physical

2) Linguistic

3) Psychological

4) Linguistic

***
3.0 OBJECTIVES

The purpose of this unit is to introduce you to the fundamentals of English pronunciation, viz. the study of the English consonant and vowel sounds and the ways in which they combine in words, word stress, that is, stressing particular syllables in words, using the right stress and right intonation in sentences. However, this is a vast area of teaching and learning and so a selective attempt has been made below basically to help you overcome certain negative influences of your mother tongue. After studying this unit you should be able to:

- recognize and practice all the vowel and consonant sounds of English in isolation as well as in the sequence in which they occur in words;
UNIT 3 PRONUNCIATION

- identify the important features of word stress, sentence stress, rhythm and intonation in English;
- understand English as it is spoken by native as well as non-native speakers of English; and
- overcome influences of your respective mother tongues and acquire a neutral accent.

3.1 INTRODUCTION

It is often seen that learners of English become proficient in speaking but the way they say the words and sentences makes it difficult for others to understand them. For non-native speakers of English, one of the key challenges is to get the pronunciation right. This means getting the diction, the stress and intonation right when speaking English. It is not uncommon for new learners of English to struggle with these aspects. In this unit we will discuss the issues and problems related to English pronunciation, especially in the context of Indian learners.

Activity 1

Below is a speech by Jawaharlal Nehru. Read the lines into a recorder. Play your recorded voice and listen to it. Try to find out the pronunciation mistakes you think you made.

Occasion: Speech delivered in the Constituent Assembly, on August 14, 1947.

Long years ago we made a tryst with destiny, and now the time comes when we shall redeem our pledge, not wholly or in full measure, but very substantially. At the stroke of the midnight hour, when the world sleeps, India will awake to life and freedom. A moment comes, which comes but rarely in history, when we step out from the old to the new, when an age ends, and when the soul of a nation, long suppressed, finds utterance. It is fitting that at this solemn moment we take the pledge of dedication to the service of India and her people and to the still larger cause of humanity.

At the dawn of history India started on her unending quest, and trackless centuries are filled with her striving and the grandeur of her success and her failures. Through good and ill fortune alike she has never lost sight of that quest or forgotten the ideals, which gave her strength. We end today a period of ill fortune and India discovers herself again. The achievement we celebrate today is but a step, an opening of opportunity, to the greater triumphs and achievements that await us. Are we brave enough and wise enough to grasp this opportunity and accept the challenge of the future?

Freedom and power bring responsibility. The responsibility rests upon this Assembly, a sovereign body representing the sovereign people of India. Before the birth of freedom we have endured all the pains of labour and our hearts are heavy with the memory of this sorrow. Some of those pains continue even now. Nevertheless, the sorrow is over and it is the future that beckons to us now.
That future is not one of ease today but of incessant striving so that we may fulfill the pledges we have so often meant—the service of the millions who suffer. It means the ending of poverty and ignorance and disease and inequality of opportunity. He ambition of the greatest man of our generation has been to wipe every tear from every eye. That may be beyond us, but as long as there are tears and suffering, so long our work will not be over. And so we have to labour and to work hard, to give reality to our dreams. Those dreams are for India but they are also for the world, for all the nations and peoples are too closely knit together today for any one of them to imagine that it can live apart. Peace has been said to be indivisible; so is freedom. It is prosperity now, and so also is disaster in this One World that can no longer be split into isolated fragments.

To the people of India, wise representative as we are; we make an appeal to join us with faith and confidence in this great adventure. This is no time for petty and destructive criticism, no time for ill will or blaming others. We have to build the noble mansion of free India where all her children may dwell...."

3.2 PRONUNCIATION: PROBLEMS AND ISSUES

For any non-native speaker of English, getting the pronunciation right involves understanding the concepts of varieties of English, accent in the context of English and becoming conscious of how one’s mother tongue influences the pronunciation of a new language. Here is a brief discussion on these issues.

3.2.1 Different Varieties of English

English is the most widely spoken language today with countries from all the continents using it as their mother tongue or a second language. With such a wide geographical spread it is quite natural that it will have different varieties in different countries. Significant differences in pronunciation are also found in different regions within the same country. Though variations, dialectal and otherwise, in a language are a natural phenomenon, a standardized form is always important for a widely spoken language like English.

As far as pronunciation of English goes Standard British English and General or Standard American English, are the two chief varieties of English and are mostly adopted as models elsewhere for learning English. Within Great Britain there are differences in pronunciation in different regions but the pronunciation acquired through education in the public schools and universities in the country has been accepted as a common standard of pronunciation referred to as Standard British English or RP (Received Pronunciation). Similarly, there are different varieties of pronunciation within the United States of America. However, certain tendencies are common amongst large number of educated speakers in the country, which is referred to as General American Pronunciation.
3.2.2 Indian English and Mother Tongue Interference

In the Indian context your aim should be to overcome the interference of your respective mother tongues in your pronunciation of English. It is often seen that learners of English tend to say English sounds, words and sentences in the same way as they say them in their mother tongue. Sounds that are absent in your mother tongue may be difficult for you to pronounce, as you are more accustomed to pronouncing the sounds present in your mother tongue or the language you keep hearing since birth.

Thus your aim should be to speak a variety of English that is non-regional in accent. For this you will have to adopt one of the two chief varieties, British RP or General American, as a model. However, by following the British RP or General American for that matter, we do not end up as British RP speakers or as speakers of General American English (unless, of course, we have exceptional phonetic gifts or have lived amongst native speakers, communicating with them in English everyday and trying to imitate their accent). By overcoming the negative influences of your mother tongue, you can always acquire a variety of English pronunciation that may be called educated Indian English.

3.2.3 The Concept of Neutral Accent

Accent is defined as the pronunciation characteristic of a particular group of people relative to another group. It is different from a dialect which is a variety of a language differing in grammar, vocabulary and pronunciation. When we talk of a neutral accent we do not mean any particular accent. A neutral English accent in the context of India is pronunciation of English without any negative influence of a mother tongue or of a regional accent. It is advisable to adopt one of the chief varieties as a model and maintain consistency in its use. For historical reasons India has been following the British RP as a model, as already stated. The American accent is beginning to make its presence felt in India also, especially at the individual (non-institutional) level. One thing worth noting here is that though these are two different varieties, they have far more similarities than differences. It may also be noted that our discussion below is based on Standard British English.

Activity 2:

Try to identify the difference between British RP and American English by listening to the news broadcasts on CNN and BBC. Note down whatever differences you have been able to make out.

3.2.4 Spelling and Pronunciation

The lack of one-to-one correspondence between the spelling and pronunciation of a word has always created problems for a speaker of English. In some languages, such as Hindi, a letter is always
pronounced in the same way irrespective of its position in a word (beginning, middle, end). So there is no confusion as to how to pronounce that letter. But in English, the same letter or combination of letters can be pronounced in different ways. For example, in the words *chef* and *chap*, though the initial letters are the same, the pronunciation is different. Similarly, the letter *g* is pronounced in two different ways in *ginger* and *gregarious* and *h* is silent in *hour* but pronounced in *horse*. It is essential to know the different sounds that a language has so that one can internalize the rules of spelling and pronunciation.

### 3.3 HOW SPEECH SOUNDS ARE PRODUCED

The basic source of speech production is the respiratory system pushing air out of the lungs. Air passes through different organs of speech starting from the vocal cords. When the vocal cords vibrate we have a kind of sounds called voiced (e.g. b, d, g, m, n, l, etc.) and when the vocal cords do not vibrate we have another kind of sounds called voiceless (e.g. p, t, k, s, sh, p, etc.). After the vocal cords the air reaches the pharynx where there is a small muscular fold called the soft palate. When the palate is lowered, the air passes through the nose and when it is raised it passes through the mouth. In the mouth the tongue, the lips, the hard palate and the teeth interrupt the flow of air in some way and in the process, different sounds are produced. The tongue is the most important speech organ. The back, front and tip of the tongue, touching different articulators like teeth; hard palate or the alveolar ridge (the small protuberance behind the upper teeth that can be felt with the tip of the tongue) can produce different sounds. Different shapes of the lips (spreading or rounding) as the air comes out of the lungs can also produce different sounds, especially vowel sounds.

We use different speech organs together to produce a single sound such as 'g' as in gate or ‘b’ as in ball. The entire process of speech production is so automatic that we are hardly aware of it as we speak. The diagram below is a side view of the different organs involved in the production of speech.
3.4 THE ENGLISH CONSONANT SOUNDS

A good knowledge of the different consonant sounds will make a learner a better speaker simply for the fact that, you can utter a word with better precision and hence can be more clear and comprehensible.

The consonant sounds are produced when the different articulators interfere with the air that comes out from the lungs. Normally two organs of speech or articulators interrupt the air and produce a consonant. There are twenty-four consonant sounds in English.

For example the two lips (articulators) can be brought together and the air can be stopped for sometime. When it is released the consonant sounds $p$ as in pig and $b$ as in big are produced. When the tongue comes very close to the upper teeth, almost touching it and interrupt the air, thus producing some friction, then the sounds $th$ as in think and $th$ as in then are produced.

Below is a list of the consonant sounds with examples (the consonants are in bold)

<table>
<thead>
<tr>
<th>p</th>
<th>pill</th>
<th>ng</th>
<th>sing</th>
<th>zh</th>
<th>leisure</th>
</tr>
</thead>
<tbody>
<tr>
<td>b</td>
<td>bill</td>
<td>f</td>
<td>ferry</td>
<td>h</td>
<td>house</td>
</tr>
<tr>
<td>t</td>
<td>ten</td>
<td>v</td>
<td>very</td>
<td>y</td>
<td>yes</td>
</tr>
<tr>
<td>d</td>
<td>den</td>
<td>th</td>
<td>think</td>
<td>w</td>
<td>wall</td>
</tr>
<tr>
<td>k</td>
<td>coal</td>
<td>th</td>
<td>then</td>
<td>r</td>
<td>rain</td>
</tr>
<tr>
<td>g</td>
<td>goal</td>
<td>s</td>
<td>sue</td>
<td>l</td>
<td>lame</td>
</tr>
<tr>
<td>m</td>
<td>mill</td>
<td>z</td>
<td>zoo</td>
<td>ch</td>
<td>church</td>
</tr>
<tr>
<td>n</td>
<td>name</td>
<td>sh</td>
<td>push</td>
<td>j</td>
<td>judge</td>
</tr>
</tbody>
</table>

Indian speakers normally do not face difficulty in pronouncing all the twenty-four consonant sounds as some of them have their equivalents in most of the Indian languages. The difficulties faced are not always common, because of differences in the phonetic system of different languages. Generally speaking, however, the consonant sounds that many Indians find difficult are:

<table>
<thead>
<tr>
<th>f</th>
<th>ferry</th>
</tr>
</thead>
<tbody>
<tr>
<td>v</td>
<td>very</td>
</tr>
<tr>
<td>th</td>
<td>think</td>
</tr>
<tr>
<td>th</td>
<td>then</td>
</tr>
<tr>
<td>s</td>
<td>sue</td>
</tr>
<tr>
<td>z</td>
<td>zoo</td>
</tr>
<tr>
<td>sh</td>
<td>push</td>
</tr>
<tr>
<td>zh</td>
<td>leisure</td>
</tr>
<tr>
<td>ch</td>
<td>church</td>
</tr>
<tr>
<td>j</td>
<td>judge</td>
</tr>
</tbody>
</table>
UNIT 3 PRONUNCIATION

Now note the difference between these sounds given in separate columns:

<table>
<thead>
<tr>
<th>f-</th>
<th>ferry</th>
<th>s-</th>
<th>sue</th>
<th>s-</th>
<th>sue</th>
<th>z-</th>
<th>zoo</th>
</tr>
</thead>
<tbody>
<tr>
<td>v-</td>
<td>very</td>
<td>z-</td>
<td>zoo</td>
<td>sh-</td>
<td>push</td>
<td>zh-</td>
<td>leisure</td>
</tr>
<tr>
<td>th-</td>
<td>think</td>
<td>j-</td>
<td>judge</td>
<td>ch-</td>
<td>church</td>
<td>j-</td>
<td>judge</td>
</tr>
<tr>
<td>th-</td>
<td>then</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Special attention should be given to the difference between: s, sh, ch and z, j, dz, th as in thin and th as in then. Moreover, f and v are frequently mispronounced by Indian speakers of English, when they say these sounds like the two similar sounding consonants in their mother tongues. Such sounds need special attention on the part of learners.

Activity 3
Identify the difficult consonant sounds of English in the context of your mother tongue.

Check Your Progress 1:
What do you understand by Accent?
How many consonant sounds are there in English?
Identify the consonant sounds in the initial position of the following words:
(a) Cheap  (b) Chef   (c) Photograph  (d) Zip  (e) Those

3.5 THE ENGLISH VOWEL SOUNDS

As the air comes out of the lungs the different shapes of the lips like rounding of the lips and different tongue positions produce vowel sounds. The other articulators are not used. One important feature of English vowel sounds is the difference in the length, some vowels being 'long' and others 'short'. For example, the vowel length of cut and car is different in the sense that 'u' in cut is far shorter than a in car. In the second case you open your mouth fully. In case of the long vowels you round or spread our lips more than in those of the short vowels. There are twelve pure vowels in English and eight diphthongs.

3.5.1 Pure Vowels (Single Vowel Sounds)

We have divided the twelve pure vowels into long and short vowels so that you realize the difference in length amongst them.

1. Long vowels:
(a) The sound of a as in large. Other examples: father, car
(b) The sound of ee as in feel. Other examples: sheep, sea
(c) The sound of oo as in pool. Other examples: move, shoe
(d) The sound of o as in more. Other examples: thought, four
(e) The sound of ir as in bird. Other examples: Shirt, heard.

2. Short vowels:
(a) The sound of u as in cut. Other examples: none, shut
(b) The sound of i as in kill. Other examples: if, build
(c) The sound of u as in pull. Other examples: book, should
(d) The sound of o as in hot. Other examples: cot, gone
(e) The sound of e as in bed. Other examples: red, breath
(f) The sound of a as in man. Other examples: van, flag
(g) The sound of e as in father. Other examples: agree, contain

Note A: The vowel sounds in 1 (e) and 2 (g) do not occur in many Indian languages. Therefore, you should pay special attention to them if they do not occur in your mother tongue.

Note B: You must not also miss the difference in length between the long vowels and the short ones.

3.5.2 Diphthongs

A diphthong is a combination of two vowel sounds pronounced together as a single sound. For example, when you pronounce the word cow there are two vowel sounds that you pronounce together. Here is a list of the diphthongs in English. Pay attention to how the vowel sounds are pronounced. Do not confuse it with the spelling.

1. Kite
2. Soil
3. Here
4. Poor
5. Take
6. Sound
7. Sofa
8. Share

Check Your Progress 3:
1. How many vowel sounds are there in English?
2. What are diphthongs? How many diphthongs are there in English?
3. Identify the vowel sounds in the following words:
   (a) word (b) curd (c) key (d) glad (e) shoot

3.6 STRESS

3.6.1 Word Stress

It is important to know what a syllable is before we start a discussion on stress. A syllable usually
consists of a vowel sound. For example the word boy has got one syllable and be-gin has two syllables: be and gin.

Note, however, that the letters l and n also can be used for forming syllables, as 'l' in the second syllable of little, cattle, etc. and 'n' in the second syllable of cotton, button, etc. If a word in English consists of more than one syllable, one syllable will sound more prominent than any other. The syllable in a word, which is uttered with greater prominence than the others, is called a stressed syllable. Here we will use the symbol [] before the stressed syllable.

Word stress is vital for the intelligibility and the rhythm of English speech. Compare the following:

1. (a) Air India is an international carrier.
   (b) He has a career in management.

2. (a) This copy hasn't been compared with the original.
   (b) Ruby will be the compere of the show tomorrow.

3. (a) It's a personal matter.
   (b) She has a diploma in personnel management.

4. (a) August is not as rainy as July here.
   (b) You shouldn't insult such an august gathering.

The stress is on the first syllable in carrier and it is on the second syllable in career, though the two words sound almost same. The meaning will change if you put the stress on the wrong syllable. In example 4 the word August in (a) and august (b) are pronounced with stress on the first and the second syllable respectively. Though the spelling is the same, the meanings are different.

Look at the following pairs. Here 'v' refers to verb and 'n' refers to noun.
`Desert (n)-De`sert(v), `digest (n)- di`gest (v), `addict (n)- a`ddict (v)

When you use these words and put the stress on the wrong syllable, it will affect the intelligibility of your speech. You might be misunderstood. For example, you cannot put the stress on the second syllable when you use the word addict as a noun in a sentence like, "He is a drug addict".

Here are a few examples of words with stress on:

(a) first syllable- `canvas, `message, `manage, `stupid
(b) second syllable- pre`vent, a`tention, am`bition, re`late
(c) third syllable- after`noon, reha`bilitate, natio`nality, repre`sent

It is difficult to cover all the sounds in the English language by prescribing the rules of word stress. However, some hints are given below to help you to some extent in the matter of word stress.
(i) Many words with two syllables are stressed on the first syllable when they are used as noun or adjective but on the second syllable when they are used as a verb. For example, `subject (N)- sub’ject (V)  `present (N)-  `Present (Adjective)- pre’sent (V)
`insult (N)- in’ sult(V)

(ii) Words ending in -ion, -ious, -eous, -ic, -ics, -ial, -ion, -ental, etc. are stressed on the second syllable from the last. For example, po’sition, re’action, nationali’zation, in’dustrious, con’tinous, eco’nomic, sta’tistics, me’morial, l’italian, environ’mental, etc.

(iii) Words ending in -aire, -eer/ier, ese, ique, -easque, -ee, ette, -self, -selves, are stressed on the last syllable. For example, million’naire, engi’neer, briga’dier, Japa’nese, an’tique, pictu’reisque, ciga’rette, him’self, etc.

Please note that there may be exceptions to these rules. Moreover, there is something called a secondary stress in a word, that is to say, in longer words there may be a syllable in the word which is stressed in a less prominent way than the syllable having the main stress. Therefore to learn word stress you will have to listen to good models of English pronunciation, spoken English, and supplement it with a good English dictionary.

Note: In normal or rapid connected speech, native speakers often pronounce words like am, is, are, was, have, has, had, shall, will, Saint, and, do, can, but, etc. in shortened (contracted forms).

Again, in polysyllabic words a syllable occurring immediately after a stressed syllable may tend to be shortened or ignored. For instance, the word bachelor has three syllables with a vowel sound in each syllable but as the first syllable tends to get ignored and thus a native speaker would reduce the word into one of two syllables only (bach- and -lor). Similarly words like temperature, comparable, lavatory, probably, government, library, February, etc. get reduced in terms of number of syllables in connected speech.

3.6.2 Sentence Stress

A sentence may consist of words having only one syllable (monosyllabic) and words having more than one syllable (polysyllabic). The words having more than one syllable need to be stressed in a more or less fixed way and we cannot take much liberty with them. However, the words in a sentence with only one syllable may or may not be stressed, depending on their importance. For instance, in a sentence like, How could you say such a big lie? All the words have only one syllable. You might put the stress on how, all, big, lie, depending on which of the words you consider important for expressing your intended meaning. Such stressing of monosyllabic words and particularly syllables of polysyllabic words together produce the phenomenon that is called sentence stress.
It may be noted that English sentences are uttered in a rhythmic way and word stress and sentence stress help a speaker of English to speak English rhythmically. Please note in connection with sentence stress that-

**Function words** (personal pronouns, auxiliary verbs, prepositions, articles, conjunctions, verb 'be' together with its different forms) are generally not stressed in a sentence unless you have a special meaning in mind as in the example before. For example, in the sentence you may utter the sentence "How could you say such a big lie?" with stress on "you" as well if you want to emphasize it.

**Content words** (nouns, adjectives, verbs (except 'be'), demonstratives, question words, yes /no/not) are generally stressed. But again it is not obligatory. Depending on the meaning a monosyllabic content word may remain unstressed in a sentence. For instance you may not choose to stress tell in the above sentence, particularly if you choose to stress the word you.

### 3.7 INTONATION

When we speak a language, using different kinds of sentences the pitch of our voice may sometimes rise and sometimes fall. It is such changes in the pitch of our voice that give rise to the phenomenon called intonation. For example, take the sentence,

**Vijay is a doctor.**

If you are making a statement -Vijay is a doctor. - the pitch of your voice will, generally speaking, fall, but when you are turning it into a question, -Vijay is a doctor?- the pitch of your voice will rise. Similarly, when you say 'Yes' with your pitch rising from a lower pitch, it may sound like a question. But if you say 'Yes' with your pitch falling from a higher pitch, it may sound like supporting a statement made by someone.

Apart from the pitch of the voice falling from a higher level to a lower level (falling tone) in a stressed word or a stressed syllable in a word and the pitch of the voice rising from a lower level to a higher level (rising tone), the pitch of the voice may first fall and then rise in the same position (falling-rising tone) and also first rise and then fall (rising-falling tone).

Note: We refrain here from discussing this topic in detail, as intonation cannot be learnt by reading. There should be proper practice with a good teacher who can be a model or by listening carefully to dialogues in films and other audio/visual media or to good audio/visual materials specially designed for this purpose.

**Activity 4**

Recite and read aloud the following with proper attention on pronunciation, stress and intonation. Get the 'feel' of the sentence and put the stress and intonation accordingly.
1. Always aim at complete harmony of thought and word and deed. Always aim at purifying your thoughts and everything will be well. (Mahatma Gandhi)

2. I hate ingratitude more in a man,
   Than lying, vainness, babbling, drunkenness,
   Or any trait of vice whose strong corruption,
   Inhabits our frail blood. (William Shakespeare)

3. The Taj Mahal is a great monument to love.

4. I am sorry to see you like this.

5. I wish it would rain.

6. May I use the phone to make an urgent call?

7. What a lovely sight!

8. Hello! What are you doing here?

9. Did you watch the news today?

10. I will never talk to you again.

Check Your Progress 4: Identify the stressed syllables in the following sentences.
1. I think you could've come, but you didn't come.
2. She has an expensive pen.
3. I don't like being bullied.
4. Your shoes are prettier than hers.
5. You are supposed to do it positively.

## 3.8 BRITISH AND AMERICAN PRONUNCIATION

In section 3.2.1 we have already referred to Standard British English and Standard/General American English. This section is meant to give you an idea of the differences between British and American vocabulary and spelling. We give below a few hints on some differences in pronunciation between the two varieties:

- Stressed vowels are often lengthened more in American English than in British. For instance, the sound of ‘a’ in bad tends to be lengthened in American English, whereas it is a short vowel in British English.

- In American English vowels are often pronounced in a nasalised manner (that is, air is allowed to pass through the nose as well as the mouth at the same time).

- The vowel in the words home, go, so, etc. is essentially a diphthong in British English, but in American English sounds like a single vowel sound similar to o, as we Indians normally say.

- The short vowel sound of ‘o’ as in pot, god, dog, etc. is pronounced like the long vowel sound of a in calm, palm, charm, etc. in American English.

- The usual long vowel sound of a as in British English as in dance, fast, last, glass, after, can't, etc. are pronounced like the pure vowel sound of a as in man, glad, sad, etc. in American English.
The sound ‘r’ is pronounced in Standard British English only before a vowel sound. It is not pronounced after a vowel sound as in over, father, mother, brother, sister, etc, unless it is followed by another vowel sound. However, ‘r’ is pronounced in all positions in a word in American English. Moreover, ‘r’ is pronounced in American English in a slightly different way.

The sound of ‘t’ and d between two vowel sounds become slightly different from the sounds of the letters elsewhere in American English.

Before -u and -ew, the British pronounce t-, d-, d-, and n- like tyu-, dyu- and nyu-. For example, tune, dew, due, news, etc. In American English such words are pronounced without adding the sound y.

But again you are advised to learn such differences in pronunciation of the two varieties by listening to good models, such as the news on BBC (British English) and the news on CNN (American English).

Activity 5
Repeat activity 2 and note down as many differences in the pronunciation of the two varieties as possible.

3.9 Let Us Sum Up

In this unit we tried to break the elements of language firstly into sounds. Secondly, how these sounds are used in words and sentences. Thirdly, we discussed the other features of pronunciation like stress and intonation. If you aspire to be a confident and fluent speaker of English you will have to have thorough knowledge of all the aspects we discussed in this unit. In a nutshell:

- good pronunciation is essential to become a good speaker;
- the sound system of every language is different. English has its own;
- one has to make conscious efforts to overcome the negative influences of one’s mother tongue to acquire a neutral accent;
- knowledge of stress and intonation will enable you to speak English in a rhythmic manner; and
- proper practice and a critical ear are very important to improve your English pronunciation.

Activity 6:
Repeat activity 1. You will find a marked difference in your pronunciation this time. Try to compare the mistakes you listed down now with the ones you did before. Are they same?

3.10 FURTHER READING

UNIT 3 PRONUNCIATION


(3) Dictionaries with accompanying CDs showing both British and American pronunciations. (There are quite a few of them in the market these days.)

3.11 CHECK YOUR PROGRESS: MODEL ANSWERS

Check Your Progress 1

1. Accent is defined as the pronunciation characteristic of a particular group of people relative to another group. It is different from a dialect, which is a variety of a language differing in grammar, vocabulary and pronunciation.

2. Twenty-four

3. (a) ch (b) sh (c) f (d) z (e) th as in then

Check Your Progress 2

1. Twenty

2. A diphthong is a combination of two vowel sounds pronounced together.

3. (a) The sound of *ir* as in *bird*  
   (b) The sound of *ir* as in *bird*  
   (c) The sound of *ee* as in *feel*  
   (d) The sound of *a* as in *man*  
   (e) The sound of *oo* as in *pool*

Check Your Progress 3

1. I `think you could’ve `come, but you `didn’t come.

2. She has an ex`pensive pen.

3. I `don’t like being `bullied.

4. Your `shoes are `prettier than hers.

5. You are su`pposed to do it `positively.

***
UNIT 4 VOCABULARY

4.0 OBJECTIVES

This unit discusses the importance of vocabulary building and the different aspects of vocabulary. Words can be divided into many categories. In this unit we have divided the words into different categories with examples of how they are used. After having studied this unit you should be able to:

- increase your vocabulary;
- know how to increase your vocabulary systematically and in an organized way;
- use your vocabulary intelligently for effective communication.

4.1 INTRODUCTION

Words are a very powerful means of expressing ideas and thoughts. How successful you are in using words effectively will affect your communication skills. Using words effectively does not mean using vague, high-sounding and obscure words in your speech or writing. It means using the right word in the right context and getting the desired result. We have divided the words into different categories with suitable examples so that you get an idea of how words are used in different contexts. It will also give you information about the meaning relationship between words, which will help you in using words appropriately. We have also included a number of activities to help you practice vocabulary building and in the process increase your vocabulary.
4.2 IMPORTANCE OF VOCABULARY BUILDING

In order to express your ideas and thoughts clearly you need a good and appropriate vocabulary. It is indeed very frustrating when you want to say something but cannot express it properly because you do not have enough vocabulary. In such a situation, a low vocabulary is a handicap. Again there are times when you say something but are not aware of the implications of your words. Using the appropriate word is important to get the desired result. You may also end up offending someone if you do not know the proper use of a word.

Remember, you cannot build a good repertoire of words for a second language such as English in a day. It takes time. Read good books, listen to interesting conversations and interviews with famous personalities and practice using new words in the right context. Gradually you will pick up words as you use English more frequently for everyday communication.

Increasing your vocabulary will help you use words properly, appropriately and intelligently. Apart from developing the four language skills, grammar, vocabulary building and pronunciation practice will mean an all-round development of English skills. You cannot speak with a natural flow if you have to stop in between or fumble while trying to think of the right words. Starting with simple words you can slowly increase your vocabulary. With the knowledge of the relationship between words- similar words, opposite words- you will be able to systematize and organize your thoughts in a better way. Often learners fail to use phrases and idioms appropriately in sentences which limit their expression. With a proper knowledge of the usage of idioms and phrases you can be more effective in expressing your thoughts.

4.3 MEANING RELATIONSHIPS

Words can be divided into some categories based on their relationship with other words. Two words may have similar meanings or they may be opposite in meaning. Proper knowledge of the meaning relationship between words will help you use words appropriately in different situations and make your communication more effective.

4.3.1 Synonyms

You will find a lot of English words and expressions that have the same or nearly the same meanings. Such words and expressions are known as synonyms. For example, the words end, terminate, finish and conclude are synonyms in the sense that they are similar in meaning. Similarly, the synonyms of the word loose may be movable, slack, free, inexact, etc. Although synonymous, words may differ in the way they are used in sentences. For example, strong and powerful have nearly the same meaning, but you may say a strong wind but not a powerful wind (see 4.6 collocation). Similarly if we say, "He indulges
in loose talk", the meaning is totally different from "He advocates free speech." We cannot replace 'loose' with 'free' or 'free' with 'loose' in any of the sentences given above.

### 4.3.2 Antonyms

Antonyms are opposite in meaning. You will find innumerable words in English like long/short, wide/narrow, good/bad, clean/dirty, sweet/bitter, etc. Such words that are opposite in meaning are antonyms. Antonyms are generally gradable. We can grade hot/cold in terms of how hot or how cold a thing is by adding -er - hotter/colder. Similarly we can grade other antonyms also by adding -er or 'more'.

### 4.3.3 Polysemy

We have discussed how different words can have similar meanings. In English you will find instances where a single word may have a number of different meanings. For example the word bank may mean

1. a financial institution
2. a synonym for 'rely upon'
3. a river bank

We can use bank as a verb as in "You can always bank upon him" (example 2). In the other two examples it is a noun. The different meanings of polysemous words can be understood from the context in which the word is used.

**Look at the following sentences with light:**

1. I could not read the book as there was no light.
2. I wanted to light a fire.
3. I can carry this box. It is very light.
4. The project was stalled for a year before it saw the light of the day.

If you look at the above examples you will find that the meaning of light is not same in all the four cases. Its meaning in the four sentences are (1) a kind of natural radiation that makes things visible; (2) cause to begin burning; (3) (not heavy); (4) accept it after much difficulty. The meaning in (1) and (4) are somewhat similar but they are different in the other two cases.

This brings us to the concept of knowing the meaning from the context. Contextual meaning is a very important aspect of vocabulary. When you learn a new word it is important for you to know that the word may not mean what you thought it means. It is because the meaning of a word can be derived from the context in which it is used. For example,

(a) I have a cold.
(b) It is very cold.
Here cold has different meanings in both the sentences. In (a) it means illness and in (b) it means low temperature.

Another example in this regard can be,

She has a fair chance of winning.
She is very fair.

Thus, you should be aware of the concept of Polysemy. With a good knowledge of this concept, it will be easier for you to interpret the meaning of a word from the context.

Check Your Progress 1
1. Choose a synonym of the words given in brackets for each sentence from the list below and fill in the blanks.

(a) I would like to _____(replace) this mobile phone I bought yesterday.
(b) She is a ___ (clever) girl.
(c) Why don't you let me _____(worry) about that for you
(d) He _____ (expressed regret) for his behaviour.
(e) I had to stay back as there was a ____ (downpour).

Heavy shower, intelligent, apologize, change, be concerned.

2. Choose the words in A with their antonyms in B.

A                  B
Weary             arrogant
Intelligent       non-refundable
Modest            stupid
Guilty            refreshed
Refund            innocent

3. Look at the set of sentences and the words in italics. Find out the meaning of each italicized word from the dictionary.

(a) I like his attitude towards life.
He looks like his father.

(b) He left his diary at home.
He was sitting on my left.
(c) Let us wind up the session after an hour. 
There was a strong wind blowing from the south.

(d) She was wearing a pink skirt. 
When they asked her about her political connections she skirted the issue.

(e) I like the flavour of ginger. 
She walked gingerly as the baby was sleeping.

4.4 WORD FORMATION

Word formation is a rule applied to form a word by adding something (prefix, suffix, another word, part of a word) to another word (to which nothing has been added or to which something has been already added). For example, -ly is added to friend making it friendly. Again un- can be added to friendly making it unfriendly. Word formation can take place by

- Adding a prefix or suffix to a word
- Conversion
- Compounding

Adding a prefix

Something that is added at the beginning of a word is known as prefix. Adding prefix normally does not change the class of the word to which it is added.

Negative prefixes
un    Examples: unwell
       unwanted
       unsure
in     Examples: incorrect
       incomplete
       inactive
dis    Examples: dislike
       disqualify
       disagree
non   Examples: non-smoker
       non-alcoholic
Preposition-based prefixes

over
Examples: overturn, overpriced

up
Examples: upswing, upgraded

under
Examples: underestimate, underweight

Some other commonly used prefixes are:

sub
Example: submarine

ad
Example: Adjoin

inter
Example: Interrelated

pre
Example: pre-lunch

post
Example: Post-lunch

Adding a suffix

Something that is added at the end of a word is known as suffix. Some commonly used suffixes are: -ness, -ly, -able, -ity, -ise (-ize), ship, hood, etc. When a suffix is added to a word, the word may change or maintain the same class. For example (in the examples N- noun, adj- Adjective, Adv- adverb and V- verb):

1. Nation (nation + -al )

He sacrificed his life for the **nation** (N).

He is an Indian **national** (N).

The prime minister unfurled the **national** (Adj) flag.

Hospital (hospital + -ize)

I went to the **hospital** (N) yesterday.

He had to be **hospitalized** (V) after he suddenly fell ill.

Rely (rely + -able)

You cannot **rely** (V) on technology all the time.

He is a very **reliable** (Adj) person.

Slow (slow + -ly)

He is a **slow** (Adj) learner.

He was asked to drive **slowly** (Adv).
In the above examples some undergo a change of class after suffixation and some do not.

2. Some other suffixes commonly used in English are:

Free
Fancy-free, fat-free

Proof
Soundproof, waterproof

Less
Selfless, effortless

Hood
Childhood, Neighbourhood

Ster
Gangster, Prankster

Ship
Friendship, Leadership

Addition of this type of suffix (list 2) also changes the word-class
Note: Note the suffixes used and the change in the word class in the above (1 and 2) examples.

Conversion
This is a process of word change wherein the words change their class without the addition of a suffix or prefix. For example, the verb walk as in, *He walked from his house to office and He took a walk from his house to office.*

Other such examples are:

He is in *love* with this place.
He *loves* this place.

There is an aquarium in that *corner* of the room.
Can you *corner* the aquarium a bit?
Cover this book.
You should put a cover on this book.

Your dress is very dirty.
Do not dirty your dress.

Compounding
Compounding is a process of combining two words into one. For example,
Playboy
Sunset
Doormat

For enriching your vocabulary you should also keep in mind the following two things:

Shortening a word
Loan words
Words easily confused
Shortening a word

Abbreviation: When are words shortened and their initial letters are used, they are called abbreviations. Some common abbreviations are,

NB: nota bene which means note well.
e.g.: exampli gratia which means for example
WHO: World Health Organization
AIDS: Acquired Immune Deficiency Syndrome

Acronym: Some abbreviations are called acronyms when the abbreviated forms can be pronounced as words. For example: AIDS and WHO

Loan words

You will find a number of words in English that have been borrowed from other languages. Such words are known as loanwords. Some common loanwords are:

Cliché (borrowed from French): a phrase or idea that has been used so often that it no longer has much meaning and is not interesting.

Déjà vu (borrowed from French: the feeling that you have previously experienced something that is happening to you now.
Soiree (borrowed from French): a formal party in the evening. 
Apart from these you will find a number of Indian words in English vocabulary like, raja, pyjama, etc.

**Words and expressions easily confused**

Some words and expressions that are easily confused are:
Continually/ continuously
Intervene/interfere
Effect/affect
Lose/loose
Series/serial
Economy/economical
Outbreak/ broke out
Outlook/ looking out

**Check your progress 2**

1. Match the meaning of the words in A and B

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Under-signed</td>
<td>to study or explain things</td>
</tr>
<tr>
<td>Cross-over</td>
<td>the people whose signatures are put below a text, usually</td>
</tr>
<tr>
<td></td>
<td>at the end of a formal letter</td>
</tr>
<tr>
<td>Over-cast</td>
<td>to make a piece of machinery more powerful.</td>
</tr>
<tr>
<td>Up-grade</td>
<td>covered with clouds</td>
</tr>
<tr>
<td>Go-over</td>
<td>the process of changing from one area of activity or style of</td>
</tr>
<tr>
<td></td>
<td>doing something to another.</td>
</tr>
</tbody>
</table>

2. Give two words each with the following suffixes:

- able
- ship
- ness
- ity
- rich

DOEACC Society Guwahati / Tezpur Centre
4.5 COLLOCATION

Collocation can be defined as the way words occur with one another. For example, we say a *flock of sheep* and not a group of *sheep*. Similarly we do not say "He lifted a point" but "He raised a point."

Below we provide you a list of words that collocate with one another.

1. Verb + object collocation
   I *said* my prayers. (Not: *did* my prayers)
   He *made* a request. (Not: *did* a request)
   He carved a niche for himself. (Not: *cut* a niche for himself)

2. Adjective + Noun collocation
   strained relations (Not: tense relations)
   rotten eggs (Not: stale eggs)
   fierce debate (Not: furious debate)
   good deal (Not: bright deal)
   light drizzle (Not: slight drizzle)

3. Adverb + adjective collocation
   utterly disgusting (Not: totally disgusting)
   totally blind (Not: utterly blind)
   fast asleep (Not: fully asleep)
   extremely happy (Not: totally happy)

4. Some collective words collocation
   herd of cattle
   bunch of keys
   shoal of fish

Check Your Progress 3

Choose the word from the bracket that collocates with the underlined word and fill in the blanks.

1. A _____ (leisurely, casual) walk in the garden refreshes my mind.
2. A _____ (swarm, shoal) of bees were buzzing in the tree.
3. He was _____ (fully, completely) unaware of the happenings in the office.
4. He ____ (did, committed) a heinous crime.
5. He relied ___ (solely, totally) on dictionaries to learn vocabulary.
6. It is a good habit to take a ____ (brisk/brash) walk before breakfast.
7. The doctor asked him not to eat junk food anymore, as it has ____ (spoilt/lowered) his appetite.
8. The death ____ (tally/toll) in the earthquake is supposed to be more than 50,000.

**Check Your Progress 4**

Look at the following sentences. Try to find out the meaning of the words in italics from the context. Consult a dictionary if required.

1. She has every right to cancel the tickets if she does not want to watch the show.
2. Though she went through the book many times, she did not get the answer right.
3. When you reach the library take a right turn.
4. I was standing right next to her when she fainted.
5. Excuse me for a moment. I'll be right back.

**4.6 IDIOMS AND PHRASAL VERBS**

Idioms are expressions with two or more words that have a meaning that is different from the meanings of the individual words. For example, spill the beans means to reveal something. As you can see the meaning of this idiom is different from the meaning of the individual words—spill/beans. However, some association of idea with the idioms and their meanings cannot be denied. Some such idioms are:

- Out of the blue: unexpectedly after a long time
- Last nail in something or somebody's coffin: something that makes the end or failure of an organization
- Fly off the handle: get angry

There are innumerable idioms in English that start with some verbs. For example:

**Call**
- Call it a day:
- Call a spade a spade
- Call the shots

**Pull**
- Pull a fast one
- Pull the rug out from under somebody's feet
- Pull the strings
There are some idioms that are associated with colour terms. For example,
Out of the blue
Green with envy
Go blue in the face
Bolt from the blue
In black and white

Other common idioms in English are the phrasal verbs. Phrasal verb is a group of words with a combination of a verb and a preposition or adverb, or both. For example, give up (verb preposition).

Some common phrasal verbs in English are formed with the verbs make, give, look, take and get. Combining with prepositions or adverbs.

Make
Make out (understand)
Make up (prepare)

Give
Give in (agree, admit, offer for judgment)
Give up (not try, to stop doing something)

Look
Look after (to take care of something or someone)
Look forward to (to fell excited and happy about something that is going to happen)

Take
Take off (succeed, leave, copy)
Take over (start doing a job or something or responsibility that was carried out by someone else before, get control)

Get
Get through (to succeed in talking with someone on the phone)
Get away (to escape from something or somewhere when it is difficult to do so)

A good dictionary will help you immensely in learning phrasal verbs. Look up the main verb in the dictionary to find the meaning of the phrasal verbs and their usage.
4.7 BRITISH AND AMERICAN VOCABULARY

The two chief varieties of English, British and American differ in some ways from each other, though the differences are not very great. In this section we will discuss the differences between these two varieties in vocabulary and spelling.

Vocabulary

<table>
<thead>
<tr>
<th>American</th>
<th>British</th>
</tr>
</thead>
<tbody>
<tr>
<td>automobile</td>
<td>(motor) car</td>
</tr>
<tr>
<td>apartment</td>
<td>flat</td>
</tr>
<tr>
<td>bar</td>
<td>pub</td>
</tr>
<tr>
<td>billboard</td>
<td>hoarding</td>
</tr>
<tr>
<td>cab</td>
<td>taxi</td>
</tr>
<tr>
<td>candy</td>
<td>sweets</td>
</tr>
<tr>
<td>elevator</td>
<td>lift</td>
</tr>
<tr>
<td>faculty</td>
<td>staff</td>
</tr>
<tr>
<td>fall</td>
<td>autumn</td>
</tr>
<tr>
<td>movie</td>
<td>film</td>
</tr>
<tr>
<td>rest room</td>
<td>public toilet</td>
</tr>
<tr>
<td>mail</td>
<td>post</td>
</tr>
<tr>
<td>schedule</td>
<td>timetable</td>
</tr>
<tr>
<td>vacation</td>
<td>holiday</td>
</tr>
<tr>
<td>truck</td>
<td>lorry</td>
</tr>
</tbody>
</table>

Spelling

You will find some differences in spelling between standard British English and General American English. Some of them are:

<table>
<thead>
<tr>
<th>American</th>
<th>British</th>
</tr>
</thead>
<tbody>
<tr>
<td>theater</td>
<td>theatre</td>
</tr>
<tr>
<td>center</td>
<td>center</td>
</tr>
<tr>
<td>labor</td>
<td>labour</td>
</tr>
<tr>
<td>neighbor</td>
<td>neighbour</td>
</tr>
<tr>
<td>dialog</td>
<td>dialogue</td>
</tr>
<tr>
<td>catalog</td>
<td>catalogue</td>
</tr>
<tr>
<td>realize</td>
<td>realize or realise</td>
</tr>
</tbody>
</table>

Note: These are only a few examples. You need to consult a good dictionary to acquaint yourself with the differences.
4.8 WAYS TO BUILD YOUR VOCABULARY

Vocabulary building can be an interesting exercise. The most important thing is to realize how motivated you are to learn new words. If you are happy knowing the words that you keep using in your day-to-day communication and do not wish to build your vocabulary you may not find vocabulary building exercises interesting enough. You should always start by learning the simple words that you require to communicate in English. However, you cannot stop there. You should keep expanding your knowledge of words and use them while communicating. This will help you immensely in making your communication effective and interesting.

Apart from doing vocabulary building exercises found in good vocabulary building books, you should make it a habit to read good English newspapers, magazines, story books and novels on a regular basis. In addition to this, listening to good speakers will also help you in building your vocabulary. (Many people take delight in testing their stock of vocabulary by solving crossword puzzle.)

Activity 1
Take out a news item or editorial from any newspaper. Take out a few words (both familiar and unfamiliar). Write them down in a notebook. Try to find out as many words - synonyms, antonyms, polysemes - as you can for all the words. Look up the unfamiliar words in the dictionary and after knowing the meaning do the same exercise with them.

4.9 LET US SUM UP

Vocabulary building is an integral part of language learning. It helps a learner to become a better communicator. You need good vocabulary to communicate effectively as lack of vocabulary will limit your expression of thoughts and ideas.

Instead of learning new words at random it is better to adopt a systematic approach towards it. Thorough knowledge of different aspects of vocabulary - meaning relations, collocation, contextual meaning, word formation and idioms and phrasal verbs - will help you systematize the exercise of vocabulary building and enable you to use words properly and appropriately. This knowledge with right practice and a good dictionary are the basic requirements of vocabulary building.

4.10 FURTHER READING


3. Wilfred Funk, Six Weeks To Words Of Power, Pocket Books, New York

### 4.11 CHECK YOUR PROGRESS: MODEL ANSWERS

#### Check Your Progress 1

1. 
   - (a) change
   - (b) intelligent
   - (c) be concerned
   - (d) apologize
   - (e) heavy shower

2. 
   - A
     - Weary
     - Intelligent
     - Modest
     - Guilty
     - Refund
   - B
     - refreshed
     - stupid
     - arrogant
     - innocent
     - nonrefundable

#### Check Your Progress 2

1. Match the meaning of the words in A and B

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Under-signed</td>
<td>the people whose signatures are put below a text, usually at the</td>
</tr>
<tr>
<td></td>
<td>end of a formal letter.</td>
</tr>
<tr>
<td>Cross-over</td>
<td>the process of changing from one area of activity or style of doing</td>
</tr>
<tr>
<td></td>
<td>something to another.</td>
</tr>
<tr>
<td>Over-cast</td>
<td>covered with clouds.</td>
</tr>
<tr>
<td>Up-grade</td>
<td>to make a piece of machinery more powerful</td>
</tr>
<tr>
<td>Go-over</td>
<td>to study or explain things</td>
</tr>
</tbody>
</table>

2. Give two words each with the following suffixes:

   - able
     - reachable
     - lovable
   - ship
     - ownership
     - dealership
   - ness
     - fairness
     - kindness
   - ity
     - brutality
     - hospitality
   - rich
     - oil-rich
     - mineral-rich
UNIT 4 VOCABULARY

Check Your Progress 3

(a) leisurely   (b) swarm
(c) completely  (d) committed
(e) solely      (f) brisk
(g) spoilt     (h) toll

Check Your Progress 4

1. something that is correct according to law
2. true/ correct
3. direction
4. exactly
5. immediately

***
5.0 OBJECTIVES

This unit focuses on speaking as a language skill and the areas that you need to take care of to develop this skill. There are a number of sub skills that are involved with speaking. In order to acquire good speaking skills you will have to develop the sub skills as well. After reading this unit you should be able to:

- identify the aspects related to speaking;
- pay adequate attention to the skills required to be developed in order to develop speaking skill; and
- communicate effectively in all the speaking situations

5.1 INTRODUCTION

Speaking is essentially considered to be the most effective skill when it comes to communication. Probably, this is one skill along with listening that we exercise the most. It is also a difficult skill to acquire when a language other than our mother tongue is concerned. There are some other major skills and some sub skills that should be paid attention to in order to develop this skill.

Acquisition of a language cannot be complete unless one is able to speak in that language proficiently.
Most English learners find themselves more at ease with reading and writing than speaking. In this unit we will discuss the key areas related to speaking which will help you identify the areas you need to concentrate in order to develop your speaking skill.

5.2 SPEAKING AS A LANGUAGE SKILL

Speaking features in the second place amongst the four language skills. It is a productive skill, unlike listening, which is receptive. Thus, it is a difficult skill to acquire especially while learning a language other than your mother tongue. However, with right practice and improvement of the key areas related to speaking, it can be easily acquired.

This skill, also known as Oral Communication skill, is often considered to be the most important skill in language learning (though it is to be remembered that equal importance should be given to all the four skills). Speaking is closely related to listening (see unit 2). You learn to speak a language by listening to the language. So in order to develop speaking skill you will have to be a good listener. Reading and writing in English also contributes to developing your speaking skills.

Out of the four language skills, speaking and writing are productive skills while listening and reading are receptive skills. In speaking and writing you have a message, and a sender and a receiver of the message. In the case of speaking the sender is the speaker and the receiver is the listener. While in the case of written communication, the sender is the writer and the receiver is the recipient of the written product. Some people think that writing is more difficult than speaking. However, this is not true. Speaking is as challenging as writing. The most important characteristic in case of speaking is that you do not get enough time to organise your thoughts. The listener cannot wait for you to organise your thoughts and then speak. You have to speak fluently, without unnecessary pauses. This makes speaking a challenging task. There are instances of English learners being good at writing but not as fluent in speaking. They can write something correctly, but when they are asked to say the same thing they may falter. Of course, there are specific areas that need to be dealt with for developing your writing skills as well.

Coming back to speaking, this is a slightly difficult skill especially for learners in India as far as speaking English is concerned. You will not find too many people in India who can speak fluent English in the early stages of learning this language, unless they have a good exposure to English (spoken in schools, at home, in social circles etc).

To become proficient in speaking English we need to understand the problem areas and then identify ways in which we can address those areas.

1. Articulation: Your ability to articulate your thoughts and ideas clearly in unambiguous terms.
2. Pronunciation and diction: The way you pronounce the words in sentence.
3. Use of the right words: Your ability to use the right words to convey your message without fumbling.
4. Pause and emphasis for effect (to convey or emphasise the meaning): Your ability to use significant pauses and emphasis, especially in public speaking, to gain the audience's attention.

5. Accent: The accent in which you speak. For English, it is advisable that you use a neutral accent, that is, without interference of your mother tongue. Do not try to imitate an accent blindly. This hampers your ability to speak fluently as you tend to focus more on getting the accent right instead of focussing on what you have to say.

Activity 1
Do this activity in the classroom or with a group of friends outside the classroom. Imagine you are a team leader in a travel agent company and you have to inform the customers about a new holiday package at discounted rate. Communicate in English. Make sure all the members in the group participate equally. If someone is not being able to participate actively, encourage him or her to speak by seeking his or her opinion throughout the discussion. After the activity is over, analyse whether it was interesting or not. How long did the discussion go on? Who was able to speak more clearly and correctly than the rest of you?

5.3 KINDS OF SPEAKING SITUATION
A good speaker should be able to speak fluently in any situation he or she is in. There are three kinds of speaking situations in which you may find yourself.

- Interactive
- Partially interactive, and
- Non interactive

**Interactive situations** are those situations when you talk to someone on a one-to-one basis with appropriate turn-taking. This situation is very common for all of us. Everyday you face an interactive situation. In such a situation you have a listener, who can be the speaker again with you becoming the listener. Here you will find the listener interrupting you in between, or asking you to clarify or repeat the message while speaking. Examples of this kind of situations are face-to-face conversations and telephone calls.

**Partially interactive** situations are when you speak to a live audience, where the convention is that the audience does not interrupt you when you are speaking. In such a situation you may have to speak according to the reaction of your listeners in non-verbal ways, that is, facial expressions, suggesting keenness, boredom or confusion, body language, etc. ((see unit7). Examples of such situations giving a presentation and a speech.
Non-interactive situations are those situations when you do not interact with the listeners at all. In such a situation the listeners do not have the opportunity to directly interact with you. An example of such a situation is when you record something for a radio or TV programme or when you are reading the news on TV or radio.

Amongst the three situations, the first situation is the most challenging, as it is very rare that in such a situation you can organise all your thoughts and ideas beforehand as you do not know how the speech situation might progress.

In the other two situations you may speak something that you have already thought out in detail and prepare yourself well in advance, as you do not have to interact directly with the listeners.

Activity 2

Do this activity with a friend. Imagine you are a customer who has lost a credit card and your friend is a customer care executive. You are at the office reporting. Your friend asks you for details. Remember that you should not prepare what you will say beforehand. Make it look like a real life conversation.

Check Your Progress 1

1. Do you think speaking is more important than the other language skills? If so, why?
2. What are the three important components in case of speaking or oral communication?
3. Do you think developing the other skills can improve your speaking skill?
4. In which Speaking situation you get very less time to organise your thoughts?

5.4 DEVELOPING SPEAKING SKILLS: THINGS TO REMEMBER

When the listener is listening to you or she expects you to speak clearly, correctly, with good pronunciation and confidently. The image of a good speaker is always that of a speaker with a good voice, good pronunciation and someone who speaks the language accurately (grammatically), using appropriate words. We will be discussing those sub skills that you require to polish in order to be a good speaker. Let us discuss them one by one in brief as we have already discussed them in detail in the previous chapter, though it was done with the perspective of communication in general.

5.4.1 Pronunciation

The listener always expects the speaker to have the correctness of standard pronunciation (see unit 3). You cannot afford to mispronounce words even if you are speaking fluently. Mispronounced words will affect your communication skills. Your speech will be good to listen to when it is spoken rhythmically. Thus, you have to be able to-
Pronounce the English sounds clearly enough so that people can make out the words you are saying.

Do justice to stress, rhythm and intonation of English. Try to speak in a rhythmic way with stress on the right syllables.

Make the important information stand out from the unimportant with appropriate use of sentence stress and voice modulation.

5.4.2 Grammar

Grammatical accuracy is a basic necessity to speak English well, or any language for that matter. How you acquire this will depend on how well you have been able to apply the grammatical rules practically. Thus, in order to speak correct English you have to be able to -

- Use the correct forms of words. This may mean, for example changes in the tense, case or gender.
- Put words together in correct order.
- Make the talk systematic by maintaining cohesion (use of connectors or linking words).

5.4.3 Vocabulary

Remember, using high sounding and obscure words do not make you a proficient speaker. The idea should be to use vocabulary that serves the purpose. You may use simple words and may be successful in putting across your point effectively.

Thus, you have to be able to-

- Use vocabulary appropriately
- Adjust the pitch and loudness of your voice according to the demand of the situation.

5.4.4 Knowledge of the Different Styles

Often the context and the relationship you share with the listener will determine the style you will have to adopt while speaking. You may be required to use formal language in some situations and can be informal in some other situations. Formal language is the type of language we use for purposes like official reports, business letters and academic writing. Formal language is generally used for written communication (for purposes mentioned above). However, it may also be used for writing personal letters. Informal language is the language used for day-to-day communication and is mostly used while speaking. But it is not normally used on occasions like giving a speech in a meeting or other formal occasions where you are required to speak. Here are some examples of a few occasions and the language that may be used while speaking on such occasions:
UNIT 5 SPEAKING

<table>
<thead>
<tr>
<th>Situation</th>
<th>Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Facing an interview</td>
<td>Formal</td>
</tr>
<tr>
<td>Chatting with friends</td>
<td>Informal</td>
</tr>
<tr>
<td>Giving a speech</td>
<td>Formal</td>
</tr>
<tr>
<td>Making a request to your friend</td>
<td>Informal</td>
</tr>
</tbody>
</table>

Activity 3

Do this activity with a friend. Tell your friend about an interview you had. Your friend should be seeking information from you about your experience. It should be a one-to-one conversation with both of you speaking and listening alternately.

Check Your Progress 2

State whether the following statements are true or false. Write T for true and F for false in the spaces provided.

1. Your pronunciation is not a major issue with the listener(s) if you speak fluently. ___
2. You should use vocabulary that serves the purpose and helps you put across your point of view. ___
3. You are a good speaker if your pronunciation is good; you are grammatically accurate but sometimes fail to link your talk properly. ___
4. It is important to keep the context in mind and speak accordingly. _____

Activity 4

Describe your city to the class. You should include information on the roads and streets, educational institutions, places for recreation, industries and how people earn their living in your city. You should also tell the class what you like and dislike about your city.

5.5 LET US SUM UP

Speaking well involves using language effectively in all speaking situations. You can become a good speaker by paying attention to all the details related to speaking skill. However, identifying and understanding the details will not help you much if you cannot practice the related skills properly. Regular practice and using your knowledge of grammar while speaking will help you develop your
The suggestions made in this unit with regard to the areas you need to work on will yield results only when you actually practice them. Please note that in order to develop your speaking skills you will have to listen to good speakers of English as much as possible and communicate in English not only inside the classroom but also outside it.

5.6 FURTHER READING


5.7 CHECK YOUR PROGRESS: MODEL ANSWERS

Check Your Progress 1
1. No, all the four skills are equally important and should be paid adequate attention to.
2. The three important components in speaking or oral communication are: the speaker, listener and the message.
3. Yes. One cannot be a good speaker if he or she is not a good listener. Similarly, reading English books and writing can help in developing your speaking skills.
4. Interactive situation.

Check Your Progress 2

1. F 2. T 3. F 4. T

***
6.0  OBJECTIVES

This unit is designed to introduce you to a very important kind of English that is used for business purpose - Business English. The fact that English is widely used in almost every communicative situation for business purposes has made it an important subject which learners of English should be aware of. After having read this unit you should be able to:

- understand what is Business English
- identify the areas where business English is required
- use Business English in your professional life (both in oral and written communication, wherever required)

6.1  INTRODUCTION

In today’s highly competitive world it is necessary for you to equip yourself with the skills that help you to get ahead in life. From the point of view of language, apart from the other skills that we have already discussed in this book, a discussion on Business English is very important, as you need to be aware of this kind of English, which will help you immensely in developing your career.

What is Business English? How does it fit into the perspective of a learner of English? What kind of
English is used while communicating at the written level for business purposes? These are some of the questions we will be discussing in this unit.

6.2 BUSINESS ENGLISH

6.2.1 Meaning and Definition

We have dealt extensively with the issue of using language effectively for different communicative purposes (See unit 1.2). We will start this discussion as well with this issue. Different situations demand of us to perform differently (in terms of language). So it is quite obvious that when we talk about the world of business we will find a kind of English that is used for business purposes. Though it is to be mentioned that English as a language is not different from Business English. The difference is only at the rate at which some language features of English in terms of sentence structure, grammar and style that suit the purpose in a business situation are used. This kind of English is known as Business English. For instance, in a business situation some English words, sentence structures and styles of English language are more common as they help in getting the desired result. It is to be, however, noted that Business English as such is not as much distinguishable in oral communication as in written communication. In oral communication it may be used to build interpersonal relations, to give presentations, for negotiations, in meetings, etc. In this chapter we will be discussing Business English for effective writing. Good business English is required for writing letters, reports, memos, minutes, etc.

6.2.2 Importance of Business English

With India emerging as a global player in the world of business and trade and multinational companies investing heavily in India, we find corporate houses emerging in great numbers. Thus, we cannot ignore the skills one requires to be successful in the corporate world, as many of you may find yourself with jobs in corporate houses. Apart from the other skills -soft skills, interpersonal skills, academic qualification, technical skills-from the language point of view, you should definitely be aware of the kind of English used in this sector. Awareness of Business English will make you a better communicator in the sense that you can use the kind of English that the (business) situation demands.

A skillful communicator should be will aware of how to use language for different purposes and achieve the desired goal. For instance, you may know how to write a letter but may not be aware of the principles of a good business letter, as you may not know the kind of vocabulary and sentence structures used in such letters. As a result you may not be able to perform at your peak, with misunderstandings and ambiguity hindering your communication process.

Activity 1

Group Discussion: Form a group of eight people. Have a discussion on the topic" Importance of market research before launching a new product". If you are not aware of the subject matter, let every group member know the topic beforehand and try to find out some points on the topic and discuss them the next day. You may choose any topic that suits the business situation for discussion.
Check Your Progress 1
1. What do you understand by Business English? 2. Why do you think this kind of English is used for particular situations? 3. Give two reasons for learners to be aware of Business English.

6.3 WRITTEN COMMUNICATION

6.3.1 Vocabulary
Here it is pertinent to mention the concept of jargon to you. Jargons are special words and phrases which are used by particular groups of people, especially in their work. For example, sue motto, ipso facto, etc. are legal jargons. Jargons when used in a business report cannot be avoided as they form an integral part of the report. So in order to understand such a report you are required to know a few commonly used jargons. However, while writing a business letter the use of jargons and clichés excessively should be avoided, as these will make your letter very technical and dull.

The vocabulary used should be simple, concise and easily comprehensible. Use the word that is most effective to get the desired result. Instead of saying, "The project may not be completed on due date." "The project may be delayed." is a more concise expression.

6.3.2 Grammar
At the level of grammar one of the most important things to remember is the voice of the sentences. Do not use passive voice. You will not be projected as a strong human being if you avoid active voice and use passive voice all the time. For example, instead of saying, "The meeting has been cancelled" say, "We have cancelled the meeting." Another aspect of grammar to be remembered is the use of complex sentences. A better idea will be to use simple and short sentences.

The next point is the use of verbs that indicate actions you want to take and the actions you expect the receiver (of your message) to take instead of rehashing the same with long sentences. For example, instead of saying, "As your last date for bill payment is approaching, you are requested to pay your bill by 28-3-06" you can say, "We request you to pay your bill by 28-3-06. Your last date for bill payment is 28.3.06."

6.3.3 Style
The style followed in writing a business letter or report may vary from country to country. The style may also vary according to the rapport you have with the recipient of your message. However, adopting a **formal style without being impersonal** is a good idea in business communication.
Check Your Progress 2

Below is a news item published in *The Times Of India*. Read it carefully and note down the words that are typical business-situation words.

New Delhi: The government on Thursday said it would continue its war on galloping inflation by easing supply pressures through more liberal import and fiscal regime for cement and metals.

Tight monetary policy and various fiscal sops have failed to contain inflation as it jumped to a record level of 6.73% during the week ended February 3 compared with 6.58% for the previous week.

While the reserve Bank is fighting inflation by tightening the money supply, the government has decided to ban exports of wheat and milk and allowed freer imports of maize. Today, it also cut prices of petrol and diesel.

### 6.4 PRINCIPLES OF A WRITING A BUSINESS LETTER

You will have to develop the art of writing good business letters to communicate effectively at the written level. Almost every one of us has written a letter at some point of our life. A business letter is slightly different from other letters. In today's age of technology, e-mail, a kind of letter sent via the electronic machine also comes under the purview of letter writing. However, we will not discuss letter writing in general but business letters only in this section. We will discuss some principles that are essential for writing a good business letter. Let us start with a quick look at the layout of a business letter.

**Layout**

There is no fixed layout for writing a business letter as different organizations may have their own prescribed layouts to be used in business letters sent from their organization. However, we can discuss a common layout that is generally followed while writing a business letter.

The following things are to be included in a business letter:

- **Letterhead**
  The company's name and full address should be included in this section.

- **Date**
  The date is written before the inside address of the recipient.

- **Inside Address**
  This includes the address of the recipient. The address should include the name and the full address of the recipient.

- **Salutation or Greeting**
  The way you write the salutation depends on the relationship you share with the recipient. If you do not know the gender and name of the recipient it is best to use a neutral, "Dear Sir/ Madame."
UNIT 6 BUSINESS ENGLISH

- Letter Body
  The body of your letter should be clearly written with not more than three paragraphs. The purpose of every paragraph should be clear.

- Closing
  The closing comes after the last paragraph of the letter. The closing again depends on the relationship you share with the recipient and hence the degree of formality.

- Signature
  This comes after the closing. You will have to include your signature, printed name and position (strictly in that order) here.

Reasons for writing business letters
You may need to write a business letter for many reasons. It may be
- to persuade
- to recommend
- to accept/reject offers
- to apologize
- to inform
- to request
- to remind

The language cannot be different just because we are writing a business letter. But there are certain things you should remember while writing a business letter. The language should be very simple and precise. You cannot waste your time by writing things that do not serve the real purpose but makes your letter long and complicated.

Here are some principles you should remember while writing a business letter:
- Start from the end. Figure out the **purpose**. Try to find out the goal you want to achieve through the letter.
- Make a list of the things you have to say and allot a paragraph each to the main points. Add an introductory paragraph and a concluding paragraph.
- Get to the point early. Do not **beat around the bush**! The reader is not interested in reading the plot of a story but the **purpose** of the letter.
- Be logical and coherent in your approach. This will reflect in the way you write the letter.
- Identify the **reader** and your relationship with him or her. You may address the reader with a simple Dear Mr./ Ms/ Miss X (the First and last name) if you are familiar with the person. However, if you are not familiar with him or her, Dear Sir/ Madam will be all right. You are also supposed to write Dear Sir/Madam if you do not know the gender or name of the reader.
- Avoid repetitions.
Avoid camouflaged verbs. For example, "Announcement of the decision made him relieved" is using the noun form of the verb and lacks power. Instead, use "He was relieved to announce his decision."

Use familiar words.

Avoid using vague and abstract words. Always be precise and concrete. Instead of 'immense benefit in all respects' or 'significant gain', it would help if you use '25% gain' or 'benefit in terms of cost, production, performance'.

Use adverbs and adjectives sparingly. Do not be too judgemental or passionate in your use of words. Words like 'breathtaking', 'absolutely', and 'fantastic' are best avoided.

Avoid jargons and clichéd sentences. That will make your letter natural.

Use adjectives appropriately. Do not use them too much neither should you be too stingy in using them. Strike a balance.

Use active voice as much as possible.

Use simple and short sentences. You cannot waste your time by writing things that do not serve the real purpose but makes your letter long and complicated.

End it with what should be the action taken by the reader or you.

Try to be friendly. You should not appear rude in an attempt to be too straightforward. You can be straightforward and friendly at the same time.

Close with a simple and plain closing phrase. "Yours sincerely" or "Sincerely" and your signature can be a good closing phrase.

Take care of the layout and format of the letter.

Never write a business letter in anger. You may regret it later.

Always end it with an action step if required. Do not leave it vague or leave the reader wondering what you expect from him or her.

E-mails

Formatting Business Email

E-mails are more common nowadays than a letter sent by post. The principles to be followed here would remain the same as the ones for a regular business letter. However, you should keep in mind the following things while writing business e-mails:

Use a simple subject line but one that stands out in the pile of incoming mails in the recipient's email box. If you are sending a status report, mention it in the subject line. If you are discussing a point, mention the point in the subject line.
If possible, mark the urgency of the email so that the reader knows the urgency and responds accordingly.

Always check your spelling before sending the email.

When attaching a document, always mention the document name in the body of the letter so that the reader knows what to expect.

Repeat the subject line in the body of the e-mail as it may be lost if the recipient takes out a printout of your e-mail.

Avoid using hyperlinks within the body of the text as it distracts the reader. You may provide links at the end of the letter.

Your typed name should come in place of your signature.

Check Your Progress 3
Look at the business letter below. (Apology for delay in delivery of order) Though it is not a bad business letter there are instances in the letter that does not comply with the principles of a good business letter. Can you find out what they are?

Sarin Brothers Manufacturing Co. Ltd
489, Greenwood Road, Akash Nagar, Mumbai 400 026, Maharashtra, India.

Ms. Samiksha Sharma
Broadway Group
112, Highway Road
Goregaon (E)
Mumbai 400 063

November 26, 2006

Dear Ms Sharma,
This is to inform you that we are unable to make delivery on the purchase order (attached herewith) on the date indicated.

We should have our merchandise ready to dispatch within 10 days of the original delivery date and we hope that you can hold off until that time. We are informing you of this delay in order to give you as much time as possible to make alternate arrangements, if necessary. We can assure you, however, that if your order remains in force we will expedite delivery to you as soon as we have received the merchandise.
We are hopeful that you will understand the issue and bear with us.

Again, thank you for doing business with us.

Yours Sincerely,

Rajiv Saxena
Manager, Sales

6.5 LET US SUM UP

Business English is not a different variety of language altogether. It is the use of some English words, sentence structures and style more frequently than the others. It is generally used in business situations. Today when the need is to learn English not for academic purposes only but to fulfill ones day-to-day needs, it is important to equip oneself with skills that will help you face any situation confidently. Thus awareness of business English is very important, especially in the global context. Use of appropriate vocabulary, sentence structures and style will help you meet the demands of a business situation. Awareness of the strategies to be applied while writing a business letter will be helpful as this kind of letters are different from other letters- personal, social, etc. This unit should definitely help you in giving a general idea of Business English and its use.

Activity 2

Form two groups of four or five members. Imagine that the two groups you formed are two business companies. One group writes a letter to the other group for placing an order. The other group replies in return.

6.6 FURTHER READING

Check Your Progress 1

1. Business English is the kind of English that is used in business situations. It is not a different variety of English but is a special kind of English where certain vocabulary, sentence structures and styles are more frequently used than the others.

2. Every situation puts different demands on us in terms of linguistic performance. Similarly in a business situation it is important to use the appropriate language to get the desired result.

3. The two reasons for learners of English to be aware of this kind of English are:
   - Enable them to perform effectively in any situation including business, which they may encounter as professionals.
   - All-round development of English skills.

Check Your Progress 2

Inflation supply import monetary policy fiscal exports prices

Check Your Progress 3

1. The date has been placed after the inside address.

2. No clear date mentioned for delivery- lack of commitment.

3. Clichéd expression used for closing.

***
UNIT 7 NON-VERBAL COMMUNICATION

Structure
7.0 Objectives
7.1 Introduction
7.2 Non-Verbal Communication
  7.2.1 Definition and Meaning
  7.2.2 Role of Non-Verbal Communication
7.3 Components of Non-Verbal Communication
  7.3.1 Posture
  7.3.2 Gestures
  7.3.3 Facial Expression
  7.3.4 Eye Contact
  7.3.5 Space Distancing
  7.3.6 Personal Appearance
  7.3.7 Paralinguistics
7.4 Let Us Sum Up
7.5 Further Reading
7.6 Check Your Progress: Model Answers

7.0 OBJECTIVES

This unit is designed to raise your awareness of Non-Verbal Communication. As a learner of English you should have a fair idea of non-verbal communication as it plays a vital role in increasing effectiveness of communication. It will help you in speaking English naturally and fluently and increase your confidence while speaking. Many ambiguities are also removed if you can understand the non-verbal cues that accompany a person’s speech.

After going through this unit, you will be able to:

- become aware of the non-verbal cues that accompany any conversation;
- understand the importance of non-verbal communication in developing your communication skills; and
- identify the various components of non-verbal communication and understand their relevance in the communication process.
7.1 INTRODUCTION

We have been discussing the various skills a learner of English should develop in order to become a confident and fluent speaker. A thorough knowledge of non-verbal communication will complement your listening and speaking skills.

You communicate with people throughout the day. You are heard and understood as much by the words you use as by your hand and body movements, your facial expression, your eyes and the tone and pitch of your voice. These are the non-verbal clues that accompany any verbal communication. In this unit you will learn how to interpret these non-verbal clues. You will also come to know about the appropriate use of the various components of non-verbal communication.

7.2 NON-VERBAL COMMUNICATION

Activity 1: Work in pairs. Ask a colleague or peer to conduct a mock-interview with you as a candidate for an important assignment or job. You may take either role—as the candidate or interviewer. During the interview, make a mental note of the gestures, pauses, hand movements, eye movement, pitch and tone of voice used by the other person while speaking and listening. After the interview write down your observations (for example: when he moved his head sideways, he was paying attention/lost interest in the subject/was distracted; when he moved his hands he was emphasizing a point) against each of the non-verbal clues as listed above. Then discuss this with your peer or colleague to find out whether you were right in your observations. Note the non-verbal clues that accompany the following:

1. Calling someone
2. Greeting someone
3. Confused
4. Interested in someone’s speech
5. Nervous
6. Agreeing
7. Disagreeing
8. Surprise
9. Regret
10. Expressing thanks
7.2.1 Definition and Meaning

Non-verbal communication is a system consisting of features that include the non-verbal signals you use to express your thoughts and feelings. You may use your eyes, hands, body movements, face or the tone of your voice along with words to express your thoughts and feelings. In verbal communication you use words; in non-verbal communication you take the help of your hands, eyes, face, and other body movements to express your thoughts. Even the tone and pitch of your voice sends some signals about your speaking abilities. This area of study has of late gained immense importance and interest amongst researchers as its relevance in the communication process is being recognized worldwide.

Knowledge of non-verbal cues helps you in developing your communication skills.

In today’s multicultural and global work environment, it is essential to learn how to decode non-verbal cues for effective communication. Though formal training is given for verbal and written communication and training, it would be risky for a business to ignore the importance of understanding non-verbal communication. When it comes to noticing sadness, anger, irritation, lack of interest, disagreement or enthusiasm, body language and non-verbal cues never lie. If you train your ears and eyes to watch out for them, you will be successful in any communication situation.

Though non-verbal communication is relevant in the context of written communication as well, we will discuss it in the context of oral communication here.

7.2.2 Role of Non-verbal Communication

Non-verbal communication plays a vital role in the communication process. You do not speak with words alone. The movement of your body, your hands, your eyes, face and your appearance also convey some message. Moreover, in today’s global world you should have knowledge of non-verbal communication to avoid any kind of cultural misunderstanding, as some of the non-verbal signals that we send are culture-specific. Non-verbal cues are like words. They can be used as single gestures or as cluster gestures. Single gestures such as nodding the head in agreement is equivalent to saying ‘yes’ while cluster gestures such as keeping your arms crossed, clenched hands, and a serious face is equivalent to being defensive.

According to researchers only 7% of the message is **verbal**, 55% of it is **sent visually** (gestures, postures and other physical movements). The rest of the 38% is **vocal**, i.e., the intonation, pitch and volume of your voice. In a face-to-face situation the audience is not only listening to you but also watching you. You are sending the message verbally (through spoken words) but some amount of it is visual. Imagine this; you are listening to someone who is speaking on an interesting subject. But the speaker
has a feeble voice, is perspiring abnormally, is hardly making any eye contact with the audience, and is wearing garish clothes with flashy colours. Now imagine another speaker who is speaking on the same subject. This speaker has a clear voice, is looking relaxed, makes it a point to look at every person in the audience and is suitably dressed for the occasion. There is no doubt that you will find the second speaker more interesting and impressive.

A good subject and good language may not always click with the listeners if you do not have the right body language and is unable to modulate your voice according to the situation.

Working on body language will help you to handle questions in job interviews, seminars, conferences, social gatherings, official meetings and potentially confronting situations. If you can read the other person well, chances are you will be able to build a rapport with them and communicate better.

Check Your Progress 1:
1. What do you understand by Non-verbal communication?
2. Why do you think Non-verbal Communication is important in the communication process?

7.3 COMPONENTS OF NON-VERBAL COMMUNICATION

7.3.1 Posture

Posture refers to the way you walk, stand and sit. You communicate numerous messages by the way you walk and the position in which you stand and sit. It can reveal your personality—whether you are confident, energetic and full of life, or interactive. It also reflects your state of mind—whether you are nervous, interested, angry, happy, bored etc.

An erect posture indicates confidence and a positive attitude. A person with a slumped posture will be perceived as unenergetic with low spirits. Remember; do not try to change your natural posture drastically as it may make you appear awkward. Just try to improve on the areas where you can.

Different situations demand different postures. For instance, in an interview it is always desirable to sit in a relaxed posture with your arms and legs uncrossed. This posture indicates openness and willingness to learn. On the other hand, a rigid posture with your legs and arms crossed is always interpreted as nervous and defensive, whatever the situation may be. In a classroom situation a teacher may always stand, as it is easier to address the entire class that way.

A speaker should always stand straight with the weight over the instep. The chin should be kept on a parallel line to the floor.
In the course of your speech you may change your posture. It is important to learn the right posture, like where to place your hands and how to change your sitting or standing position, while speaking. People gauge your communication skills and personality by the way you walk, stand, and sit and your other body movements.

### 7.3.2 Gestures

Gestures refer to the movement of your hands, arms, head or legs to express a feeling. They are a natural part of our speech. Using your hands to reinforce what you say is a very natural phenomenon. Sometimes you may use only gestures to express something. It is quite common when you agree or disagree with someone like nodding or shaking your head. Waving and shaking hands are also very common gestures.

Some gestures like pointing the index finger in a heated argument is a negative gesture. Clenched hands are often interpreted as a sign of nervousness or over confidence and should be avoided, especially in an interview. Open palms, uncrossed arms and a firm handshake indicate openness, friendliness and confidence. Gestures like scratching your neck or head may mean you are confused and should be strictly avoided while communicating in a formal situation. Such gestures also distract the attention of the audience from your speech.

**Gestures are not the same around the world. They are very culture-specific.** For example, the 'thumbs up' sign is a positive gesture in most parts of the world including India. But in a country like Australia it means an 'insult'. Another such example is the gesture we use by bringing the tips of our thumb and index finger to form an 'O'. In most countries it means 'very good'. But it has a different connotation in Brazil where it means 'insult'.

For effective communication you should practice the right gestures and avoid gestures that convey negative messages.

### 7.3.3 Facial Expression

A person's mind can be read from his or her face. Facial expressions like a smile, a frown, raising your eyebrows can send positive or negative signals. Unlike other features like gesture that have geographical significance, facial expressions are universal. A smile always sends positive signals like friendliness and openness. It is such an important tool for effective communication that experts ask professionals dealing with customers to smile even when they talk on the phone as it gets reflected in your speech. On the other hand, a frown or a fixed expression sends negative signals. You will always love to listen to someone who has got a smile on his or her face. But when you talk to a person with a frown or an expressionless face it does not contribute much to the communication process.
7.3.4 Eye Contact

As the old saying goes, eyes are "windows to the soul and door to most relationships". Eye contact or the lack of it can make the difference between a successful conversation and a failed one. In a situation where there is more than one listener, stress is laid on continuous eye contact with all of them. Making eye contact with only one listener may lead to reduced interest on the part of the other listeners as they may feel ignored. A good speaker always looks (or at least seems to look) at each and every person in the audience and not on the ground or ceiling or the walls. If you look at something else rather than the listeners you may be perceived as someone with low self-confidence. It also serves as a tool to measure your performance. You can gauge their interest level depending on whether they are making eye contact with you or not.

7.3.5 Space Distancing

This area of non-verbal communication refers to the distance shared between the speaker and the listener. Every speaker maintains a personal territory and does not like that space to be invaded while communicating. Different situations demand different space distancing. It is also determined by the relationship you share with the listener.

Space distancing is very culture-specific. Inadequate knowledge of this area may create confusion and misunderstanding in today's global world.

You can divide the space that you and the listener should maintain while communicating, into three categories: personal zone, social zone and public zone. The distance that should exist between you and the listener in the three categories are:

- Personal zone- 0.5 to 1.2 m
- Social zone- 1.2 to 3m
- Public zone- 3 m

7.3.6 Paralinguistics

When you speak, the tone, pitch and the volume of your speech give some cues to the listener. A listener who is listening attentively can tell what state of mind you are in: whether you are in a pleasant mood, interested in the subject, bored, irritated, nervous or passionate about what you are discussing. Such non-verbal cues have become crucial to understanding how communication works. This area of study is known as paralinguistics. Paralinguistics is the science of vocal cues like tone, pitch, volume, modulation and the rate of speech. We can judge the level of confidence, mood and educational background of a speaker from the tone, volume, accent and pitch of one's voice. If you have a feeble
voice with a diffident tone you will be immediately perceived as a nervous speaker with low level of confidence. It is always advisable to speak with a low pitch, with appropriate pauses and emphasis on the right words.

Learners of a language should pick up the paralinguistic aspects of the new language to be able to speak like the native speakers.

### 7.3.7 Personal Appearance

55% of the message you send is visual. The first impression created in the minds of the listener is based on your physical appearance. Even before you utter a word your appearance will make an impression in the minds of the listeners. Your personal appearance is a part of your overall personality. A good personality helps in becoming a good communicator. If you wear garish clothes, have unpolished shoes and report for a formal presentation with disheveled hair, the impression may not be favourable to you.

Certain situations demand that you dress appropriately. Keep in mind the cultural nuances when you prepare to dress for an occasion, whether it is a funeral of a colleague, a farewell party, an office party, a formal dinner or a business meeting. Wear clothes that suit the occasion. Here are some tips:

- If you are at a loss about what to wear, it is advisable to be conservative.
- Never overdo the makeup and jewellery, no matter what the occasion.
- You need not be fashionable; just make sure your clothes are clean and well-ironed.
- Dress smart.
- Polished shoes, sober colours, well brushed hair and a good deodorant are important to make a good impression.

### Check Your Progress 2

1. You have just studied the various components of Non-Verbal Communication. Name them with one example each.
2. Here are a few non-verbal clues. Say whether they communicate a positive or negative message. Write P for positive and N for negative in the spaces provided after each clue.
   1. walking with a slumped back ______
   2. erect posture with body weight evenly distributed on both legs. ______
   3. pointing one's index finger in an argument ______
3. Below you can see two columns. Column A consists of examples of Non-verbal communication. Column B consists of its components. Match the examples with the components.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Handshake</td>
<td>Posture</td>
</tr>
<tr>
<td>2. Smile</td>
<td>Gesture</td>
</tr>
<tr>
<td>3. Standing</td>
<td>Paralinguistics</td>
</tr>
<tr>
<td>4. Intonation</td>
<td>Facial expression</td>
</tr>
<tr>
<td>5. Walking</td>
<td></td>
</tr>
</tbody>
</table>

Activity 2

Many aspects of non-verbal communication are culture-specific. Here is a list of some situations that visitors may encounter in some countries. Can you guess what kind of gestures and posture will accompany them?

1. Greeting someone in Japan
2. Thanking someone in England
3. Greeting someone in India in the traditional way
4. Departing after a formal meeting in America
5. Greeting a colleague or friend in America
6. Greeting a group of visitors from Saudi Arabia

7.4 LET US SUM UP

To sum up, non-verbal cues determine how others perceive us and receive our messages when we communicate. Some of these cues are seen and heard in a face-to-face situation; some are heard even when we speak over the telephone. They directly affect your communication skills, as they are natural accompaniments of your speech.

**Developing a greater sensitivity to non-verbal cues can help you interpret others’ thoughts and feelings, which is very important to build interpersonal relations.** It is also an effective tool to judge your own competence and performance. Knowledge of non-verbal communication will take you a step forward towards the refinement of your listening and speaking skills.
7.5 FURTHER READING


7.6 CHECK YOUR PROGRESS: MODEL ANSWERS

Check Your Progress 1

1. Non-verbal Communication is a system consisting of features that include the non-verbal signals we use to express our thoughts and feelings. It includes all the body movements, hand movements, eyes, facial expression and the intonation and volume of our voice which express some feelings and emotions.

2. Non-verbal communication reinforces and aids what we say. It helps in making our speech more effective. Inappropriate body language or other nonverbal clues can send a wrong message and thus affect our communication.

Check Your Progress 2

1. The components of non-verbal communication are:
   (a) Posture
      Example: leaning forward while sitting
   (b) Gesture
      Example: nodding
   (c) Facial Expression
      Example: Frown
   (d) Eye contact
Example: Eye contact

(e) Paralinguistics

Example: intonation

(f) Personal appearance

Example: Attire

2. (a) N
   (b) P
   (c) N
   (d) P
   (e) P

3. 1. Handshake : Gesture
    2. Smile : Facial expression
    3. Standing : Posture
    4. Intonation : Paralinguistics
    5. Walking : Posture

***
Learning Material for ITES

I.T. SKILLS
Chapter 1

Introduction to ITES/ Call Centre
Introduction

It is difficult to imagine that by outsourcing something like finance, procurement, information technology, or human resources that firms can increase their revenue but it's true. It may be indirect but by improving the businesses focus, by stripping away non-core activities biotech and technology firms can improves their ability to focus on revenue generating activities. This matters all the more if you are competing on the international stage.

The term outsourcing gained common acceptance in the 1980s and is still used today to describe a relationship with an outside service provider for work traditionally done in-house. The important distinction between an outsourcing deal and any other business relationship is that in outsourcing, control of the process is determined not by the client, but by the supplier. The client dictates what it wants to gain from the relationship, but it is left to the supplier to set the strategy to accomplish the implementation and delivery.

Firms usually from developed countries outsource such services to countries like India, China and Philippines in order to gain from large talent pool and low labor cost. This method of outsourcing was mainly seen as giving most benefit in the technology departments of organizations. Latterly, with the technology outsourcing (ITO) market becoming more mature in the developed countries like UK, USA, Germany and others, Business process outsourcing, or BPO, has come to the notice of one and all in the policy making and control boards of the organizations.

About ITES

Information technology enabled services, or ITES, is a form of outsourced service which has emerged due to involvement of IT in various fields such as banking and finance, telecommunications, insurance, etc. Some of the examples of ITES are medical transcription, back-office accounting, insurance claim, credit card processing and many more. This is also called BPO or Business Process Outsourcing.

The terms IT Enabled Services (ITES) and Business Process outsourcing (BPO) are used interchangeably now days. ITES is basically a subset of BPO. If process that is outsourced involves use of Information Technology it is called ITES else it just Business process outsourcing.

What is BPO?

Business Process outsourcing (BPO) is the delegation of an intensive business process to an outside service provider who owns administers and manages it according to a defined set of metrics. Business-process outsourcing is generally for back-end administrative functions that are necessary to run a business but are not a part of the core business.

BPO is a more comprehensive, or business process oriented, approach. Instead of outsourcing along traditional functional lines, the scope of the services covered
by the deal cuts across the organization in a more holistic way. Generally, BPO contracts are seen as being more inclusive, covering a great deal of process redesign work, redeployment and retraining of the people transitioned to the supplier, and almost always includes the information technology that enables and supports the business process. The goal is to provide an even greater opportunity for generating innovation, speed to market and shareholder value through this more integrated approach.

Companies are now increasingly outsourcing their Finance & Accounting functions followed by Human resource (HR) outsourcing. The evolution of IT services outsourcing in the Indian banks started from the basic level of annual maintenance contracts (AMCs) around 10-12 years ago and from there the IT services outsourcing curve in the banking segment has presently moved on to the level of Facilities Management (FM).

BPO industry has grown mainly due to the business of catering towards services to foreign clients mainly based in USA & Europe. But with recession setting the world over, the profitability margins have decreased tremendously, thus causing consolidation in the industry. Since a client out source’s more than one service, it makes sound business sense to offshore it from a single concern. Thus the players in the industry are versatile, offering a gamut of services to their clients.

Private banks like ICICI Bank, HDFC Standard Life, UTI and ABN-Amro and government banks like SBI and Punjab National Bank are now looking at business process management (BPM) to increase returns on investment, improve customer relationship management (CRM) and employee productivity.

For, these entities sustaining long-term customer relationship management (CRM) has become a challenge with almost everyone in the market with similar products.

A BPM system involves workflow automation, data imaging and features of enterprise application integration wherein the business processes, tasks and procedural steps of an organization are defined, analyzed and integrated, thus providing a framework for the organization to deliver its (business) solutions.

BPO deals have seen a huge increase in both their size and frequency over the past year. In the HR outsourcing market, 2001 saw an increase of 65 per cent year-on-year. One look in any business or consulting publication gives the same view; outsourcing is going to explode in popularity over the next 24-36 months.

Corporations need to bring outsourcing to the fore. With increased competition and in difficult markets for exporters, concentrating on core activity becomes ever more vital. Outsourcing deals offer corporations the virtuous cycle of decreasing costs, increasing EBITDA (Earnings Before Interest, Tax, Depreciation and Amortization) and the subsequent increase in shareholder value.
What constitutes BPO?

BPO deals mainly with non-core processes of an organization. Some of these processes have been briefly explained below.

- **Administrative support:** Outsourcing of administrative support functions includes data entry, document conversion, forms processing, document scanning, indexing, secretarial tasks support, etc.
- **Customer relationship management:** Customer service outsourcing includes outsourcing of functions such as customer support, order taking, customer service, product support, technical help desk, collections and market research. Refer to the report on Customer Service Outsourcing for more details.
- **Document processes:** Document process outsourcing includes outsourcing of customer facing, technical, marketing and communications, financial accounting, and regulatory compliance documents.
- **Finance and accounting:** Finance and accounting outsourcing includes services such as internal auditing, time and expense management, travel expenses, credit and debt analysis, collections, invoicing, accounts payable, accounts receivable and billing-dispute resolution.
- **Human resources and training:** Human resources (HR) is one of the most critical assets of a company and companies need to carry out various tasks such as recruitment, training, attrition/retention, database management, contract-worker management, etc., for their employees. Carrying out these tasks through an internal HR department is costly and diverts the attention of the management from its core business issues. Hence, companies are now resorting to HR outsourcing big time.
- **Intellectual property research and documentation:** Outsourcing in intellectual property research and documentation includes filing and drafting of patent applications, prior art research, licensing support, and patent portfolio analysis.
- **Legal services:** Legal process outsourcing (LPO) involves consulting, research, transcription, documents management, billing, translation and other administrative and secretarial support services required for various legal functions such as commercial litigation, arbitration and mediation, appeals, government contracts, legal risk evaluation, etc.
- **Medical transcription:** Medical transcription is writing down medical records dictated by physicians and other healthcare professionals. These records include patient history and physical reports, clinic notes, therapeutic procedures, clinical course, diagnosis, prognosis, discharge summaries, etc.
- **Payroll maintenance and other transaction processing:** This segment includes payroll, payment, check, credit card and stock trade processing. Forester research predicts transaction processing to be a large segment within the BPO industry soon, with a market size of USD 58 billion in 2008. Some vertical processes such as mortgage, loans and insurance claims processing are also being outsourced.
- **Product development:** Companies need to constantly innovate to remain competitive in the market. With the increasing specialization of expertise required to carry out product development, companies choose to outsource their R&D functions to vendors who have expertise in a given field. Over the past few years, numerous MNCs have initiated off shoring R&D to other countries including India which is emerging as a hub for R&D outsourcing.
• **Publishing:** Publishing outsourcing involves outsourcing of publishing functions such as book design, book digitization, e-publishing, drawings and graphics, indexing, journal administration, etc.

• **Research and analysis:** Companies require data and its analysis for making informed strategic decisions. These companies have started outsourcing their research and analysis requirements to vendors who specialize in typical research and analysis work such as data analytics, financial analytics, market research, secondary research, primary research, industry overview, competitive intelligence, etc.

• **Sales and marketing (including telemarketing):** Sale and marketing outsourcing involves delegating parts of sales and marketing functions such as cold calling, email pitches, telephone surveys, lead generation, lead qualifying, appointment setting, sales team management, etc.

• **Security:** Companies have to search for new technologies and employ qualified security professionals to keep their data secure from theft. Maintaining these resources and implementing a fool-proof security policy is a difficult task which can be better handled by experienced third party security agencies. Security outsourcing involves management of investigative services, physical security, electronic security systems, computer and network security, etc.

• **Supply chain management:** Outsourcing in supply chain management involves logistics, procurement, warehouse management, contract management, supply chain relationship management, etc.

**BPO Trends**

The BPO industry is a developing sector and is being studied by analysts and researchers all over the world. Analysts tracking BPO have observed the following trends in the industry:

• The BPO market worldwide is expanding with new services getting added to the list of business processes that are outsourced and new locations coming up as potential offshore destinations, India being the most preferred destination for offshore BPO.

• Cost savings is one of the most important drivers now. Information security, execution capability and financial stability are important considerations while selecting a vendor.

• According to reports from international data corporations and various other related agencies, customer care and logistics are mature segments, while procurement and training are emerging markets and are expected to have a growth of more than 10 percent in the next five years.

• It has been observed that the latest trend of offshore in sourcing, in which firms establish their own offshore captive centers. These captive centers are generally shared service centers and allow the firms to retain control over the processes.

**BPO Business Models**

Over the years, different models have been used for conducting business in BPO. The regular outsourcing models of on-shoring, near-shoring and off shoring are seen in BPO
as well. Sourcing advisories, have observed that in addition to on-shoring, near-shoring and off shoring, BPO operations are also conducted through the following three business models:

- **Transactional BPO:** Transactional BPO handles one aspect of a process only. The customer has to carry out a significant part of the process in-house and hence the customer owns the risk of the process. Also, outsourcing many aspects of the process in a transactional mode leads to complex fragmentation which can pose as a threat to productive delivery.

- **Niche BPO:** A niche BPO carries out 3-4 aspects of a process. A niche BPO, which also makes certain investments in the customer's process, aims at improving the efficiency of the process. The vendor in a niche BPO works in close coordination with the buyer, sometimes seeking the services of the customer's employees. Both the vendor and the buyer share the risk of the process.

- **Comprehensive BPO:** A comprehensive BPO handles both transactional and administrative tasks in a process and takes 70 percent responsibility of the output. The vendor purchases the buyer's assets and also hires most of its employees. Comprehensive BPO has bulk deals lasting for 7-10 years.

**Types of BPO Services**

BPO services are generally categorized into horizontal and vertical services. These have been explained below:

1. **Horizontal BPO:** Horizontal BPO involves function centric outsourcing. The vendor specializes in carrying out particular functions across different industry domains. Examples of horizontal BPO are outsourcing in procurement, payroll processing, HR, facilities management and similar functions. Automatic Data Processing (ADP) is an example of a horizontal BPO vendor. ADP focuses on providing services in horizontal functions such as payroll, HR, benefit administration, tax solutions, etc. However, according to Gartner, companies should focus on providing vertical services as the market matures.

2. **Vertical BPO:** A vertical BPO focuses on proving various functional services in a limited number of industry domains. Healthcare, financial services, manufacturing and retail are examples of vertical BPO domains. EXL Service Holdings is a vertical BPO having focus on industry domains such as healthcare, business services, utilities and energy and manufacturing.
**Table 1: Horizontal and Vertical BPO**

<table>
<thead>
<tr>
<th>Vertical Outsourcing</th>
<th>Horizontal Outsourcing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recruitment</td>
<td>Sales</td>
</tr>
<tr>
<td>Identify open position</td>
<td>Identify customer</td>
</tr>
<tr>
<td>Search candidates</td>
<td>Obtain order</td>
</tr>
<tr>
<td>Conduct interviews</td>
<td>Deliver product</td>
</tr>
<tr>
<td>Select new hire</td>
<td>Receive payment</td>
</tr>
<tr>
<td></td>
<td>Send payment</td>
</tr>
<tr>
<td></td>
<td>Process A</td>
</tr>
<tr>
<td></td>
<td>Process B</td>
</tr>
<tr>
<td></td>
<td>Process C</td>
</tr>
<tr>
<td></td>
<td>Process D</td>
</tr>
</tbody>
</table>

**BPO PROCESSES BEING OUTSOURCED- A CLASSIFICATION**

1. Inbound customer Services
2. Outbound customer Services
3. Imaging technology
4. Billing Service Provider
5. Financial Services (Banking, Finance & Insurance)
6. Transaction Processing
7. Accounts Processing
8. Training Services  
9. Application-led Services  
10. Technical Help Desk  
11. Email management, web chat and web collaboration  
12. HR Processing  
13. Depository participant Services

**BPO Best Practices**

With time, every industry starts following certain best practices as it develops and matures. The best practices followed in the BPO industry include:

- Companies outsource critical but non-core business processes that are not strategic to the firm's vision.
- An inefficient process is not outsourced to a third party vendor without any re-engineering.
- Companies gather support from its employees before taking the outsourcing plunge. The first step towards this is early communication of the outsourcing decision to the employees and even the shareholders.
- Sourcing advisors are consulted for negotiating a deal.
- Vendor is selected based on various criteria such as quality commitment, cost, transparency of operations, data security, etc.

**BPO Drivers and Inhibitors**

The advantages offered by outsourcing in general are valid for BPO as well, and these advantages act as internal drivers for BPO. In addition to these internal drivers, companies are lured to choose the BPO option due to the following external drivers:

- **Robust IT and telecommunications infrastructure:** The developments in IT and telecommunications infrastructure has enabled companies to transfer data to any place in the world instantaneously at very little cost. This infrastructure also allows them to increase their ROI(Return on Investment) and shareholder value.
- **Pressure to lower costs:** Companies are facing huge competition from their competitors to provide better services, and at the same time lower their costs. Companies are constantly innovating the way they are conducting businesses and BPO allows them to partner with external specialized vendors for efficient operations. Offshore BPO is cheaper than onshore BPO and many companies are now moving their operations to offshore locations, India being the most preferred destination.
- **Little infrastructure for automation:** The IT revolution has not achieved success in automating business processes and most of the business processes still need human labor for productive delivery. In such a scenario, resorting to BPO, which provides human labor at a lower cost, enables companies to maximize their ROI.

The perceived risks of outsourcing act as a big inhibitor for BPO. Some of these risks have been described below:
- **Loss of control**: Companies perceive the risk of losing control over the operations of their processes. Also, if the (trained) employees in the vendor firm leave the job, the buyer may be at risk.
- **Financial instability of the vendor**: If the vendor becomes financially unstable in some years, the buyer will have to search another vendor; the operations being at risk, if it does not search the new vendor fast.
- **Loss of expertise**: Customers may lose the expertise and knowledge of carrying out the outsourced processes with time.
- **Data security**: Data confidential to the customer may be prone to theft if the vendor firm does not have stringent security policies.

**What is Call Center?**

A Call Center is an Information Technology Enabled Service, which acts as an access point to the customers of the enterprise. A call center is traditionally defined as a physical location where calls are placed, or received, in high volume for the purpose of sales, marketing, customer service, telemarketing, technical support or other specialized business activity.

Call centre are highly complex operations, in many ways a microcosm of a business in one building. They have People, Process, Technology, Customers, Buildings and Facilities. To setup a Call centre often requires significant investment - commanding multi-million pound budgets when 50 or more staff are involved.

Call Centers can be classified on the basis of- location, nature of call, ownership, technology and type of service offered. Call Centers can be classified as Voice based or Web based call centers based on access media used.

In a voice based call center telephone network (PSTN-Public Switched Telephone Network) is used, whereas in the case of a web based call center the customer will access the call center using the Internet.

The concept of call centers is thus giving way to "contact centers".

Call centers are also called as "Helpdesk", "customer care centers," "support centers," in view of increasing importance and functionalities of the call centers.

Call centers evolved around 30 years ago, in the travel and hospitality industry. Call centers gained acceptance, once companies learned that service is the key to attracting and maintaining customers. Companies started using call centers to improve their customer relationships, to learn more about their customers, and therefore serve them better. Call centers have thus evolved from cost centers to profit centers.

GE set up an in-house international Call Center in 1983 in Gurgaon near New Delhi for its global customers and marked beginning of the Indian Call Center Industry. Later large number of fortune 500 companies relocated their call center operations to India. India's call center industry accounts for a quarter of all...
software and services exports from the country and Indian call centers employ 160,000 professionals. (Source- Nasscom)

- In a Call Center the software used depends on the technology used and the application run in the call center. In addition to following software, many utilities and tools are used for the smooth functioning of a call center.
- Network Operating System
- CTI (Computer Telephone Integration) software
- Groupware
- CRM software

Groupware is technology designed to facilitate the work of groups. This technology may be used to communicate, cooperate, coordinate, solve problems, compete, or negotiate. While traditional technologies like the telephone qualify as groupware, the term is ordinarily used to refer to a specific class of technologies relying on modern computer networks, such as email, newsgroups, videophones, or chat.

Groupware technologies are typically categorized along two primary dimensions:

1. Whether users of the groupware are working together at the same time ("realtime" or "synchronous" groupware) or different times ("asynchronous" groupware).
2. Whether users are working together in the same place ("colocated" or "face-to-face") or in different places ("non-colocated" or "distance").
Chapter 2

Introduction to Computer Fundamentals
Basics of Computer

A Computer mainly consists of:

**OS** Operating System (e.g. DOS, Windows 3.1, Windows 95, Windows 98, Windows NT, Novell NetWare, OS/2, SCO Unix, Banyan Vines, ..)

**ROM** Read-Only Memory

**BIOS** Basic Input Output System

**CPU** The microchip or Central Processing Unit

Byte and bits

Just as a word is made up of letters, a byte is made up of bits. While words have a variable number of letters, all bytes have eight bits. A bit represents a positive or negative electric charge. The computer interprets these electric states as either the digits 0 (negative charge) or 1 (positive charge). These are the only two digits the computer can understand. Because of this, computers work on a binary number system, instead of the decimal system we are used to. The word bit stands for binary digit.

The computer interprets the negative and positive electric charges as binary digits (bits), and groups eight bits together. The sequence of the eight 1s and 0s identifies one byte from another. There are 256 different possible 0-1 combinations the eight bits can make (2 to the power of 8 = 256), and so a computer can identify 256 different characters. This is a sufficient number to represent all of the uppercase and lowercase letters of the alphabet, the digits 0-9, all the punctuation marks, a symbol used by the computer for a space, special characters such as * and I, other symbols used specifically by the computer, and still leave plenty of possible symbols for future uses.

- 8 bits = 1 byte
- 1,024 bytes = 1 kilobyte (KB)
- 1,024 kilobytes = 1 megabyte (MB)
- 1,024 megabytes = 1 gigabyte (GB)
- 1,024 gigabytes = 1 terabyte (TB)

Peripheral Component Interconnect (PCI)

(PCI) A standard for connecting peripherals to a personal computer, designed by Intel and released around Autumn 1993. PCI is supported by most major manufacturers including Apple Computer. It is technically far superior to VESA's local bus. It runs at 20 - 33 MHz and carries 32 bits at a time over a 124-pin connector or 64 bits over a 188-pin connector. An address is sent in one cycle followed by one word of data (or several in burst mode).

Accelerated Graphics Port (AGP)

A bus specification by Intel which gives low-cost 3D graphics cards faster access to main memory on personal computers than the usual PCI bus.

- It dynamically allocates the PC's normal RAM to store the screen image and to support texture mapping, z-buffering and alpha blending.
- Intel has built AGP into a chipset for its Pentium II microprocessor AGP cards are slightly longer than a PCI card.
- It operates at 66 MHz, doubled to 133 MHz, compared with PCI's 33 Mhz.
- It allows for efficient use of frame buffer memory, thereby helping 2D graphics performance as well.
- It provides a coherent memory management design which allows scattered data in system memory to be read in rapid bursts.

**Computer Terminology**

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>State-of-the-art</td>
<td>Any computer you can't afford</td>
</tr>
<tr>
<td>Obsolete</td>
<td>Any computer you own</td>
</tr>
<tr>
<td>Microsecond</td>
<td>The time it takes for your state-of-the-art computer to become obsolete</td>
</tr>
<tr>
<td>Keyboard</td>
<td>The standard way to generate computer errors</td>
</tr>
<tr>
<td>Mouse</td>
<td>An advanced input device to make computer errors easier to generate</td>
</tr>
<tr>
<td>Floppy</td>
<td>The state of your wallet after purchasing a computer</td>
</tr>
<tr>
<td>Portable Computer</td>
<td>A device invented to force businessmen to work at home, on vacation, and on business trips</td>
</tr>
<tr>
<td>Disk Crash</td>
<td>A typical computer response to any critical deadline</td>
</tr>
<tr>
<td>Power User</td>
<td>Anyone who can format a disk from DOS</td>
</tr>
<tr>
<td>System Update</td>
<td>A quick method of trashing ALL of your software</td>
</tr>
</tbody>
</table>

**CPU**

A computer is a complex system consisting of many different components. But at the heart -- or the brain, if you want -- of the computer is a single component that does the actual computing. This is the Central Processing Unit, or CPU. In a modern desktop computer, the CPU is a single "chip" on the order of one square inch in size. The job of the CPU is to execute programs.

A program is simply a list of unambiguous instructions meant to be followed mechanically by a computer. A computer is built to carry out instructions that are written in a very simple type of language called machine language. Each type of computer has its own machine language, and it can directly execute a program only if it is expressed in that language. (It can execute programs written in other languages if they are first translated into machine language.)
When the CPU executes a program, that program is stored in the computer’s main memory (also called the RAM or random access memory). In addition to the program, memory can also hold data that is being used or processed by the program. Main memory consists of a sequence of locations. These locations are numbered, and the sequence number of a location is called its address. An address provides a way of picking out one particular piece of information from among the millions stored in memory. When the CPU needs to access the program instruction or data in a particular location, it sends the address of that information as a signal to the memory; the memory responds by sending back the data contained in the specified location. The CPU can also store information in memory by specifying the information to be stored and the address of the location where it is to be stored.

Microprocessor History

A microprocessor -- also known as a CPU or central processing unit -- is a complete computation engine that is fabricated on a single chip. The first microprocessor was the **Intel 4004, introduced in 1971**. The 4004 was not very powerful -- all it could do was add and subtract, and it could only do that 4 bits at a time. But it was amazing that everything was on one chip. Prior to the 4004, engineers built computers either from collections of chips or from discrete components (transistors wired one at a time). The 4004 powered one of the first portable electronic calculators.

The first microprocessor to make it into a home computer was the **Intel 8080, a complete 8-bit computer on one chip, introduced in 1974**. The first microprocessor to make a real splash in the market was the Intel 8088, introduced in 1979 and incorporated into the IBM PC (which first appeared around 1982). If you are familiar with the PC market and its history, you know that the PC market moved from the 8088 to the 80286 to the 80386 to the 80486 to the Pentium to the Pentium II to the Pentium III to the Pentium 4. All of these microprocessors are made by Intel and all of them are improvements on the basic design of the 8088. The Pentium 4 can execute any piece of code that ran on the original 8088, but it does it about 5,000 times faster!

The following table helps you to understand the differences between the different processors that Intel has introduced over the years.

<table>
<thead>
<tr>
<th>Name</th>
<th>Date</th>
<th>Transistors</th>
<th>Microns</th>
<th>Clock speed</th>
<th>Data width</th>
</tr>
</thead>
<tbody>
<tr>
<td>8080</td>
<td>1974</td>
<td>6,000</td>
<td>6</td>
<td>2 MHz</td>
<td>8 bits</td>
</tr>
<tr>
<td>8088</td>
<td>1979</td>
<td>29,000</td>
<td>3</td>
<td>5 MHz</td>
<td>16 bits, 8-bit bus</td>
</tr>
<tr>
<td>80286</td>
<td>1982</td>
<td>134,000</td>
<td>1.5</td>
<td>6 MHz</td>
<td>16 bits</td>
</tr>
<tr>
<td>80386</td>
<td>1985</td>
<td>275,000</td>
<td>1.5</td>
<td>16 MHz</td>
<td>32 bits</td>
</tr>
<tr>
<td>80486</td>
<td>1989</td>
<td>1,200,000</td>
<td>1</td>
<td>25 MHz</td>
<td>32 bits</td>
</tr>
<tr>
<td>Pentium</td>
<td>1993</td>
<td>3,100,000</td>
<td>0.8</td>
<td>60 MHz</td>
<td>32 bits, 64-bit bus</td>
</tr>
<tr>
<td>Pentium II</td>
<td>1997</td>
<td>7,500,000</td>
<td>0.35</td>
<td>233 MHz</td>
<td>32 bits, 64-bit bus</td>
</tr>
<tr>
<td>Pentium III</td>
<td>1999</td>
<td>9,500,000</td>
<td>0.25</td>
<td>450 MHz</td>
<td>32 bits, 64-bit bus</td>
</tr>
<tr>
<td>Pentium 4</td>
<td>2000</td>
<td>42,000,000</td>
<td>0.18</td>
<td>1.5 GHz</td>
<td>32 bits, 64-bit bus</td>
</tr>
</tbody>
</table>
THE CPU SPENDS ALMOST ALL ITS TIME fetching instructions from memory and executing them. However, the CPU and main memory are only two out of many components in a real computer system. A complete system contains other devices such as:

- A hard disk for storing programs and data files. (Note that main memory holds only a comparatively small amount of information, and holds it only as long as the power is turned on. A hard disk is necessary for permanent storage of larger amounts of information, but programs have to be loaded from disk into main memory before they can actually be executed.)
- A keyboard and mouse for user input.
- A monitor and printer which can be used to display the computer's output.
- A network interface that allows the computer to communicate with other computers that are connected to it on a network.
- A scanner that converts images into coded binary numbers that can be stored and manipulated on the computer.

The list of devices is entirely open ended, and computer systems are built so that they can easily be expanded by adding new devices. Somehow the CPU has to communicate with and control all these devices. The CPU can only do this by executing machine language instructions (which is all it can do, period). So, for each device in a system, there is a device driver, which consists of software that the CPU executes when it has to deal with the device. Installing a new device on a system generally has two steps: plugging the device physically into the computer, and installing the device driver software. Without the device driver, the actual physical device would be useless, since the CPU would not be able to communicate with it.

A computer system consisting of many devices is typically organized by connecting those devices to one or more busses. A bus is a set of wires that carry various sorts of information between the devices connected to those wires. The wires carry data, addresses, and control signals. An address directs the data to a particular device and perhaps to a particular register or location within that device. Control signals can be used, for example, by one device to alert another that data is available for it on the data bus. A fairly simple computer system might be organized as: Now, devices such as keyboard, mouse, and network interface can produce input that needs to be processed by the CPU. How does the CPU know that the data is there? One simple idea, which turns out to be not very satisfactory, is for the CPU to keep checking for incoming data over and over. Whenever it finds data, it processes it. This method is called polling, since the CPU polls the input devices continually to see whether they have any input data to report. Unfortunately, although polling is very simple, it is also very inefficient. The CPU can waste an awful lot of time just waiting for input.
All modern computers use multitasking to perform several tasks at once. Some computers can be used by several people at once. Since the CPU is so fast, it can quickly switch its attention from one user to another, devoting a fraction of a second to each user in turn. This application of multitasking is called timesharing. But even modern personal computers with a single user use multitasking. For example, the user might be typing a paper while a clock is continuously displaying the time and a file is being downloaded over the network.

Memory Basics
If your computer's CPU had to constantly access the hard drive to retrieve every piece of data it needs, it would operate very slowly. When the information is kept in memory, the CPU can access it much more quickly.

As you can see above, the CPU accesses memory according to a distinct hierarchy. Most data goes in random access memory (RAM) first. The CPU then stores pieces of data it will need to access, often in a cache, and maintains certain special instructions in the register.

All of the components in your computer, such as the CPU, the hard drive and the operating system, work together as a team, and memory is one of the most essential parts of this team.

- You turn the computer on.
- The computer loads data from read-only memory (ROM) and performs a power-on self-test (POST) to make sure all the major components are functioning properly.
- The computer loads the basic input/output system (BIOS) from ROM. The BIOS provides the most basic information about storage devices, boot sequence, security, Plug and Play (auto device recognition) capability and a few other items.
The computer loads the **operating system** (OS) from the hard drive into the system's RAM. Generally, the critical parts of the operating system are maintained in RAM as long as the computer is on. This allows the CPU to have immediate access to the operating system, which enhances the performance and functionality of the overall system.

When you open an **application**, it is loaded into RAM. To conserve RAM usage, many applications load only the essential parts of the program initially and then load other pieces as needed.

After an application is loaded, any **files** that are opened for use in that application are loaded into RAM.

When you **save** a file and **close** the application, the file is written to the specified storage device, and then it and the application are **purged from RAM**.

### Memory Types

RAM chips used to be sold as individual chips, but today several RAM chips are soldered together onto a plug-in board called a module. This RAM module is called a **SIMM** (Single In-line Memory Module). SIMMs come in three basic designs: an older design that has 30 connector pins, a newer design that has 72 connector pins, and the newest design that has 168 connector pins (also called SDRAM). Each computer is designed to use one or the other of these SIMM designs, but today most all computers use the 72 pin design.

SIMMs come in several different speeds. The most common speed is called 70 nanoseconds (ns). The rule in RAM is the lower (or smaller) the nanosecond number, the faster the RAM will operate. Therefore, a 60 ns SIMM is faster than a 70 ns SIMM. The new SDRAM has a speed of 10ns, which is 6 times faster than the fastest 72 pin SIMMS. All Pentium II and most new Pentium computers incorporate **SDRAM**.

Several new memory technologies seek to close the gap between processor and RAM performance. The goal is to increase the chips’s speed and widen the bandwidth with which they communicate with the processor. The players include double data rate RAM, or DDRAM (also known as SDRAM II), SLDRAM, Direct RDRAM (aka Direct Rambus) and Concurrent RDRAM (aka Concurrent Rambus). Of these, **Direct Rambus**, endorsed by Intel, offers the greatest speed improvements, moving the peak bandwidth from SDRAM’s 125MBps to an astounding **1.6GBps**.

When you think about it, it’s amazing how many **different types of electronic memory** you encounter in daily life. Many of them have become an integral part of our vocabulary:

- RAM
- ROM
- Cache
- Dynamic RAM
- Static RAM
- Flash memory
- Memory sticks
- Volatile memory
- Virtual memory
- Video memory
- BIOS
• SIMM
• DIMM
• EDO RAM
• Rambus
• DIP

**Double Data Rate (DDR) SDRAM:** DDR is rated by its speed or potential bandwidth

- PCI1600/DDR200 - 1.6 Gbps throughput, 200 MHz bus
- PCI12100/DDR266 - 2.1 Gbps throughput, 266 MHz bus
- PCI2700/DDR333 - 2.7 Gbps throughput, 333 MHz bus

**Buffer** (To move data into a temporary storage area)

A temporary storage area, usually in RAM. The purpose of most buffers is to act as a holding area, enabling the CPU to manipulate data before transferring it to a device.

Because the processes of reading and writing data to a disk are relatively slow, many programs keep track of data changes in a buffer and then copy the buffer to a disk. For example, word processors employ a buffer to keep track of changes to files. Then when you save the file, the word processor updates the disk file with the contents of the buffer. This is much more efficient than accessing the file on the disk each time you make a change to the file.

Note that because your changes are initially stored in a buffer, not on the disk, all of them will be lost if the computer fails during an editing session. For this reason, it is a good idea to save your file periodically. Most word processors automatically save files at regular intervals.

Another common use of buffers is for printing documents. When you enter a PRINT command, the operating system copies your document to a print buffer (a free area in memory or on a disk) from which the printer can draw characters at its own pace. This frees the computer to perform other tasks while the printer is running in the background. Print buffering is called spooling.

**Cache**

Pronounced cash, a special high-speed storage mechanism. It can be either a reserved section of main memory or an independent high-speed storage device. Two types of caching are commonly used in personal computers: memory caching and disk caching. A memory cache, sometimes called a cache store or RAM cache, is a portion of memory made of high-speed static RAM (SRAM) instead of the slower and cheaper dynamic RAM (DRAM) used for main memory. Memory caching is effective because most programs access the same data or instructions over and over. By keeping as much of this information as possible in SRAM, the computer avoids accessing the slower DRAM.

Some memory caches are built into the architecture of microprocessors. The Intel 80486 microprocessor, for example, contains an 8K memory cache, and the Pentium
has a 16K cache. Such internal caches are often called Level 1 (L1) caches. Most modern PCs also come with external cache memory, called Level 2 (L2) caches. These caches sit between the CPU and the DRAM. Like L1 caches, L2 caches are composed of SRAM but they are much larger.

Disk caching works under the same principle as memory caching, but instead of using high-speed SRAM, a disk cache uses conventional main memory. The most recently accessed data from the disk (as well as adjacent sectors) is stored in a memory buffer. When a program needs to access data from the disk, it first checks the disk cache to see if the data is there. Disk caching can dramatically improve the performance of applications, because accessing a byte of data in RAM can be thousands of times faster than accessing a byte on a hard disk.

When data is found in the cache, it is called a cache hit, and the effectiveness of a cache is judged by its hit rate. Many cache systems use a technique known as smart caching, in which the system can recognize certain types of frequently used data. The strategies for determining which information should be kept in the cache constitute some of the more interesting problems in computer science.

Different Types of RAM

**DRAM**
Dynamic random access memory. Comes in 80, 70, or 60 nanosecond (ns) speed. The lower the number, the faster the memory.

**CDRAM**
Cached RAM (invented by Mitsubishi Electronics). It combines an SRAM cache with 4 or 16 MB of DRAM within a single chip. This onboard SRAM can be used as both a cache or a buffer and gives the RAM an approximate 15 ns access time.

**EDRAM**
Enhanced DRAM (developed by Ramtron International Corp. of Colorado Springs). Like CDRAM also incorporates an on-chip SRAM cache.

**EDO RAM**
Extended Data Out RAM is a form of DRAM that works by extending the time during which data can be read from memory. Provide from 4 to 15 per cent greater performance than standard DRAM.

**RDRAM**
Rambus DRAM (Toshiba and Samsung). It's similar to SDRAM, but faster,

**SRAM**
Static RAM. Is powered once and doesn't need to be continually refreshed, unlike dynamic RAM.

**SDRAM**
Synchronous DRAM (from Texas Instruments) has its timing synchronized to the system clock. Is about 10 per cent faster than EDO RAM.

**Video memory types:**

**SGRAM**
Synchronous graphics RAM is a form of DRAM for graphics controllers and printers. According to Fujitsu, produces data bandwidth up to five times that of standard DRAM.

**VRAM**
Video RAM. Co-called "dual port" memory types that allow the graphics processor to read from memory and redraw the screen simultaneously.
WRAM

Window RAM (developed by Samsung Electronics) is both faster (50 percent performance increase) and less expensive than VRAM.

HARD DRIVES

Following are the points which are to be considered when hard drive comes into picture

Speed

Your computer’s central processing unit (CPU) spends a lot of time waiting for your much slower hard drive to catch up. While operations inside the CPU are timed in nanoseconds (one billionth of a second), your hard drive operations are limited to mere milliseconds. Although considered very fast by human standards, a millisecond is actually 1,000,000 (one million) times slower than a nanosecond. Comparing the speed of your CPU to your hard drive is like comparing a Ferrari to a turtle.

So when you're loading your favorite word processor, for example, your CPU will have to wait until your hard drive can access all of the necessary data and load it into RAM (which also operates in nanoseconds), before it can proceed and give you a blinking cursor, at which point you're ready to type away.

Inside

A hard drive is made up of several unique components. The most popular of these components are the platters and the read/write heads. The platters are disc-shaped, usually made out of aluminum or glass. Unlike the flexible media in floppy diskettes, these platters cannot bend or flex, which is where the term hard disk comes into play. Another popular term to describe a hard drive is fixed disk, which is derived from the fact that the platters are fixed firmly in place and are not removable.

Physically, the operation of a hard drive is similar to a floppy diskette drive: the discs spin while the heads move over them to store or read data in tracks and sectors. Hard drives contain multiple platters with two sides each, where data is stored. For every platter, there is a read/write head, all of which move across the discs at the same time since they are all connected to one arm.

Although it is these heads that are responsible for writing data to the discs, they will never actually come into physical contact with the platters. These heads are kept suspended by an extremely thin cushion of air, and thereby float just a fraction of a millimeter above or below the platter. If dust or other small particles ever get into this part of the drive, it would easily be enough to cause the head to come into contact with the platter and do physical damage to it. Also, if a sufficiently large shock were to be applied to the drive while under power, the force could be enough to cause the heads to go crashing into the spinning platters and once again causing physical damage to the drive, not to mention data loss. This is know as a "head crash."
Partitions

Every file you store on a hard drive relies on some kind of file addressing system to organize all your data. Among PC’s, the most common file system is known as **FAT (File Allocation System)**. Windows 95 uses a modified version of FAT called **VFAT (virtual FAT)**, which adds support for long filenames. Windows NT supports both FAT, and its own **NTFS** format. NTFS is the most advanced file system. It allows access to partitions up to 16 PB (petabyte) in size. [Equal 16 million terabytes - 16 followed by 18 zeroes]. Each file system must organize data into segments called clusters. Under the FAT file system, the maximum size of any one cluster is 32KB (32,768 bytes). The maximum number of these clusters is limited to 65,536. When you multiply these two numbers, you come up with what has come to be termed the **"2.1GB barrier,"** referring to the maximum number of bytes that can be allocated on the drive.

Keep in mind that every file on your hard drive must occupy at least one cluster. This means that if you had a tiny batch file which was 156 bytes long, the FAT system would automatically allocate an entire cluster to that file, despite the fact that it’s so small. What a waste of space.

Microsoft later created **FAT32** to support partitions larger than two gigabytes and pathnames greater that 256 characters. It also allows more efficient use of disk space since clusters are four kilobytes rather than 32 kilobytes.

Input device

A hardware device that sends information into the CPU. Without any input devices a computer would simply be a display device and not allow users to interact with it, much like a TV. Below is a listing of different types of computer input devices.

- Digital Camera
- Keyboard
- Microphone
- Mouse
- Scanner
- Webcam

Digital camera

A type of camera that stores the pictures or video it takes in electronic format instead of to film. There are several features that make digital cameras a popular choice when compared to film cameras. First, the feature often enjoyed the most is the LCD display on the digital camera. This display allows users to view photos or video after the picture or video has been taken, which means if you take a picture and don’t like the results, you can delete it; or if you do like the picture, you can easily show it to other people. Another nice feature with digital cameras is the ability to take dozens, sometimes hundreds of different pictures. Below is a picture of the Casio QV-R62, a 6.0 Mega Pixel digital camera used to help illustrate what a digital camera may look like. Digital cameras
have quickly become the camera solution for most users today as the quality of picture they take has greatly improved and as the price has decreased. Many users however are hesitant in buying a digital camera because of the inability of getting their pictures developed. However, there are several solutions in getting your digital pictures developed. For example, there are numerous internet companies capable of developing your pictures and send you your pictures in the mail. In addition, many of the places that develop your standard cameras film now have the ability to develop digital pictures if you bring them your camera, memory stick, and/or pictures on CD.

**Joystick**

A peripheral input device that looks similar to a control device you would find on an arcade game at your local arcades. A computer joystick allows an individual to easily navigate an object in a game such as navigating a plane in a flight simulator. The image below is an image of the Logitech Freedom 2.4 joystick and is an example of what you would expect most computer joysticks to look like.

**Keyboard**

One of the main input devices used on a computer, a PC’s keyboard looks very similar to the keyboards of electric typewriters, with some additional keys. Below is a graphic keyboard with indicators pointing to each of the major portions of the keyboard.

Finally, today most users use the QWERTY style keyboards. Below is a graphic illustration of where each of the keys are on a U.S. QWERTY style keyboard.

<table>
<thead>
<tr>
<th>QWERTY KEYBOARD</th>
</tr>
</thead>
<tbody>
<tr>
<td>~ ! @ # $ % ^ &amp;</td>
</tr>
<tr>
<td>Tab Q W E R T Y U I O P { [ ] }</td>
</tr>
<tr>
<td>Caps A S D F G H J K L : ; ” , Enter</td>
</tr>
<tr>
<td>Shift Z X C V B N M &lt; , &gt; ? / Shift</td>
</tr>
<tr>
<td>Ctrl Alt Ctrl Ctrl</td>
</tr>
</tbody>
</table>

DOEACC Society Guwahati/Tezpur Centre
HANDY KEYS. Before that Windows key (the one with the Windows logo in the lower left of the keyboard) gets rusty for lack of use, look at all the handy things it will do for you: By itself, it displays the Start menu. With D, it minimizes or restores all Windows, with E it displays the Windows Explorer, with Tab it cycles through active applications on your taskbar, and with F it displays the find function for all files. Use it with F1 to display Help, with R to display the Run command, and with Pause/Break for the System Properties dialog window. With Shift + M, the Windows key will undo minimizing all Windows, and with Ctrl + F it will display the find: computer dialog window. All these work on at least Windows 98 and XP operating system and you can experiment on the others as you please.

MOUSE WHEEL REVISITED. That wheel on your mouse (if you have one) can be useful with Internet Explorer. With the Ctrl key depressed, moving the wheel forward or backward resizes the font. With the Shift key depressed, the wheel moves you backward or forward to other sites visited in the current browsing session.

You can open a menu by holding the Alt key and typing the first letter of the menu title. For example, pressing Alt + E opens the Edit menu. You can also press either Alt or F10 to activate the menu bar, then use the right and left arrow keys to highlight a menu name, and press Enter to open the highlighted menu.

WINDOW + M - Have you ever wanted to get to your Desktop screen fast, but found yourself closing applications with your mouse? Try this shortcut, which instantly minimizes all open windows and returns you to the desktop in one quick jump. (The WINDOW key is the one between CTRL and ALT.)

WINDOW + E - This launches an instance of Windows Explorer, a very handy program for file management. Use this shortcut instead of running through the Start > Programs > Accessories > Windows Explorer route.

SHIFT + CTRL + ARROWS - This shortcut is very handy for selecting text in HTML or text editors. Rather than highlighting with a mouse, this will quickly grab text one word at a time from the cursor position

Shortcut Keys

<table>
<thead>
<tr>
<th>Cut: Ctrl &gt; X</th>
<th>Copy: Ctrl &gt; C</th>
<th>Paste: Ctrl &gt; V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo: Ctrl &gt; Z</td>
<td>Select All: Ctrl &gt; A</td>
<td></td>
</tr>
<tr>
<td>F10 - goes to menu mode</td>
<td>Enter - opens</td>
<td>Esc - Cancels</td>
</tr>
<tr>
<td>Ctrl &gt; Tab or Ctrl &gt; Shift &gt; Tab (in Properties) - Switches between properties tabs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alt &gt; Space Bar - open application central box</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alt &gt; Enter - switch from icons to editing mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alt &gt; Tab - to switch between running programs</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Microphone

Sometimes abbreviated as *mic*, a **microphone** is a hardware peripheral that allows computer users to input audio into their computers.

### Mouse

An input device that allows an individual to control a mouse pointer in a graphical user interface (GUI). Utilizing a mouse a user has the ability to perform various functions such as opening a program or file and does not require the user to memorize commands, like those used in a text-based environment such as MS-DOS. Below is a picture of a Microsoft IntelliMouse and is an example of what a mouse may look like.

### Optical scanner

Hardware input device that allows a user to take an image and/or text and convert it into a digital file, allowing the computer to read and/or display the scanned object. A scanner is commonly connected to a computer USB, Firewire, Parallel or SCSI port.

### Web cam

A camera connected to a computer or server that allows anyone connected to the Internet to view still pictures or motion video of a user. The majority of web cam websites are still pictures that are frequently refreshed every few seconds, minutes, hours, or
days. However, there are some sites and personal pages that can supply streaming video for users with broadband.

The image below is a picture of the Logitech QuickCam Express and an example of what a web cam may look like. Today, most web cams are connected to the USB or Fire wire port on a computer.

- There are millions of web cams around the world that allow you to view other people, places, and even events. If you're interested in looking at web cams, click here to open a search for web cams.

**Output device**

Any peripheral that receives and/or displays output from a computer. Below are some examples of different types of **output devices** commonly found on a computer.

- Monitor
- Printer
- Sound card
- Speakers
- Video card

**Monitor**

1. Also called a **video display terminal (VDT)** a **monitor** is a video display screen and the hard shell that holds it. In its most common usage, monitor refers only to devices that contain no electronic equipment other than what is essentially needed to display and adjust the characteristics of an image.

2. To view or watch over someone or something.

**Different Monitors available depends on arrays of pixels**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>Video Graphics Array</td>
<td>640 x 480</td>
</tr>
<tr>
<td>SVGA</td>
<td>Super VGA</td>
<td>800 x 600</td>
</tr>
<tr>
<td>XGA</td>
<td>eXtended Graphics Array</td>
<td>1024 x 786</td>
</tr>
<tr>
<td>SXGA</td>
<td>Super XGA</td>
<td>1280 x 1204</td>
</tr>
<tr>
<td>UXGA</td>
<td>Ultra XGA</td>
<td>1600 x 1200</td>
</tr>
<tr>
<td>QXGA</td>
<td>Quad XGA</td>
<td>2048 x1536</td>
</tr>
</tbody>
</table>
**Printer**

An external hardware device responsible for taking computer data and generating a hard copy of that data. Printers are one of the most used peripherals on computers and are commonly used to print text, images, and/or photos. The image below is a visual example of the Lexmark Z605 Inkjet printer and is an example of what a printer may look like.

**Types of printers:**

- Dot Matrix printer
- Inkjet printer
- Laser printer
- Thermal printer
- LED printer

**Sound card**

Also known as a sound board or an audio card, a sound card is an expansion card or integrated circuit that provides a computer with the ability to produce sound that can be heard by the user.

1. A term used to describe the user who is giving a software program vocal commands.

A hardware device connected to a computer’s sound card that outputs sounds generated by the card.

**Video adapter**

Also known as a graphics card, video card, video board, or a video controller, a video adapter is an internal circuit board that allows a display device, such as a monitor, to display images from the computer. Below is an example image of the ATI Radeon 9600 AGP video card; most video cards today resemble the picture shown below.
Storage devices

A storage device is a hardware device designed to store information. There are two types of storage devices used in computers; a 'primary storage' device and a 'secondary storage' device.

Primary storage device

A storage location that holds memory for short periods of times. For example, computer RAM is an example of a primary storage device.

Secondary storage device

A storage medium that holds information until it is deleted or overwritten. For example, a floppy disk drive or a hard disk drive is an example of a secondary storage device.

FDD

A Floppy Disk Drive, or FDD for short, is a computer disk drive that enables a user to easily save data to removable diskettes. Although 8” disk drives were the first real disk drives, the first widely used an floppy disk drives were the 5 1/4” floppy disk drives, which were later replaced with 3 1/2” floppy disk drives. However, today because of the limited capacity and reliability of floppy diskettes many computers no longer come equipped with floppy disk drives.

Hard disk

Rigid circular disk located inside a computer hard disk drive. The term hard disk is often used as an abbreviation to hard disk drive

MAINTENANCE GUIDE

Things to Do

...Every Day

- Update your virus and spyware definitions: Viruses spread within hours, so keeping your antivirus software up-to-date is essential.
- Do an incremental backup: Making a copy of files that have changed since your last full backup is quick and easy.
- Reboot when programs crash: Failed applications can cause other programs to falter. Restart your system after every crash to clear it out.

...Every Week

- Perform a full virus and spyware scan: Find anything nasty hiding on your system by regularly scheduling a total scan.
- Do a complete backup: Better safe than sorry. A backup of all of your data will help you recover if your drive fails.
Run Windows Update: Get the latest patches from Microsoft to secure your system, by running this from the Start menu.

Run a spyware-and-adware removal program: Quickly find and remove sneaky spyware.

Every Month

- Update your programs: To make your apps more stable, check for vendors’ software updates or visit a site such as Version Tracker (www.versiontracker.com).
- Check for new drivers: Installing the latest drivers for your devices can help speed up and stabilize your PC.
- Use one of utility-diagnostic checkup program.

…Every Year - call a technician

- Clean out your PC case: Use a vacuum cleaner to carefully clear out the dust that collects in a case and can clog up the fans.
- Spring-clean your programs: If your PC seems sluggish and bloated, make a full backup and then use the restore CD to return the system to its original state.
- Conduct a full diagnostic check: A hardware-diagnostic program can test your equipment and track down faulty components before they fail completely.

Introduction to OS

Whenever Computer is discussed, Operating System (OS) comes into the picture, We can say that OS is the heart of computer without which it can’t work.

What is an Operating System?

The 1960’s definition of an operating system is “the software that controls the hardware”. However, today, due to microcode we need a better definition. We see an operating system as the programs that make the hardware useable. In brief, an operating system is the set of programs that controls a computer. Some examples of operating systems are UNIX, Mach, MS-DOS, MS-Windows, Windows/NT, Chicago, OS/2, MacOS, VMS, MVS, and VM.

Controlling the computer involves software at several levels. We will differentiate kernel services, library services, and application-level services, all of which are part of the operating system. Processes run Applications, which are linked together with libraries that perform standard services. The kernel supports the processes by providing a path to the peripheral devices. The kernel responds to service calls from the processes and interrupts from the devices. The core of the operating system is the kernel, a control program that functions in privileged state (an execution context that allows all hardware instructions to be executed), reacting to interrupts from external devices and to service requests and traps from processes. Generally, the kernel is a permanent resident of the computer. It creates and terminates processes and responds to their request for service.
Objectives of Operating Systems

Modern Operating systems generally have following three major goals. Operating systems generally accomplish these goals by running processes in low privilege and providing service calls that invoke the operating system kernel in high-privilege state.

- To hide details of hardware by creating abstraction
- To allocate resources to processes (Manage resources)
- Provide a pleasant and effective user interface

Thus, purpose of an operating system is to organize and control hardware and software so that the device it lives in behaves in a flexible but predictable way.

Operating System Types

As computers have progressed and developed so have the types of operating systems. Below is a basic list of the different types of operating systems and a few examples of Operating Systems that fall into each of the categories. Many computer Operating Systems will fall into more than one of the below categories.

**GUI** - Short for Graphical User Interface, a GUI Operating System contains graphics and icons and is commonly navigated by using a computer mouse. See our GUI dictionary definition for a complete definition. Below are some examples of GUI Operating Systems.

- System 7.x
- Windows 98 and above
- Windows CE

**Multi-user** - A multi-user Operating System allows for multiple users to use the same computer at the same time and/or different times. See our multi-user dictionary definition for a complete definition for a complete definition. Below are some examples of multi-user Operating Systems.

- Linux
- Unix
- Windows 2000

**Multiprocessing** - An Operating System capable of supporting and utilizing more than one computer processor. Below are some examples of multiprocessing Operating Systems.

- Linux
- Unix
- Windows 2000
**Multitasking** - An operating system that is capable of allowing multiple software processes to run at the same time. Below are some examples of multitasking operating systems.

Unix  
Windows 2000

**Multithreading** - Operating systems that allow different parts of a software program to run concurrently. Operating systems that would fall into this category are:

Linux  
Unix  
Windows 2000

**Introduction into Microsoft Windows**

Microsoft is GUI, multiuser, multithreading, multitasking OS. It is computer's operating system that makes the usage of computer user-friendly and flexible as per requirement of the user to run all your programs. Windows 98 stores files in items called *Folders* on different *Drives*.

**Main Keywords Associated With Microsoft Windows**

- **Drives**  
  - Drives are devices used to store data. Most computers have at least two drives: a hard drive C:\ (which is the main means of storage) and a floppy drive (which stores smaller volumes of data (1.44 Mb) on 3.5” disks - *floppy disks*). The hard drive is typically designated the C:\ drive and the floppy drive is typically designated the A:\ drive. If you have an additional floppy drive, it is typically designated the B:\ drive. You will also have network drives on your computer, depending on authorization and rights of each user. This drives will typically be labeled F:\ or H:\ or G:\

- **Folders**  
  - Folders are used to organize the data stored on your drives. Think of your drives as filing cabinets. You want to sort your filing cabinets with folders that store different files. The files that make up a program are stored together in their own set of folders. You will want to organize the files you create in folders. You will probably want to store files of a like kind in a single folder.

- **Directory**  
  - A Directory is the path given to a folder on a drive. For example a text file called *Phone Numbers* is located in the *My Documents* directory on the C:\ drive. It would therefore read "C:\My Documents\ Phone Numbers.txt"

- **File Extensions**  
  - File Extensions are the ending letters associated with a file and an application that it can be manipulated in. This way Windows 98 knows to tell which program to open the file you want to manipulate. For example a text file has an extension of .txt, so a text file created in Notepad called
Phone Numbers would look like this `PhoneNumbers.txt` ... You do not have to assign a file extension to a file that you create. The program you use will automatically do this for you. All you need to do is give it a filename. Some other common extensions are as follows:

- `.doc` = Microsoft Word Document
- `.xls` = Microsoft Excel Document
- `.ppt` = Microsoft PowerPoint Presentation
- `.mdb` = Microsoft Access Database
- `.bmp` = Windows Bitmap Picture
- `.wav` = Sound File
- `.html` or `.htm` = Internet Document

- **Icon**
  - An icon is a graphic image. Icons help you execute commands quickly. Commands tell the computer what you want the computer to do. To execute a command by using an icon, double-click on the icon.

**Windows Desktop**

When starting your computer, the desktop is the first thing you. The Bay City Public Schools image is displayed on the screen with icons for various programs. The desktop is the area you work in.

<table>
<thead>
<tr>
<th>Name</th>
<th>Picture</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Taskbar</td>
<td><img src="image" alt="Taskbar" /></td>
<td>The taskbar is usually located on the bottom of the desktop. The Start button, active program buttons, and the system tray are located on the Taskbar</td>
</tr>
<tr>
<td>System Tray</td>
<td><img src="image" alt="System Tray" /></td>
<td>You’ll typically find the System Tray in the lower right hand corner of the Windows Desktop. The system tray contains a display of the current computer time, and the icons representing the programs activated when Windows first starts up.</td>
</tr>
<tr>
<td>My Computer</td>
<td><img src="image" alt="My Computer" /></td>
<td>My Computer icon provides access to the different parts on your computer. You can access the different drives (Hard Drive, Floppy Drive, Network Drives) inside My Computer.</td>
</tr>
</tbody>
</table>
Recycle Bin
When you delete an object, Windows 98 sends it to the Recycle Bin. You can restore objects that are located in the Recycle Bin or you can permanently delete them by right clicking on the Recycle Bin and select **Empty Recycle Bin**.

My Documents
The My Documents folder is nothing more than a regular folder that resides on your Windows Desktop. However, it offers an easy-to-reach location where you can store and retrieve important data, and the icon is always available in Explorer Windows and on the desktop.

Internet Explorer
The Internet Explorer icon launches the Internet Explorer browser. The Internet Explorer browser is what you will use to access the Internet and the World Wide Web.

Shortcut Icons
Icons with an arrow in the lower left corner (picture on left) are shortcut icons. If you double click on them they will open up the program that the icon displays on it.

Shutting Down Windows

1. Click on the **Start at bottom left corner of screen**
2. Click on **Shutdown** (A Shut Down Windows dialog box will appear)
3. Click on **Shut Down**
4. Click on **OK**
Restarting Windows

(To shutdown and immediately restart your computer)

1. Click on the **Start at bottom left corner of screen**
2. Click on **Shut down** (A Shut Down Windows dialog box will appear)
3. Click on **Restart**
4. Click on **OK**

Opening A Program

- If the program you want to open is on the desktop, simply double-click the icon and it will open. However if it is not located on the desktop do the following steps
  1. Click on the **Start at bottom left corner of screen**
  2. Click on **Programs**
  3. Select the Program you want to open
Finding Files On Your Computer

- If, for some reason, you cannot locate a file on your computer or home drive, you still might be able to locate it by using the Find Files Program.
  1. Click on the **Start at bottom left corner of screen**
  2. Click on **Find**
  3. Select the **Find Files or Folders**
4. Enter your search criteria. You do not need to complete every field. Only enter the criteria you want to use for your search. Switch through the different tabs (Date, Advanced, Name & Location) to further your search.
5. Click the **Find Now** button

**Locating Your Most Recent Files**

- Windows provides shortcuts to your most recent files, so you may get access to them very quickly.
  1. Click on the **Start at bottom left corner of screen**
  2. Click on **Documents**
  3. Select the file that you want

**Using the Windows Explorer Program**

- Windows Explorer is a program which allows you to view all of your folders, and the files that belong in those folders. It is divided into 2 panes. On the left side are the drives and folders. The right pane shows the files and subfolders of the folder or drive you have chosen from the left pane.
  1. Click on the **Start at bottom left corner of screen**
  2. Click on **Programs**
  3. Select Windows Explorer
Creating A Folder
1. Select the Drive or Folder you want to create your Folder in
2. Right click in the right pane in the white area
3. Select New
4. Select Folder
5. Type in name for that Folder

Deleting a file or folder
1. Select the File/Folder you want to delete
2. Hit the Delete Key on the keyboard
3. Confirm Deletion

Moving/Copying files to different folders
1. Select the Folder you want to move or copy
2. To Move File - Simply drag it to the destination you want it to go to
3. **To Copy File** - Click on **Edit --> Copy** from the top of the screen. Then go to the destination folder and click **Edit --> Paste**

- **Copying a file/folder to a floppy disk**
  1. Select the Folder you want to move or copy
  2. Right click on the file or folder in the right pane
  3. Select **Send To -->**
  4. Select **3.5 Floppy (A)**

- **Copying a file/folder from a floppy disk to other drive**
  1. Select **3.5 Floppy (A:)** in the left pane
  2. Select the File/Folder you want to copy from in the floppy drive
  3. Drag it to your destination

- **Renaming A File or Folder**
  1. Select the File or Folder you want to rename
  2. Right Click on it
  3. Select **Rename**
  4. Rename File

---

**Introduction to Linux**

Linux is an open source operating system used to run a wide range of computers around the world. Linux offers graphical environments, similar to Microsoft's Windows or Apple's Mac OS X, in which a user can interact easily with applications. The main graphical environments for Linux consist of desktop environments and window managers.

Window managers provide an environment for launching and managing applications with graphical user interfaces (GUI). Desktop environments provide a similar interface for GUI applications and contain additional applications to manage everyday computing tasks, such as reading email and Web browsing.

**Logging in**

Once your computer has booted up, you will be presented with a login screen. There are many different login screens for Linux and each has its own look and feel. Each one consists of an area to enter your user name and password. (A picture with your user name may be substituted in the place of an area to enter your user name; if you see this,
simply click on the picture, then enter your password.) Your password will not be displayed while you type but instead will be represented by asterisks in order to keep someone from stealing your password by viewing your computer screen.

You will also notice an area that contains a list of desktop environments or window managers to choose from. Select the one you wish to use and click the login button (or press the Enter key on your keyboard) to complete the login process. The two main desktop environments for Linux are KDE (K Desktop Environment) and GNOME (GNU Network Object Model Environment).

The desktop

After a brief splash screen, you will be presented with your Linux desktop. There are two main areas of the desktop: the desktop area and the desktop panel.

The desktop area comprises the majority of the computer screen. This is where application windows appears when you launch an application. It also contains the desktop icons, which are small pictures that represent different items. Some common desktop icons are:

- **Home** -- This lets you browse your home directory, which is where your personal files are stored. Each user on a Linux system has an individual home directory.
- **Device icons** -- These indicate media devices such as diskette drives, CD-ROM drives, DVD drives, and hard drives. Clicking on of these allows you to browse the contents of the device.
- **Application icons** -- This allows you to launch an application directly from your desktop area.
- **Trash** -- This is where files go when you delete them by selecting the file and pressing the Delete key on your keyboard. The Trash folder allows you to recover files that you inadvertently delete. Emptying the trash, or using the Shift-Delete keyboard combination to delete files, results in permanent deletion of the files.

The desktop panel consists of a bar that is normally always visible. The Linux desktop may contain one or more panel areas, depending on your settings. The panel area may contain application icons, special buttons, GNOME/KDE menus, and panel applets.

The GNOME and KDE menus, which you'll find in the lower left corner of your
screen, appear different for every Linux distribution. They may be indicated by the GNOME logo (a foot), the KDE logo (a gear), or the distribution's logo. After clicking the icon you will see a hierarchical list of applications by category, and actions (such as Log Out). Clicking a menu item starts the selected application or action.

The panel applets are small areas within the panel(s) that perform specific function. There are a multitude of applets available for both the KDE and GNOME panels. Some common applets are:

- Taskbar -- An area containing the names of all open applications. By clicking the area of the application you want to use you can easily switch between open applications. Applications are always visible here when minimized.
- System Tray -- The system tray contains iconified applications, which are small applications that are running during normal desktop operation but which do not take up space in the taskbar. Some larger applications may be shown here as well to uncluttered the taskbar. Applications running in the system tray can only be exited through the system tray, usually by right-clicking the icon to invoke a menu and selecting quit.
- Pager -- It is possible to have multiple desktops, known as virtual desktops, under Linux. The pager area allows you to switch between these virtual desktops by clicking the desktop that you wish to switch to.
- Clock -- The clock indicates the time. Clicking the clock applet opens a small calendar.

That's a brief tour of the Linux desktop.

Linux GUI: of mice and menus

Some of the basic elements of the Linux desktop were introduced. Now you need to learn how to navigate and use it to start applications. To do this you need to know how your mouse works with the Linux desktop and understand the desktop menus.

Knowing usage of mouse, a lesser-known action you can perform with the mouse under Linux is middle-clicking. Linux allows you to simulate a middle mouse button by pressing and releasing the left and right mouse buttons simultaneously. Middle-clicking makes cut and paste operations easy; select an area of text, move the cursor to where you want to paste the selected text, and middle-click again.

The best place to start using your Linux desktop is at the desktop menu. The desktop menu provides easy access to the many GUI applications available for the Linux desktop. Within the desktop menu you can start applications and perform many actions related to your Linux desktop. Most desktop environments and window managers have a desktop menu system, usually accessed by clicking on the icon located on the desktop panel. For KDE, the K menu's icon is usually the letter K and a gear. The GNOME menu icon usually looks like a left footprint with only four toes. Some distributions use their own logo in the place of the default GNOME and KDE menu buttons.

The desktop menu is a hierarchical menu, meaning it contains submenus that are displayed in a cascading fashion. Categories containing submenus are indicated by a small arrow to the right of the category name.
To navigate the desktop menu, simply move the cursor over the menu. The menu item beneath the cursor will be highlighted. If an item contains a submenu, then that submenu will be displayed automatically when the cursor is over the item. Navigate the submenus in the same way as the main desktop menu.

The desktop menus of nearly all Linux distributions are a little different. While most Linux distributions simply use the default menu structure for GNOME and KDE, some distributions have customized the desktop menu structure to make it more user-friendly. Some common desktop menu categories are:

- Office, containing applications for performing many work-related tasks, such as creating text documents, creating presentations, and using a calculator;
- Internet (or Network), containing many applications used to perform tasks on the Internet, such as Web browsers, email clients, instant messengers, and Web editors;
- Multimedia, containing applications used to view movies and listen to sound files or CDs;
- System (or Configuration), containing items you can use to change the settings on your Linux system;
- Documentation; and
- Games.

Once you have familiarized yourself with the desktop menu you can begin running applications by moving the cursor over the application that you wish to start until the item is highlighted, then clicking the item to start it. Tool tips, which are pop-up text areas that give you more information about an item, may appear when you highlight a menu item or desktop item, depending upon your desktop settings.

At some point while exploring the applications that come with Linux, you will find some applications that you'll want to run every day. You can place these menu items on your desktop or desktop panel to provide easier access to the applications. To do this, locate and highlight an application in the desktop menu, drag the application to your desktop area or desktop panel until a small plus-sign appears next to the cursor, and release the mouse button. You can use this technique to place single applications or entire sections from the desktop menu on the desktop. When you drag an item onto the desktop, a pop-up menu will appear; choose Copy Here from the menu to create a shortcut on the desktop.

As well as containing applications, the desktop menu also contains special sections, including:

- Bookmarks, which contain bookmarks from your Web browser;
- Quick Browse, which allows you to navigate your computer directly from the menu;
- Recent Documents, which contains a list of your most recently accessed files;
- Print System, which allows you to manage and configure printers;
- Find, which contains search utilities to locate files on your computer; and
- Preferences, which allows you to configure your KDE desktop settings.
You can also find some special actions in the KDE desktop menu. The Run Command action allows you to start an application by typing its name in a text box. Lock Screen lets you password-protect your computer while you’re away. Logout ends your desktop session and returns to the login screen.

You can find similar entries for the GNOME desktop in a separate desktop menu labeled as Actions.

In addition to the desktop menu, Linux offers context menus -- pop-up menus that appears when you right-click on an item or the desktop. These special menus provide a quick and easy method for performing specific actions on the item (such as copy, paste, or delete), or to configure the item. The Linux desktop has a context menu for nearly every item and application that it contains. If you change your mind about using a context menu, then click an area away from the menu and it will disappear.

**Application Windows**

After discussion about how to start desktop applications using the mouse and the desktop menu. If done few times and the multiple running desktop applications can make the desktop a bit overcrowded. To help overcome this, the application windows are used.

Most desktop applications are surrounded by an application window consisting of thin borders on the right, left, and bottom sides and a thicker area containing the title bar at the top. The application window allows you to manipulate the application within your desktop.

While the look of a desktop application remains the same no matter what desktop environment (or window manager) you are using, the appearance of the application window is dependent on the style setting of the desktop environment.

The title bar displays a tiny icon of the application, the name of the file that you are working with, and the name of the running application on the left side. The title bar also contains the sizing buttons (minimize and maximize/restore) and the close button, usually grouped together on the right side of the title bar.

The minimize button is usually the leftmost button of the three and is usually represented with a small horizontal line. Clicking on it removes the application from the desktop to allow you to work with other applications. Though it is minimized, it is still running; you can access the application again by clicking the button that corresponds to the application on the taskbar.
The maximize and restore buttons both take up the middle position, but never appear at the same time. The maximize button, indicated as a small square, makes the application take up the entire desktop area. The restore button, shown as two small overlapping squares, restores the application to its original size. A few applications do not have a maximize/restore button on their title bars, because those applications have a fixed sized that cannot be changed.

You can also change the size of an application window by dragging its edges with the mouse. Move the cursor over any edge or corner of a window until the cursor changes into a line with two arrows on each end. By dragging the border you can change the window's size. The direction shown by the mouse cursor indicates the direction that the window may be resized. You can also use the mouse to reposition a window on your desktop by dragging the title bar.

Shading is another technique for manipulating desktop windows, and one that, unlike all the previous techniques, Microsoft Windows lacks. By double-clicking the title bar, you can make the application roll up like a window shade and show only the title bar. To restore a shaded application, simply double-click the title bar again.

Most of the above actions can also be accomplished by clicking on the small icon located on the left side of the title bar and selecting the appropriate action in the menu it displays. From that menu you can also select other options for manipulating the behavior of the application window. You can elect to keep the window above all others on the desktop even when the application is no longer the active application. Just the opposite of keeping the application above all others is the option to keep the application below all others. Full screen mode is another option; it allows you to expand the application to fill the entire screen area. You can also determine which virtual desktops the application will appear on; next week we'll talk about virtual desktops in detail.

When you have multiple applications open, all but one of the applications' title bars are grayed out. This indicates that an application is no longer active, meaning that you are not directly working in that application. Only one application may be active at a time. Applications can receive input only if they are active.

Each desktop application has its own distinctive set of actions it can performed. To organize these actions, applications use a menu bar located at the top of the application. The menu bar has several small menus on it, and each menu works in the same manner that the desktop menu works. Some common menus seen on the menu bar are:

- **File** -- This menu contains actions to manage the file that you are viewing with the application. Common entries include: New, to create a new file; Open, to open a file for viewing or editing; Save, to save the file after making changes;
Save as..., to save the file and specify the name to save the file as; Close, to close the file but leave the application running; and Quit, which closes the file and quits the application.

- **Edit** -- Here you will find actions for manipulating the file. Usual items found here are: Copy, to copy selected items from the file; Paste, for pasting a previously copied item into the file; Undo, to undo the last action performed on the file; and Redo, for undoing a previous undo command.
- **View** -- Actions that change the way a file or application appears. here you will also find entries for adding and removing toolbars.
- **Help** -- This is probably the most useful menu when using an application for the first time, and it is also probably the least used menu. Here you will find the entry for launching the application's help system. The help system contains information on how to use the application.

While the menus on the menu bar act similarly to the desktop menu, some entries contained in these menus are actually options for the application. Some of these options are single options that can be either enabled or disabled. A small check mark is displayed on the left of the menu entry when the option is enabled. Clicking the entry changes the option from enabled to disabled, and vice versa. Other option areas in the menu contain multiple options that can be enabled only one at a time. These options have a bullet -- a small solid circle -- to the left of the enabled option. Simply click on another option in that section to change the settings.

Some menu entries have keyboard shortcuts, also called keystroke shortcuts, that appear to the right of the menu entry. Keyboard shortcuts perform the menu action when the keyboard keys shown are pressed. These shortcuts can be single keys or a combination of keys. For examples, a keyboard shortcut represented by F11 is a shortcut performed by pressing the F11 key on the keyboard, while one represented by Ctrl+V is a shortcut performed by pressing the Control (Ctrl) key and the letter V on the keyboard at the same time. Keyboard shortcuts differ from application to application. They can be an invaluable time-saving tool.

Below the menu bar you can often find an area called a toolbar. A toolbar contains icons that represent the most common actions used in the application. To execute an action, click on an icon on the toolbar. Some applications contain multiple toolbars. You can usually control which toolbars are shown from the View menu on the menu bar. You can also customize some toolbars by adding or removing icons. Right-click the toolbar and select Customize from the pop-up menu that appears to edit the appearance of the toolbar. As you might expect, the majority of an application's window is taken up by the file or object that you are viewing. This is where you interact with the object, by actions such as typing text in a text document or clicking links on a Web page. Sometimes the file that you are viewing is larger than the file viewing area. When this happens, you can use the scroll bars that appear on the right and bottom of the file viewing area to view additional contents of the file. Simply drag the scroll bar, or click the scroll arrows located at either end of the scroll bar, in the direction you wish to see more information. At the bottom of the application is another bar called the status bar, which displays useful messages relating to the status of the file you are working with. The status bar is dynamic, meaning that it changes depending on the state of the application or file.
Those are the basics of working with desktop applications. There are, unfortunately, a couple of exceptions to the general rules. Some applications, such as XMMS (a multimedia player), do not have an application window, but instead offer built-in buttons for performing some of the same actions as the application window does, such as minimize and close. Other applications operate in full screen mode until you quit; Frozen-Bubble, an amusing and addictive game, is an example of one such application.

**MS-EXCEL**

Microsoft Excel is allows you to create professional spreadsheets and charts. It performs numerous functions and formulas to assist you in your projects. Where spreadsheets are designed to work well with numbers but often include text. Sometimes text in a spreadsheet is called a label, because it is labeling columns and rows of numbers. Numbers are called values sometimes, and can include numbers for counts or measurements, dates, times, and calculations from numbers. Spreadsheets can help organize information, like alphabetizing a list of names or other text or reordering records according to a numeric field.

However, spreadsheets are more often used for calculating, such as totaling a column of numbers or generating a more sophisticated formula to calculate some statistical measure on a list of numbers. Spreadsheets and databases are in competition and have similar features. Yet the way they work in the background is different. When you work in a spreadsheet, you view the data you are entering as a section.

In a database, you only see the data you are entering—you have to request a report or different display to see more of the information. Other differences are: (1) databases are more often used for applications with long textual entries, (2) very large applications (thousands of entries) are more often handled in databases; and (3) spreadsheets are easier to learn to use and get calculations from than a database program. This latter reason is why many researchers and students prefer spreadsheets for keeping track of their data over databases.

It is impossible to give a complete listing of applications that can be done in spreadsheets, but they include budgeting displays, checkbook registers, enrollment records, inventories, coded surveys, field and laboratory research data, and financial and accounting applications.

The capacities of Excel are as follows. You can have 256 columns of information. You can have up to 16,384 rows. That comes out to over 4,194,000,000 cells of information and that's only on the first sheet!!! You can have 16 sheets of information in one workbook, and the number of sheets can be increased, if needed. Excel refers to each file as a workbook, because there can be multiple sheets (pages) in one file.

**Using MS-Excel**

**Starting Microsoft Excel**
Two Ways

1. Double click on the Microsoft Excel icon on the desktop.
2. Click on Start --> Programs --> Microsoft Excel

LEARN ABOUT SPREADSHEETS

Opening Excel opens a new spreadsheet. The spreadsheet is the basic document in Excel; the spreadsheet contains many rectangles, called cells; a cell is a field where data is entered; columns in the spreadsheet are vertical and are identified by letters (A, B, C, D...); rows in the spreadsheet are horizontal and are identified by numbers (1, 2, 3, 4...); each cell is identified by the letter at the top of its column and the number to the left of its row (A1, B4, C26...).

Type in cell A1: NAMES continue down column A (A2, A3, A4, and so on), typing one student's name in each cell until each student's name is listed; Type in cell B1 TV TIME continue down column B (B2, B3, B4, and so on), typing the number of hours per day each student watches TV.

Click File: Save As to save your work.

Type in cell C1 Average Hours of TV Viewing: Point out to students that cell C1 is not big enough to show all the text. Explain that they can change the size of a cell in three ways: double-click the line between the A and the B above Names and TV Time, click and hold any line between the letters or numbers of a cell to make it bigger or smaller, click Format > Rows > Height or Format Column > Width.

Type in cell C2 the formula =(B2+B3+B4+B.....)/[number of students]. (They type in cell C2 the location of each cell that lists a student's TV time, with a + sign between...
each cell location. Then, after the slash, they type the total number of students in
the class. The formula for a class of 20 students, therefore, would be
=(B2+B3+B4+B5+B6+B7+B8+B9+B10+B11+B12+B13+B14+B15+B16+B17+B18+B19+B20+B21)/20.)

But wait! Tell students that they don't really need to type that long formula; they can
use a shortcut instead. Explain to students that, instead of typing the name of every
cell that has a TV time in it, they can type the Cell Range of the cells with TV times
in them. Cell Range is shown by typing the name of the first cell and the name of the
last cell with a : between them. The Cell Range for the above example, therefore,

Explain to students that in Excel a function is a shortcut for a frequently used
mathematical operation. Some Excel shortcuts include SUM, AVERAGE, MIN (for
minimum), and MAX (for maximum.)

Point out to students that they need to tell Excel what mathematical operation to
perform on cells B2:B21. Explain that the formula for finding the average hours of
TV viewing for all 20 students in the class is =AVERAGE(B2:B20). Have students
highlight and delete the long formula in cell C2, type the shorter formula into that

Creating Formulas

1. Click the cell that you want to enter the formula.
2. Type = (an equal sign).
3. Click the Function Button.
4. Select the formula you want and step through the on-screen instructions

Students are now ready to print the page. Tell them to make sure the entire area within
the border is still highlighted. Then tell them to click File>Print Area>Set Print Area and
then click Print. (Unlike Word, Excel will print lots of blank pages unless a specific print
area is set.)
Order of Operations Excel Uses

<table>
<thead>
<tr>
<th>Precedence</th>
<th>Operation</th>
<th>Operator</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Exponentiation</td>
<td>^</td>
</tr>
<tr>
<td>2</td>
<td>Multiplication</td>
<td>*</td>
</tr>
<tr>
<td>2</td>
<td>Division</td>
<td>/</td>
</tr>
<tr>
<td>3</td>
<td>Addition</td>
<td>+</td>
</tr>
<tr>
<td>3</td>
<td>Subtraction</td>
<td>-</td>
</tr>
<tr>
<td>4</td>
<td>Concatenation (putting 2 strings together, like Jenn &amp; ifer)</td>
<td>&amp;</td>
</tr>
<tr>
<td>5</td>
<td>Equal To</td>
<td>=</td>
</tr>
<tr>
<td>5</td>
<td>Greater Than</td>
<td>&gt;</td>
</tr>
<tr>
<td>5</td>
<td>Less Than</td>
<td>&lt;</td>
</tr>
</tbody>
</table>

Adding Borders and Shading to Cells

1. Make sure you have the Formatting toolbar visible
   - Click on View --> Toolbars --> Formatting
2. Select cells you wish to format by left clicking on them and highlighting them
3. Click the button to shade a cell and/or the to give a cell a border

Inserting A Chart

1. Select over the text you want to make your chart with
   - Click Insert --> Chart

2. Select the type of chart you want
3. Confirm or change your data range
4. Update the Chart Options

5. Select if you want to put it into the current worksheet or into a new worksheet
Chapter 3

Introduction to Internet
**Introduction to Internet**

The Internet is a network of networks, joining or connecting computers to computers through protocols like TCP/IP protocols. The Internet is the mechanism which acts as transport vehicle for the information stored in files or documents on another computer. It can be compared to an international communications utility servicing computers. It is sometimes compared to a giant international plumbing system. The Internet itself does not contain information. It is a slight misstatement to say a "document was found on the Internet." It would be more correct to say it was found *through* or *using* the Internet. What it was found in (or on) is one of the computers linked to the Internet.

Computers on the Internet may use one or all of the following Internet services:

- **Electronic mail (e-mail).** Permits you to send and receive mail. Provides access to discussion groups often called Listservs® after the software they operate under.
- **Telnet or remote login.** Permits your computer to log onto another computer and use it as if you were there.
- **FTP or File Transfer Protocol.** Allows your computer to rapidly retrieve complex files intact from a remote computer and view or save them on your computer.
- **Gopher.** An early, text-only method for accessing internet documents. Gopher has been almost entirely subsumed in the World Wide Web, but you may still find gopher documents linked to in web pages.
- **The World Wide Web (WWW or "the Web").** The largest, fastest growing activity on the Internet.
- **RSS readers,** interpreting XML in a way analogous to how browsers interpret HTML (see below).

**What is the World Wide Web and what makes it work?**

The WWW incorporates all of the Internet services. You can retrieve documents, view images, animation, and video, listen to sound files, speak and hear voice, and view programs that run on practically any software in the world, provided your computer has the hardware and software to do these things.

When you log onto the Internet using a web browser like Internet Explorer, Firefox, Mozilla, Netscape, Opera, Safari, you are viewing documents on the World Wide Web. The basic language on which the WWW functions is the programming language called HTML. It is HTML and other programming imbedded within HTML like XML, XHTML, DHTML, etc that make possible hypertext. Hypertext is the ability to have web pages containing links, which are areas in a page or buttons or graphics on which you can click your mouse button to retrieve another document into your computer. This "clickability" using Hypertext links is the feature which is unique and revolutionary about the Web.

**How do hypertext links work?**

Every document or file or site or movie or soundfile or anything you find on the Web has a unique URL (uniform resource locator) that identifies what computer the thing is on,
where it is within that computer, and its specific file name. Every Hypertext link on every web page in the world contains one of the URLs.

What is a Browser?

A browser is a computer program that resides on your computer enabling you to use the computer to view WWW documents and access the Internet taking advantage of text formatting, hypertext links, images, sounds, motion, blogs, and other features. Firefox and Internet Explorer are currently the leading "graphical browsers" in the world and they facilitate the viewing of graphics such as images and video and more. There are other browsers like Mozilla, Safari, Opera. Most offer many of the same features and can be successfully used to retrieve documents and activate many kinds of programs.

Browsers all rely on "plug-ins" to handle the fancier files like ActiveX, Flash, JVM, etc, you find on the Web. Plug-ins are sub-programs stored within a browser or elsewhere in your computer especially to support special types of files you may click on. If you click on a link, and your computer does not currently have the plug-in needed for the file you clicked on, you are usually prompted with an opportunity to get the plug-in. Most plug-ins are free, and easy and safe to install on your computer.

The main way in which browsers differ is in the convenience features they offer for navigating and managing the Web and all the URLs you may want to keep track of. Netscape and Internet Explorer both offer the ability to e-mail documents, download them to diskette, print them, and keep track of where you've been and sites you want to "bookmark" or "Add to Favorites".

Getting Started Internet and Web

This lesson is to introduces you to how to use the Internet and Web.

To access the Internet by computer, you need a computer, a modem or other telecommunications link, and inbuilt software to connect to an Internet Service Provider

Using the Internet and Web

Get to a Internet-connected computer

In order to use the Internet, you need to access to some computer that has access to the Internet.

This computer might be:

- Your personal computer at home, connected to the Internet through an Internet Service Provider (ISP).
- A computer or workstation at your school or place of employment that is connected to the Internet
- A computer at a Net Cafe which is available for public use.
- A handheld device like PAD, Mobile, etc that accesses the Internet through wireless signals
- A computer at your home or office that uses Internet connections such as a cable modem, DSL, or some other means
A terminal at your school or place of work that is connected to a main computer that is in turn connected to the Internet

Start up a Web browser

Once you have access to an Internet-connected computer, you can access the Web if that computer has Web browser software installed. Two popular Web browsers are Netscape Navigator and Microsoft Internet Explorer, Mozilla Firefox. Small handheld devices may have their own versions of these Web browsers or have a special Web browser that operates on them.

Use the Web browser

Web browser typically through manipulating it with your mouse and cursor, and entering information from your keyboard.

Choose a Web browser

Although it may seem like Microsoft's Internet Explorer is the only Web browser in use, there are other brands of Web browsers available. In fact, the Web was designed so that any brand of Web browser should be able to display content from any Web server.

Get to know your Web browser

Whichever Web browser you choose, spend some time getting to know it. Learn about some customizations that can save you time and make it easier for you to surf the Web.

Microsoft Internet Explorer is the most used Web browser. The Internet Explorer browser has a vast amount of customizations available (See the menu Help).

Customize your Web browser

a. Setting our own font size.

1. Choose the menu Tools->Internet Options. Choose the Accessibility box (lower right-hand corner)
2. Click the boxes for "Ignore font styles specified on Web pages" and "Ignore font sizes specified on Web pages."
3. Set your own font style in menu Tools->Internet Options, Fonts box.
4. Choose your own font sizes in menu View->Text Size.
b. Set your own start page; or use a blank one. The default Web page is http://www.microsoft.com/isapi/redir.dll?prd=ie&pver=6&ar=msnhome. Every time you launch a Web browser, this page has to load. i.e. msn home page.

1. If you want to set your start page to be a specific Web page, bring that page up in the Web browser. This page could be an HTML file stored on your hard drive.
2. Choose the menu Tools->Internet Options
3. In Home page area, choose either Use Current (to set the displayed Web page as your start page) or Use Blank (to set a blank page to be your start page--this saves a lot of time when your Web browser launches as it does not have to load a Web page from the Internet.)

c. Refuse cookies except from sites you approve.

A **cookie** is a file that gets downloaded to your hard drive as a result of visiting a Web site. Every Web page or image you see in your Web browser has to be downloaded to your disk in a temporary area on your hard drive; otherwise you wouldn't be able to see it at all. But cookies are special little files that can be used to track sites that you visit. Many people like to clean them out or control when they are used. Internet Explorer has some good features for controlling cookies.

How to set cookies:

1. Choose the Internet Explorer menu option Tools->Internet Options
2. Choose Privacy tab
1. Choose Advanced box

2. Check "Override automatic cookie handling"

3. Check Block in First-party Cookies

4. Check Block in Third-party Cookies

5. Check Always allow session cookies

6. Check OK

3. In Privacy tab, select Edit.. to handle cookies for individual Web sites

a. Enter the domain names of trusted Web sites that save information for you from session to session or require cookies in order to operate properly; for example: nytimes.com, live365.com, yahoo.com, your banking site, etc.

b. Check OK

d. Customize your browser’s toolbar: menu View->Toolbars->Customize...
Use of shortcut keys

For each of these, make sure the Web browser of interest is the active window (indicated by highlighted title bar; click on a window to make active).

### Internet Explorer Key Sequences

<table>
<thead>
<tr>
<th>Key Sequence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl/N</td>
<td>Launch another Web browser</td>
</tr>
<tr>
<td>Ctrl/F</td>
<td>Search for a text string on a Web page (the F stands for &quot;Find&quot;)</td>
</tr>
<tr>
<td>Ctrl/W</td>
<td>Close a Web browser</td>
</tr>
<tr>
<td>Ctrl/H</td>
<td>Bring up your history in a side panel; shows pages you have visited</td>
</tr>
<tr>
<td>Ctrl/I</td>
<td>Bring up your favorites in a side panel; shows pages you have &quot;bookmarked&quot; to quickly visit again</td>
</tr>
<tr>
<td>Ctrl/D</td>
<td>Save a page URL to your favorites</td>
</tr>
<tr>
<td>Esc</td>
<td>Stop the Music! (Some Web &quot;designers&quot; cause a music file to automatically start when you visit a Web page; also stops loading graphics.)</td>
</tr>
<tr>
<td>Tab</td>
<td>Move to next field in a Web form.</td>
</tr>
<tr>
<td>Alt/D</td>
<td>Move to the address box</td>
</tr>
<tr>
<td>Shift/click on hypertext link</td>
<td>This will cause the link to open in a new Web browser</td>
</tr>
</tbody>
</table>

### Some useful tips while using internet explorer

a.

<table>
<thead>
<tr>
<th>Internet Explorer Tricks</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get to a something.com site quickly; Works for sites of the form <a href="http://www.something.com">http://www.something.com</a></td>
<td>1. Type something in address (URL) box</td>
</tr>
<tr>
<td>Get to a something.else site quickly; Works for sites of the form <a href="http://something.else">http://something.else</a></td>
<td>2. Press control/Enter</td>
</tr>
<tr>
<td>Save a picture from a Web page to your computer's hard drive</td>
<td>1. Place your cursor over picture</td>
</tr>
<tr>
<td>Overcome dark text on dark or textured background; some Web &quot;designers&quot; do this, making the page hard (or impossible) to read!</td>
<td>2. Right click mouse</td>
</tr>
<tr>
<td></td>
<td>3. Select &quot;Save Picture As ...&quot;</td>
</tr>
<tr>
<td></td>
<td>4. Or choose &quot;Set as Background&quot; to make picture your wallpaper</td>
</tr>
<tr>
<td></td>
<td>1. Choose menu Edit-&gt;Select All (or Ctrl/A)</td>
</tr>
<tr>
<td></td>
<td>2. Resulting page is in reverse video--perhaps enabling you to read the page</td>
</tr>
<tr>
<td></td>
<td>3. If this fails:</td>
</tr>
<tr>
<td></td>
<td>a. Choose the menu Tools-&gt;Internet Options.</td>
</tr>
<tr>
<td></td>
<td>3. Choose the Colors box (lower left-hand corner)</td>
</tr>
<tr>
<td></td>
<td>b. Unclick the box for &quot;Use windows colors&quot; and then select your own colors</td>
</tr>
</tbody>
</table>
b. How to Stop the popup windows

You will come across or discover when visiting or leaving some Web sites, a new window, usually containing an advertisement, will appear on your computer. These are called popup windows and they can be irritating and make using the Web efficiently almost impossible.

You can consider installing a popup blocker software. Plenty of them are available for free and you may be able to find one easily that would work on your computer. Shareware or commercial software can be bought for a modest price. Popup blocking software is well worth it, and it saves a lot of headaches.

c. Protect yourself

Raise your awareness of potential security problems and ways to prevent problems. The Internet can be dangerous if you don't use caution, common sense, or some basic common sense.

SEARCH ENGINE

Internet search engines like Google, AltaVista, Yahoo help users find web pages on a given subject. The search engines maintain databases of web sites and use programs often referred to as "spiders" or "robots" to collect information, which is then indexed by the search engine. Similar services are provided by "directories," which maintain ordered lists of websites. Although search engine is really a general class of programs, the term is often used to specifically describe systems that enable users to search for documents on the World Wide Web and USENET newsgroups.

The Essentials of Google Search

BASIC SEARCH

Doing a search on Google is easy. Simply type one or more search terms (the words or phrase that best describe the information you want to find) into the search box and hit the 'Enter' key or click on the Google Search button.

In response, Google produces a results page: a list of web pages related to your search terms, with the most relevant page appearing first, then the next, and so on.

Here are some basic tips to help you maximize the effectiveness of your search:

- Choosing search terms
- Capitalization
- Automatic "and" queries
- Exclusion of common words
- Word variations
- Phrase searches
- Negative terms
- I'm Feeling Lucky
Choosing search terms

Choosing the right search terms is the key to finding the information you need.

Start with the obvious – if you're looking for general information on India, try *India*

But it's often advisable to use multiple search terms; if you're planning a Indian vacation, you'll do better with *vacation India* than with either *vacation* or *India* by themselves. And *vacation India golf* may produce even better (or, depending on your perspective, worse) results.

You might also ask yourself if your search terms are sufficiently specific. It's better to search on *luxury hotels Mumbai* than on *Le Meridean hotels*. But choose your search terms carefully; Google looks for the search terms you chose, so *luxury hotels Mumbai* will probably deliver better results than *really nice places to spend the night in Mumbai*

Capitalization

Google searches are **NOT** case sensitive. All letters, regardless of how you type them, will be understood as lower case. For example, searches for *george washington*, *George Washington*, and *gEoRs wAsHiNgToN* will all return the same results.

Automatic "and" queries

By default, Google only returns pages that include all of your search terms. There is no need to include "and" between terms. Keep in mind that the order in which the terms are typed will affect the search results. To restrict a search further, just include more terms. For example, to plan a vacation to India, simply type *vacation India*

Exclusion of common words

Google ignores common words and characters such as "where" and "how", as well as certain single digits and single letters, because they tend to slow down your search without improving the results. Google will indicate if a common word has been excluded by displaying details on the results page below the search box.

If a common word is essential to getting the results you want, you can include it by putting a "+" sign in front of it. (Be sure to include a space before the "+" sign.)
Another method for doing this is conducting a phrase search, which simply means putting quotation marks around two or more words. Common words in a phrase search (e.g., "where are you") are included in the search.

For example, to search for Shaktimaan, Episode I, use:

```
Shaktimaan Episode +I
~ OR ~
"Shaktimaan Episode I"
```

**Word variations**

Google now uses stemming technology. Thus, when appropriate, it will search not only for your search terms, but also for words that are similar to some or all of those terms. If you search for `pet lemur dietary needs`, Google will also search for `pet lemur diet needs`, and other related variations of your terms. Any variants of your terms that were searched for will be highlighted in the snippet of text accompanying each result.

**Phrase searches**

Sometimes you'll only want results that include an exact phrase. In this case, simply put quotation marks around your search terms.

```
"the long and winding road"
```

Phrase searches are particularly effective if you're searching for proper names ("George Washington"), lyrics ("the long and winding road"), or other famous phrases ("This was their finest hour").

**Negative terms**

If your search term has more than one meaning (bass, for example, could refer to fishing or music) you can focus your search by putting a minus sign ("-"), in front of words related to the meaning you want to avoid.

For example, here's how you'd find pages about bass-heavy lakes, but not bass-heavy music:

```
bass -music
```

Note: when you include a negative term in your search, be sure to include a space before the minus sign.

**And finally... "I'm Feeling Lucky"**
After you've entered your search terms, you might want to try the "I'm Feeling Lucky" button, which takes you straight to the most relevant website that Google found for your query. You won't see the search results page at all, but if you did, the "I'm Feeling Lucky" site would be listed on top.

For example, if you're looking for the Doeacc homepage, just enter Doeacc and click "I'm Feeling Lucky" instead of the Google Search button. Google will take you directly to "www.Doeacc.edu."

Advanced Search

Once you know the basics of Google search, you might want to try Advanced Search, which offers numerous options for making your searches more precise and getting more useful results.

You can reach this page (shown below) by clicking the "Advanced Search" link on the Google home page.

With Advanced Search, you can search only for pages:

- that contain ALL the search terms you type in
- that contain the exact phrase you type in
- that contain at least one of the words you type in
- that do NOT contain any of the words you type in
- written in a certain language
- created in a certain file format
- that have been updated within a certain period of time
- that contain numbers within a certain range
- within a certain domain, or website
- that are available for anyone to use, share or modify, even commercially
- that don't contain "adult" material

Advanced search "operators"

You can also improve your searches by adding "operators" to your search terms in the Google search box, or selecting them from the Advanced Search page.

Advanced search operators include:

- Include Search
- Synonym Search
- OR Search
- Domain Search
- Numrange Search
- Other Advanced Search Features

"+" search

Google ignores common words and characters such as where, the, how, and other digits and letters which slow down your search without improving the results. We'll indicate if a word has been excluded by displaying details on the results page below the search box. If a common word is essential to getting the results you want, you can include it by putting a "+" sign in front of it. (Be sure to include a space before the "+" sign.)

For example, here's how to ensure that Google includes the "I" in a search for Shaktimaan, Episode I:

Shaktimaan

Synonym search

If you want to search not only for your search term but also for its synonyms, place the tilde sign ("~") immediately in front of your search term.

For example, here's how to search for food facts and nutrition and cooking information:

~food ~facts

"OR" search

To find pages that include either of two search terms, add an uppercase OR between the terms.
For example, here's how to search for a vacation in either Mumbai or Delhi:

vacation Mumbai OR Delhi

Domain search

You can use Google to search only within one specific website by entering the search terms you're looking for, followed by the word "site" and a colon followed by the domain name.

For example, here's how you'd find admission information on the Doeacc site:

admission site:Doeacc.edu

Numrange search

The numrange operator searches for results containing numbers in a given range. You can use Numrange to set ranges for everything from dates (Willie Mays 1950..1960) to weights (5000..10000 kg truck). Just add two numbers, separated by two periods, with no spaces, into the search box along with your search terms, and specify a unit of measurement or some other indicator of what the number range represents.

For example, here's how you'd search for a DVD player that costs between Rs5000 and Rs10000:

DVD player RS5000..Rs10000

Fill in the blanks "***" search

Sometimes the best way to ask a question is to get Google to 'fill in the blank' for you. You can do this by adding an asterisk "***" in the part of the sentence or question that you want filled in.

For example, here's how you'd search for who invented the parachute:

the parachute was invented by *

Other advanced search features

- **Language:** specify in which language you'd like your results.
- **File format:** specify the file format you'd like in your results
• **Date:** restrict your results to the past three, six, or twelve month periods.
• **Occurrences:** specify where your search terms occur on the page - anywhere on the page, in the title, or in the url.
• **Domains:** search only a specific website, or exclude that site from your search.
• **Usage rights:** specify the rights of usage you'd like in your results
• **SafeSearch:** Eliminates adult sites from search results
• **Page-specific:** Specify pages that are similar or link to your page

**WebMail**

The terms **Web-based email** (or **Web-based e-mail**) and **Webmail** refer to the implementation of an e-mail client as a Web application that allows users to access their e-mail through a Web browser, as an alternative to using a desktop-based client such as Microsoft Outlook, Mozilla Thunderbird or Eudora. A webmail client is usually offered by an email service to allow its users to access their mail stored on the service's server.

**Features**
Most Webmail services have the following features:
- Folders
- Filtering (incoming e-mail to dispatch to related folder)
- Trash folder
- Address book

Several Webmail services offer additional webmail client features:
- Dictionary and thesaurus when composing messages
- Spell checker
- Multiple sender identities
- Email search capabilities
- Secure login

And non-webmail features:
- Access to email through other protocols such as POP3 or IMAP4
- E-mail forwarding
- Email account integration (pulling of email from other accounts)
- E-mail spam detection
- Anti-virus checking of mail attachments
- Unicode (UTF-8) support

**Advantages of Webmail services**
- E-mail is stored remotely on a server, which means that it is accessible anywhere there is an Internet connection and a Web browser.
- Most Webmail providers charge no fee.
- Centralised maintenance of the Webmail i.e e-mail client; backups, upgrades and security fixes are done by the administrator. There is no need to install, update and patch by local e-mail clients.
- Some Webmail providers offer disposable (spam collection) e-mail addresses.

**Disadvantages of Webmail services**
- Users must stay online to read and write more than one e-mail. They cannot easily edit mails they are working on offline except by copying and pasting the text.
- Commercial Webmail services often offer only limited e-mail storage space and either display advertisements during use or append them to mails sent
- Webmail accounts are often targets of spam.
- Webmail accounts are accused of being insecure.
Blogs

Definition
A frequent, chronological publication of personal thoughts and Web links.

Information
A blog is often a mixture of what is happening in a person's life and what is happening on the Web, a kind of hybrid diary/guide site, although there are as many unique types of blogs as there are people.

Blogs are alternatively called web logs or weblogs. However, "blog" seems less likely to cause confusion, as "web log" can also mean a server's log files.

Newsgroup Definition

A newsgroup is a discussion about a particular subject consisting of notes written to a central Internet site and redistributed through Usenet, a worldwide network of news discussion groups. Usenet uses the Network News Transfer Protocol (NNTP).

Newsgroups are organized into subject hierarchies, with the first few letters of the newsgroup name indicating the major subject category and sub-categories represented by a subtopic name. Many subjects have multiple levels of subtopics. Some major subject categories are: news, rec (recreation), soc (society), sci (science), comp (computers), and so forth (there are many more). Users can post to existing newsgroups, respond to previous posts, and create new newsgroups. Newcomers to newsgroups are requested to learn basic Usenet netiquette and to get familiar with a newsgroup before posting to it. A frequently-asked questions is provided. The rules can be found when you start to enter the Usenet through your browser or an online service.

You can subscribe to the postings on a particular newsgroup. Some newsgroups are moderated by a designated person who decides which postings to allow or to remove. Most newsgroups are unmoderated.

Yahoo! Groups

Yahoo! Groups is a free service that allows you to bring together family, friends, and associates through a web site and email group. Yahoo! Groups offer a convenient way to connect with others who share the same interests and ideas. There are millions of groups that you can join in an easy-to-use, privacy-protected, and spam-protected environment. You can use the Yahoo! Groups service at our web site or through any email program.
Chapter 4(A)

Microsoft Excel
What is Excel?

Microsoft Excel is an electronic spreadsheet program. You might of heard the terms "spreadsheet" and "worksheet". People generally use them interchangeably. To remain consistent with Microsoft and other publishers the term worksheet refers to the row-and-column matrix sheet on which you work upon and the term spreadsheet refers to this type of computer application. In addition, the term workbook will refer to the book of pages that is the standard Excel document. The workbook can contain worksheets, chart sheets, or macro modules.

Introduction to Spreadsheet Concept

The Workbook

Most of the Excel screen is devoted to the display of the workbook. The workbook consists of grids and columns. The intersection of a row and column is a rectangular area called a cell.

Cells

The workbook is made up of cells. There is a cell at the intersection of each row and column. A cell can contain a value, a formula, or a text entry. A text entry is used to label or explain the contents of the workbook. A value entry can either be a constant or the value of a formula. The value of a formula will change when the components (arguments) of the formula change. The appeal of spreadsheet programs is the ability to change one value and watch all other values that depend on that first value automatically change when the spreadsheet is recalculated.

Rows, Columns, and Sheets

The Excel worksheet contains 16,384 rows that extend down the worksheet, numbered 1 through 16384. The Excel worksheet contains 256 columns that extend across the worksheet, lettered A through Z, AA through AZ, BA through BZ, and continuing to IA through IZ. The Excel worksheet can contain as many as 256 sheets, labeled Sheet1 through Sheet256. The initial number of sheets in a workbook, which can be changed by the user is 16.

Cell References

Cell references are the combination of column letter and row number. For example, the upper-left cell of a worksheet is A1.

The Excel Window

You will learn about Excel's toolbars and entering information into a workbook in the next part of the tutorial.
Getting Started

Throughout the tutorial you will have two windows active; a window displaying the tutorial and a window displaying an Excel workbook. Let's begin.

- Find and Open Excel.
- Resize and position then window displaying the tutorial next to the blank Excel workbook.

Excel displays a new workbook when it is opened. In a new workbook all the cells are empty. A cell is active when the border is highlighted in blue. When you enter information, the information is stored in the active cell. Let's learn how to enter information into a workbook.

Entering Information Into a Workbook

Entering Text and Constants

Click on the Excel window, select a cell by clicking on it, and enter: Excel is fun. Observe the following:

Observe that your text is displayed in two areas. Text is displayed in the active cell within the workbook and it is also displayed in the formula bar. The formula bar is activated as soon as you begin typing in a cell. At the far left is the reference section, which will show the reference of the active cell. Next to the formula bar are the Cancel and Enter buttons (X √ ). The Cancel and Enter buttons are only visible while Excel is in edit mode. Excel is in edit mode anytime you begin typing an entry. To put Excel in edit mode, click in the formula bar.

Within the Excel window, click in the formula bar to display the Cancel and Enter buttons. The Enter button enters the text you typed into the cell. You could also press the Return key on the keyboard.

If you want to edit the text you entered into a cell, you click the formula bar, type your changes and click on the Enter button. The Cancel button cancels your changes.

Within the Excel window, click in the formula bar and change the text: fun, to outrageous.

Click on the Enter button to enter the edit.

Click on the Cancel button to cancel the edit.

Entering constant values is the same as entering text, except that constant values are right-justified by default. You will learn how to change this default when you learn other formatting changes.
Entering Formulas

All formulas in Excel must begin with an equal sign (=). When a formula is entered into a cell, the formula itself is displayed in the formula bar when that cell is highlighted, and the result of the formula is displayed in the actual cell. When you are typing in formulas, do not type spaces; Excel will delete them.

Within the Excel window, select cell A2 and enter the constant value 12. (Remember to click the Enter button or the Return key when you are done typing).

Within the Excel window, select cell A3 and enter the constant value 15.

Within the Excel window, select cell A4 and click on the formula bar.

Within the formula bar, enter an equal sign followed by A3+A4.

Observe:
Click on the Enter button or press the Return key to enter the formula. Your worksheet should look as follows:

Excel displays the result of the formula in cell A4.

Within the Excel window, select cell A3 and change the number 15 to the number 40, and enter the edit.
The formula value should have changed in cell A4 to the number 52.

Creating a Simple Workbook

To create a simple workbook, you need to start with a blank workbook.

Within the Excel window, close and do not save the Workbook1 document.

Choose New from the File menu.
A new workbook should appear labeled Workbook2.
Resize and position **Workbook2** next to the tutorial. In this part of the tutorial you will be creating a check register.

Starting in cell A1, build the following table:

To move through your worksheet, you can use the arrow keys.

- The down arrow moves the active cell down to the next row.
- The up arrow moves the active cell up to the previous row.
- The right arrow moves the active cell right to the adjacent column.
- The left arrow moves the active cell left to the adjacent column.
- The return key moves the active cell to the next row.

Remember to click on the **Enter** button or press the Return key to enter each check number.

Select cell B1 and type in the text: **Data**.

Starting in cell C1, build the following table:

Select cell D1, and type the following text: **Payment Amount**.

Observe that the text is too large for the cell. You can change the width of the cell and as a result the whole column to fit the text.

**Changing Column Widths**

Position the pointer between the column headings for column D and column E. The pointer should change shape to show a double arrow as you position the pointer between the two column headings. When the pointer changes shape, you can change the width of the column by dragging to the right or left.

Press the mouse button and drag to the right until the width of column D will fix the text.
Starting in cell D3, build the following table:

Starting in cell E1, build the following table: Make sure you change the column width of column E.

Starting in cell F1, build the following table:

It is now time to save your worksheet.

Choose Save from the File menu or click on the Save button and call your worksheet "checks".

Writing Formulas Using Operators and Functions

Operators are what connects the elements of a formula. Some familiar operators are: addition (+), subtraction (-), multiplication (*), and division (/). There is an order of operations when you are evaluating a formula. Formulas are evaluated from left to right, with expressions enclosed in parentheses evaluated first, then exponents, multiplication, division, addition, and subtraction. Excel has many more operators, but we will work with the operators listed above for now. Here is an example of how the order of operations works: If you have the following formula within a cell; =A8/(A9+A4)

The first operation would be the sum of A9 and A4 and then A8 would be divided by that sum.
Describing Formulas

Excel allows you to add comments to explain the purpose of an inserted formula. The comments are displayed in the **Cell Note** window which can be viewed by choosing **Note** from the **Insert** menu. Let’s enter a formula using operators and comment the formula.

1. **Open a new workbook window.**
2. **Starting in cell A1 build the following table:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Grades</td>
</tr>
<tr>
<td>2</td>
<td>76</td>
</tr>
<tr>
<td>3</td>
<td>89</td>
</tr>
<tr>
<td>4</td>
<td>76</td>
</tr>
<tr>
<td>5</td>
<td>100</td>
</tr>
<tr>
<td>6</td>
<td>53</td>
</tr>
<tr>
<td>7</td>
<td>89</td>
</tr>
<tr>
<td>8</td>
<td>21</td>
</tr>
<tr>
<td>9</td>
<td>65</td>
</tr>
<tr>
<td>10</td>
<td>98</td>
</tr>
<tr>
<td>11</td>
<td>Total</td>
</tr>
<tr>
<td>12</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
</tr>
</tbody>
</table>

You are going to enter a formula which will calculate the average of these nine grades.

3. **Select cell A11 and type in the text:** Total.

It would be best if the total sum of the grades was beneath the last grade. You need to insert a column between column A and column B so you don’t have to retype all the numbers.

4. **Insert a Column**

   a. Highlight column A by clicking in the column heading. Observe:
      - Choose **Columns** from the **Insert** menu.
   b. Column A should be a blank column now. Select cell B1 and click in the formula bar.
   c. Highlight the text: Grades and **Cut and Paste** the text into cell A1.
   d. **Cut and Paste** the text: Total into cell A11.

Now to enter the formula for the total sum of the grades.

5. **Select cell B11 and enter the following formula:**

   Remember to click on the **Enter** button or press the Return key to enter the formula.

```
B11 = SUM(B2:B10)
```

Your worksheet should look as follows:

6. **Select cell A12 and enter the text:** Average.

7. **Select cell B12 and enter the following formula:**

   ```
   B12 = AVERAGE(B2:B11)
   ```

   ```
   A   B    C
   1   Grades  76
   2   89
   3   76
   4   100   53
   5   89
   6   21
   7   65
   8   98
   9   11   Total  867
   10
   11
   12
   ```
Your worksheet should look as follows:

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Grades</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>76</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>89</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>76</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>53</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>89</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>21</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>65</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>90</td>
</tr>
<tr>
<td>11</td>
<td>Total</td>
<td>667</td>
</tr>
<tr>
<td>12</td>
<td>Average</td>
<td>74.11111111</td>
</tr>
</tbody>
</table>

Let's annotate (comment) the formula in cell B12.

**Annotating Formulas**

You can attach notes to cells by using comments, formerly called cell notes. You can view each comment when you rest the pointer over the cell or view all comments at the same time. You can print comments in the same locations where they are displayed on the worksheet or a list at the end of the worksheet. Microsoft Excel uses the user's name in each comment.

Select cell B12.

Choose **Comment** from the **Insert** menu.

The following **Cell Comment** box should appear:

Within the Text Note box, type in the text: Average of nine grades and then click anywhere outside the box.

Note that there is a red note indicator in the upper-right corner of the cell. Anytime you put the mouse over the red note indicator, your comment will appear.

Now that you know how to compute the average using operators, it is time to learn how to write a formula using Excel's functions.

**Functions**

Functions are used to form all or part of a formula. Excel provides two general types of mathematical functions: those that are used in business applications and those that are oriented to higher mathematics. In this tutorial we will focus on the business applications formulas.

The **AutoSum** button (Σ) located in the **Standard** toolbar.

Whenever you click the **AutoSum** button, Excel inserts a SUM() function in the active cell. Not only will the SUM() function write the sum formula, but it will make a guess at what range of cells you desire to sum, and will leave you in edit mode so that you can correct the sum range.

Select cell C11 and click on the **AutoSum** button located in the **Standard** toolbar.

Your worksheet should look as follows:
Excel has guessed that you want to insert cell B11, which contains the appropriate formula. Let’s assume Excel did not guess correctly.

Within the formula bar highlight B11 and delete it.

The Sum function is waiting for its arguments. You want to sum up B2 through B10, this is denoted in a more compact form as B2:B10.

Position your cursor in the formula bar, cut out B11 and instead type in B2:B10.

Observe:

Click on the Enter button or press the Return key to enter the formula.

The Sum function is one of the many functions Excel provides. Excel also provides many statistical functions in particular the Average function.

Excel provides two ways for entering function names. You can type the name of the function in if you know it or you can use the Function Wizard.

Using The Function Wizard

To use the Function Wizard you can choose Function from the Insert menu or you can click on the Function Wizard button (function) located on the Standard toolbar.

Select cell C12 and open the Function Wizard dialog box by either method described above.

Observe:

We want to use the AVERAGE function. The AVERAGE function will take the average of all the numbers you list in the parentheses. The Function Wizard will take you through setting up the formula step by step.
Within the **Function Wizard** dialog box highlight the Function Category: Most Recently Used and highlight the Function Name: AVERAGE then click on the OK button.

The following dialog box should appear:

Enter the range B2:B10 and then click on the OK button.

Click on the Enter button or press the Return key to enter the formula.

The following dialog box should appear:

![AVERAGE dialog box](image)

- **Number1**: B2:B10
- **Number2**: (Optional)

Returns the average (arithmetic mean) of its arguments, which can be numbers or names, arrays, or references that contain numbers.

<table>
<thead>
<tr>
<th>Formula</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=AVERAGE(B2:B10)</td>
<td>Enter the range B2:B10</td>
</tr>
</tbody>
</table>

Your workbook should look as follows:

Now that you know how to enter formulas using operators and functions, you can practice on your "checks" workbook.

Close **Workbook3** and don't save the file. Open the "checks" workbook.

Select cell F3 and enter the following formula:

```excel
=F2-D3
```

This formula will computer your balance after check 100 has been written.

Select cell F4 and enter the following formula:

```excel
=F3-D4
```

This formula will computer your balance after check 101 has been written.

Select cell F5 and enter the following formula:

```excel
=F4+900-D5
```

This formula will computer your balance after check 102 has been written plus the $900 dollar deposit has been accounted for.

Select cell F6 and enter the formula that would compute the balance after 103 has been written.

Your "checks" workbook should look as follows:

If something is incorrect in your "checks" workbook, go back and check over your formulas.
Save your changes.

Starting in cell B3, build the following table:

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>100</td>
<td>8-Aug-96</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>101</td>
<td>10-Aug-96</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>102</td>
<td>13-Aug-96</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>103</td>
<td>20-Aug-96</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Formatting The Appearance of a Workbook**

You will learn how to format an Excel workbook in this part of the tutorial.

Open your "checks" workbook if it isn't already opened.

Select the first row of the "checks" workbook, by clicking in the cell containing the bold face 1. Observe:

You have just selected what Excel describes as a range.

**The Concept of a Range**

A range is a rectangular block of cells. Many things are accomplished in Excel using ranges. For instance, the format used to display values can be changed for an entire range. All the values in a range can be referred to when writing a formula. A range of cells can also be protected, which means the contents of the cells cannot be altered. Ranges can also be named. Excel also allows you to select discontinuous ranges. You will learn how to do this further on in the tutorial.

With the range of cells A1:F1 selected, click on the Bold button and Center alignment button. This formatting should have made the text too big for the cells.

Adjust the column widths of the columns.

Your workbook should look similar to the following:

<p>| | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>100</td>
<td>8-Aug-96</td>
<td>Almacs</td>
<td>89.54</td>
<td>210.46</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>101</td>
<td>10-Aug-96</td>
<td>Nynex</td>
<td>56.1</td>
<td>154.36</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>102</td>
<td>13-Aug-96</td>
<td>Sue Fisher</td>
<td>235.13</td>
<td>900</td>
<td>819.23</td>
</tr>
<tr>
<td>6</td>
<td>103</td>
<td>20-Aug-96</td>
<td>BMG</td>
<td>76.36</td>
<td></td>
<td>742.88</td>
</tr>
</tbody>
</table>

Selecting Discontinuous Ranges
Select the first range of cells: A3:A6.

Hold down the Ctrl key and select the range of cells: C2:C6.

Observe:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Eq Balance</td>
<td></td>
<td></td>
<td></td>
<td>300</td>
</tr>
<tr>
<td>2</td>
<td>100</td>
<td>8-Aug-96</td>
<td>Amlacs</td>
<td>89.54</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>101</td>
<td>10-Aug-96</td>
<td>Nynex</td>
<td>56.1</td>
<td>210.46</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>102</td>
<td>13-Aug-96</td>
<td>Sush Fisher</td>
<td>235.13</td>
<td>154.36</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>103</td>
<td>20-Aug-96</td>
<td>EMG</td>
<td>76.35</td>
<td>819.23</td>
<td></td>
</tr>
</tbody>
</table>

Click on the Center alignment button. Let's format the dates.

Formatting Dates and Numbers

The basic formatting rule "select and then do" is used when working with Excel.

Select the range of cells: B3:B6.

Choose Cells from the Format menu. The following Format Cells dialog box should appear:

Click on the Number tag if it is not already displayed.

Within the Category box highlight Date to view all the Format Codes.

Scroll through the options in the Format Codes. There is no format that displays as: Aug. 8, 96. You can custom format by typing in the Code box.

Within the Code box, type in the following custom format:

Click on the Center alignment button to align the dates.

Now let's format the dollar amounts. Select the discontinuous range displayed below:
<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Number</td>
<td>Date</td>
<td>Description</td>
<td>Payment Amount</td>
<td>Deposit Amount</td>
<td>Balance</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td>Beg. Balance</td>
<td></td>
<td></td>
<td>300</td>
</tr>
<tr>
<td>3</td>
<td>100</td>
<td>Aug. 8, 96</td>
<td>Almacs</td>
<td>89.54</td>
<td></td>
<td>210.46</td>
</tr>
<tr>
<td>4</td>
<td>101</td>
<td>Aug. 10, 96</td>
<td>Nynex</td>
<td>56.1</td>
<td></td>
<td>154.36</td>
</tr>
<tr>
<td>5</td>
<td>102</td>
<td>Aug. 13, 96</td>
<td>Sue Fisher</td>
<td>235.13</td>
<td>900</td>
<td>819.23</td>
</tr>
<tr>
<td>6</td>
<td>103</td>
<td>Aug. 20, 96</td>
<td>BMG</td>
<td>76.35</td>
<td></td>
<td>742.88</td>
</tr>
</tbody>
</table>

Remember to select the first region, then hold down the apple key when you select the remaining regions.

- Choose **Cells** from the **Format** menu.
- Click on the **Number** tab if it is not already displayed.
- Within the Category box highlight Currency.
- Select the following Format Code and then click **OK**:
- Click on the **Center** alignment button to align the dollar amounts.

Note that you could have selected the whole "checks" workbook and then clicked on the **Center** button.

Your "checks" workbook should look as follows:
Let's insert a row between row 2 and row 3 in the "checks" workbook, to make the workbook more appealing to the eye.

Select row 3 by clicking on the bold face 3.

Choose Rows from the Insert menu.
You have now learned how to format an Excel document. Note that within the Format Cells dialog box you can format the borders of the cells, change the color, pattern, and shading of the cells and protection of cells can be set there too.
You have completed your first workbook. It is time to preview it.
Choose Print Preview from the File menu.
Observe:
Click on the Close button to return you to the workbook.
Observe the dotted line between column E and column F, the dotted line indicates that there will be a page break there.

What you want to do is actually flip the table so it will fit on the whole page. You can do this by choosing Page SetUp from the File menu.
Choose Page SetUp from the File menu.
The following Page Setup dialog should appear:
Click on the Page tab if it isn't already displayed.
Within the Orientation box click on Landscape and then click on the OK button. Observe the dotted line (indicating a page break) at the bottom of your workbook and running horizontal.
Preview your "checks" workbook and then print a copy of it.

When your done printing close the "checks" workbook.

Advanced Excel (Copying Cells)

In this part of the tutorial you will be creating a workbook and learning how to fill a cell or range of cells with formulas to speed data entry.

Find and Open Excel 97 if it isn't already open.

Choose New from the File menu to start a new workbook if there isn't a new workbook open.

Choose Formula Bar from the View menu to display the formula bar.

You will be creating an income statement worksheet.

Make the entries displayed below:

Select the text below the bold faced headings, and right justify the text. Remember to hold down the Ctrl key when selecting a discontinuous range.

Observe:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The Book Company</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1996 Projections</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Ctrl</td>
</tr>
<tr>
<td>4</td>
<td>REVENUE</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Sales</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Service</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Total</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>Ctrl</td>
</tr>
<tr>
<td>9</td>
<td>EXPENSES</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Wages</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Supplies</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Total</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td>Ctrl</td>
</tr>
<tr>
<td>14</td>
<td>INCOME</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Gross</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Tax</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Net</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td>Ctrl</td>
</tr>
</tbody>
</table>

Your workbook should look as follows:
Before you enter any formulas, let's name some of the cells in your worksheet.

**Naming Cells**

Excel allows you to name any cell, range, or value in a workbook. You can then use this name to refer to the cell, range, or value. Names make formulas easier to read, understand, and maintain. You can change or delete names that have been defined previously. Names appear in the reference area of the formula bar when you select a named cell or range.

Select cell B6 and choose **Name** from the **Insert** menu, and choose **Define** from the **Name** submenu.

Within the **Names** dialog box, Excel provides a possible name: Sales. This is fine. Click the **OK** button.

Select cell B7 and name it: Service.

Enter the following constants into your workbook:

Select cell B8 and enter the formula that sums Sales and Services.

Save your workbook as "company".

The formula in cell B8 should be either the formula =B6+B7 or =SUM(B6:B7). The formula is summing up the two cells directly above cell B8. If you look at cell B13, it will need a formula too. The formula in cell B13 will also sum up the two cells directly above it. This is where Excel's **Copy** command is useful. What you can do is copy the formula from one cell to another cell.
Copying From One Cell to Another Cell

Select cell B8.

Choose Copy from the Edit menu. Excel places a marquee around the cell.

Select cell B13 and choose Paste from the Edit menu.

Your company workbook should look as follows:

Press the Escape key on your keyboard to cancel the marquee.

Select cell B13. The formula should be =B11+B12 or =SUM(B11:B12). That is the formula has summed the two cells directly above cell B13.

Your company workbook should look as follows:

```
<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The Book Company</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1996 Projections</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>Qtr.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>REVENUE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Sales</td>
<td>46000</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Service</td>
<td>55000</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Total</td>
<td>101000</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>EXPENSES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Wages</td>
<td>52000</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Supplies</td>
<td>22500</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Total</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>INCOME</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Gross</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Tax</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Net</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Save your work before proceeding.

You now know how to copy a formula from one cell to another. Next, in order to duplicate the Qtr. heading across columns C through E, you will make a copy from one cell to several other cells.

Copying From One Cell to Several Cells

Select cell B4 and choose Copy from the Edit menu.

Highlight the range C4:E4.
Choose **Paste** from the **Edit** menu.

Press the Escape key to remove the marquee.

Your *company* workbook should look as follows:

Center the Qtr. headings.

Save your work before proceeding.

The next step is to fill in the range C6:E7 with projected revenues.

Select cell C6 and enter the formula \(=B6*1.08\).

Choose **Copy** from the **Edit** menu.

Highlight the range C6:E7.

Observe:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The Book Company</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1996 Projections</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Qtr.</td>
<td>Qtr.</td>
<td>Qtr.</td>
<td>Qtr.</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>Sales</td>
<td>46000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>Service</td>
<td>55000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>Total</td>
<td>101000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>INCOME</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>Gross</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>Tax</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>Net</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Fill Command

Choose **Paste** from the **Edit** menu.

Your *company* workbook should look as follows:

Highlight the cells in the range C6:E7 and observe the cell's formulas. In each cell the formula multiplies the cell directly to the left of it by 1.08.
Select the range B8:E8.

Choose Fill from the Edit menu, and from the Fill submenu choose Right. Your company workbook should look as follows:

The projected expenses in the range C11:E12 are computed as 1.02 times the value of the previous quarter.

Select cell C11 and enter the formula =B11*1.02.

Select the range C11:C13 and choose Fill from the Edit menu, and from the Fill submenu choose Down.

Your company workbook should look as follows:

Excel provides another means of copying text, values, or formulas from one cell to other cells. Excel provides the AutoFill command. AutoFill copies cell’s contents without using the menu. You work directly on the workbook using the mouse.
Copying Cells Using AutoFill

The AutoFill feature is used to copy formatting, formulas, or all cell contents, or to perform different types of series extensions. For example, if you type Monday and Tuesday in consecutive columns, and then drag the fill handle to the right, Excel fills Wednesday, Thursday and so on into selected cells.

Select cell C11. Cell C11 contains the formula you want to copy. Observe the fill handle located in the lower-right corner. Place your mouse over the fill handle, until the arrow becomes a black cross.

Drag the fill handle across the cells D11 and E11 and then release the mouse button.

Your company workbook should look as follows:

You can also select more than one cell and then use the AutoFill command to copy.

Select the range C12:C13.

Drag the fill handle across the range D12:E13.

Your company workbook should look as follows:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The Book Company</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1995 Projections</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Qtr.</td>
<td>Qtr.</td>
<td>Qtr.</td>
<td>Qtr.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>REVENUE</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Sales</td>
<td>46000</td>
<td>49680</td>
<td>53654.4</td>
<td>57945.752</td>
</tr>
<tr>
<td>7</td>
<td>Service</td>
<td>23000</td>
<td>29400</td>
<td>64152</td>
<td>69290.16</td>
</tr>
<tr>
<td>8</td>
<td>Total</td>
<td>101000</td>
<td>109080</td>
<td>117806.4</td>
<td>127230.912</td>
</tr>
<tr>
<td>9</td>
<td>EXPENSES</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Wages</td>
<td>50000</td>
<td>60240</td>
<td>64504.8</td>
<td>65794.896</td>
</tr>
<tr>
<td>11</td>
<td>Supplies</td>
<td>21500</td>
<td>22960</td>
<td>23498</td>
<td>23977.18</td>
</tr>
<tr>
<td>12</td>
<td>Total</td>
<td>81500</td>
<td>83200</td>
<td>87913.6</td>
<td>90572.076</td>
</tr>
<tr>
<td>13</td>
<td>INCOME</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Gross</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Tax</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Net</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You have now learned how to copy in Excel. You may use any method above to finish the company workbook.

Select cell B16 and enter the formula =B8-B13. (Gross Income is equal to Total Revenue minus Total Expenses)
Select cell B17 and enter the formula =B16*.22. (The Tax is 22%) Select cell B18 and enter the formula =B16-B17. (Net Income is Gross Income minus the Tax)

Your company workbook should look as follows:

Copy the formulas in the range B16:B18 to the range C16:E18 using any method you would like.

Your company workbook should look as follows:

You have almost completed your company workbook. There is one more column to enter.

Select cell F4 and enter and center the text: Year.

Select cell F6 and enter the formula =SUM(B6:E6).

Copy the formula in cell F6 into the following ranges: F7:F8, F11:F13, and F16:F18.

Your completed company workbook should look as follows:
Save your changes. Your company workbook is complete. You can now use the power of Excel's automatic recalculation feature. You can now use **What If?** analysis.

**What If? Analysis**

What If? analysis involves three steps:

1. First, you ask a What If? question about your workbook. For example, "What if the total revenue in the first quarter was $5000?"

2. Second, you alter the appropriate cell or cells in your workbook. In this case it would be cell B8.

3. Third, you observe how the different values in the workbook change.

Experiment with a What If? analysis and enter $5000 into cell B8.

Observe that the Income entries are now negative.

Undo the entering of $5000 or enter $101000 in cell B8.

**Linking Documents in Excel**

Excel can dynamically link a workbook to source data in another workbook so that any changes you make in one workbook are immediately reflected in the other workbook. The following terms apply to linking documents:

- **External Reference** - A reference to another Excel workbook cell, cell range, or defined name. A formula containing an external reference is called an external reference formula.

- **Dependent Workbook** - A workbook that contains a link to another workbook. In other words, a workbook that relies on information in another workbook.

- **Source Workbook** - A workbook that is the source of the information referred to in an external reference formula; source workbooks are referred to by dependent workbooks.

**Creating Links between workbooks**

You will need two workbooks to create a link. The company workbook will serve as your first and as the Source Workbook. The second workbook will be created and serve as the Dependent Workbook.

Let's start by creating the Dependent Workbook.
Choose **New** from the **File** menu to start a new workbook.

Create the following workbook and call it **budget**:

- Select cell C6 and enter the formula =C4+C5.
- Select cell C11 and enter the formula =C9+C10.
- Select C13 and enter the formula =C6-C11.

Your **budget** workbook should look as follows:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Personal Budget</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td><strong>Revenue</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Book Company Net Income</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Salary</td>
<td>25000</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Total</td>
<td>25000</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td><strong>Expenses</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Mandatory</td>
<td>6000</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Personal</td>
<td>2500</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Total</td>
<td>10500</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td><strong>Net Income</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td>14500</td>
<td></td>
</tr>
</tbody>
</table>

It is now time to create a link between the workbooks; **company** and **budget**. Have both workbooks open.

In the **Source Workbook**: **company** select cell F18. This is the cell you want to refer. You want to insert this value into your **budget** workbook.

Click the **Copy** button or choose **Copy** from the **Edit** menu. A moving border should appear around cell F18.

Switch to the **budget** workbook. This is the workbook you want to paste the linked data.

Select cell C4. This is the cell in which you want the linked data to appear.

Choose **Paste Special** from the **Edit** menu.

The following **Paste Special** dialog box should appear:
Choose All in the Paste box and None in the Operation box.

Choose the Paste Link button to paste the link into cell C4.

Your budget workbook should look as follows:
Excel created an external reference formula that links the workbooks. This formula appears in the formula bar.

You have successfully linked two documents. You can now play around with What If? analysis and see how changes in the the Book Company's income will effect your personal budget.

Save your changes.

Creating Charts

Before you can draw a chart using Excel, the numbers that compose the chart must be entered in a workbook. There are five general steps in defining a chart.

Steps in Creating a Chart:

1. Enter the numbers into a workbook.
2. Select the data to be charted.
3. Choose Chart from the Insert menu.
4. Choose either Chart Type from the Format menu or click on the ChartWizard button.
5. Define parameters such as titles, scaling color, patterns, and legend.

These five steps should be performed in this order. Note that since the chart is linked to the workbook data, any subsequent changes made to the workbook are automatically reflected in the chart.
You will be making two charts in this part of the tutorial. The first chart will be a pie chart and the second chart will be a column chart.

Creating a Pie Chart

Pie charts are used to show relative proportions of the whole, for one data series only. Data series are a group of related data points. A data point is a piece of information that consists of a category and value.

For example, if you were collecting data on how couples first meet, then the number of couples who met through friends would be a data point. In this case the category is "through friends" and the value is the number of couples who met that way.

When you create a chart with Excel, the categories are plotted along the horizontal or X-axis, while the values are plotted along the vertical or Y-axis. Data series originate from single worksheet rows or columns. Each data series in a chart is distinguished by a unique color or pattern. You can plot one or more data series in a chart except for pie charts. An example of a data series is the population of the United States over ten years. Each data point would be made up of a year (the category) and the population in that year (value). The first step in creating any chart is to enter the data on a workbook.

1. Find and open Excel 97 if it is not already open.
2. Make sure your toolbars and formula bar is displayed.
3. Open a new workbook.
4. Save your workbook and name it "expenses".
5. Enter the following into your expenses workbook:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>1</td>
<td>Weekly</td>
</tr>
<tr>
<td>2</td>
<td>Food 40</td>
</tr>
<tr>
<td>3</td>
<td>Clothes 20</td>
</tr>
<tr>
<td>4</td>
<td>School Supplies 15</td>
</tr>
<tr>
<td>5</td>
<td>Bills 45</td>
</tr>
<tr>
<td>6</td>
<td>Recreation 25</td>
</tr>
<tr>
<td>7</td>
<td>Gas 10</td>
</tr>
</tbody>
</table>

You will be using the ChartWizard to create your pie chart.

Using The ChartWizard

The ChartWizard is a series of dialog boxes that guides you through the steps required to create a new chart or modify settings for an existing chart. When creating a chart with the ChartWizard, you can specify the worksheet range, select a chart type and format, and specify how you want your data to be plotted. You can also add a legend, a chart title, and a title to each axis.

There are two commands and two buttons that start the ChartWizard. The command you choose or the button you click will create either an embedded chart or a chart sheet.

An embedded chart is a chart object that has been placed on a worksheet and that is saved on that worksheet when the workbook is saved. When it is selected you can move...
and size it. When it is **activated**, you can select items and add data, and format, move, and size items in the chart. A chart sheet is a sheet in a workbook containing a chart. When a chart sheet is created, it is automatically inserted into the workbook to the left of the worksheet it is based on. When a chart sheet is activated, you can select items and add data, and format, move and size items in the chart. In this tutorial you will be creating chart sheets only.

**Do this:**
Select the data you just entered.

**Do this:**
Choose Chart from the Insert menu.
Observe that the ChartWizard's first dialog box appears:

You want a regular pie chart not a 3-D pie chart.

**Do this:**
Select the chart type: Pie and click on the Next button.
The following dialog should appear:

**Do this:**
Read the dialog box, make sure the range is correct and then click the Next button.
The following dialog should appear:

**Do this:**
Select the Titles tab and then enter "Weekly Expenses" as the chart title.

**Do this:**
Select the Legend tab and make the following adjustments:
Select the Data Labels tab and select the following options:

Select the following options and then click the Finish button.

Your expenses workbook should look as follows:
Save your changes. Once you complete the ChartWizard, Excel displays the new chart sheet, the Chart toolbar (), and the chart menu bar. Note that if the chart toolbar is not displayed, simply choose Toolbars from the View menu and check off the chart box. The chart menu bar is similar to the worksheet menu bar, except the Insert and Format menus have some different commands.

**Formatting a Chart**

Before we can discuss the details of how to edit and format a chart, you need to know how to activate the chart and select items in the chart using a mouse.

**Selecting Items In a Chart Using a Mouse**

To select one of the following items in an Excel chart:

- **Data Series**- click any data marker belonging to a data series.
- **Pie slice**- select the pie ring, and then click the slice.
- **Data labels**- click any data label associated with a data series.
- **Single data label**- select the data labels, and then click an individual label.
- **Legend**- click anywhere in the legend, or click its border.
- **Single legend entry**- select the legend, and then click the legend entry.
- **Title**- click the chart title, axis title, or text box.
- **Axis**- click the axis or a tick-mark label to format or modify the axis.

Let's change the colors of the pie slices.
Select the Pie ring. Your pie chart should look similar to the following:

Select the 29% pie slice.

Observe:

Choose Selected Data Point from the Format menu.

The following Format Data Point dialog box should appear:

Select the Patterns tab and choose a different color and pattern for the slice.

Select another pie slice and change its color.

Select the Chart title.
Choose a different color from the Font Color button.

Select the chart.

Observe the ChartWizard toolbar that is displayed on your screen. There is a Legend button located on the toolbar. If you want to add or delete a legend to a chart just press that button. Now that you have completed your weekly expenses pie chart let's print it out. Before you print it out let's preview it.

Save all your changes.

Choose Print Preview from the File menu.

Make sure that the text: Page 1 and Chart 1 is not displayed, if this text appears the layout of the page must be set.

Click on the Close button.

Choose Page SetUp from the File menu.

Within the Page Setup dialog box select the Header/Footer tab.

Within the Header/Footer box select none from the Header and Footer pull-down menus. This will clear the text: Chart1 at the top of your pie chart and it will also clear the text: Page 1 at the bottom of your pie chart.

Within the Page Setup dialog box, select the Chart tab and select the following setting:
Click on the OK button.

Click on the Print button.

Creating a Column Chart

Column charts use bars of varying lengths to indicate amount. The bars are of different colors or patterns to indicate the different type of data, and they run vertically across the chart.

Open your expenses workbook.

Click on the Sheet 2 tab at the bottom of the expenses workbook to enter the data for your column chart.

Create a worksheet that looks as follows:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Month</td>
<td>General</td>
<td>Business</td>
</tr>
<tr>
<td>2</td>
<td>Jan</td>
<td>225</td>
<td>12</td>
</tr>
<tr>
<td>3</td>
<td>Feb</td>
<td>747</td>
<td>748</td>
</tr>
<tr>
<td>4</td>
<td>Mar</td>
<td>100</td>
<td>422</td>
</tr>
<tr>
<td>5</td>
<td>Apr</td>
<td>987</td>
<td>991</td>
</tr>
<tr>
<td>6</td>
<td>May</td>
<td>45</td>
<td>211</td>
</tr>
<tr>
<td>7</td>
<td>Jun</td>
<td>789</td>
<td>1000</td>
</tr>
<tr>
<td>8</td>
<td>Jul</td>
<td>142</td>
<td>345</td>
</tr>
<tr>
<td>9</td>
<td>Aug</td>
<td>55</td>
<td>881</td>
</tr>
<tr>
<td>10</td>
<td>Sep</td>
<td>640</td>
<td>33</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Remember to use Excel's Copy features that you learned in the previous part of the tutorial.

Select the data to be charted.
Choose **Chart** from the **Insert** menu.

The following should appear on your screen:

Choose the chart type: **Column** and click on the **Next** button.

Choose following format type and click on the **Next** button.

The following should appear on your screen:

If the range is correct, click on the **Next** button.

Insert the following on the titles tab and click the **Next** button.

Observe:

Select the following options and click the **Finish** button.

Observe:
Let's format the column chart.

- Select the business (data series) columns and make them yellow.
- Select the general (data series) columns and make them green.

Your column chart should look similar to the following:

Select a grid line and choose **Selected Gridlines** from the **Format** menu.
The following **Format Gridlines** dialog should appear:

Choose a different style for the line and click the **OK** button.
Lastly, let's change the alignment of the text that makes up the months.

Select the X-axis.

Choose **Selected Axis** from the **Format** menu.

Within the **Format Axis** dialog box click on the **Alignment** tab.

Select the following option and click the **OK** button. Observe:
Your column chart should look similar to the following:

- Preview your chart.
- Clear the Chart 2 and Page 1 text in the Header and Footer respectively using the **Page Setup** command.
- Print a copy of your column chart.
Chapter 4(B)

Introduction to PowerPoint
Introduction to PowerPoint

Index

1. Using PowerPoint
2. Getting started
3. A simple presentation
4. Colour schemes
5. Animations and Transitions
6. Graphics from files
7. Drawing your own diagrams
8. Using the master slide
9. Preparing and delivering a presentation
Introduction to PowerPoint

1. Using PowerPoint

PowerPoint is a presentation package. Its most common use is to create a slideshow to accompany a lecture or presentation. It can also be used to create an automatic on-line presentation or to create posters. The point of a presentation package like PowerPoint is that it makes it easy to place different objects on the page or the screen. Objects can be of different sorts, including text, images, hypertext links, movies and sounds. These notes will deal with slideshows consisting of slides containing text and images. The slides in your slideshow can be printed on overhead projector (epidiascope) slides, often known as acetates, or made into 35mm slides, but the commonest way of presenting PowerPoint slides nowadays is through a computer and data projector.

Power Point files

When you create a presentation you usually create a single file which contains all your slides. Be careful, there are two New buttons on the PowerPoint toolbar: one on the extreme left of the toolbar is the new presentation button and it will create a new presentation file. The other is the new slide button, which creates a new slide within the current presentation. If you use images in your presentation they are usually all embedded in the presentation, so that everything you need is included in a single file. PowerPoint files are often too large to fit on a floppy disk. You should expect to have to save your presentation on a Zip disk, CD, or USB memory stick. On your own computer you can save the presentation on your hard disk, but you will need a Zip disk or CD for backup or if you want to transfer your presentation to another computer.

Versions of PowerPoint

There are three versions of PowerPoint in common use at present, PowerPoint97, PowerPoint2000 and PowerPoint XP (otherwise known as PowerPoint2002). The classroom PCs have PowerPoint2000. The appearance of the menus and toolbars is almost identical in PowerPoint97 and PowerPoint2000, but they have been re-organized in PowerPoint2002. You can open presentations created with PowerPoint2002 in PowerPoint2000 or 97, but features that depend on the later version will be lost. You can save files created with PowerPoint2002/2000/97 in a format that is compatible with the older PowerPoint95, but files saved in this way are usually very large. PowerPoint95 is not very common nowadays. Moving presentations to a different computer You will often create your presentation on one computer and present it on a different one. In this case you need to think ahead. You should save your presentation on a CD or memory stick, as not all PCs have a Zip drive. Beware that some features of your presentation will not appear identical on all computers. Some advanced features will be lost if the computer you are using for the presentation has an older version. Fonts present a special problem. If the fonts on your slides not installed on the computer you are using, the results are often unpredictable. You can embed your fonts in your presentation (increasing the file size still further) but even so the result depends on how exactly the PC you are using is configured. The best advice is to restrict yourself to standard fonts such as Arial and Times New Roman. In any case, always test your presentation in advance on the computer you expect to use.

Library and Information Services
2. Getting started

Exactly how we get started depends on our version of PowerPoint and how it has been set up.

- If PowerPoint is not running start it up and tell it to start a blank presentation. If PowerPoint is already running click the New Slide button or choose New Slide from the Insert menu.
- You should see a dialog-box (called the New slide or the Slide layout dialog-box) which offers you a range of different slide layouts. Choose the layout for bulleted list (referred to in PowerPoint 2002 as Title and Text) PowerPoint is sometimes configured to give you the bulleted list layout automatically, in which case you will not have to use the Slide layout dialog-box.

The editing screen should look like this:

Editing and displaying your slides PowerPoint has different ways of displaying your slides. While you are working on your presentation you will usually look at the slides in editing mode, known as Slide view or Normal view. Here you can type in your text, edit it and paste in images. When delivering your presentation you will display the slides in Slide show view. As you create your slides you should look at them in Slide show view so that you can see how they will appear to your eventual audience. Look in the View menu and note the commands for choosing the different views. There are others apart from Normal and Slide show which we shall look at later on. Look in the bottom left corner of the screen. You will see little icons there which give a quick way of moving between different views.

Note the icon for going into Slide show view. The Slide show icon will start the slideshow not with the first slide in the presentation, but with the current slide.

Save your file As with any other computer program you must save your work frequently to guard against accidents. When you first save your presentation you will have to say where the file is to be saved and what it is to be called.
• Save your presentation now. Call it creepy crawlies and save it in My Documents. From now on, you should save the file at frequent intervals. Introduction to PowerPoint

3. A simple presentation
The building-blocks of a PowerPoint presentation are slides consisting of bullet points. This section shows how to create these basic slides, along with a title slide.

Create two slides

You should now be ready to create your first slide. The editing screen should look like this:

• Click where it says Click to add title and then type in a title for your slide. If you have to change what you have typed you can re-position the insertion-point (cursor) using either the mouse or the arrow-keys. Delete and Backspace work as usual.
• Click where it says Click to add text and then type in your first bullet point. You don’t have to type the bullet. Press Return at the end to go on to the next point.
• Type further bullet points. Your slide might now look like this.

Note that on the last line (below Millipede) there is a grey bullet. If you don’t type in anything after this, the blank bullet will not be displayed when you actually show your slide.

Now create a second slide:

• Choose New slide from the Insert menu
• If asked to choose a layout for the new slide choose the same bullet list layout
• Click in the title box and type in the title
• Click in the main text box and type in some bullet points about Frogs as shown. Now that you have two slides you can see that there is a scrollbar on the right of the window.

Slide Preview
- Scroll up to the first slide
- Amend the first slide – for example change the first two points on the first slide so that Frogs comes before stag beetle. Different levels of bullet points. So far all the bullet points are at the same level. Often you will want to use subordinate levels, and PowerPoint allows you to do this.
- Place the cursor of your final point and press Return to go onto a new line
- There is a right-pointing arrow on the toolbar which you can use to demote this point to a subordinate point. There is also a left-pointing arrow which is used to promote second level points to first level points.

In PowerPoint97 and 2000 these arrows look like this.
In PowerPoint2002 the standard increase and decrease indentation buttons are used
- Click the right-pointing arrow
- Type in your two subordinate points as shown here. Save and view your presentation
- Click the Save button on the toolbar or choose Save from the File menu
- Choose Slide show from the View menu to look at your slides properly
- The slideshow should start with the first slide. Click the mouse-button to go on to the next slide
- To go back to the previous slide press the letter P
- To finish the slideshow, either go on clicking the mouse till you get to the end or press the Esc key

Create a third slide
- Make sure you are back in normal slides view for editing. If you are still in the slideshow press the Esc key
- If you are not already looking at the second slide, scroll down to display it
- Choose New slide from the Insert menu
- If asked to choose a layout choose the bullet list layout as before
- Type in a title and a series of points about stag beetles, using the information below. Part of the point of the exercise here is to make you extract your brief bullet points from the discursive text given here.

Stag beetles look ferocious but are really quite harmless. Their numbers are threatened partly because gardeners are too tidy. To encourage stag beetles you should make sure that there are old woodpiles and other kinds of garden rubbish left to rot in odd corners of your garden. Stag beetles like damp places, but they can’t swim, and are often drowned in open water-butts.
A title slide
- Insert a new slide. This time choose Title slide from the palette of slide layouts
- Type in the title of your presentation, eg Creepy-crawlies
- Type in a sub-title.

This could be your name, or the date, or anything else you choose. You don’t have to have a sub-title

The slide sorter

- Naturally you want your title slide to be at the beginning of your presentation. You can move it using the slide-sorter.
- Choose Slide Sorter from the View menu
- Point at your title slide, press the mouse-button and drag it to before the first slide
- When the marker is at the very beginning of the slide sorter display, release the mouse button
- View your presentation as a slideshow and then save it

4. Colour schemes

At present your slides have black text on a white background, which is perfectly all right, but you may want to choose something more colourful. You can choose colours for different elements on your slides. We shall just consider the background colour and the colours for the title and body text.

Standard colour schemes

Be careful when choosing a colour scheme. Your two favorite colours might not be suitable for slides, and certainly might not go well together. PowerPoint offers some standard combinations, and unless you know what you are doing you should stick to these for now.

PowerPoint97 and 2000

- Choose Slide Color Scheme... from the Format menu
- Click on the Standard tab
- Click on the scheme of your choice
- Click Apply to all
PowerPoint2002

- Choose Slide Design from the Format menu

The Slide Design panel will open up (if it is not already open). At the top of the panel there are different options (Design Templates, Color Schemes and Animation Schemes).

- Click on Color Schemes
- Click on the scheme of your choice – just clicking on the scheme will apply it to all slides
- Not all slides need have the same scheme Usually you will want uniformity for your presentation, so you will usually want the same background for all the slides. But occasionally you will want a particular slide to be different – for example if you have an image on a slide which does not show up well against the background you have chosen.
- Scroll through your presentation to display the slide which needs a different background
- Now follow the instructions you used before to choose a scheme, but – PowerPoint97 and 2000: choose a scheme and click Apply instead of Apply to all
- PowerPoint2002: point without clicking at the scheme you want, and then click on the little arrow that appears just to the right of the scheme – this will give you a drop-down menu, and you can choose Apply to selected slides

Custom schemes

You can create your own schemes, known as custom schemes.
- PowerPoint97 and 2000: choose Slide Color Scheme from the Format menu
- PowerPoint2002: click on Edit Color Schemes at the foot of the Slide Design panel
- Click on the Custom tab
- To change the colour of the title text, click on the colour box beside Title text and then click Change colour
- Select the colour you want from the palette and click OK
- Change any of the other colours
- Click Apply or Apply to All

If you find you don’t like the colour scheme you have just applied, remember there is an Undo button on the toolbar.

5. Animations and Transitions

Animation refers to the way in which the points, or other objects, are added to your slide one at a time. Transition refers to the special effect used in the slide show when you move from one slide to another. Be careful not to distract your audience with too many fancy effects. Animation for a single slide

PowerPoint97 and 2000

- Make sure the cursor is positioned on a line containing text
- Choose Preset Animation from the Slide show menu
- From the sub-menu, choose the animation effect that you want
Choose Animation Schemes from the Slide show menu
Click on a scheme in the list shown in the Slide Design panel
Check to see what the animations look like.
Click the Slideshow button
Click the mouse button to display your bullet points one at a time
Typing P moves backwards a point at a time

**Animation for all slides in the presentation**

- Choose Slide Sorter from the View menu to display all the slides
- Choose Select All from the Edit menu to select all the slides
- Choose Preset Animation from the Slideshow menu
- From the sub-menu, choose the animation effect that you want
- Choose Slide or Normal from the View menu to go back to the normal slide editing view
- Go to the Animations schemes as before, choose one of the schemes
- Click the Apply to All Slides button at the foot of the list
- View the slideshow to see what it looks like

**Custom animations**

You can create more complicated effects using the Custom Animation command in the Slide Show menu. This is particularly useful when you have second or third level points on your slides, since it is only with a custom animation that you can animate these subordinate points separately from the main points. Also, you can use custom animations to animate images and other objects. We shan’t look at custom animations now, but you might like to experiment with them for yourself.

**Transitions**

- Choose Slide Transition from the Slide Show menu
- PowerPoint97 and 2000: You will get a dialog-box with a drop down list of transition effects
- PowerPoint2002: The Slide Design panel will display a list of transition effects
- Choose the effect that you want
- If you want to apply the same effect to all slides, click the Apply to all button
- View the effect in the slideshow, and go back and try some other effects.

6. Graphics from files

This section will tell you how to place images on your slides. You will need some image files, which will be provided on floppy disk or which you can download from the LIS web space.
Insert an image from a file

- Go to your **Frog** slide
- Choose Picture from the Insert menu and then choose From file from the sub menu
- In the dialog-box locate and open the file **Frog.jpeg**
- A picture of a Frog will be inserted on your slide
- Click on the picture to select it

When selected the image will have little white squares at the edges and corners. These are known as handles. You can change the size of the picture by pointing at one of the handles and dragging with the mouse. The corner handles will change the size of the image but still keep the same proportions. If you point at the image (avoiding the handles) you can drag the image and move it elsewhere on the slide.

- Point at the handle at the bottom left of the image, press the mouse button and keep it down while dragging inwards until the picture is reduced to a third of its original size
- Point at the resized image, avoiding the handles. The mouse pointer becomes a cross with four arrow-points. Now press the mouse-button and drag the image to the top left corner

**The drawing toolbar**

To carry out some of the instructions that follow and also those in the next section you will need to use the Drawing toolbar. This is usually located at the foot of the PowerPoint window. The first item on the Drawing toolbar is the Draw menu. It also has a number of standard drawing tools, for drawing ellipses, rectangles, lines and other shapes.

- If the Drawing toolbar is not shown, go to the Toolbars command in the View menu and choose Drawing from the list of toolbars

**A picture on a blank slide**

- Choose New Slide from the Insert menu
- From the palette of slide layouts choose the blank slide
- Insert the image of the cockroach from the file, as before
- This time use the corner handles to enlarge the picture so that it is as big as it can be while fitting on the slide
- Move the image across to the right hand side of the slide
To the left of the picture we shall insert a text box containing the Latin name for this particular cockroach.

- Click on the Text box tool in the Drawing toolbar
- Click near the bottom left corner of the slide to indicate where the text is to begin You will see a small box with the flashing cursor inside it
- Type the name of the Forges: Frog1
- Save your presentation
- Look at the slide show

**A background image**

- Go to your 2nd slide
- Choose Picture from the Insert menu and From file from the submenu
- Locate and open the image Frog.jpg
- Move the image into the centre of the slide. The slide should now look like this:

The image is obliterating the text, so you need to move it into the background.

- Click on the image to select it (the handles should be visible)
- Click on Draw in the Drawing toolbar and choose Order from the menu and then Send to back from the sub-menu

The image will now appear in the background, with the text over-writing it. Images from the web. The web is a fertile source of pictures for your slides, although you must be careful about copyright issues if your presentation is for public use. To copy a picture from the web to a slide you can simply drag it from the page displayed in Internet Explorer onto your PowerPoint slide.

- Use a Google search to find a picture of a centipede or some other appropriate creature
- Drag the picture onto one of your slides, re-size it and move it around using the techniques you have learnt

**Excel charts and tables**

You can put parts of an Excel spreadsheet, either a range of cells or a chart, onto a slide. You can do this either by dragging, as for web images, or by copying and pasting.

**7. Drawing your own diagrams**

You can use the drawing tools to create your own diagrams.

Line tool drag to create straight lines, Rectangle tool drag to create a rectangle. Oval tool drag to create an oval AutoShapes Click on the AutoShapes button and select one of the families of shapes listed, and then a particular shape from the sub-menu. To use the drawing tools, click on a tool – the mouse-pointer then becomes a cross, and you can drag it to draw the line or shape: point at the top left corner of the area you want your shape to occupy; press the mouse-button and keep it down while dragging to the bottom right corner; then release the mouse-button. Holding the Shift key down while dragging will draw a shape whose height is the same as its width. So with Shift held down the Rectangle tool will draw a square, for example.
Creating objects

- Use the Oval tool to draw an egg and an airship
- Then use the same tool with the Shift key held down to draw a circle airship
- Select one of the shapes by clicking on it – little boxes (handles) appear at the corners and on the edges – for the ellipse shapes, what is selected is the rectangular area which you outlined when you drew the shape
- Moving the object: point at the shape (but don’t point at a handle), press the mouse button and keep it down while dragging – the shape will move as you drag
- Re-sizing the object: point at one of the handles, press the button and drag – the size and shape of the object will change as you drag. If you keep the Shift key down while dragging on one of the corner handles, you will preserve the proportions of the object as you change its size.

Try experimenting with some of the other shapes in the AutoShapes selection box.

Object attributes

For the following exercises you should have three shapes on your slide, which will be referred to as the circle, the egg and the airship – it doesn’t matter if your original shapes have been changed, just so long as you still have three different shapes.

Selecting colours and line-styles

- Point at the circle and click on it to select it
- Choose Auto shape from the Format menu
- Click the Colors and Lines tab
- In the dialog-box choose a new colour for the “fill” and a new colour and style for the line. Make your selections by clicking on the down arrows beside the various selection boxes and choosing from the list

The Color selection boxes not only offer you a palette of colours – there are various other options you can choose. For example in the Fill Color selection box you can choose from various patterns and effects. You should experiment with these. Copying attributes from one object to another

- Click on your circular shape
- Click once on the Format Painter button (like a broad paintbrush) in the Formatting toolbar (usually at the top of the screen, just under the menu bar)
- Point at your egg shape and click

Your circle and egg should now have the same fill colour and line style. The airship remains unchanged.
Default attributes

- Point at your circular shape and click the right mouse-button
- Choose AutoShape from the Format menu and then click on the Colors and Lines tab
- Choose a fill colour and line colour and line style for the circle
- Before you click OK tick the box labeled Default for new objects
- Now draw another object – for example a square

The new object should have the same fill colour and line style as the circle. These styles will be used for all new objects, on this slide or on new slides, until you change the default again.

Grouping objects

Grouping objects combines them so you can work with them as though they were a single object.

This is useful if you are creating a complex graphic and need to keep its components fixed relative to one another.

- Create a graphic consisting of more than one shape.
- Click on one of the objects to select it
- Then select the other objects by holding down the Shift key and clicking on each in turn
- Click the Draw button on left of the Drawing toolbar, and choose Group from the pop-up menu

Instead of having the “selection handles” round each object separately, a single set of handles appears round the whole group.

- Now try moving and resizing this group
- Work out how to ungroup the objects so as to be able to move and resize them individually

8. Using the master slide

You can use the Master slide to set various formatting and layout features that will apply to every slide in the presentation. You can in fact make individual variations if you wish, but the master slide is useful as a way of establishing a basic uniformity for your presentation.

- Choose Master from the View menu and then Slide Master from the sub-menu
  Notice the Slide Master view toolbar, which contains the button for closing the Master view, which you will need when you have finished.
An image on the master slide

- Click where it says Click to edit Master title style. The box will be highlighted as shown above, with handles at the edges and corners
- Drag on the handle on the right edge to reduce the width of the box by about an inch
- Now insert one of the images used in the previous section, reduce it in size and place it in the space you have created in the top corner of the slide

Change the font styles

- Click where it says Click to edit Master title style
- Use the font selection box to change the font style to Arial
- You can change the font colour too if you like
- Click where it says Click to edit Master text styles
- Again change the font style to Arial
- Repeat the process for the Second level text
- When you have finished click the Close Master View button
- Always remember to close the Master view to get back to the normal editing view. You can't edit the text while in Master view.
- Look at your slides in the slide show to see the effect of your changes. Making changes on particular slides. You can change the text styles for particular slides. Just select the bits of text that you want to reformat and use the usual formatting commands. The image which you placed in the top right corner of the master slide might not be appropriate for every slide.
- Go to the slide containing the large picture of the cockroach
- Choose Background from the Format menu
- Tick the box labelled Omit background graphics from Master
- Click Apply

Slide numbers

You can insert numbers on all your slides without going to the Master view.

- Choose Slide number from the Insert menu. This will display the Header and Footer dialog-box. In this dialog-box you can choose different elements to be inserted on every slide.
- Make sure the Slide number option is ticked and also the Don't show on Title Slide option
- Click Apply to All. The number will not be shown on your title slide. It will also be omitted from any slides for which you have chosen the Omit background graphics from Master (see above).

9. Preparing and delivering a presentation

Here are a few brief points which you should bear in mind when preparing and delivering your presentation.
Always test your presentation in advance, if possible testing it on the computer which you will be using for the live presentation. Take note of the points in section 1 of this document about versions, file size and fonts.

Usually when you are delivering your presentation the big screen will be behind you and your audience in front. Always look at your audience, not at the screen. Usually the data projector will allow you to show your slides on a computer in front of you as well as on the big screen. If possible, visit the room well in advance so you can work out how it should be arranged so that you can be comfortable delivering your presentation.

New data projectors are strong enough for your slides to be visible even in normal daylight; older ones may require the room to be dimmed. Even with new equipment you should avoid having light (sunlight or artificial light) shining directly onto the display screen. Check beforehand both the equipment and the room.

When designing your slides be careful over the choice of colours. Make sure you have good contrast between text and background. Don't clutter your slides with unnecessary images.

Think how your slides are going to fit in with what you say in your presentation. Their purpose is to help your audience (and you) follow the structure of your presentation, and also to emphasise the important points. Your talk should not simply consist of reading out what is written on your slides.

If there is a lot of text on a slide (for example an extended quotation) give the audience time to read and digest it before you move on to the next slide.

While delivering a presentation you can turn the mouse-pointer into a “pen” to scribble on the screen to draw attention to parts of the slide. To turn the pointer into a pen, press Control+P. To turn it back into an ordinary pointer, press the Esc key. While the pointer is a pen, clicking the mouse will not make the slide show move on to the next slide. If you want to move on while keeping the pen, press N. Practise this beforehand.

You can provide your audience with a copy of your slides on paper. In the Print dialog box there is a selection box labeled Print what and you can choose to print Handouts and also choose how many slides to print per page.

You might choose to print six slides per page (for reasons of economy) but remember that some of your audience may need larger print copies, so be prepared to print each slide on a single sheet.

Also in the Print dialog box you can choose which slides to print. So if you have slides which are not absolutely essential, or which wouldn't make sense on paper or in black and white, you can leave them out of your printed handout.
Chapter 4(C)

Office Automation Tools:
MS-Office (MS-Word)

1. Getting Familiar with Microsoft Word
2. Things You Need to Know About Microsoft Word
3. Microsoft Word Basic Features
4. More Microsoft Word Basic Features
5. Working with Paragraphs & Documents
6. Microsoft Word Tables
Getting Familiar with Microsoft Word

This tutorial teaches Microsoft Word basics. Although knowledge of how to navigate in a Windows environment is helpful, this tutorial was created for the computer novice. To begin, open Microsoft Word. Your screen will look like the one shown here.

Click the X in the upper right corner of the New Document pane to close the New Document pane. Your screen will then look like the one shown here.

The Title Bar

This lesson will familiarize you with the Microsoft Word screen. We will start with the Title bar, which is located at the very top of the screen. On the Title bar, Microsoft Word displays the name of the document on which you are currently working. At the top of your screen, you should see "Microsoft Word - Document1" or a similar name.

The Menu Bar

The Menu bar is generally found directly below the Title bar. The Menu bar displays the menu. The Menu bar begins with the word File and continues with Edit, View, Insert, Format, Tools, Table, Window, and Help. You use the menus to give instructions to the software. Point with your mouse to a menu option and click the left mouse button to open a drop-down menu. You can now use the left and right arrow keys on your keyboard to move left and right across the Menu bar options. You can use the up and down arrow keys to move up and down the drop-down menu. The most frequently used menu options appear on the menu list. A chevron appears at the bottom of the list. Click the chevron to display additional menu options.
To select an option, click the option or use the arrow keys to move to the option on the drop-down menu and press Enter. An ellipse or a right arrow after a menu item signifies additional options; if you select that menu item, a dialog box appears. Items in gray are not available.

You can customize your screen so that all of the menu options display when you click a menu item. This tutorial assumes that your menu is set to display all menu options. To customize your menu to display all of the menu options:

1. Click Tools on the Menu bar.
2. Click Customize on the drop-down menu. The Customize dialog box opens.
3. Click the Options tab.
4. Click in the check box to select Always Show Full Menus.
5. Click Close.

**Exercise 1**

Do the following exercise. It demonstrates using the Microsoft Word menu.

1. Click File on the Menu bar.
2. Press the right arrow key until Help is highlighted.
3. Press the left arrow key until Format is highlighted.
4. Press the down arrow key until Styles and Formatting are highlighted.
5. Press the up arrow key until Paragraph is highlighted.
6. Press Enter to select the Paragraph menu option.
7. Click Cancel to close the dialog box.

**Toolbars**

**The Standard Toolbar**

**The Formatting Toolbar**
Toolbars provide shortcuts to menu commands. Toolbars are generally located just below the Menu bar. Before proceeding with this lesson, make sure the toolbars you will use -- Standard and Formatting -- are available. Follow these steps:

1. Click View on the Menu bar.
2. Highlight Toolbars.
3. Standard and Formatting should have check marks next to them. If both Standard and Formatting have check marks next to them, press Esc three times to close the menu.
4. If they do not both have check marks, click Customize.
5. Click the Toolbars tab.
6. Point to the box next to the unchecked option and click the left mouse button to make a check mark appear.
7. Note: You turn the check mark on and off by clicking the left mouse button.
8. Click Close to close the dialog box.

The Ruler

The ruler is generally found below the main toolbars. The ruler is used to change the format of your document quickly. To display the ruler:

1. Click View on the Menu bar.
2. The option Ruler should have a check mark next to it. If it has a check mark next to it, press Esc to close the menu. If it does not have a check mark next to it, continue to the next step.
3. Click Ruler. The ruler now appears below the toolbars.

Document View

In Word, you can display your document in one of five views: Normal, Web Layout, Print Layout, Reading Layout, or Online Layout.

Normal View
Normal view is the most often used and shows formatting such as line spacing, font, point size, and italics. Word displays multiple-column text in one continuous column.

Web Layout
Web layout view enables you to view your document as it would appear in a browser such as Internet Explorer.

Print Layout
The Print Layout view shows the document as it will look when it is printed.

Reading Layout
Reading Layout view formats your screen to make reading your document more comfortable.

Outline View
Outline view displays the document in outline form. Headings can be displayed without the text. If you move a heading, the accompanying text moves with it.

Word 2002
In Word 2002, you can display your document in one of four views: Normal, Outline, Page Layout, or Online Layout.

**Normal view**
Normal view is the most often used and shows formatting such as line spacing, font, point size, and italics. Word displays multiple-column text in one continuous column.

**Outline view**
Outline view displays the document in outline form. Headings can be displayed without the text. If you move a heading, the accompanying text moves with it.

**Print Layout view**
The Print Layout view shows the document as it will look when it is printed.

**Online Layout view**
The Online Layout view optimizes the document for online viewing (viewing the document in a browser such as Internet Explorer).

Before moving ahead, check to make sure you are in Normal view:

1. Click View on the Menu bar.
2. The icon next to Normal should have a box around it. If the icon next to normal has a box around it, press Esc to close the menu. If the icon next to Normal does not have a box around it, continue on to the next step.
3. Click Normal. You are now in Normal view.

**Text Area**

Just below the ruler is a large area called the "text area." You type your document in the text area. The blinking vertical line in the upper left corner of the text area is the cursor. It marks the insertion point. As you type, your work shows at the cursor location. The horizontal line next to the cursor marks the end of the document.

**Exiting Word**

You have completed Lesson One. Typically, you would save your work before exiting. This lesson does not require you to enter any text, so you might have nothing to save. To exit Word:

1. Click File.
2. Click Exit, which can be found at the bottom of the drop-down menu.
3. If you have entered text, you will be prompted: "Do you want to save changes to Document1?" To save your changes, click Yes. Otherwise, click No.
4. Specify the correct folder in the Save In box.
5. Name your file by typing **lesson1.doc** in the File Name field.
6. Click Save.
Things You Need to Know

This lesson instructs you on how to set up your computer so that you can compete the lessons that follow successfully and it provides you with background information on Microsoft Word. To begin this lesson, open Microsoft Word.

Click

During the lessons that follow, you will be asked to "click" items. When asked to click:

Point to the item.

Press your left mouse button once.

If you are asked to double-click an item:

Point to the item.

Quickly press your left mouse button twice.

If you are asked to right-click:

Point to the item.

Press your right mouse button.

Options

The following is an introduction to various features of the Microsoft Word screen.

Status Bar

The Status bar appears at the very bottom of the screen and provides such information as the current page, current section, total number of pages, inches from the top of the page, current line number, and current column number. The Status bar also provides options that enable you to track changes or turn on the Record mode, the Extension mode, the Overtype mode, and the Spelling and Grammar check.

Word 2002

The Status bar for the 2002 version of Word includes WordPerfect help, but does not include Spelling and Grammar check.
Horizontal and Vertical Scroll Bars

The Horizontal and Vertical scroll bars, if turned on, enable you to move up and down or across the window simply by pressing the icons located on the scroll bars. The Horizontal scroll bar is located above the Status bar. The Vertical scroll bar is located along the right side of the screen. To move up and down your document, click and drag the Vertical scroll bar up and down. To move back and forth across your document, click and drag the Horizontal scroll bar.

Nonprinting Characters

Certain characters do not print but do affect the document layout. You can elect to see these characters on the screen as you type or have them remain invisible. For these lessons, you should opt to see them onscreen. Here are most of them:

Denotes a tab
Denotes a space
Denotes the end of a paragraph
Denotes hidden text

To show non-printing characters: Click Home

Click the Show/Hide button. The button is orange.

Recently Used File List

If you enable the recently used file list, clicking File displays the most recently opened files near the bottom of the drop-down menu. You can click the file name to open the file quickly.

Setting Options

Before proceeding, turn on the Status bar, Horizontal scroll bar, Vertical scroll bar, nonprinting characters, and the recently used file list. Follow the procedure outlined here:

Click Tools on the Menu bar.

Click Options.
Click View to choose the View tab.

In the Show frame, check to see if there are checks next to Status Bar, Horizontal Scroll Bar, and Vertical Scroll Bar.

If all these items do not have check marks, go to the box next to the unchecked item(s) and click the left mouse button.

Note: You toggle the check mark on and off by clicking the left mouse button.

In the Formatting Marks frame, check to see if there is a check mark next to All.

If there is no check mark next to All, go to the box next to All and click the left mouse button. A check mark will now appear.

Click General to choose the General tab.

Check to see if there is a check mark next to the Recently Used File List. If there is no check mark, go to the box next to Recently Used File List and click the left mouse button. Check to see if the number in the Entries box is at least four. If it is not, type 4 in the box.

Check to see if Inches is selected in the Measurement Units box (this sets the unit of measurement for the ruler). If it is not, click the pull-down menu and then click Inches.

Click OK to close the dialog box.

**Highlighting Text**

Throughout these lessons, you will be asked to highlight text. You can use either of the following methods:

*Highlighting by Using the F8 and Arrow Keys*

Place the cursor before or after the text you wish to highlight and click the left mouse button.

Press the F8 key, which will serve as an "anchor" showing where text you wish to highlight begins or ends.

Press the appropriate arrow key (left arrow to move to the left or right arrow to move to the right) until the text is highlighted. You can use the up or down arrow key to highlight one line at a time. Press Esc to remove the anchor.

*Highlighting by Using the Mouse*

Place the cursor before or after the text you wish to highlight.

Hold down the left mouse button.
Move the mouse left, right, up, or down until the text is highlighted.

**Highlighting Menu Items**

**Menu Bar**

To select a Menu bar item:

Click the Menu bar item. A drop-down menu will appear.

To change the Menu bar option selected, move the mouse pointer across the Menu bar. **Note:** After you highlight an item on the Menu bar, you can also use the left and right arrow keys to move across the Menu bar.

**Drop-Down Menu Items**

When you click any option on the Menu bar, a drop-down menu appears. To choose a drop-down menu item:

Click the drop-down menu item.

Or Use the arrow keys to move up or down the drop-down menu.

Press Enter to select a drop-down menu item.

**Placing the Cursor**

During the lessons, you will often be asked to place the cursor at a specific location on the screen. You place the cursor by moving the cursor to the specified location and pressing the left mouse button or by using the arrow keys to move to the specified location.

**Choosing Menu Commands by Using the Alt Key**

There are many methods to accomplish tasks when you are using Microsoft Word. Generally, when selecting items from the menu, we will ask you to click or highlight the menu item. However, you can also select a menu option by:

Pressing the Alt key while typing the underlined letter on the Menu bar.

Typing the letter underlined on a drop-down menu. If a dialog box appears, you can move around the dialog box by pressing the Alt key and any underlined option.

**Shortcut Key Demonstration**

Hold down the Alt key and press "o" to select Format from the menu.
Press "p" to select Paragraph from the drop-down menu.

Hold down the Alt key and press "i" to select the Indents and Spacing tab.

Hold down the Alt key and press "b" to select Before from the Spacing frame.

Press Enter to close the dialog box.

**Shortcut Notations**

A key name followed by a dash and a letter means to hold down the key while pressing the letter. For example, Alt-o means you should hold down the Alt key while pressing "o." A shorthand notation of the above demonstration would read as follows:

Press Alt-o, p.

Press Alt-i.

Press Alt-b.

Press Enter.

Typists who are slowed down by using a mouse usually prefer using keys.

**Starting a New Paragraph**

When you type in Microsoft Word, you do not need to press a key to move to a new line as you do when typing with a typewriter. To start a new paragraph, press the Enter key.

**Exiting Microsoft Word**

You have completed this lesson. Typically, you would save your work before exiting. This lesson does not require you to enter any text, so you might have nothing to save. To exit Microsoft Word:

Click File on the Menu bar.

Click Exit, which can be found at the bottom of the drop-down menu.

If you have entered text, you will be prompted: "Do you want to save changes to Document1?" To save your changes, click Yes. Otherwise, click No. Specify the correct directory in the Save In box.

Name your file by typing lesson2.doc in the File Name field. Click Save.

**Microsoft Word Basic Features**

This lesson covers typing, the Backspace key, the Delete key, inserting text, bolding, underlining, and italicizing. To begin this lesson, open Microsoft Word.
Typing and Using the Backspace Key

The exercises that follow will teach you how to enter and delete text. To enter text, simply type just as you would if you were using a typewriter. To capitalize, hold down the Shift key while typing the letter. Use the Backspace key to delete text. You do not need to press Enter to start a new line -- Microsoft Word automatically wraps at the end of the line. Press Enter to start a new paragraph.

Exercise 1

Type the following sentence:

Joe has a very large house.

Now delete the word "house." Using either the arrow keys or the mouse, place the cursor between the period and the "e" in "house."

Press the Backspace key until the word "house" is deleted.

Type boat. The sentence should now read:

"Joe has a very large boat."

The Delete Key

You can also delete text by using the Delete key. First, highlight the text you wish to delete; then press the Delete key.

Exercise 2

Delete the word "very" from the sentence you just typed.

Highlight the word "very." Place the cursor before the "v" in the word "very" and press the F8 key. Then press the right arrow key until the word "very" is highlighted.

Press the Delete key. The sentence should now read:

"Joe has a large boat."

Inserting Text

You can insert text. To insert text, you must be in the Insert mode. To check to see whether you are in the Insert mode, look at the Status bar, located at the very bottom of the screen. Look at the right side of the Status bar. If the letters "OVR" are gray, you are in the Insert mode. If the letters "OVR" are black, you are in the Overtype mode.
Insert Mode  Overtype Mode
To change to the Insert mode:  Double-click the letters "OVR."
The letters "OVR" are now gray.

Alternate Method -- Setting Options by Using the Menu
You can also use the menu to change to the Overtype mode.
Choose Tools > Options from the menu. The Options dialog box opens.
Click the Edit tab to choose the Edit tab.
The Overtype Mode box should be blank. If the box is blank, click OK.
If the Overtype Mode box is not blank, click the box to remove the check mark. Then click OK.

Alternate Method -- Setting Options by Using Key
You can use the keyboard to change to the Overtype mode.
Press Alt-t, o.
Click Edit.
Press Alt-v (toggles between overtype and insert).
Press Enter.

Exercise 3
Make sure the letters "OVR" are gray before proceeding. You are going to insert the word "blue" between the words "large" and "boat."
Place the cursor after the dot between the words "large" and "boat."
Type the word blue.
Press the spacebar to add a space.
The sentence should now read: "Joe has a large blue boat."
Overtyp e

You can type over the current text (replace the current text with new text). However, you must be in the Overtyp e mode. Do the following to change to the Overtyp e mode.

Double-Cl ick "OVR" on the Status bar. The letters "OVR" should now be black.

Make sure the letters "OVR" are black before proceeding to the following exercise.

Exercise 4

Change the word "blue" to "gray."

Place the cursor before the letter "b" in "blue."

Type the word gray.

The sentence should now read: "Joe has a large gray boat."

Bold, Underline, and Italicize

You can bold, underline, or italicize when using Word. You also can combine these features -- in other words, you can bold, underline, and italicize a single piece of text. In the exercise that follows, you will learn three different methods for bolding, italicizing, or underlining when using Word. You will learn to bold, italicize, or underline by using the menu, an icon, or the keys.

Exercise 5

Type the following exactly as shown. Remember, pressing the Enter key starts a new paragraph. Press the Enter key at the end of each of the following lines to start a new paragraph. Menu: Bold Italicize Underline these words All three Regular Icon: Bold Italicize Underline these words All three Regular Keys: Bold Italicize Underline these words All three Regular:- Your screen should look similar to the one shown here.

Bold - Using the Menu

On the line that begins with Menu, highlight the word Bold. To do so, place the cursor before the letter "B" in "Bold." Press the F8 key; then press the right arrow key until the entire word is highlighted.
Choose *Format > Font* from the menu. The Font Dialog box opens.

Click Bold in the Font Style box. **Note:** You can see the effect of your selection in the Preview window. To turn off the bold, click Regular.

Click OK to close the dialog box.

Click anywhere in the text area to remove the highlighting. You have bolded the word bold.

**Alternate Method -- Bold by Using an Icon**

On the line that begins with "Icon," highlight the word "Bold." To do so, place the cursor before the letter "B" in "Bold." Press the F8 key; then press the right arrow key until the entire word is highlighted.

Click the Bold icon on the toolbar. **Note:** To turn off bold, highlight the text and press the Bold icon again.

Click anywhere in the Text area to remove the highlighting.

**Alternate Method -- Bold by Using the Keys**

On the line that begins with "Keys," highlight the word "Bold." To do so, place the cursor before the letter "B" in "Bold." Press the F8 key; then press the right arrow key until the entire word is highlighted. Press Ctrl-b (hold down the Ctrl key while pressing b). **Note:** To turn off Bold, press Ctrl-b again. You can also remove formatting by pressing Ctrl-spacebar.

Click anywhere in the Text area to remove the highlighting.

**Italicize - Using the Menu**

On the line that begins with "Menu," highlight the word "Italicize." To do so, place the cursor before the letter "I" in "Italicize." Press the F8 key; then press the right arrow key until the entire word is highlighted.

Choose *Format > Font* from the menu. Click Italic in the Font Style box. **Note:** You can see the effect of your selection in the Preview window. To turn off the italics, click Regular. Click OK to close the dialog box.

Click anywhere in the Text area to remove the highlighting.

**Alternate Method -- Italicize by Using an Icon**

On the line that begins with "Icon," highlight the word "Italicize." To do so, place the cursor before the letter "I" in "Italicize." Press the F8 key; then press the right arrow key until the entire word is highlighted.
Click the Italic icon on the toolbar.

*Note:* To turn off italics, highlight the text and press the Italic icon again.

Click anywhere in the Text area to remove the highlighting.

**Alternate Method -- Italicize by Using Keys**

On the line that begins with "Keys," highlight the word "Italicize." Place the cursor before the letter "I" in "Italicize." Press the F8 key; then press the right arrow key until the entire word is highlighted.

Press Ctrl-i (hold down the Ctrl key while pressing i).

*Note:* To toggle Italic off, press Ctrl-i again. You can also remove formatting by pressing Ctrl-spacebar.

Click anywhere in the Text area to remove the highlighting.

**Underline - Using the Menu**

You can underline when using Word. The following are some of the underlines that are available if you use the menu: The following illustrates underlining by using the menu:

On the line that begins with "Menu," highlight the words "Underline these words."

Choose *Format* > *Font* from the menu.

In the Underline Style box, click to open the pull-down menu. Click the type of underline you wish to use.  

*Note:* To remove an underline, you select None from the pull-down menu.

Click OK to close the dialog box.

Click anywhere in the Text area to remove the highlighting.

**Alternate Method -- Underline by Using the Icon**

On the line that begins with "Icon," highlight the words "Underline these words."

Click the Underline icon on the toolbar. You will get a single underline.

*Note:* To turn off underlining, press the Underline icon again.

Click anywhere in the Text area to remove the highlighting.

**Alternate Method -- Underline by Using the Keys**
On the line that begins with "Keys," highlight the words "Underline these words."

Press Ctrl-u (hold down the Ctrl key while pressing u). You will get a single underline.  
**Note:** To turn off underlining, press Ctrl-u again.

Click anywhere in the Text area to remove the highlighting.

**All Three - Using the Menu**

On the line that begins with "Menu," highlight the words "All three."

Choose Format > Font from the menu.

In the Font Style box, click Bold Italic.  
**Note:** You can see the effect of your selection in the preview window. To turn off the Bold Italic, click Regular.

In the Underline box, click to open the pull-down menu. Click the type of underline you want to use.  
**Note:** To remove an underline, select None from the pull-down menu.

Click OK to close the dialog box.

Click anywhere in the Text area to remove the highlighting.

**Alternate Method -- All Three by Using Icons**

On the line that begins with "Icon," highlight the words "All three."

Click the Bold icon on the toolbar.

Click the Italic icon on the toolbar.

Click the Underline icon on the toolbar.

Click anywhere in the Text area to remove the highlighting.

**Alternate Method -- All Three by Using the Keys**

On the line that begins with "Keys," highlight the words "All three."


Press Ctrl-u (underline).  
**Note:** You can remove formatting by highlighting the text and pressing Ctrl-spacebar.

Click anywhere in the Text area to remove the highlighting.
Save File

You must save your files if you wish to recall them later. Before you can save, you must give your file a name. To save your file and close Word, follow the instructions given here:

1. Choose File > Save As from the menu.
2. Specify the correct folder in the Look In box.
3. Name your file by typing lesson3.doc in the File Name box.
4. Click Save.
5. Choose File > Exit from the menu.

More Basic Features

This lesson covers cut, copy, paste, AutoText, spell check, find, replace, and fonts. To begin this lesson, open Microsoft Word.

Open File

To continue working on a file you previously saved, you must open the file. To open the file you used in Lesson 3:

Choose File > Open from the menu.

Make sure the folder you noted during the previous lesson displays in the Look In field.

The file is named "lesson3.doc." Type lesson3.doc in the File Name field.

Click Open. The file you created during the previous lesson appears.

Alternate Method -- Opening a File by Using the Drop-Down Menu

1. Click File.
2. Look for the file name "lesson3.doc" near the bottom of the drop-down menu.
3. Click "lesson3.doc." The file you created during the previous lesson opens.

Cut and Paste

In Microsoft Word, you can cut (delete) text from one area of a document and save that text so it can be pasted elsewhere in the document. When you cut text, it is stored on the Clipboard. You can also copy text. When you copy text, it is also stored on the Clipboard. Information stored on the Clipboard stays there until new information is either cut or copied. Each time you execute Cut or Copy, you replace the old information on the Clipboard with whatever you just cut or copied. You can paste Clipboard information as often as you like.

Exercise 1

Cut - Using the Menu
Type the following:
I want to move. I am content where I am.

Highlight "I want to move."

Choose Edit > Cut from the menu.

Your text should now read:
"I am content where I am."

Paste - Using the Menu

1. Place the cursor after the period in the sentence "I am content where I am."
2. Press the spacebar to leave a space.
3. Choose Edit > Paste from the menu.
4. Your text should now read:
  "I am content where I am. I want to move."

Alternate Method -- Cut by Using the Icon

1. Type the following:
   I want to move. I am content where I am.
2. Highlight "I want to move."
3. Click the Cut icon.
4. Your text should now read: "I am content where I am."

Alternate Method -- Paste by Using the Icon

Place the cursor after the period in the sentence "I am content where I am."
Press the spacebar to leave a space. Click the Paste icon. Your text should now read: "I am content where I am. I want to move."

Alternate Method -- Cut by Using Keys

1. Type the following:
   I want to move. I am content where I am.
2. Highlight "I want to move." And Press Ctrl-x.
3. Your text should now read. "I am content where I am."

Alternate Method -- Paste by Using Keys

Place the cursor after the period in the sentence: "I am content where I am."
Press the spacebar to leave a space. Press Ctrl-v. Your text should now read. "I am content where I am. I want to move."

Copy and Paste
In Microsoft Word, you can copy text from one area of the document and place that text elsewhere in the document. As with cut data, copied data is stored on the Clipboard.

**Exercise 2**

**Copy - Using the Menu**

Type the following:
You will want to copy me. One of me is all you need.

Highlight "You will want to copy me." Choose Edit > Copy from the menu.

**Paste - Using the Menu**

1. Place the cursor after the period in the sentence: "One of me is all you need."
2. Press the spacebar to leave a space.
3. Choose Edit > Paste from the menu.
4. Your text should now read: "You will want to copy me. One of me is all you need. You will want to copy me."

**Alternate Method -- Copy by Using the Icon**

1. Type the following: You will want to copy me. One of me is all you need.
2. Highlight "You will want to copy me." And Click the Copy icon.

**Alternate Method -- Paste by Using the Icon**

1. Place the cursor after the period in the sentence: "One of me is all you need."
2. Press the spacebar to leave a space.
3. Click the Paste icon.
4. Your text should now read: "You will want to copy me. One of me is all you need. You will want to copy me."

**Alternate Method -- Copy by Using Keys**

1. Type the following:
   You will want to copy me. One of me is all you need.
2. Highlight "You will want to copy me."
3. Press Ctrl-c.

**Alternate Method -- Paste by Using Keys**

1. Place the cursor after the period in the sentence "One of me is all you need."
2. Press the spacebar to leave a space.
4. Your text should now read:
   "You will want to copy me. One of me is all you need. You will want to copy me."
**AutoText**

Cut and Copy both store information on the Clipboard. Each time you store new information on the Clipboard, the old information is lost. If you wish to store text permanently so you can use it repeatedly, use AutoText.

**Exercise 3**

1. Type the following: **AutoText information is stored permanently.**
2. Highlight "AutoText information is stored permanently."
3. Choose *Insert > AutoText > New* from the menu.
4. Microsoft Word suggests a name. The suggestion displays in the dialog box. Change the name by typing **AT** in the Please Name Your AutoText Entry field.
5. Click OK.
6. Click anywhere in the text area to remove the highlighting.
7. Place the cursor between the period in the sentence you just typed and the paragraph marker (¶).
8. Press the spacebar twice to leave two blank spaces.
9. Type **AT**.
11. Your text should now read: "AutoText information is stored permanently. AutoText information is stored permanently."

   **Note:** Whenever you need the text, simply type the name and press F3.

**Spell Check**

Word checks your spelling and grammar as you type. Spelling errors display with a red wavy line under the word. Grammar errors display with a green wavy line under the error. If you want to spell check your entire document, press F7 and click the spelling icon, or choose *Tools > Spelling and Grammar* from the menu. If you want to spell check part of your document, highlight the area you want to spell check. Then press F7 and click the spelling icon, or choose *Tools > Spelling and Grammar* from the menu.

**Exercise 4**

1. Type the following exactly as shown. Include all errors. **Open thr door for Mayrala. She is a teacher from the town of Ridgemont.**
2. Highlight: "Open thr door for Mayrala. She is a teacher from the town of Ridgemont."
3. Press F7 or click the Spelling icon on the Standard toolbar.
4. "The" is misspelled, so it is highlighted on the screen and noted in the Not in Dictionary box.
5. Word suggests correct spellings. These suggestions are found in the Suggestions box.
6. To change the word to the correct spelling, make sure "the" is highlighted in the Suggestions box. Click Change. **Note:** If the word is misspelled in several places in the document, click Change All to correct all misspellings.
7. The name "Mayrala" is not in the dictionary, but it is correct. Click Ignore Once to leave "Mayrala" in the document with its current spelling. 
   **Note:** If a word appears in several places in the document, click Ignore All so you are not prompted to correct the spelling for each occurrence.
8. "Ridgemont" is not found in the dictionary. If you frequently use a word not found in the dictionary, you should add that word to the dictionary by pressing the Add to Dictionary button. Word will then recognize the word the next time it encounters it. Click Add to Dictionary.
9. The following should appear on your screen: "Word finished checking the selection. Do you want to continue checking the remainder of the document?"
10. Click No. If you wanted Word to spell-check the entire document, you would have clicked on Yes.

**Find and Replace**

If you need to find a particular word or piece of text, you can use the Find command. If you want to search the entire document, simply execute the Find command. If you want to limit your search to a selected area, highlight that area and then execute the Find command.

After you have found the word or piece of text you are searching for, you can replace it with new text by executing the Replace command.

**Exercise 5**

**Find - Using the Menu**

1. Type the following:
   Monica is from Easton. She lives on the east side of town. Her daughter attends Eastern High School.
2. Highlight: "Monica is from Easton. She lives on the east side of town. Her daughter attends Eastern High School."
3. Choose Edit > Find from the menu.
4. Type east in the Find What field.
5. Click Find Next.
   Note that the "East" in Easton is highlighted.
6. Click Find Next.
   Note that "east" is highlighted.
7. Click Find Next.
   Note that the "East" in Eastern is highlighted.
8. Click Find Next. The following message should appear: "Word has finished searching the selection. Do you want to search the remainder of the document?"
9. Click No.
10. Click Cancel.

**Alternate Method -- Find by Using Keys**

Highlight: "Monica is from Easton. She lives on the east side of town. Her daughter attends Eastern High School."

DOEACC Society Guwahati/Tezpur Centre
Press Ctrl-f.

Follow steps 5 through 10 in the preceding section.

**Replace - Using the Menu**

1. Highlight "Monica is from Easton. She lives on the east side of town. Her daughter attends Eastern High School."
2. Choose *Edit > Replace* from the menu.
3. Type "east" in the Find What box.
4. Click Find Next. Do not replace the "East" in "Easton."
5. Click Find Next.
6. In the Replace With box, type *west*.
7. Click Replace. Word replaces east with west.
8. The "East" in Eastern is highlighted.
9. Click Replace. Eastern becomes Western.
10. The following message will appear: "Word has finished searching the selection.
Do you want to search the remainder of the document?"
11. Click No.
12. Click Close.
13. Your text should now read,
   "Monica is from Easton. She lives on the west side of town. Her daughter attends Western High School."

**Alternate Method -- Replace by Using Keys**

Highlight "Monica is from Easton. She lives on the west side of town. Her daughter attends Western High School."

Press Ctrl-h.

Follow steps 4 through 13 in the preceding section, but type *East* in the Replace With box.

**Font Size**

In Microsoft Word, you can change the size of your font (text). The following exercise illustrates changing the font size.

**Change Font Size - Using the Menu**

1. Type the following:
   **I am the smallest. I am a little bigger. I am the biggest.**
2. Highlight "I am the smallest."
3. Choose *Format > Font* from the menu.
4. Choose the Font tab.
5. Type 8 in the Size field, or click 8 in the box below the Size field.
6. Click OK.
7. Highlight "I am a little bigger."
8. Choose *Format > Font* from the menu.
9. Choose the Font tab.
10. Type **14** in the Size field, or click 14 in the box below the Size field.
11. Click OK.
12. Highlight "I am the biggest."
13. Choose Format > Font from the menu.
14. Choose the Font tab.
15. Type **24** in the Size field, or click 24 in the box below the Size field.
16. Click OK.
17. Your text should now look similar to the following:
   "I am the smallest. I am a little bigger. I am the biggest."

**Alternate Method -- Change Font Size by Using the Toolbar**

Highlight:
"I am the smallest. I am a little bigger. I am the biggest."

Press Ctrl-spacebar to set the formatting back to the default.

Highlight "I am the smallest." In the Font Size box on the toolbar, type **8**.

Press Enter. Highlight "I am a little bigger."

In the Font Size box on the toolbar, type **14**.

Press Enter.

Highlight "I am the biggest."

In the Font Size box on the toolbar, type **24**.

Press Enter.

**Fonts**

In Microsoft Word, you can change the font (the "family" of type you use for your text).
This feature is illustrated in the following exercise:

**Change the Font - Using the Menu**

1. Type the following:
   **Arial Courier Times New Roman**
2. Highlight "Arial."
3. Choose Format > Font from the menu.
4. Choose the Font tab.
5. In the box below the Font field, click "Arial."
6. Click OK.
7. Highlight "Courier."
8. Choose Format > Font from the menu.
9. Choose the Font tab.
10. In the box below the Font field, click "Courier New."
11. Click OK.
12. Highlight "Times New Roman."
13. Choose Format > Font from the menu.
14. Choose the Font tab.
15. In the box below the Font field, click "Times New Roman."
16. Click OK.
17. Your text should now look similar to the following: "Arial Courier Times New Roman"

Alternate Method -- Change the Font by Using the Formatting Toolbar

Highlight "Arial Courier Times New Roman."

Press Ctrl-spacebar. Ctrl-spacebar sets the formatting back to the default.

Highlight "Arial."

Click to open the Font pull-down menu on the Formatting toolbar. Click "Arial."

Next, highlight "Courier."

Click to open the Font pull-down menu on the Formatting toolbar. Click "Courier."

Next, highlight "Times New Roman."

Click to open the Font pull-down menu on the Formatting toolbar. Click "Times New Roman."

Click "Times New Roman."

Your text should now look similar to the following: "Arial Courier Times New Roman"

Save File

Save your file by following these instructions:

1. Choose File > Save As from the menu.
2. Specify the correct folder in the Look In field.
3. Name your file by typing lesson4.doc in the File Name field.
4. Click Save. 
   Note: This document will contain Lesson Three and Lesson Four.
5. Click File.

**Working with Paragraphs and Documents**

Open Microsoft Word. In the lesson that follows, you will learn various ways to format a paragraph. When you are formatting a paragraph, you do not need to highlight the entire paragraph. Placing the cursor anywhere in the paragraph enables you to format it. After you set a paragraph format, subsequent paragraphs will have the same format unless you change their format. You will need text to work with to perform the exercises for this lesson, so type the following exactly as shown. End paragraphs where you see the end-of-paragraph marker (¶). Press Enter once to end the paragraph, **but do not leave spaces between paragraphs**. You will set the space between paragraphs during the exercise. Do not press Enter to move to a new line -- Microsoft Word automatically wraps at the end of a line.

**Sample Paragraphs ¶**

We will use this paragraph to illustrate several Microsoft Word features. It will be used to illustrate Space Before, Space After, and Line Spacing. Space Before tells Microsoft Word how much space to leave before the paragraph. Space After tells Microsoft Word how much space to leave after the paragraph. Line Spacing sets the space between lines within a paragraph. ¶

We will use this paragraph to illustrate some additional Microsoft Word features. It will be used to illustrate first-line indent. With first-line indent, you can indent the first line of your paragraph. We will also look at indentation. Indentation enables you to indent from the left or right margin of your document. ¶

**Space Before and Space After**

Space Before sets the amount of space before the paragraph. Space After sets the amount of space after the paragraph. Following are the sample paragraphs with Space After set to 12 pt. The exercises that follow give you a chance to see how Space Before and Space After work.

**Example -- Space After**

Sample Paragraphs ¶

We will use this paragraph to illustrate several Microsoft Word features. It will be used to illustrate Space Before, Space After, and line spacing. Space Before tells Microsoft Word how much space to leave before the paragraph. Space After tells Microsoft Word how much space to leave after the paragraph. Line Spacing sets the space between lines within a paragraph. ¶

We will use this paragraph to illustrate some additional Word features. It will be used to illustrate first-line indent. With first-line indent, you can indent the first line of your
paragraph. We will also look at Indentation. Indentation enables you to indent from the left and/or right margins of your document.

**Exercise 1**

**Space Before**

Highlight the title of the sample text: "Sample Paragraphs."

Choose *Format > Paragraph* from the menu.

Choose the Indents and Spacing tab.

Enter **18 pt** in the Before field.

Click OK. You now have 18 points before "Sample Paragraph."

**Space After**

1. Highlight all of the text you typed (the title and both paragraphs):
2. Choose *Format > Paragraph* from the menu.
3. Choose the Indents and Spacing tab.
4. Enter **12 pt** in the After field.
5. Click OK. You now have 12 points after each paragraph.

**Line Spacing**

Line Spacing sets the amount of space between lines within a paragraph. Single spacing is the default. The spacing for each line is set to accommodate the largest font on that line. If there are smaller fonts on the line, there will appear to be extra space between lines where the smaller fonts are located. At 1.5 lines, the Line Spacing is set to one-and-a-half times the single-space amount. For double-spaced lines, the line spacing is set to two times the single-space amount.

**Exercise 2**

Highlight the first paragraph you typed, starting with "We will use" and ending with "within a paragraph."

Choose *Format > Paragraph* from the menu. Choose the Indents and Spacing tab.

Click to open the drop-down menu on the Line Spacing field.

Click **1.5 Lines**. Click OK. Your line spacing for the paragraph is now 1.5.

**First-Line Indent**

This exercise demonstrates how you can indent the left side of the first line of your paragraph, as in the following example.
**Example -- First-line Indent**

The first-line indent feature indents the first line of the paragraph. The amount of the indent is specified in the By field. The remainder of the paragraph is indented by the amount specified in the Indentation field.

**Exercise 3**

1. Highlight the second paragraph you typed, beginning with "We will use" and ending with "of your document."
2. Choose Format > Paragraph from the menu.
3. Choose the Indents and Spacing tab.
4. Click to open the drop-down menu on the Special field.
5. Click First Line.
6. Enter 0.25" in the By field.
7. Click OK.

The first line of your paragraph is now indented .25 inches.

**Special Note:** To remove the first line indent:

Place the cursor anywhere in the paragraph. Choose Format > Paragraph from the menu. Choose the Indents and Spacing tab.

Click in the Special pull-down menu; then Click None. Click OK.

**Indentation**

Indentation allows you to indent your paragraph from the left or right margin. The following examples show different types of indentation.

**Example -- Indentation**

We will use this paragraph to illustrate several Word features. We will illustrate Space Before, Space After, and Line Spacing. Space Before tells Word how much space to leave before the paragraph. Space After tells Word how much space to leave after the paragraph. Line Spacing sets the space between lines within a paragraph. We will use this paragraph to illustrate some additional Word features. We will illustrate first-line indent. With first-line indent, you can indent the first line of your paragraph. We will also look at Indentation. Indentation enables you to indent from the left or right margins of your document.

**Exercise 4**

1. Highlight the second paragraph, beginning with "We will use" and ending with "of your document "
2. Choose Format > Paragraph from the menu.
3. Type 1” in the Left field.
4. Type 1” in the Right field.
5. Click OK. Your paragraph is now indented one inch from both the left and right margins, as in the example.

Alignment

Microsoft Word gives you a choice of several types of alignment. Left-justified text is aligned on the left side. It is the default setting.

**Example -- Left-Justified**

Sample Paragraph

This is a sample paragraph. It is used to illustrate alignment. Left-justified text is aligned on the left. Right-justified text is aligned on the right. Centered text is centered between the left and right margins. You can use Center to center your titles. Justified text is flush on both sides. Right-justified text is aligned on the right side.

**Example -- Right-Justified**

Sample Paragraph

This is a sample paragraph. It is used to illustrate alignment. Left-justified text is aligned on the left. Right-justified text is aligned with on the right. Centered text is centered between the left and right margins. You can use Center to center your titles. Justified text is flush on both sides.

Centered text is centered between the left and right margins.

**Example -- Centered**

Sample Paragraph

This is a sample paragraph. It is used to illustrate alignment. Left-justified text is aligned on the left. Right-justified text is aligned with on the right. Centered text is centered between the left and right margins. You can use Center to center your titles. Justified text is flush on both sides.

Justified text is flush on both sides.
**Example -- Justified**

Sample Paragraph

This is a sample paragraph. It is used to illustrate alignment. Left-justified text is aligned on the left. Right-justified text is aligned with on the right. Centered text is centered between the left and right margins. You can use Center to center your titles. Justified text is flush on both sides.

The following exercises demonstrate how to justify text.

**Exercise 5**

**Right-Justify**

Return to the first paragraph you typed, beginning with "We will use" and ending with "within a paragraph." Highlight the paragraph.

Choose *Format > Paragraph* from the menu.

Choose the Indents and Spacing tab.

Click to open the Alignment pull-down menu.

Click Right. Click OK. The paragraph is now right-aligned.

**Left-Justify**

1. Highlight the first paragraph you typed, beginning with "We will use" and ending with "within a paragraph."
2. Choose *Format > Paragraph* from the menu.
3. Choose the Indents and Spacing tab.
4. Click to open the Alignment pull-down menu.
5. Click Left.
6. Click OK. The paragraph is now left-aligned.

**Alternate Method -- Right-Justify by Using Keys**

Highlight the text.

Press Ctrl-r. The paragraph is now right-aligned.

**Alternate Method -- Left-Justify by Using Keys**

1. Highlight the text.
2. Press Ctrl-l. The paragraph is now left-aligned.

**Alternate Method -- Right-Justify by Using the Icon**
Highlight the text.

Click the Align Right icon. The paragraph is now right-aligned.

**Alternate Method -- Left-Justify by Using the Icon**

Highlight the text.

Click the Align Left icon. The paragraph is now left-aligned.

**Center - Using the Menu**

Highlight the first paragraph you typed, beginning with "We will use" and ending with "within a paragraph."

Choose Format > Paragraph from the menu.

Choose the Indents and Spacing tab.

Click to open the Alignment pull-down menu.

Click Centered.

Click OK. The paragraph is now centered.

**Justify - Using the Menu**

1. Highlight the first paragraph you typed, beginning with "We will use" and ending with "within a paragraph."
2. Choose Format > Paragraph from the menu.
3. Choose the Indents and Spacing tab.
4. Click to open the Alignment pull-down menu.
5. Click Justified.
6. Click OK. The paragraph is now justified.

**Alternate Method -- Justify and Center by Using Keys**

Highlight the text.

Press Ctrl-e. The text is now centered.

Press Ctrl-j. The text is now justified.

**Alternate Method -- Justify and Center by Using the Icon**

Highlight the text.
Click the Center icon. The text is now centered.

Click the Justify icon. The text is now justified.

**Hanging Indent**

The hanging indent feature indents each line except the first line by the amount specified in the By field, as shown in the example.

**Example: Hanging Indent**

Hanging Indent: The hanging indent feature indents the first line of the paragraph from the margin by the amount specified in the Left field. The amount in the Left field plus the amount specified in the By field indent all subsequent lines.

**Exercise 6**

When you begin typing the following paragraph, you might find that your paragraph is indented one inch on both sides. When you start a new paragraph in Microsoft Word, the setting from the previous paragraph carries over. If you wish, you can reset the indentation. If you choose not to reset the indentation, it will not affect your ability to perform the exercise.

1. Type the following:
   **Hanging Indent:** The hanging indent feature indents the first line by the amount specified in the Left field. Subsequent lines are indented by the amount specified in the Left field plus the amount specified in the By field. Highlight the paragraph you just typed.
2. Choose Format > Paragraph from the menu.
3. Choose the Indents and Spacing tab.
4. In the Special field, click to open the pull-down menu.
5. Click Hanging.
6. In the By box, type 2.0".
7. Click OK.
8. Place the cursor after the colon following "Hanging Indent."
9. Press the Tab key.
10. Notice how the indentation changes.

**The Tab Key**

The default tab setting for Microsoft Word is .5 inches. When you press the Tab key, the cursor moves 1/2 inch across the page and an arrow appears on the screen. The arrow is a nonprinting character, when you print your document the arrow does not print.

**Illustration**
Press the Tab key a few times. Note how the cursor moves across the page.

To change the default tab setting:

Choose Format > Tabs from the menu. The Tabs dialog box opens.

Enter 1" in the Default Tab Stops field.

Click OK.

Press the Tab key a few times. Note how the cursor moves across the page. The cursor stops at every inch.

You can also set up custom tab stops. To set your tab stops to 1.5", 3.5", and 6":

Choose Format > Tabs from the menu. The Tabs dialog box opens.

Enter 1.5" in the Tab Stop Position field.

Click Set.

Enter 3.5 in the Tab Stop Position field.

Click Set.

Enter 6 in the Tab Stop Position field.

Click OK.

Press the Tab key a few times. Note how the cursor moves across the page.

**Bullets and Numbering**

In Microsoft Word, you can easily create bulleted or numbered lists of items. Several bulleting and numbering styles are available, as shown in the examples. You select the one you wish to use. Try the exercises to see how it works.

**Examples -- Numbering**


i. Apple
ii. Orange
iii. Grape
iv. Mango
v. Cherry
Examples -- Bulleting

- Apple
- Orange
- Grape
- Mango
- Cherry
- Apple
- Orange
- Grape
- Mango
- Cherry
- Apple
- Orange
- Grape
- Mango
- Cherry
- Apple
- Orange
- Grape
- Mango
- Cherry

1. Apple 1) Apple I Apple
2. Orange 2) Orange II Orange
3. Grape 3) Grape III Grape
4. Mango 4) Mango IV Mango
5. Cherry 5) Cherry V Cherry

Exercise 1

Type the following as shown.
Apple
Orange
Grape
Mango
Cherry

Highlight the words you just typed.

Choose Format > Bullets and Numbering from the menu.

Choose the Numbered tab. Several styles are available to you. Click the style you want to use.

Click OK. Your list is now numbered.

To remove the numbering:

1. Highlight the list again.
2. Choose Format > Bullets and Numbering from the menu.
3. Click None.
4. Click OK. Your list is no longer numbered.

Alternate Method -- Numbering by Using the Icon.
Highlight the list you typed.

Click the Numbering icon on the Formatting toolbar. Your list is now numbered.

To remove the numbering:

1. Highlight the list again.
2. Click again on the Numbering icon. Your list is no longer numbered.

**Bulleting**

Highlight the list you typed.

Choose Format > Bullets and Numbering from the menu.

Choose the Bulleted tab.

Several styles are available to you. Click the style you want to use.

Click OK. Your list is now bulleted.

To remove bulleting: Highlight the list again.

Choose Format > Bullets and Numbering from the menu.

Click None.

Click OK. Your list is no longer bulleted.

**Alternate Method -- Bulleting by Using the Icon**

Highlight the list you typed.

Click the Bullets icon on the Formatting toolbar. Your list is now bulleted.

To remove the bulleting: Highlight the list again.

Click the Bullets icon again. Your list is no longer bulleted.

**Undo & Redo**

You can quickly reverse most commands you execute by using Undo. If you then change your mind, you can use Redo.

**Exercise 2**

1. Type **Undo example**.
2. Choose Edit > Undo Typing from the menu. The typing disappears.
3. Choose Edit > Redo Typing from the menu. The typing reappears.
4. Highlight "Undo example."
5. Press Ctrl-b to bold.
6. Choose Edit > Undo Bold from the menu. The bolding is removed.
7. Choose Edit > Redo Bold from the menu. Your text is bolded.

Alternate Method -- Undo & Redo by Using Keys

Type: Undo example.
Press Ctrl-z. The typing disappears.
Press Ctrl-y. The typing reappears.
Highlight ":Undo example."
Press Ctrl-u to underline.
Press Ctrl-z. The underline is removed.
Press Ctrl-y. The underline reappears.

Save File

Save your file by following these instructions:
Choose File > Save As from the menu.
Specify the correct folder in the Look In field.
Name your file by typing lesson6.doc in the File Name field.
Click Save. Don't exit Microsoft Word.

File Close

Close your file by following these instructions. You are going to open a new file for the next exercise. Choose File > Close from the menu.

Open New File

1. Choose File > New from the menu.
3. If you need to close the pane, click on the X in the upper right corner of the New Document Pane to close the pane.

Exercise 3
This exercise is intended to bring together all the things you have learned. Type and save the following document. Refer to the previous lessons and exercises if you need help.

**Selecting Accounting Software**

Many accounting software packages are on the market today. Selecting the right one for your company can be a daunting task. You must consider many factors, such as software, hardware, accounting issues, and internal needs that might be specific to your company.

When reviewing software features, you need to review at a long list of criteria. Among them are these:

- Reporting
- Security
- Ease of use
- Customizability
- Operating system

When looking at reporting, you must review these two reporting features:

**Standard reports:** Standard reports are reports that come with the software when you purchase it. You will want to check these reports against your current reports.

**Custom reports:** Customized reporting means you can create your own custom reports. If you need information that is not contained in the standard reports, you will need to write your own customized reports.

**Printing**

After you have finished typing your document, you will want to print it. While preparing to print, you can specify the number of copies you want and the pages you want to print.

Exercise 3 -- Print Your Document Choose File > Print from the menu.

Click OK. Alternate Method - Printing by Using the Icon

Click the Print icon on the Standard toolbar.

**Microsoft-Word Tables**

This lesson will teach you how to create tables. You use tables to format all or part of your document into columns and rows. Each exercise in this lesson is dependent on your having completed the exercise that preceded it. Complete the exercises in sequence. To begin this lesson, open Microsoft Word.
Creating a Table

To create a four-column, five-row table: Choose Table > Insert > Table from the menu. The Insert Table dialog box opens.

Type 4 in the Number of Columns field. Type 5 in the Number of Rows field.

Select Auto in the Column Width field. Selecting Auto allows Microsoft Word to determine the size of your column widths. Alternatively, you can enter the column width you desire.

Click OK. Your table should look like the one shown here, with four columns and five rows.

**Alternate Method -- Creating a Table by Using the Insert Table Icon**

You can also create a table by clicking on the Insert Table icon on the Standard toolbar.

1. Click the Insert Table icon.

Highlight the number of rows and columns you need. The maximum table size you can create by this method is a four-row by five-column table. Press Enter (or click) to create the table.

**Note:** Microsoft Word has a Tables and Borders toolbar. This lesson does not cover the Tables and Borders toolbar.

**Moving Around a Table**

Each block in a table is called a cell. Use the Tab key to move from cell to cell from left to right. Use Shift-Tab to move from cell to cell from right to left. The following exercise demonstrates. Click in the first cell in the first column.

Press the Tab key nine times. The cursor moves forward nine cells.

Press Shift-Tab six times. The cursor moves backward six cells.

**Note:** You can also move to a cell by clicking in the cell. In addition, you can move around the table by using the left, right, up, and down arrow keys.
Entering Text into a Table

To enter text into a table, simply type as you normally would. Press Tab to move to the next cell. Enter the text shown below into your table.

1. Type **Salesperson** in the first cell in the first column. Press the Tab key.
2. Type **Dolls** in the first cell in the second column. Press the Tab key.
3. Continue until you have entered all of the text.

<table>
<thead>
<tr>
<th>Salesperson</th>
<th>Dolls</th>
<th>Trucks</th>
<th>Puzzles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kennedy, Sally</td>
<td>1327</td>
<td>1423</td>
<td>1193</td>
</tr>
<tr>
<td>White, Pete</td>
<td>1421</td>
<td>3863</td>
<td>2934</td>
</tr>
<tr>
<td>York, George</td>
<td>2190</td>
<td>1278</td>
<td>1928</td>
</tr>
<tr>
<td>Banks, Jennifer</td>
<td>1201</td>
<td>2528</td>
<td>1203</td>
</tr>
</tbody>
</table>

Selecting a Row and Bolding the Text

You learned about bolding in Lesson Three. In this exercise, you will select the first row of the table and bold all of the text on the row.

Click anywhere on the first row of your table.

Choose **Table > Select > Row** from the menu. Press Ctrl-b to bold the row.

Right-Aligning Text

You learned about alignment in Lesson Five. In this exercise, you will right-align the second (Dolls), third (Trucks), and fourth (Puzzles) columns of the table you created. You need to highlight "Dolls," "Trucks," and "Puzzles." Place the cursor before the "D" in "Dolls." Press the F8 key to anchor the cursor. Then press the right arrow key until you have highlighted "Dolls," "Trucks," and "Puzzles."

Choose **Table > Select > Column** from the menu. Press Ctrl-r to right-align the cells. Your table should look like the one shown here. Make any needed corrections before continuing. **Note:** All of the formatting options you learned about in previous lessons can be applied to cells in a table.

Adding a New Row to the End of the Table

You can add additional rows to your table. The simplest way to add a new row is to move to the last column of the last row and press the Tab key. You can then type any additional text you need to add.
1. Move to the last column of the last row of your table.
2. Press the Tab key.
3. Type the text shown here.

| Atwater, Kelly | 4098 | 3079 | 2067 |

**Adding a Row Within the Table**

You can add a new row anywhere in the table. The exercise that follows demonstrates.

To add a row just above York, George:

Place the cursor anywhere in the fourth row (the row with York, George as the salesperson).

Choose Table > Insert > Rows Above from the menu.

Add the information shown here to the new row.

| Pillar, James | 5214 | 3247 | 5467 |

**Resizing the Columns**

You can easily change the size of your column widths. In this exercise, you will select the entire table and adjust all the column widths.

Click anywhere in your table.

Choose Table > Select > Table from the menu. Your table is selected.

Choose Table > Table Properties from the menu. Choose the Column tab.

Type 1" in the Preferred Width field. This will cause Microsoft Word to set all the columns to a width of one inch. Click OK.

Depending on your font, the first column of your table might not be wide enough and the text might be wrapping.

To widen the first column:

Place the cursor anywhere in the first column.

Choose Table > Select > Column from the menu.

Choose Table > Table Properties from the menu.

Choose the Column tab.
Type 1.5 in the Preferred Width field. Click OK.

Alternate Method -- Resizing Your Column Widths by Using the Width Indicator

You can resize your column widths by placing the cursor on the line that separates two columns. This causes the width indicator to appear. After the width indicator appears, left-click and drag with the mouse to adjust the column width.

Adding a New Column to a Table

You can add new columns to your table. To add a new column between the Salesperson and Dolls columns:

Place the cursor anywhere in the Dolls column.

Choose Table > Insert > Columns to the Left from the menu.

Label the new column Region and add the text shown in the table below.

<table>
<thead>
<tr>
<th>Salesperson</th>
<th>Region</th>
<th>Dolls</th>
<th>Trucks</th>
<th>Puzzles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kennedy, Sally</td>
<td>S</td>
<td>1327</td>
<td>1423</td>
<td>1193</td>
</tr>
<tr>
<td>White, Pete</td>
<td>N</td>
<td>1421</td>
<td>3863</td>
<td>2934</td>
</tr>
<tr>
<td>Pillar, James</td>
<td>N</td>
<td>5214</td>
<td>3247</td>
<td>5467</td>
</tr>
<tr>
<td>York, George</td>
<td>S</td>
<td>2190</td>
<td>1278</td>
<td>1928</td>
</tr>
<tr>
<td>Banks, Jennifer</td>
<td>S</td>
<td>1201</td>
<td>2528</td>
<td>1203</td>
</tr>
<tr>
<td>Atwater, Kelly</td>
<td>S</td>
<td>4098</td>
<td>3079</td>
<td>2067</td>
</tr>
</tbody>
</table>

Sorting a Table

With Microsoft Word, it is easy to sort the data in your table. To sort your table data by Region and within Region by Salesperson in ascending order:

1. Click anywhere on your table.
2. Choose Table > Sort from the menu.
3. Select Region in the Sort By field.
4. Select Text in the Type field (because you are sorting text).
5. Select Ascending.
6. Select Salesperson in the Then By field.
7. Select Text in the Type field (because you are sorting text).
8. Select Ascending.
9. Select Header Row (because your table has titles across the top of the table).
10. Click OK.
Microsoft Word should have sorted your table like the one shown here:

<table>
<thead>
<tr>
<th>Salesperson</th>
<th>Region</th>
<th>Dolls</th>
<th>Trucks</th>
<th>Puzzles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pillar, James</td>
<td>N</td>
<td>5214</td>
<td>3247</td>
<td>5467</td>
</tr>
<tr>
<td>White, Pete</td>
<td>N</td>
<td>1421</td>
<td>3863</td>
<td>2934</td>
</tr>
<tr>
<td>Atwater, Kelly</td>
<td>S</td>
<td>4098</td>
<td>3079</td>
<td>2067</td>
</tr>
<tr>
<td>Banks, Jennifer</td>
<td>S</td>
<td>1201</td>
<td>2528</td>
<td>1203</td>
</tr>
<tr>
<td>Kennedy, Sally</td>
<td>S</td>
<td>1327</td>
<td>1423</td>
<td>1193</td>
</tr>
<tr>
<td>York, George</td>
<td>S</td>
<td>2190</td>
<td>1278</td>
<td>1928</td>
</tr>
</tbody>
</table>

The Sum Function

You can perform calculations on the numbers in your table. Several functions are available to you. A review of all of the functions is beyond the scope of this tutorial, but the exercise that follows demonstrates the Sum function. In this exercise, you will add a new row to your table, place the word "Total" at the bottom of the Salesperson column, and sum the Dolls, Trucks, and Puzzles columns.

1. Place your cursor in the cell located on the last row in the last column.
2. Press the Tab key to create a new row.
3. Type Total in the cell on the bottom row in the Salesperson column.
4. Move to the Dolls column.
5. Choose Table > Formula from the menu.
6. Type =SUM(ABOVE) in the formula field, if it does not automatically appear.
7. Select #,##0 in the Number Format field. This selection causes Microsoft Word to separate thousands with a comma.
8. Click OK.
9. Move to the Trucks column.
10. Choose Table > Formula from the menu.
11. Type =SUM(ABOVE) in the formula field, if it does not automatically appear.
12. Select #,##0 in the Number Format field. This selection causes Microsoft Word to separate thousands with a comma.
13. Click OK.
14. Move to the Puzzles column.
15. Choose Table > Formula from the menu.
16. Type =SUM(ABOVE) in the formula field, if it does not automatically appear.
17. Select #,##0 in the Number Format field. This selection causes Microsoft Word to separate thousands with a comma.
18. Click OK.

Deleting a Column

You can delete columns from your table. To delete the Trucks column:

Place your cursor anywhere in the Trucks column.

Choose Table > Delete> Columns from the menu.
Deleting a Row

You can delete rows from your table. To delete the York, George row:

1. Place your cursor anywhere in the York, George row.
2. Choose Table > Delete > Rows from the menu.

Recalculate

Unlike a spreadsheet, Microsoft Word does not automatically recalculate every time you make a change to the table. To cause a function to recalculate, you must first move to the cell that contains the function and then press the F9 key. Alternatively, you can move to the cell that contains the function, right-click, and select Update Field from the context menu. Because you deleted a row in the previous exercise, your calculations are now incorrect. To recalculate:

1. Move to the Dolls/Total cell.
3. Move to the Puzzles/Total cell and right-click.
4. Click Update Field.

Note: The context menu is a useful tool. When you right-click, Microsoft Word supplies you with a list of menu choices. You can execute a command by selecting an option from the context menu.

Merge Cell

Using Microsoft Word, you can merge cells -- turn two or more cells into one cell. In this exercise, you are going to create a new row at the top of your table, merge the cells, and add a title to the table.

Move to the cell located on the first row of the first column of your table (the Salesperson cell). Choose Table > Insert > Rows Above from the menu.

Choose Table > Merge Cells from the menu. Type Toy Sales in the new cell.

Press Ctrl-e to center the title.

Table Headings

If Microsoft Word splits your table with a page break, the table heading will display on the first page but not on subsequent pages. To correct this problem, you can designate rows as headings. Heading rows are repeated on the top of your table at the top of each page. To designate a row as a heading:

1. Place your cursor on the row.
2. Choose Table > Heading Rows Repeat from the menu.
**Converting Text to a Table**

You can convert text to a table; however, a delimiter such as a comma, paragraph marker, or tab must separate columns of text. In the exercise that follows, you will convert comma-delimited text into a table.

1. Type the following as shown (do not bold).
   - **Color**, **Style**, **Item**
   - Blue, A980, Van
   - Red, X023, Car
   - Green, YL724, Truck
   - **Name**, **Age**, **Sex**
   - Bob, 23, M
   - Linda, 46, F
   - Tom, 29, M

2. Highlight the text.
3. Choose **Table > Convert > Text to Table** from the menu.
4. Type **3** in the Number of Columns field.
5. Select **Auto** in the Column Width field.
6. Select the **Commas** radio button in the Separate Text At frame.
7. Click OK.

Microsoft Word should have converted your text to a table and your table should look like the one shown here.

**Splitting a Table**

With Microsoft Word, splitting a single table into two tables is easy. To separate the table you just created into two tables:

Place your cursor anywhere on the row that reads "Name, Age, Sex."

Choose **Table > Split Table** from the menu. You should now have two tables.

**Table AutoFormat**

You can use AutoFormats to apply borders, shading, special fonts, and color to your table. Microsoft Word lists all Formats in the Table AutoFormat dialog box. While in the Table AutoFormat dialog box, click a format to see that format displayed in the Preview box. You can customize how the format is applied. Check the features you want in the Formats to Apply and the Apply Special Formats To frames. Microsoft Word comes with a long list of AutoFormats.
To apply an AutoFormat to your Name, Age, and Sex table:

1. Click anywhere in the table.
2. Choose Table > Table AutoFormat from the menu.
3. Click Table Colorful 1 in the Table Styles box.
4. Select Heading Rows and First Column in the Apply Special Formats To frame.
   Do not select Last Row and Last Column.
5. Click Apply.

Your table should look like the one shown here.

**Save File**

Save your file by following these instructions:

1. Choose File > Save As from the menu.
2. Specify the correct folder in the Look In field.
3. Name your file by typing lesson7.doc in the File Name field.
4. Click Save.
5. Choose File > Exit from the menu to close Microsoft Word.
Reference

Books:

Web sites:
- http://lorien.ncl.ac.uk/ming/Dept/Tips/present/comms.htm
- http://www.communicationskills.co.in/
- http://www.hinduonnet.com/folio/fo9908/99080360.htm
- http://www.corporateculture.co.in/
- http://sbinfocanada.about.com/cs/successprogram/a/week5.htm
- http://www.intelligententerprise.com/030718/612feat2_1.jhtml
- http://www.freshthinkingbusiness.com/crm-model.html
- http://www.learnenglish.de/improvepage.htm
- http://www.antimoon.com/
- http://nonverbal.ucsc.edu/
- http://www.vocabulary.co.il/
- http://www.pronouncenames.com/names/alpha/Ah
- http://www.bbc.co.uk/worldservice/learningenglish/grammar/pron/
- http://www.perfectpronunciation.com/
- http://international.ouc.bc.ca/pronunciation/
- http://www.businessenglishpod.com/
- http://www.listening-in.com/